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រុពវកថា 

 

ដំលណីរ ភិវឌ្ឍននស្រះរជាណាចស្កកម្ព៊ុជាលៅកន៊ុងយ៊ុគរម័្យទំលនីបលនះ ជាលម្លរៀនដ៏លជាគជ័យ
បំផ៊ុតមួ្យដដ ចាប់ឬរគ ់លចញរីការបញ្ច ប់របបស្ប ័យរូជសារន៍ ការបញ្ច ប់រង្គ្រា ម្ ការផសះផារ
ជាតិ ការកសាងមូ្ ដ្ឋា នរងឹមនំនរនតិភារនិងលរេរភារ និងការ ភិវឌ្ឍលរដាកិចច។ លៅលស្កាយលរ 
ដដ រនតិភារស្តូវបានលកីតល ីងលដ្ឋយបរបូិរណ៍លៅឆ្ន ១ំ៩៩៨ កម្ព៊ុជាទទួ កំលណីនលរដាកិចចខ្ពរ់ គឺ
ស្បមណ៨%កន៊ុងមួ្យឆ្ន ។ំ ល ីររីលនះលទៀត ស្តាននភារស្កីស្កស្តូវបានកាត់បនេយរីស្បមណ៥៣% 
លៅឆ្ន ២ំ០០៤ម្កលៅទាបជាង១០% លៅឆ្ន ២ំ០១៩។ ដំលណីរននការ ភិវឌ្ឍជាតិជារកម្មភារដដ បនត
លៅម្៊ុខ្ជាប់ជានិចច លហយីលោ នលោបាយថ្មីៗដដ មន កខណៈ នតរវរិ័យស្គបដណត ប់ ក៏កំរ៊ុងល ច
រូបរងល ីងលដីម្បីតស្ម្ង់ទិរកម្ព៊ុជាលឆ្ព ះលៅកាន់ស្បលទរមនស្បាក់ចំណូ ម្ធ្យម្កស្មិ្តខ្ពរ់លៅឆ្ន ំ
២០៣០ និងឈានល ងីជាស្បលទរមនស្បាក់ចំណូ ខ្ពរ់ លៅឆ្ន ២ំ០៥០។ ការដស្បស្បួ ឆ្ប់រហ័រនន
និមម បនកម្មរិភរលោក និងតំបន់រួម្ទាងំទំនាក់ទំនងភូមិ្សាង្គ្រតនលោបាយ បានផត ់កាោន៊ុវតតភារ
រស្មប់ការ ភិវឌ្ឍឧរាហកម្មលៅកម្ព៊ុជា ដដ ស្តូវបានរជរដ្ឋា ភិបា ចាត់ទ៊ុកជាមូ្ ដ្ឋា នស្គឹះនន
កំលណីនលរដាកិចចកម្ព៊ុជា។ រជរដ្ឋា ភិបា កម្ព៊ុជាបានកំរ៊ុងបនតរស្ងឹង និង ភិវឌ្ឍវរិ័យ ប់រលំឆ្ព ះលៅរក
ការស្សាវស្ជាវ និងនវាន៊ុវតតន៍លដីម្បីរស្ងឹងរម្តេភារនិងជំនាញរបរ់ធ្នធានម្ន៊ុរសលៅកម្ព៊ុជាឱ្យស្រប
លៅនឹងបរបិទថ្មីននការ ភិវឌ្ឍ ជារិលររការរស្ងឹងរហស្គិនភារកន៊ុងការលរៀបចំម្៉ាូដដ ធ្៊ុរកិចចថ្មីៗ។ 
លដីម្បីចាប់យកកាោន៊ុវតតភាររីបដិវតតន៍ឧរាហកម្មទី៤ និងលរដាកិចចឌី្ជីថ្ ដដ កំរ៊ុងផ៊ុរផ៊ុ 
ល ងី ស្បរ័នធល កូ ូហស៊ុដីដ បងក កខណៈ ំលណាយផ ដ ់ការបលងកីតថ្មី នវាន៊ុវតតន៍ ការស្សាវស្ជាវ និង
 ភិវឌ្ឍន៍ ស្តូវដតមនការដក ម្អ។ 
  

បណាត ស្បលទរលៅទវីបអរ៊ុីកំរ៊ុងនាំម្៊ុខ្កន៊ុងការវនិិលោគល ីការស្សាវស្ជាវនិង ភិវឌ្ឍ លដ្ឋយ 
មនភាគហ ៊ុនស្បមណ៤៤% ននការវនិិលោគទាងំមូ្ របរ់រិភរលោក។ ស្បលទរចិនកំរ៊ុងបនតកសាង 
លហដ្ឋា រចនារម្ព័នធននការវនិិលោគល ីការស្សាវស្ជាវនិង ភិវឌ្ឍ ក៏ដូចជារម្តេភារម្ន៊ុរស។ ផទ៊ុយលៅ 
វញិ ស្បលទរលៅទវីបអលម្រកិខាងតបូង និងអង្គ្ហវកិ កំរ៊ុងរេិតលៅឆ្ា យរីការវនិិលោគលនះ លហយីជា ទធ
ផ  ស្បលទរទាងំលនាះក៏រ៊ុំមនកំលណីនលរដាកិចចគួរឱ្យកត់រមា  ់ដដរ។ ទ៊ុនវនិិលោគររ៊ុបល ីការស្សាវ 
ស្ជាវនិង ភិវឌ្ឍរបរ់ស្បលទរលៅទវីបអលម្រកិខាងតបូវនិងអង្គ្ហវិក មនស្បមណ៥%ននការវនិិលោគ 
ទាងំមូ្ របរ់រិភរលោក កន៊ុងលរ ដដ តំបន់ទាងំ២លនះមនស្បជាជនស្បមណ២០%ននស្បជាជន 
រិភរលោក។ ស្បលទរចំនួន៦ដដ មន ំដ្ឋប់ខ្ពរ់ជាងលគលៅកន៊ុងការវនិិលោគល ីការស្សាវស្ជាវនិង
 ភិវឌ្ឍ រួម្មនរហរដាអលម្រកិ ចិន ជប៉ា៊ុន អ លឺម្៉ាង់ ឥណាា  និងកូលរ ៉ាខាងតបូង ដដ លរមីនឹងស្បមណ 
៧០%ននទ៊ុនវនិិលោគររ៊ុបរបរ់រិភរលោក។ 
 

លតីចំលណះដឹង ផ ិតផ  និងលរវាកម្មថ្មីទាងំលនះលកីតល ងីរី វី? លហយីលកីតល ងីលដ្ឋយ
រលបៀបណា? ស្រះរជាណាចស្កកម្ព៊ុជាកំរ៊ុងដតកសាងមូ្ ដ្ឋា នរស្មប់ការលស្តៀម្ខ្លួនទទួ  និងស្បកួត
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ស្បដជងកន៊ុងយ៊ុគរម័្យបដិវតតឧរាហកម្មទី៤ លៅកន៊ុងលរដាកិចចដដ ដផអកល ីរ៊ុទធិ លហយីដដ ស្បការលនះ
ចាបំាច់តស្មូ្វឱ្យរ រដាកម្ព៊ុជា ស្តូវកាល យខ្លួនជារ រដាឌី្ជីថ្  រ រដារក  និងរ រដាដដ ស្បកប
លដ្ឋយការទទួ ខ្៊ុរស្តូវ ដដ មនរម្តេភារកន៊ុងការផ ិត ដចកចាយ និងលស្បីស្បារ់រ៊ុទធិលដីម្បទីទួ 
ម្ន៊ុញ្ញផ  និងរមួ្ចំដណកកន៊ុងកំលណីន។ ធ្នាោររិភរលោកបានលធ្វីការកត់រមា  ់តាងំរីឆ្ន ២ំ០០២
នូវបមល រ់បតូរននមូ្ ដ្ឋា នលរដាកិចច រីលរដាកិចចដដ រឹងដផអកល ីកមល ងំរ កម្ម និងធ្នធាន តិកម្ម 
(Labour and Resource Based Economy) លៅកាន់លរដាកិចចដដ រឹងដផអកល ីរ៊ុទធិ (Knowledge 
Based-Economy) ដដ កន៊ុងន័យលនះ រ៊ុទធិគឺជាគនលឹះននការ ភិវឌ្ឍ។ អស្រ័យលហត៊ុលនះ លៅល ីគនលង
ដដ កម្ព៊ុជាកំរ៊ុងលធ្វីដំលណីរលឆ្ព ះលៅកាន់លរដាកិចចឌី្ជីថ្  រងាម្កម្ព៊ុជាស្តូវដតមនរម្តេភារកន៊ុងការ  
ផ ិត លស្ជីរលររី បនា៊ុ ំ បលងកីតម្៊ុខ្របរ និងលស្បីស្បារ់រ៊ុទធិ លដីម្បរីកានិរនតរភារននកំលណីន និងដក ម្អ
ជីវភារររ់លៅ។ រម្តេភារទាងំលនះ អចលកីតល ងីលៅលរ រ រដាកម្ព៊ុជាមនឱ្ការកន៊ុងការទទួ 
បានបទរិលសាធ្ន៍រីការស្សាវស្ជាវ ការបណត៊ុ ះគំនិតនចនស្បឌិ្ត និងការដរវងរកនវាន៊ុវតតន៍។  
 

កំដណទស្ម្ង់វរិ័យ ប់រ ំ គឺជាការស្តួរស្តាយមោ៌ា រស្មប់ដំលណីរលឆ្ព ះលៅកាន់រងាម្ស្បកប
លដ្ឋយរ៊ុទធិ និងស្បជារ រដាស្បកបលដ្ឋយភារររ់រលវកី។ តាម្រយៈមូ្ ដ្ឋា ន ប់រ ំរងាម្ស្បកបលដ្ឋយរ៊ុទធិ
នឹងស្បមូ្ ផត៊ុ ំ បលងកីត និងដចករដំ ក លៅកាន់រមជិកកន៊ុងរងាម្នូវរម្បទា ប់រ ំ រិលររគឺរ៊ុទធិរម្បទា 
កន៊ុងប៊ុរវលហត៊ុននម្ន៊ុរសជាតិនិងឧតតម្ស្បលោជន៍ននស្បលទរ។ រងាម្ស្បកបលដ្ឋយរ៊ុទធិ គឺរ៊ុំស្ោន់ដតជា
រងាម្ដដ រម្បូររ័ត៌ាមនប៉ា៊ុលណាណ ះលទ ដតជារងាម្ដដ ស្បជារ រដាអចលធ្វីបរវិតតកម្មរីរ័ត៌ាមនលៅជា 
មូ្ ធ្នស្បកបលដ្ឋយស្បរិទធភារ។ ការរកីចលស្មី្នលៅម្៊ុខ្ជា ំដ្ឋប់ននបលចចកវទិានិងតំណភាា ប់ បាន
រស្ងីកស្រំដដនននការចូ លៅកាន់ និងការទទួ បានរ័ត៌ាមនជារក  លហយីដដ កន៊ុងន័យលនះ ការ
 ប់រនឹំងបនតវវិតតលៅម្៊ុខ្និងមនការផ្លល រ់បតូរ។ រងាម្មួ្យដដ មន ំណាន និងរបាប់ជាប៊ុលរ កខខ្ណា
ននជីវភារស្បចានំថ្ាននស្បជារ រដា លរ លនាះបំណិននន ំណាន និរនធ និងការគណនាល ខ្នរវនត គឺជា
ច ករននការលរៀនរបរ់ររិស។ ធាត៊ុដ៏ចម្បងមួ្យដដ រេិតលៅកន៊ុងការកសាងរងាម្ដដ ស្បកបលដ្ឋយ 
រ៊ុទធិគឺលរៀវលៅរិកា លហយីការលរៀបលរៀង និរនធ និងដក ម្អលរៀវលៅរិកាជាស្បចា ំ គឺជានវាន៊ុវតតន៍នន  
វរិ័យ ប់រដំដ នាលំៅរកការរិកាលរញមួ្យជីវតិ ការ ភិវឌ្ឍរម្បទា ប់រ ំ និងការដចករដំ កចំលណះ
ដឹង។ មូ្ ដ្ឋា ន ប់រ ំ ជារិលររគឺស្គឹះសាេ នឧតតម្រិកាស្តូវមនតួនាទីដដ ស្បកបលដ្ឋយការល ល្ីយតប 
ចំល ះតស្មូ្វការខាងល ីលនះ។ សាង្គ្សាត ចារយ  នកស្សាវស្ជាវ និងប៊ុគា ិក ប់រសំ្តូវបនតរិកាជាប់ជានិចច 
តាម្រយៈការលរៀបលរៀង និរនធ និងដក ម្អលរៀវលៅរិកា លហយីដដ លរៀវលៅរិកាទាងំលនះនឹងកាល យជា 
សាព នននទំនាក់ទំនងរវាងនវាន៊ុវតតន៍ននបលចចកវទិា និងការលរៀននិងបលស្ងៀនលៅកន៊ុងថ្នន ក់លរៀន។  

 

រងាម្ដដ ស្បកបរ៊ុទធិ ក៏ជារងាម្ដដ បណត៊ុ ះឱ្យមនរចនារម្ព័នធទន់ននលរដាកិចចដដ រឹង
ដផអកល ីរ៊ុទធិដដរ។ ឧទាហរណ៍ជាក់ដរតងននដបបដផនលនះរួម្មន Silicon Valley ននរហរដាអលម្រកិ 
រួនឧរាហកម្មវរិវកម្មអការោនយនតនិងោនយនតលៅទីស្កុង Munich ស្បលទរអ លឺម្៉ាង់ តំបន់
ជីវបលចចកវទិាលៅស្កុង Hyderabad ស្បលទរឥណាា  តំបន់ផ ិតលស្គឿងល  ចិស្តូនិក និងសារ-
គម្នាគម្ន៍ ឌី្ជីថ្ លៅទីស្កុង Seoul ស្បលទរកូលរខាងតបូង ក៏ដូចជារួនឧរាហកម្មថ្នម្រ  និង
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ឥនធនគីមី្សាង្គ្រតននស្បលទរលស្បរ៊ុី  លហយីក៏លៅមនទីស្កុងននស្បលទរជាលស្ចីនលទៀតលៅល ីរិភរលោក 
 កខណៈរម្បតតិននទីស្កុងទាងំលនះគឺការលស្បីស្បារ់និនាន ការននការ ភិវឌ្ឍដដ ជំរ៊ុញ និងតស្ម្ង់ទិរ
លដ្ឋយចំលណះដឹង លហីយដដ ចំលណះដឹងទាងំលនាះលកីតលចញជាដំបូងរីការវនិិលោគលៅល ីស្គឹះសាេ ន
ឧតតម្រិកា សាេ ប័នស្សាវស្ជាវ ម្ជឈម្ណា  ឧតតម្ភារននជំនាញជាន់ខ្ពរ់ ការស្បកួតស្បដជងលដ្ឋយ      
គ៊ុណាធិ្បលតយយ និង ជារិលររគឺការបណត៊ុ ះវបបធ្ម្៌ា ំណាននិងនិរនធលរៀវលៅ។ ល បឿនននការរកី
ចលស្មី្នដផនករ៊ុទធិ និងបលចចកវទិាកំរ៊ុងមនរនទ៊ុះល ឿនជាង វីដដ រិរស និងនិរសិតអចទទួ បាន
រីស្គូលៅស្គឹះសាេ នរិកា ដដ លធ្វីឱ្យលោ លៅននការ ប់រលំៅលរ បចច៊ុបបននលនះ មនការស្បឈម្ខាល ងំ
ជាងលរ ណាទាងំ រ់។ ឧទាហរណ៍ កន៊ុងមួ្យឆ្ន  ំមនលរៀវលៅជាង២,២ោនចំណងលជីង ស្តូវបាន
ររលររ និងលបាះរ៊ុម្ព ដដ កន៊ុងលនាះស្បលទរចិនមន៤៤០ ន់ ចំដណកឯរហរដាអលម្រកិមន ៣០៥
 ន់ និងស្បលទររ៊ុរស៊ុមីន ១២០ ន់ចំណងលជីង។ 
 

ខ្ណៈលរ ដដ បលចចកវទិាកំរ៊ុងរកីចលស្មី្នជាលរៀងរ ់នថ្ា ម្លធ្ាបាយរស្មប់ ំណានក៏មន
លស្ចីនជលស្មី្ររស្មប់រិរស និរសតិ និងសាធារណៈជនរមួ្មនការអនលរៀវលៅ ការអនល ីឧបករណ៍ 
ល  ិចស្តូនិក ការអនលដ្ឋយលស្បីទូរររទនវឆ្ល ត និងការអនល ីក៊ុំរយូទ័រ ដដ រ៊ុទធរឹងជាម្លធ្ាបាយ  
រំខាន់ៗដដ នា ំនកអនទាងំឡាយឱ្យរលស្ម្ចលោ បំណងអនរបរ់ខ្លួន។ ម្ា៉ាងវញិលទៀត  ំណាន
លដ្ឋយលស្បីម្លធ្ាបាយបលចចកវទិាទំលនីប ចំណាយលរ តិច រយស្រួ អន និងជួយដ ់បរសិាេ នមួ្យ
កស្មិ្តលទៀត។ នាលរ បចច៊ុបបនន រិរស និរសតិ និងសាធារណៈជនកម្ព៊ុជាដដ ស្រឡាញ់ ំណានកំរ៊ុង
ដតលស្បីស្បារ់ម្លធ្ាបាយ ំណានទាងំលនះ។ លបីលយីងស្កល កលមី្ លៅស្បលទរលជឿនល ឿន លទាះបីជា  
បលចចកវទិារកីចលស្ម្ីនខាល ងំោ៉ា ងណា  ំណានតាម្រយៈលរៀវលៅលៅដតមនរនទ៊ុះដដដ ។ ម្ា៉ាងវញិ
លទៀត បលចចកវទិាអនដបបទំលនីបតាម្រយៈឧបករណ៍ទំលនីប អស្រ័យល ី ទធភារននធ្នធាន ប់រ ំ   
ឌី្ជីថ្  និងមតិកាឌី្ជីថ្ ស្គប់ស្ោន់ដដ បានផ ិត និងបលរហ ះដចកចាយរស្មប់ ំណាន។ 
 កន៊ុងបរបិទកម្ព៊ុជា ជារិលររកន៊ុងបរកិារណ៍ននការផទ៊ុះរកីរ ដ្ឋ ននជំងឺកូវដី-១៩ ស្ករួង ប់រ ំ
យ៊ុវជន និងកីឡា បានជំរ៊ុញឱ្យមនបរវិតតកម្មឌី្ជីថ្ លៅកន៊ុងល កូរ៊ុីដរតម្ននការ ប់រ ំជារិលររការ
 ប់រតំាម្ស្បរ័នធល  ចិស្តូនិកនិងការ ប់ររីំចមា យលដីម្បលី ីកកម្ពរ់ ំណានតាម្រយៈការផ ិតមតិកា  
ឌី្ជីថ្ ដដ មនភារចំរ៊ុះ ការកសាងរម្តេភារដផនកតំណភាា ប់និងលវទិកាឌី្ជីថ្  ការរស្ងីកវសិា 
ភារននម្ជឈម្ណា  ទិននន័យ និងការល ីកកម្ពរ់គ៊ុណភារននការផ ិតធ្នធាន ប់រឌីំ្ជីថ្  គួបផសំ 
ជាមួ្យការដចករនលឹកកិចចការឱ្យរិរសយកលៅលរៀនលៅផទះ និងការច៊ុះលៅជួបជាមួ្យរិរសជាបណត៊ុ ំ លៅ
តាម្រហគម្ន៍។ កន៊ុងន័យល ីកកម្ពរ់ ំណាន និងភាររម្បូរដបបននធ្នធានលរៀវលៅរិកាឱ្យកាន់ដត
មនស្បរិទធភារនិងភាររកតិរិទធិ និងផត ់ឱ្ការ ំណានកាន់ដតលស្ចីនដថ្ម្លទៀតដ ់រិរាន៊ុរិរស 
និរសិត និងសាធារណៈជន ស្ករួង ប់រ ំយ៊ុវជន និងកីឡាល ីកទឹកចិតតនូវចំណ៊ុ ចមួ្យចំនួនដូចខាង
លស្កាម្៖ 
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1. សាង្គ្សាត ចារយ  នកស្សាវស្ជាវ និងប៊ុគា ិក ប់រ ំរូម្បនតនិងបលងកីនការលបាះរ៊ុម្ពសាន នដបដនេម្
លទៀត លដីម្បីលធ្វីឱ្យធ្នធានរស្មប់ ំណានកាន់ដតរម្បូរដបប ជារិលររធ្នធាន ំណាន
ជាលខ្ម្រភាសា 

2. ស្គឹះសាេ នឧតតម្រិកា រូម្ផត ់ ទធភារស្គប់ដបបោ៉ា ង លដីម្បីឱ្យប៊ុគា ិក ប់រសំ្គប់ ំដ្ឋប់
ថ្នន ក់ និង និរសតិស្គប់កស្មិ្តរិកាអចចូ រមួ្អន និងរិកាស្សាវស្ជាវតាម្ស្គប់ ទធភារ
ជាមួ្យធ្នធាន ំណាន ជារិលររការលរៀបចំឱ្យមនលរ លវោរស្មប់រហរិកា និង
 ំណានកន៊ុងបណាណ  ័យ  

3. សាង្គ្សាត ចារយតាម្ម្៊ុខ្វជិាា  និង នកស្សាវស្ជាវតាម្ជំនាញឬវរិ័យ ស្តូវលរៀបចំដំលណីរការលរៀន 
បលស្ងៀន និងស្សាវស្ជាវដដ មនដ្ឋក់បញ្ចូ  កិចចការរវ័យរិកា រហរិកា ឬការ
ស្សាវស្ជាវបណាណ  ័យដដ តស្មូ្វឱ្យនិរសតិ ស្តូវអននិងស្សាវស្ជាវជាមួ្យធ្នធាន ំណាន 

4. ស្គឹះសាេ នឧតតម្រិកា និងម្ជឈម្ណា  ស្សាវស្ជាវ ស្តូវខិ្តខំ្ឱ្យ រ់ ទធភារកន៊ុងការបលងកីតប
ណាណ  ័យ ម្ជឈម្ណា  រកាឯកសារ ឬម្ជឈម្ណា   ប់រឌីំ្ជីថ្  ជាលដីម្ លដីម្បឱី្យប៊ុគា ិក
 ប់រសំ្គប់ ំដ្ឋប់ថ្នន ក់និងនិរសតិស្គប់កស្មិ្តរិកា អចទទួ បាន និងដរវងរកស្បភរ
រស្មប់ ំណាន កាន់ដតរម្បូរដបប និងមនភារបត់ដបន ល ល្ីយតបតាម្តស្មូ្វការ នកអន 

5. និរសិតស្គប់កស្មិ្តរិកា ស្តូវខិ្តខំ្និងចំណាយលរ អន និងចាត់ទ៊ុកវបបធ្ម្៌ា និង កបប
កិរោិ ំណានជាដផនកមួ្យ ននលរ លវោនិងភាររ៊ុីវ ិ័យននជិវតិស្បចានំថ្ា 

6. បងបអូនជនរមួ្ជាតិ ដដ ជាមតាបិតា ឬ នកអណារាបា  រូម្ជួយជំរ៊ុញនិងបងក កខណៈ
កាន់ដត លស្ចីនដថ្ម្លទៀត ជារិលររការន  កចំណាយលៅកន៊ុងស្គួសាររស្មប់ការទិញរ
មា រៈរិកា លរៀវលៅអន និងឧបករណ៍រស្មប់ ំណានដ ់កូនៗ ដដ ចាត់ទ៊ុកជាការវ ិ
និលោគមួ្យដ៏រំខាន់ រស្មប់ បលងកីនចំលណះដឹង និង នាគតរបរ់រួកលគ។ 

 

លដ្ឋយមនការោសំ្ទរីស្ករួងលរដាកិចច និងហរិញ្ញវតេ៊ុ លៅឆ្ន ២ំ០២០ ស្ករួង ប់រ ំយ៊ុវជន និង
កីឡា បានបលងកីតមូ្ និធិ្ស្សាវស្ជាវ គំនិតនចនស្បឌិ្ត និងនវាន៊ុវតតន៍ ដដ លៅកាត់ថ្ន“មូ្ និធិ្ រ.គ.ន” 
និងលៅជាភាសា ង់លគលរថ្ន The Research Creativity and Innovation Fund ដដ លៅកាត់ជា
ភាសា ង់លគលរថ្ន “RCI Fund”។ លោ លៅចម្បងននមូ្ និធិ្លនះ គឺរមួ្ចំដណកល ីកកម្ពរ់វបបធ្ម្៌ានន
ការស្សាវស្ជាវ បំផ៊ុរគំនិតនចនស្បឌិ្ត និងជំរ៊ុញការលធ្វីនវាន៊ុវតត លដីម្បជីាស្បលោជន៍ដ ់វរិ័យ ប់រ ំយ៊ុវជន 
និងកីឡា ដដ ល ល្ីយតបលៅនឹងទីផាររ កម្ម និងសាក ភាវូបនីយកម្ម។  មូ្ និធិ្ រ.គ.ន បាន
រលស្ម្ចកំណត់ស្បធានបទ ជាអទិភាររស្មប់ការោសំ្ទលដ្ឋយមូ្ និធិ្ចំនួន៣ រួម្មន ឌី្ជីថ្ នីយ
កម្មរស្មប់បដិវតតឧរាហកម្ម៤.០(Digitalization for IR.4.0)ការស្សាវស្ជាវ ន៊ុ វតតល ីវរិ័យ
ករិកម្ម (Applied Agricultural Research) និងការស្សាវស្ជាវគរ៊ុលការ យរតវតសទី២១ (21st 
Century Pedagogy Research)។ 

 

លដ្ឋយមនការលធ្វីអទិភារវូបនីយកម្មលៅល ីទិរលៅននការលស្បីស្បារ់ថ្វកិាមូ្ និធិ្រស្មប់
ឆ្ន ២ំ០២០ ស្ករួងលរដាកិចច និងហិរញ្ញវតេ៊ុ និងស្ករួង ប់រ ំយ៊ុវជន និងកីឡា បានផត ់ការោសំ្ទដ ់



v 

ការលរៀបលរៀង និរនធ និងដក ម្អ លរៀវលៅរិកា(Text book) ដដ នឹងស្តូវលស្បីស្បារ់លៅកស្មិ្តឧតត
ម្រិកា។ លោ បំណងននការលរៀបលរៀង និរនធ និងដក ម្អ លរៀវលៅរិកាលៅកស្មិ្តឧតតម្រិកាគឺ
លដីម្បីបលងកីនបរមិណ ល ីកកម្ពរ់គ៊ុណភារ និងរស្ងីករម្ធ្ម្៌ាននធ្នធានរិកាជាលខ្ម្រភាសា ជូន
ដ ់និរសិតដដ កំរ៊ុងបនតការរិកា និងលស្តៀម្ខ្លួនលធ្វីការស្សាវស្ជាវលៅកស្មិ្តឧតតម្រិកា។ ល ីររី
លនះលទៀតការលរៀបលរៀង និរនធ និងដក ម្អលរៀវលៅរិកាលៅកស្មិ្តឧតតម្រិកា មនលោ លៅដូចខាង
លស្កាម្ ៖ 

- ល ល្ីយតបជាបនាទ ន់ចំល ះការខ្វះខាតធ្នធានរិកា ដដ ជាតស្មូ្វការរិការបរ់និរសតិ 
លៅកស្មិ្តឧតតម្រិកា  

- ល ីកកម្ពរ់ទំលនីបភាវូបនីយកម្ម និងឧតតមន៊ុវតតន៍ននការលរៀននិងបលស្ងៀន និងការស្សាវស្ជាវ
លៅល ីម្៊ុខ្វជិាា  កម្មវធីិ្រិកា ឬម្៊ុខ្ជំនាញជាក់ោក់ 

- បលងកីនភាររ៊ុីជលស្ៅកន៊ុងការកសាងវជិាា ជីវៈនិងបទរិលសាធ្ន៍រស្មប់ឋានៈសាង្គ្សាត ចារយ និង
 នកស្សាវស្ជាវ  

- រមួ្ចំដណកដ ់ការកសាងភារជារហគម្ន៍វជិាា ជីវៈ ការដចករដំ កបទរិលសាធ្ន៍ និងវបប
ធ្ម្៌ាននការលរៀបលរៀង និរនធ និងដក ម្អលរៀវលៅរិកាលៅកស្មិ្តឧតតម្រិកា។ 

 

ស្ករួង ប់រ ំយ៊ុវជន និងកីឡា បានវាយតនម្លខ្ពរ់ចំល ះការលបាះជំហានស្បកបលដ្ឋយម្នរិការ
វជិាា ជីវៈននស្គឹះសាេ នឧតតម្រិកា និងប៊ុគា ិក ប់រទំាងំ រ់ កន៊ុងការលរៀបចំ លរៀបលរៀង និរនធ និងដក ម្អ
លរៀវលៅរិកា លដីម្បីបលងកីនបរមិណ ល ីកកម្ពរ់គ៊ុណភារ និងរស្ងឹងរម្ធ្ម្៌ាននធ្នធានរិកាជា
លខ្ម្រភាសា ជូននិរសតិដដ កំរ៊ុងបនតការរិកា និងលស្តៀម្ខ្លួនលធ្វីការស្សាវស្ជាវលៅកស្មិ្តឧតតម្រិកា។ 
លរៀវលៅរិកាជាដផនកមួ្យននការទទួ សាា  ់គ៊ុណភារ ប់រនំនស្គឹះសាេ នឧតតម្រិកា និងជាធ្នធាន
រិកាដដ ជាមូ្ ដ្ឋា នមួ្យដ៏រំខាន់ កន៊ុងការោសំ្ទដ ់ការបលស្ងៀន និងលរៀន លហីយស្តូវមនបរមិណ
ស្គប់ស្ោន់ ល ល្ីយតបលៅនឹងកម្មវធីិ្ ប់រ ំនិងតស្មូ្វការរិកាស្សាវស្ជាវ។ ជាលោ ការណ៍ ស្គឹះសាេ នឧតតម្
រិកាទាងំ រ់ ស្តូវមនលរៀវលៅរិកាដដ លស្បីជាលោ រស្មប់ម្៊ុខ្វជិាា នីមួ្យៗ។ ចំនួនលរៀវលៅ
រិកាដដ ស្គប់ស្ោន់រស្មប់ការស្សាវស្ជាវ និងការរិការបរ់និរសិត ស្តូវមនោ៉ា ងតិចមួ្យចំណង
លជីងកន៊ុងមួ្យម្៊ុខ្វជិាា  លហយីស្តូវតម្ក ់ោ៉ា ងតិច២ចាប់ លៅកន៊ុងបណាណ  ័យ ឬអចរកបានតាម្ស្បរ័នធល 
 ចិស្តូនិក។ ស្ករួង ប់រ ំយ៊ុវជន និងកីឡា ល ីកទឹកចិតតបដនេម្លទៀតជូនដ ់ស្គឹះសាេ នឧតតម្រិការដា 
និងឯកជនដដ បានលរនីរ៊ុ ំថ្វកិាម្ូ និធ្ិរចួ រូម្ចូ រមួ្បដនេម្លទៀតលដីម្បបីលងកីនចំនួនចំណងលជីង
លរៀវលៅ។ ចំដណកស្គឹះសាេ នឧតតម្រិការដានិងឯកជនដដ រ៊ុំទាន់បានដ្ឋក់ កយលរនីរ៊ុំ រូម្ចូ រួម្ 
លដីម្បជីាគ៊ុណស្បលោជន៍ដ ់តស្មូ្វការដ៏ទទូច និងនថ្លថ្នល នននិរសតិកម្ព៊ុជាកន៊ុងការរិកា និងស្សាវស្ជាវលៅ
កស្មិ្តឧតតម្រិកា។ 
  



vi 

សេនកតីរញ្ជា ក ់

ច្នមូលនិធិការស្រាវស្រាវ គំនិតច្នៃស្ររឌិត និងនវានុវតតន៍ 
 

លរៀវលៅរិកាលនះជា ទធផ ននការលរនីរ៊ុំ ន៊ុវតតថ្វកិាមូ្ និធិ្ការស្សាវស្ជាវ គំនិតនចនស្បឌិ្ត 
និងនវាន៊ុវតតន៍ កន៊ុងគលស្មងលរៀបលរៀង និរនធ និងដក ម្អលរៀវលៅរិកា ដដ នឹងស្តូវលស្បីស្បារ់លៅ
កស្ម្ិតឧតតម្រិកា។ លរៀវលៅរិកាលនះ ស្តូវបានលរៀបលរៀង និរនធ ឬដក ម្អលដ្ឋយមនការធានា
 ះអងថ្នជាសាន នដរបរ់ នកនិរនធផ្លទ  ់ និងបាន្លងកាត់ស្តួតរិនិតយ ផត ់លោប ់ និងវាយតនម្ល
លដ្ឋយស្កុម្ស្បឹកា ប់រ ំស្កុម្ស្បឹកាស្សាវស្ជាវ ឬស្កុម្ស្បឹកាដដ មនតនម្លលរមីននស្គឹះសាេ នឧតតម្រិកា 
និងតាម្រយៈកិចចរនាដដ បានលធ្វីល ីង និងដដ បានតម្ក ់ទ៊ុកលៅមូ្ និធិ្ការស្សាវស្ជាវ គំនិតនចន
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អារមភកថា 

រូម្សាវ គម្ន៍ម្កកាន់រិភរននការដករូបភារជាមួ្យ GIMP! មិ្នថ្ន នកជា នកចាប់លផតីម្ដំបូង ឬ
 នកលស្បីស្បារ់ដដ មនបទរិលសាធ្ន៍លនាះលទ លរៀវលៅរិកាលនះស្តូវបានរចនាល ងីលដីម្បជីាម្គា៊ុលទទរក៍
ដ៏ទូ ំទូោយរបរ់ នកកន៊ុងការលធ្វីជាមច រ់ននរិ បៈននការដករស្មួ្ រូបភារ លដ្ឋយលស្បីកម្មវធីិ្ស្បភរ
លបីកចំហ ឥតគិតនថ្ល និងឥតគិតនថ្ល GIMP (GNU Image Manipulation Program)។ 

លរៀវលៅរិកា ការដករស្ម្ ួរូបភារជាម្យួ GIMP “ភាគ១” លនះដ្ឋក់មូ្ ដ្ឋា នស្គឹះរស្មប់ការ
ផសងលស្រងដករស្មួ្ រូបភាររបរ់ នក។ លយងីនឹងចាប់លផតីម្លដ្ឋយដណនា ំនក ំរីចំណ៊ុ ចស្បទាក់ GIMP 
និងម្៊ុខ្ររលផសងៗរបរ់វា លដ្ឋយផត ់ឱ្យ នកនូវការយ ់ដឹងដ៏រងឹម ំំរីរម្តេភាររបរ់កម្មវធីិ្។  នកនឹង
លរៀនរីរលបៀបរ៊ុករកតាម្ម្៊ុឺន៊ុយ បនទះ និងឧបករណ៍លផសងៗ ដដ  ន៊ុញ្ញ តឱ្យ នករយស្រួ ជាមួ្យ
ចំណ៊ុ ចស្បទាក់រយស្រួ លស្បីរបរ់ GIMP។ លៅលរ ដដ  នកសាា  ់មូ្ ដ្ឋា នស្គឹះ លយងីនឹងដរវងយ ់
រីបលចចកលទរដករស្មួ្ រនូ ។  នកនឹងរកលឃញីរីរលបៀបលរៀបចំរូបភារ ដកតស្មូ្វរណ៌ា   ន៊ុវតតតស្ម្ង និង
ដកតស្មូ្វភារមិ្ន អឥតលខាច ះ។ លយងីនឹងដណនា ំនកតាម្រយៈកិចចការរំខាន់ៗដូចជា ការស្ចឹប ផ្លល រ់បតូ
រទំហ ំ និងការបងវិ រូបភារ ដដ ផត ់ ទធភារឱ្យ នកបលងកីតរូបភាររបរ់ នកស្របតាម្ចកខ៊ុវរិ័យនចន
ស្បឌិ្តរបរ់ នក។ 

លរៀវលៅរិកាលនះ លយងីក៏បានរមួ្បញ្ចូ   ំហាត់ ន៊ុវតដ និងឧទាហរណ៍ជាក់ដរតងជាលស្ចីន លដីម្បី
រស្ងឹងការលរៀនរូស្តរបរ់ នក។ ឧទាហរណ៍ទាងំលនះស្តូវបានរចនាល ងីលដីម្បលី ីកទឹកចិតតដ ់ការ
រិលសាធ្ន៍ និងជស្មុ្ញការគិតស្បកបលដ្ឋយភារនចនស្បឌិ្តរបរ់ នក។ លយងីលជឿថ្នវធីិ្ អបំផ៊ុតលដីម្បលីរៀនដក
រស្មួ្ រូបភារ គឺលដ្ឋយការចូ រមួ្ោ៉ា ងរកម្មកន៊ុងការ ន៊ុវតដជាមួ្យកម្មវធីិ្ និងដរវងយ ់រី
បលចចកលទរលផសងៗ។  

ដូលចនះ លតី នកលស្តៀម្ខ្លួនលហយីឬលៅកន៊ុងការលធ្វីដំលណីរដ៏រលំភីបមួ្យននការបំដបលងរូបភាររបរ់ នក
ជាមួ្យ GIMP? លតាះចូ លមី្  និងដរវងយ ់រី ទធភារោម នដដនកំណត់ននការដករូបភារទាងំ រ់
ោន ។ មិ្នថ្ន នកស្បាថ្នន ចង់បលងកីតរូបថ្តដ៏ សាច រយ រចនាស្កាហវកិគួរឱ្យចាប់អរម្មណ៍ ឬស្ោន់ដតបលងកីនរូប
ភារផ្លទ  ់ខ្លួនរបរ់ នក លរៀវលៅរិកាលនះនឹងផត ់ឱ្យ នកនូវចំលណះដឹង និងជំនាញលដីម្បដីស្បកាល យចកខ៊ុវ ិ
រ័យរបរ់ នកឱ្យកាល យជាការរិត។ 

 នកនិរនធ 
 
 
ហ ុន រ៉ា វី 
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សេនកដីថ្លែងអ្ណំរគុណ 

ជាការរិតលរៀវលៅ «ការដករស្ម្ ួរូបភារជាម្ួយ GIMP “ភាគ១”» ដដ ល ចលចញជារូបរង
លៅលរ លនះគឺបានលកីតល ងីរីការខិ្តខំ្ និងយកចិតតទ៊ុកដ្ឋក់ចូ រមួ្រីភាគី និងសាេ ប័ន ក់រ័នធ          
ជាលស្ចីន។ 

ខ្្៊ុ ំបាទរូម្ដថ្លង ំណរគ៊ុណោ៉ា ងស្ជា លស្ៅបំផ៊ុតដ ់ភាគី និងសាេ ប័ន ក់រ័នធទាងំ រ់ដូចជា ៖ 
- ស្ករួងលរដាកិចច និងហរិញ្ញវតេ៊ុ ដដ បានោសំ្ទោ៉ា ងលរញទំហងឹដ ់ស្ករួង ប់រ ំយ៊ុវជន និង

កីឡាឱ្យបលងកីតមូ្ និធិ្ស្សាវស្ជាវ គំនិតនចនស្បឌិ្ត និងនវាន៊ុវតតន៍ លៅកាត់ថ្ន «មូ្ និធិ្ រ.គ.ន»។  
- ស្ករួង ប់រ ំយ៊ុវជន និងកីឡាដដ បានបលងកីតមូ្ និធិ្ស្សាវស្ជាវ គំនិតនចនស្បឌិ្ត និងនវាន៊ុវតតន៍ 

ដដ លៅកាត់ថ្ន «មូ្ និធិ្ រ.គ.ន» លដីម្បរីមួ្ចំដណកល ីកកម្ពរ់វបបធ្ម្៌ាននការស្សាវស្ជាវ បំផ៊ុរគំនិត
នចនស្បឌិ្ត និងជំរ៊ុញការលធ្វីនវាន៊ុវតត លដីម្បជីាស្បលោជន៍ដ ់វរិ័យ ប់រ ំយ៊ុវជន និងកីឡា ដដ ល ល្ីយតប
លៅនឹងទីផាររ កម្ម និងសាក ភាវូបនីយកម្ម។ 

- មូ្ និធិ្ស្សាវស្ជាវ គំនិតនចនស្បឌិ្ត និងនវាន៊ុវតតន៍ ដដ បានោសំ្ទដ ់ការលរៀបលរៀង និរនធ និងដក
 ម្អលរៀវលៅរិកា (Text book) ដដ នឹងស្តូវលស្បីស្បារ់លៅកស្មិ្តឧតតម្រិកា លដីម្បីបលងកីនបរមិណ 
ល ីកកម្ពរ់គ៊ុណភារ និងរស្ងីករម្ធ្ម្៌ាននធ្នធានរិកាជាលខ្ម្រភាសាជូនដ ់និរសិតដដ កំរ៊ុង
បនតការរិកា និងលស្តៀម្ខ្លួនលធ្វីការស្សាវស្ជាវលៅកស្មិ្តឧតតម្រិកា។ 

- លោកបណាិ តស្បធានគណៈស្គប់ស្គងវទិាសាេ នគរ៊ុលការ យបាត់ដំបង ដដ បានចាត់តាងំជា    
គណៈកម្មការនិរនធចូ រមួ្ការលរៀបលរៀង និរនធ និងដក ម្អលរៀវលៅលៅកស្មិ្តឧតតម្រិកាលនះ។  

- នាយកដ្ឋា នបណដ៊ុ ះបណាដ  ដដ បានចាត់តាងំជាគណៈកម្មការនិរនធ និងគណៈកម្មការស្តួត
រិនិតយ ល ីសាន នដននការចូ រមួ្ការលរៀបលរៀង និរនធ និងដក ម្អលរៀវលៅលៅកស្មិ្តឧតតម្រិកាលនះ។ 

- លោកស្បធាន នាយកដ្ឋា នបណដ៊ុ ះបណាដ  ដដ ស្រម្លស្រៀងទទួ រិទធិជាតំណាង នកលរៀបលរៀង
កន៊ុងការចាត់ដចង និងរស្ម្បរស្មួ្ ជាមួ្យស្ករួង ប់រ ំ យ៊ុវជន និងកីឡា ច៊ុះហតេល ខាល ីកិចចស្រម្
លស្រៀង និងកិចចដំលណីការទូទាត់ថ្វកិាតាម្រយៈការលរនីរ៊ុំ និងទទួ ថ្វកិា លបាះរ៊ុម្ព និងផសរវផាយបនតនូវ
សាន នដលរៀបលរៀង និរនធ និងដក ម្អរបរ់ នកលរៀបលរៀងកន៊ុងការលរៀន និងបលស្ងៀនកន៊ុងស្គឹះសាេ នរិកា និង
ស្បគ ់រិទធិស្របតាម្ការកំណត់ននកិចចស្រម្លស្រៀង រតីរីការលរៀបលរៀង និរនធ និងដក ម្អលរៀវលៅលៅ
កស្មិ្តឧតតម្រិកា លស្កាម្ការោសំ្ទននមូ្ និធិ្ស្សាវស្ជាវ គំនិតនចនស្បឌិ្ត និងនវាន៊ុវតតន៍។ 

- ស្គូឧលទទរម្៊ុខ្វជិាា បលចចកវទិារ័ត៌ាមន និងសារគម្នាគម្ន៍ (ICT) ននវទិាសាេ នគរ៊ុលការ យ
បាត់ដំបង ដដ បានផដ ់ម្តិដក ម្អល ីខ្លឹម្សារ ននលម្លរៀននីមួ្យៗឱ្យកាន់ដតមនភាររ៊ុស្កឹត និងមន
 កខណៈវទិាសាង្គ្រត។ 

ខ្្៊ុ ំបាទរងឃមឹ្ថ្ន លរៀវលៅលនះនឹងល ល្ីយតបជាបនាទ ន់ចំល ះការខ្វះខាតធ្នធានរិកា ដដ ជា
តស្មូ្វការរិការបររ់ិរស និរសតិ លៅកស្មិ្តវទិា ័យ និងឧតតម្រិកា។ 
  



xvi 

ការររយិាយសលើមខុវិាា  

ម្៊ុខ្វជិាច រិកាការដករស្មួ្ រូបភារលនះ ស្តូវបានរចនាល ងីជារិលរររស្មប់កម្មវធីិ្ ប់រសំ្គូ
បលស្ងៀនកស្មិ្តមូ្ ដ្ឋា ន ១២+៤ ឯកលទរបលចចកវទិារ័ត៌ាមន និងសារគម្នាគម្ន៍(ICT)។ លៅកន៊ុងម្៊ុខ្
វជិាា រិកាលនះ គរ៊ុនិរសតិនឹងរិការីមូ្ ដ្ឋា នស្គឹះននការដករូបភារលដ្ឋយលស្បី GIMP (GNU Image 
Manipulation Program) ដដ ជាកម្មវធីិ្កូដចំហដ៏មនឥទធិរ  និងលស្បីស្បារ់ោ៉ា ងទូ ំទូោយ។
ម្៊ុខ្វជិាា រិកាលនះមនស្បធានបទចំនួនដប់ស្បា ំ លដ្ឋយលផ្លដ តលៅល ីការដករស្មួ្ រូបភារលដ្ឋយលស្បី
ស្បារ់ GIMP ដដ ស្បធានបទចំនួនស្បាបីំខាងលដីម្ស្តូវោន លៅនឹងលម្លរៀនលៅកន៊ុងលរៀវលៅរិកា "ការដក
រស្ម្ ួរូបភារជាម្យួ GIMP - ភាគ ១" លនះ។ គរ៊ុនិរសតិនឹងចូ រមួ្រិកាលដ្ឋយរមួ្បញ្ចូ  ោន ននការ
លរៀនស្ទឹរតី ការ ន៊ុវតដជាក់ដរតង និងការរិភាការមួ្ោន ។ ម្៊ុខ្វជិាា រិកាលនះជំរ៊ុញឱ្យមនបរោិការរិកា
 នតរកម្ម ដដ គរ៊ុនិរសតិអច ន៊ុវតតចំលណះដឹងរបរ់រួកលគោ៉ា ងរកម្មលៅនឹងលរណារយី៉ាូកន៊ុងរិភររិត 
ដដ  ក់រ័នធនឹងការខិ្តខំ្បលស្ងៀននាលរ  នាគតរបរ់រួកលគ។ 

វឌ្ឍនភាររបរ់គរ៊ុនិរសតិដដ រិកាម្៊ុខ្វជិាា លនះ នឹងស្តូវបានវាយតនម្លតាម្ម្លធ្ាបាយជាលស្ចីន 
រមួ្ទាងំកិចចការជាក់ដរតង កស្ម្ងរំណួរ និងគលស្មងច៊ុងលស្កាយ។ ការវាយតនម្លទាងំលនះនឹងវារ់រទង់ការ
យ ់ដឹងរបរ់ស្គូរួកលគ ំរីលោ គំនិតដដ មនលៅកន៊ុងវគារិកា និងរម្តេភាររបរ់រួកលគកន៊ុងការ
 ន៊ុវតតការដករស្មួ្ រូបភារស្បកបលដ្ឋយស្បរិទធភារកន៊ុងបរបិទ ប់រ។ំ 

លៅច៊ុងបញ្ច ប់ននវគារិកាលនះ គរ៊ុនិរសតិនឹងមនមូ្ ដ្ឋា នស្គឹះដ៏រងឹមកំន៊ុងការដករស្មួ្ រូបភារ
ជាមួ្យ GIMP ។ រួកលគនឹងស្តូវបានបំ ក់លដ្ឋយជំនាញចាបំាច់លដីម្បបីលងកីនរមា រៈបលស្ងៀនរបរ់រួកលគ 
និងទាក់ទាញរិរសតាម្រយៈរូបភារដដ គួរឱ្យចាប់អរម្មណ៍។ ចូ រមួ្ជាមួ្យរួកលយងីកន៊ុងដំលណីរដ៏គួរ
ឱ្យរលំភីបលនះ លដីម្បបីលញ្ចញរកាត ន៊ុរ នចនស្បឌិ្តននការដករស្មួ្ រូបភារជាមួ្យ GIMP! 

ចំណា៖ំ លរៀវលៅរិកាលនះស្គបដណត ប់ដផនកទី ១ ននលរ រលីរៀវលៅរិកា។ ដផនកទី ២ នឹងលផ្លដ ត
លៅល ីស្បធានបទចំនួនស្បារីំរច៊ុងលស្កាយននម្៊ុខ្វជិាា រិកា ំរីការដករស្មួ្ រូបភារ លហយីរស្មប់ការ
រិកាកស្មិ្តខ្ពរ់ និងជំនាញកន៊ុងការដករស្មួ្ រូបភារជាមួ្យ GIMP ។ 
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មូលនយ័េសងេរ 

ការដករស្ម្ ួរូបភារជាម្យួ GIMP “ភាគ១” គឺជាលរៀវលៅរិកាលោ ដដ ស្តូវបានចងស្កង
ល ងីលដ្ឋយដផអកលៅល ីកម្មវធីិ្រិកា ម្អិតរបរ់វទិាសាេ នគរ៊ុលការ យ និងតាម្តស្មូ្វការរបរ់គរ៊ុ
និរសតិ លដ្ឋយផត ់នូវវធីិ្សាង្គ្រតជាក់ដរតង និងទាក់ទាញកន៊ុងការលស្បីស្បារ់កម្មវធីិ្ GIMP (GNU Image 
Manipulation Program) រស្មប់ការដករូបភារស្បកបលដ្ឋយវជិាា ជីវៈ។ លរៀវលៅរិកាលោ លនះស្គប
ដណត ប់ល ីស្បធានបទរំខាន់ៗជាលស្ចីន រមួ្ទាងំការដណនា ំំរីឧបករណ៍ដកនចនរូបភារ និង GIMP ការ
ដំល ងី និងកំណត់រចនារម្ព័នធកម្មវធីិ្ លធ្វីការជាមួ្យស្រទាប់ ជក់ ការលស្ជីរលររី របាងំ ការស្ចឹប និង
ផ្លល រ់បតូរទំហ ំនិងម្៊ុខ្ររោយបញ្ចូ  ោន ។ ជាមួ្យនឹងការរនយ ់ចារ់ោរ់ និង ំហាត់លដ្ឋយ ន៊ុវតដ
ជាក់ដរដង គរ៊ុនិរសតិនឹងទទួ បានមូ្ ដ្ឋា នស្គឹះដ៏រងឹមកំន៊ុងការលស្បីស្បារ់ GIMP រស្មប់ការដករស្មួ្ 
រូបភារ។ 

ជាមួ្យោន លនះផងដដរ ទិដាភាររំខាន់ននលរៀវលៅរកិាលោ លនះក៏បានលផ្លដ តល ីការដរវងយ ់
 ំរីរលបៀបដដ  ន៊ុញ្ញ តឱ្យគរ៊ុនិរសតិបលងកីតដបបដផនរូបភារដ៏ទាក់ទាញ និងផ្លល រ់បតូរលោ គំនិត និង
បរោិការននរូបភារ។ លរញមួ្យលរៀវលៅលនះ ការបលស្ងៀនដបបរកម្ម ការរចនាជាក់ដរតង និងជំនួយ
លផសងៗនឹងបលងកីនបទរិលសាធ្ន៍រិកា ដដ អចឱ្យគរ៊ុនិរសតិ ន៊ុវតតចំលណះដឹង និង ភិវឌ្ឍជំនាញរបរ់
រួកលគ។ លៅច៊ុងបញ្ច ប់ននលរៀវលៅរិកា គរ៊ុនិរសតិនឹងមនការយ ់ដឹងោ៉ា ងរងឹម ំំរី GIMP និងម្៊ុខ្
រររបរ់វា លដ្ឋយផត ់ ទធភារឱ្យរួកលគកន៊ុងការបញ្ចូ  បលចចកលទរដករស្មួ្ រូបភារលៅកន៊ុងការ ន៊ុវតត
ការបលស្ងៀន និង ន៊ុវតដកន៊ុងការររជាក់ដរដងរបរ់រួកលគស្បកបលដ្ឋយទំន៊ុកចិតត និងជំរ៊ុញរិរសនាលរ 
 នាគតរបរ់រួកលគកន៊ុងការបលញ្ចញម្តិដដ យ ់លឃញី និងការនិទានលរឿងដបបឌី្ជីថ្ ។ 

ររ៊ុបម្ក លរៀវលៅរិកាលោ  ការដករស្ម្ ួរូបភារជាម្យួ GIMP “ភាគ១” ផត ់នូវវធីិ្សាង្គ្រត
ដ៏ទូ ំទូោយ និងលដ្ឋយ ន៊ុវតដជាក់ដរដងកន៊ុងការលស្បីស្បារ់ GIMP រស្មប់ការដករស្មួ្ រូបភារ 
លដ្ឋយធានាថ្នគរ៊ុនិរសតិមនរម្តេភារលរញល ញលដីម្បលីស្បីស្បារ់កន៊ុរការររជាក់ដរដង និងបលស្ងៀន
រិរសរបរ់រួកលគលៅកន៊ុងរិភរដ៏គួរឱ្យរលំភីបននការលរៀបចំរូបភារឌី្ជីថ្ ។ 

 

 



1 

សមសរៀនទី១៖ ការថ្ណនាអំ្ពំី GIMP នងិគំនតិរននាស្រកាហវកិ 

១.១. ការថ្ណនាអំ្ំពីការរននាស្រកាហវកិ 

 ការរចនាស្កាហវកិ គឺជាដំលណីរការស្បកបលដ្ឋយភារនចនស្បឌិ្តដដ  ក់រ័នធនឹងការលស្បីស្បារ់
ធាត៊ុដដ លមី្ លឃញីលដីម្បទំីនាក់ទំនងសារ ឬគំនិតលៅកាន់ នកលមី្ ។ ការរចនាស្កាហវកិ ក់រ័នធនឹង
ការលស្បីស្បារ់ កសរ រូបភារ រណ៌ា  និងធាត៊ុផសនំនការរចនាលផសងលទៀត លដីម្បបីញ្ាូ នសារ ឬបលញ្ចញនូវ
អរម្មណ៍ជាក់ោក់មួ្យ។  នករចនាស្កាហវកិលស្បីឧបករណ៍លផសងៗដូចជាកម្មវធីិ្ក៊ុំរយូទ័រ ប ិក និងស្កដ្ឋរ 
លដីម្បបីលងកីតការរចនាដដ លស្បីកន៊ុងម្ជឈដ្ឋា នលផសងៗ រមួ្ទាងំរមា រៈលបាះរ៊ុម្ពដូចជា ខិ្តតប័ណណ ផ្លទ ងំរូបភារ 
និងទរសនាវដតី ស្បរ័នធផសរវផាយឌី្ជីថ្ ដូចជាលគហទំរ័រ និងស្បរ័នធផសរវផាយរងាម្ និងលផសងៗ     
លទៀត។ កន៊ុងការរចនាស្កាហវកិ លគអចបញ្ចូ  កម្មវធីិ្ក៊ុំរយូទ័រដូចជា GIMP, Adobe Photoshop, 
Illustrator, InDesign និងកម្មវធីិ្លផសងលទៀត។ លោ លៅននការរចនាស្កាហវកិ គឺលដីម្បសី្បាស្រ័យ
ទាក់ទងោ៉ា ងមនស្បរិទធភារនូវសារលៅកាន់ទរសនិកជនលោ លៅកន៊ុងវធីិ្ ដដ គួរឱ្យចាប់អរម្មណ៍ 
និងគួរឱ្យចងចា។ំ  

 ដំលណីរការននការបលងកីតការរចនាស្កាហវកិ ជាធ្ម្មតា ក់រ័នធនឹងដំណាក់កា ជាលស្ចីន។ 
ដំណាក់កា ដំបូងគឺកំណត់លោ លៅ និងលោ បំណងននការរចនា ក៏ដូចជាទរសនិកជនលោ លៅ។ 
បនាទ ប់ម្ក  នករចនានឹងបលងកីតគំនូរស្ ង ឬគំនិតននការរចនា ដដ នឹងស្តូវបានដក ម្អ និង ភិវឌ្ឍលៅ
ជាការរចនាច៊ុងលស្កាយ។ ការរចនាច៊ុងលស្កាយអច ល្ងកាត់ការដកដស្បជាលស្ចីន ម្៊ុនលរ វាស្តូវបានចាត់
ទ៊ុកថ្នលរញល ញ។ 

 ការរចនាស្កាហវកិដដ មនស្បរិទធភារ គឺរំខាន់ណារ់លស្ ះវាអចជួយបលញ្ចញសារឬ
គំនិតកន៊ុងរលបៀបដដ ទាក់ទាញដភនកនិងរយយ ់។ ជាឧទាហរណ៍  ូលហាា ដដ បានរចនាោ៉ា ង អ 
អចជួយបលងកីត តតរញ្ញ ណម៉ា កយលីហា និងលធ្វីឱ្យវាកាន់ដតសាា  ់ដ ់ នកលស្បីស្បារ់។ លគហទំរ័រដដ 
រចនាស្បកបលដ្ឋយវជិាា ជីវៈក៏អចជួយបលងកីតភារលជឿជាក់ និងលធ្វីឱ្យវាកាន់ដតរយស្រួ រស្មប់ នកលស្បី
ស្បារ់កន៊ុងការរ៊ុករក និងដរវងរករ័ត៌ាមនដដ រួកលគកំរ៊ុងដរវងរក។ 

១.២. សោលគំនិតេខំាន់ៗកៃងុការរននាររូភាព 

 លោ គំនិតននការរចនារំលៅលៅល ីគំនិត ឬចកខ៊ុវរិ័យដដ ដឹកនាកំារបលងកីតផ ិតផ     
លរវាកម្ម ឬស្បរ័នធ។ គំនិតននការរចនាជាធ្ម្មតារមួ្បញ្ចូ  នូវរំណ៊ុំ ននលោ ការណ៍ លោ លៅ និង កខ
ណៈវនិិចឆ័យដដ កំណត់ការវវិតតននការរចនា និងជួយធានាថ្នវាល ល្ីយតបនឹងតស្មូ្វការរបរ់ នកលមី្ 
ដដ មនបំណងជាក់ោក់។ លោ គំនិតននការរចនាអចមនទស្ម្ង់ជាលស្ចីន អស្រ័យល ីបរបិទ និង
 កខណៈននគលស្មង។ ជាឧទាហរណ៍ កន៊ុងការរចនាស្កាហវកិ គំនិតមួ្យអច ក់រ័នធនឹងការលស្បីស្បារ់
រណ៌ា ជាក់ោក់  កសរ និងរូបភារ លដីម្បបីរហ ញសារ ឬអរម្មណ៍ជាក់ោក់មួ្យ។ លៅកន៊ុងការរចនា
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ផ ិតផ  គំនិតមួ្យអច ក់រ័នធនឹងការលស្បីស្បារ់រមា រៈជាក់ោក់ កតាត ទស្ម្ង់ និង កខណៈរិលររ
លដីម្បបីលងកីតផ ិតផ ដដ មនម្៊ុខ្ររ លសាភ័ណភារ និងរយស្រួ លស្បី។ 

 គនលឹះននលោ គំនិតននការរចនាដ៏លជាគជ័យគឺស្តូវយ ់រីតស្មូ្វការ និងចំណូ ចិតតរបរ់ នក
លមី្  លហយីបលងកីតការរចនាដដ បំលរញតស្មូ្វការទាងំលនាះតាម្រលបៀបស្បកបលដ្ឋយភារនចនស្បឌិ្ត និង
មនស្បរិទធភារ។ ការរចនាលនះតស្មូ្វឱ្យមនការយ ់ដឹងោ៉ា ងរ៊ុីជលស្ៅ ំរីដំលណីរការរចនា ក៏ដូចជា
រម្តេភារកន៊ុងការគិតស្បកបលដ្ឋយភារនចនស្បឌិ្ត និងរះិគន់ ំរីរលបៀបលដ្ឋះស្សាយបញ្ហ រចនា និងបលងកីត
ដំលណាះស្សាយស្បកបលដ្ឋយភារនចនស្បឌិ្ត។ ជាមួ្យោន លនះផងដដរ មនលោ គំនិតរំខាន់ៗមួ្យចំនួន 
ដដ  នករចនាស្កាហវកិស្តូវយកចិតដទ៊ុកដ្ឋក់ រស្មប់កិចចការរបរ់ខ្លួនមនដូចជា៖ 

ក. រសរៀរផ្ដលខ់ែឹមារស្រតឹមស្រតូវ 

 ស្កុម្ហ ៊ុនដតងដតជួ ប៊ុគា ិកដផនករចនារូបភារ រីលស្ ះរួកលគចង់បលងកីតការ ក់ ឬផសរវ
ផាយ ំរីសាេ ប័នរបរ់រួកលគ។ លោ បំណងរបរ់ នករចនាទាងំលនះ គឺបលងកីតរូបភារជាវជិាមនតាម្     
រយៈការរចនារបរ់រួកលគរស្មប់សាេ ប័ន ក៏ដូចជាផដ ់រ័ត៌ាមនដ ់ តិថិ្ជនលោ លៅ ំរីផ ិតផ 
របរ់ស្កុម្ហ ៊ុនលនាះ។ កិចចការដដ ស្តូវលធ្វីអចរមួ្មនការបលងកីតសាល ករញ្ញ ស្កុម្ហ ៊ុន នាម្ប័ណណ 
ខិ្តតប័ណណផសរវផាយ ប័ណណស្បការ ការផសរវផាយ ណិជាកម្ម និងផ ិតផ លផសងៗជាលស្ចីនលទៀត។ 
ការរចនាមនសារៈរំខាន់ណារ់រស្មប់ផដ ់នូវខ្លឹម្សារ ដដ លគចង់បានស្បកបលដ្ឋយស្បរិទធភារ 
លដីម្បឱី្យ តិថិ្ជនយ ់ដឹង ំរីផ ិតផ របរ់ស្កុម្ហ ៊ុន និងភិនភាគប៊ុគា ិក កខណៈរបរ់រួកលគ។ 
លដីម្បឱី្យមនស្បរិទធភារ ខ្លឹម្សារចាបំាច់ស្តូវដតចារ់ោរ់ និងសាម្ញ្ញ។ លៅកន៊ុងលម្លរៀនលនះ លយងីនឹង
ដរវងយ ់ ំរីរមរធាត៊ុដដ លដីរតួនាទីោ៉ា ងរំខាន់ លដីម្បលីស្បីស្បារ់កន៊ុងការផដ ់នូវខ្លឹម្សារស្តឹម្ស្តូវ 
មនដូចជា បលង់ដដ បានរចនា អស្តឹម្ស្តូវ រ៊ុខ្ដ៊ុម្ រណ៌ា  និងការសាក បងផ្លទ  ់ខ្លួន។ 

ខ. រែង់ថ្ែលបានរននាលអស្រតឹមស្រតូវ   

 ការផសរវផាយ ណិជាកម្ម និងការលស្បីស្បារ់បដ្ឋលផសងៗ មនលោ បំណងកន៊ុងការទាក់ទាញ
ចំណាប់អរម្មណ៍របរ់សាធារណៈជនទូលៅ។ រូម្បរីូបរញ្ញ ចរចរលៅល ដីងផលូវ និងប័ណណស្បការលៅ
ល ជីញ្ា ងំស្តូវបានរចនាល ងីលដីម្បលីធ្វីឱ្យលយងីចាប់អរម្មណ៍ភាល ម្ៗ។ លៅកន៊ុងការរចនារូបភារ លយងីស្តូវ
ការបលង់រចនា អស្បលរីរលដីម្បសី្បាប់ជារ័ត៌ាមនខ្លឹម្សារដដ ចង់បាន។ បលង់រូបភារ គឺជាកដនលង ឬការ
លរៀបចំធាត៊ុដដ លយងីអចលមី្ លឃញីលៅកន៊ុងការរចនារូបភារ។ បលង់រូបភារដដ ចារ់ោរ់ទាក់
ទាញចំណាប់អរម្មណ៍របរ់លយងីបានោ៉ា ងរយស្រួ  ខ្ណៈដដ ការរចនាដដ រ៊ុំមនបលង់ចារ់
ោរ់មិ្នលធ្វីឱ្យចាប់អរម្មណ៍។ មូ្ លហត៊ុចម្បងដដ រូបភារមួ្យចំនួនមិ្នទាក់ទាញចំណាប់អរម្មណ៍ 
លដ្ឋយសារដតបលង់មិ្នសាអ ត ឬអរម្មណ៍របរ់លយងីមិ្នលផ្លដ តល ខី្លឹម្សារដដ ចង់ផដ ់។ បលង់ដដ មន
ស្បរិទធភារអចនាដំភនកលយងីលៅកដនលងដដ  នករចនាចង់ស្បាប់ឱ្យ នកទរសនាដឹង។ ជាមួ្យោន លនះ មិ្ន
ដម្នធាត៊ុ ឬដផនកទាងំ រ់មនសារៈរំខាន់ដូចោន ចំល ះបលង់លនាះលទ ជាធ្ម្មតាធាត៊ុនីមួ្យៗ ធាត៊ុខ្លះមន
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សារៈរំខាន់ជាងលគ។  នករចនាចង់ឱ្យ នកលមី្ លផ្លដ តចំណាប់អរម្មណ៍ល ីធាត៊ុ និងគំនិតរំខាន់លៅកន៊ុង
បលង់ ដដ ជាដផនករំខាន់ជាងលគននខ្លឹម្សារ។ វាអចលធ្វីបានលដ្ឋយរលំ ច ឬលធ្វីឱ្យទាក់ទាញនូវធាត៊ុ ឬ
គំនិតទាងំ រ់លនាះ។ 

 ការលធ្វីឱ្យទាក់ទាញ ឬរលំ ចមនន័យថ្នផដ ់សារៈរំខាន់ជារិលររចំល ះធាត៊ុណាមួ្យ 
លដីម្បលីធ្វីវាឱ្យល ចលធាល  ឬទាក់ទាញចំណាប់អរម្មណ៍ចំល ះដផនកលនាះ លដ្ឋយលធ្វីវាឱ្យដបលករីធាត៊ុលផសងៗ
លៅកន៊ុងបលង់លនាះ។ ការលធ្វីឱ្យទាក់ទាញអចស្តូវបានបលងកីតល ងីតាម្រយៈបលចចកលទរជាលស្ចីន ដូចជាការ
លធ្វីឱ្យធាត៊ុចារ់ធំ្ជាង លដ្ឋយលស្បីរណ៌ា ចារ់កស្មិ្តខ្ពរ់ ឬលដ្ឋយការបដូររូបរងជាម្៉ាូតលផសងៗ។ ប៉ា៊ុដនតលបី
ការលធ្វីឱ្យចារ់ ឬរលំ ចខាល ងំលរក បលង់លនាះនឹងរិបាកយ ់ លហយីចំនួនគំនិតដដ ចង់រលំ ចលស្ចីនហួរ
លហត៊ុលរកកន៊ុងបលង់មួ្យអចលធ្វីឱ្យវារំខានដូ់ចោន  ដដ មិ្នមនធាត៊ុណាមួ្យរលំ ចជាក់ចារ់រំខាន់
ជាងលគលទ។ វារំខានស់្តូវលស្ជីរធាត៊ុដដ ស្តឹម្ស្តូវរស្មប់រលំ ចឱ្យចារ់លដីម្បទីាក់ទាញ នកលមី្  និង
ផដ ់ខ្លឹម្សារបានយ ់ចារ់ និងឆ្ប់រហ័រ។ 

គ.  េខុែុម 

 លោ គំនិតននរ៊ុខ្ដ៊ុម្ គឺរំខានបំ់ផ៊ុតទាងំរិ បៈ តង្គ្នតី និងរូបភារ។ លៅលរ លយងី
របាយរកីរយជាមួ្យការសាដ ប់តង្គ្នតី រីលស្ ះតង្គ្នតីលនាះលធ្វីឱ្យលយងីមនអរម្មណ៍ អ និងនាឱំ្យលយងីមន
ការរបាយរកីរយ។ ស្បរិនលបីលយងីរកីរយនឹងបទចលស្ម្ៀងណាមួ្យ គឺលដ្ឋយសារលយងីចូ ចិតតឥទធិ
រ ននធាត៊ុនីមួ្យៗរបរ់វា ដូចជា សាច់លភលង ទំន៊ុកបទលភលង ទឹកដម្រំល ងរបរ់ នកចលស្ម្ៀង រំល ង
ឧបករណ៍លភលង និងទំន៊ុកនិរនធ។ 

  កយរ៊ុខ្ដ៊ុម្លៅកន៊ុងការរចនារូបភារ គឺជាស្បរិទធភារននការលធ្វីឱ្យលរញចិតតតាម្រយៈរូបភារ 

មនការរមួ្ផសធំាត៊ុដដ ទាក់ទងកន៊ុងការបលងកីតភាររ៊ុីររវ ក់ោន ។ មនន័យថ្នធាត៊ុននរូបភារស្តូវមន
ការថ្លឹងដថ្លងចារ់ោរ់ និងស្តូវបានលរៀបចំោ៉ា ងស្បលរីរ លដីម្បបីលងកីតអរម្មណ៍ដដ មនត៊ុ យភារ 
មួ្យ។ លៅលរ  នករចនារូបភារបលងកីតការរចនាមួ្យរស្មប់ តិថិ្ជន  តិថិ្ជនស្តូវដតមនអរម្មណ៍ថ្ន
ដផនកទាងំ រ់ស្តូវមនរ៊ុខ្ដ៊ុម្។  នករចនាស្តូវលចះលស្ជីរលររីរណ៌ា ចារ់ោរ់ ទំហ ំកសរ និងចលនាល ះ
ទំលនរស្គប់ស្ោន់លដីម្បបីលងកីតនូវបលង់ដដ មនត៊ុ យភារមួ្យ។ កតាត ដដ រំខាន់បំផ៊ុតលៅកន៊ុងបលង់មន
ដូចជា៖ រណ៌ា  ការតលស្ម្ៀប និង តេបទ។ 

ឃ. ពណ៌   

 លៅលរ លយងីបលងកីតបលង់រូបភារមួ្យ លយងីអចលស្ជីរលររីរណ៌ា លដ្ឋយនចដនយណាមួ្យ ប៉ា៊ុដនត
ស្បរិនលបីលយងីលធ្វីដូលចនះ  ទធផ ននការោយរណ៌ា អចនឹងលធ្វីឱ្យធ្៊ុញស្ទាន់ ឬមិ្នរូវរម្។ ម្ា៉ាងវញិ
លទៀត ស្បរិនលបីលយងីចំណាយលរ លស្ជីរលស្ោងរណ៌ា ដដ ស្តឹម្ស្តូវ លនាះបលង់នឹងមនការទាក់ទាញ 
និងលធ្វីឱ្យលយងីរកីរយ។ បនាទ ប់ម្កលយងីស្តូវមនរ៊ុខ្ដ៊ុម្ដផនករណ៌ា  ដដ រ៊ុខ្ដ៊ុម្រណ៌ា  គឺជា កយមួ្យ
ដដ លគលស្បីលដីម្បរិីរណ៌ា នា ំរីការោយរណ៌ា ដដ មនស្បរិទធភារលធ្វីឱ្យរកីរយ និងការបរហ ញរូប   
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ភារ។ រ៊ុខ្ដ៊ុម្រណ៌ា លធ្វីឱ្យ នកលមី្ ទាក់ដភនក និងបលងកីតអរម្មណ៍ខាងកន៊ុងតាម្ ំដ្ឋប់ ថ្លឹងដថ្លងតាម្រយៈ
ការលមី្ រូបភារលនាះ។ លៅលរ  វមួី្យមិ្នមនរ៊ុខ្ដ៊ុម្លទ វាមិ្នលធ្វីឱ្យទាក់ទាញនិងមិ្នមនការចាប់
អរម្មណ៍រយៈលរ យូរលទ។ រណ៌ា គឺជាដផនកមួ្យោ៉ា ងរំខាន់លៅលរ លយងីលធ្វីការរចនា វីមួ្យ។ 

ង.   ស្ររសេទពណ៌ 

 លៅជ៊ុំវញិខ្លួនលយងីមនរណ៌ា លស្ចីនស្បលភទ ដដ រណ៌ា ខ្លះអចោយបញ្ចូ  ោន បានលដីម្បី
បលងកីតជារណ៌ា ថ្មីលផសងមួ្យលទៀត។ ការរិរណ៌ា នាខាងលស្កាម្អចជួយឱ្យ នកដរវងយ ់បដនេម្ ំរី
ស្បលភទរណ៌ា នីមួ្យៗ៖  

• រណ៌ា លម្៖ ស្កហម្ ល ឿង លខ្ៀវ – ទាងំលនះជារណ៌ា
បីស្បលភទដដ មិ្នអចោយចូ ោន  ឬបលងកីតថ្មី
លដ្ឋយោយបញ្ចូ  ោន រវាងរណ៌ា លផសង។ រណ៌ា
បនាទ ប់បនស៖ំ នបតង ទឹកស្កូច សាវ យ – ទាងំលនះជា
រណ៌ា ដដ បលងកីតលចញរីការោយរណ៌ា លម្។ 

 

• រណ៌ា ោយោន ៖ ល ឿង-ទឹកស្កូច ស្កហម្-ទឹកស្កូច 
ស្កហម្-សាវ យ លខ្ៀវ-សាវ យ លខ្ៀវ-នបតង ល ឿង-
នបតង – ទាងំលនះជារណ៌ា ដដ បលងកីតលចញរីការ
ោយរវាងរណ៌ា លម្ និងរណ៌ា បនាទ ប់បនស។ំ លនះជា
លហត៊ុដដ រណ៌ា នីមួ្យៗមនលឈាម ះរីរ កយ ដដ 
 កយដំបូងជារណ៌ា លម្ និង កយបនាទ ប់ជា
រណ៌ា បនាទ ប់បនស។ំ 

 រណ៌ា ទាងំ រ់លនះស្តូវបានដ្ឋក់កន៊ុងរងវង់កង់ៗ តាម្ ំដ្ឋប់ននរណ៌ា ដដ ស្តូវោយ។ រងវង់លនះ
ឱ្យលឈាម ះថ្ន ការំងវង់រទង់រណ៌ា ។ វចិិស្តករ និង នករចនាលស្បីការំងវង់រណ៌ា លនះ លដីម្បោីយ និងលស្ជីរ        
រណ៌ា ។ រូម្លស្បីការំងវង់រទង់រណ៌ា លនះលដីម្បដីរវងយ ់ ំរីរ៊ុខ្ដ៊ុម្ននរណ៌ា ។ 

១.៣. តួនាទីច្នការរននាស្រកាហវកិ 

 ការរចនាស្កាហវកិ លដីរតួនាទីោ៉ា ងរំខាន់
កន៊ុងការផាយ ណិជាកម្ម ម៉ា កយលីហា និងទីផារ 
លហយីមនឥទធិរ ោ៉ា ងរំខាន់លៅល ីអកបបកិរោិ
របរ់ នកលស្បីស្បារ់។ ការរចនាស្កាហវកិស្បកបលដ្ឋយ
ស្បរិទធភារ អចជួយស្កុម្ហ ៊ុនបលងកីតម៉ា កយលីហា 

រូបភារទី១.១ រណ៌ា លម្ (ស្កហម្ ល ឿង លខ្ៀវ) 

រូបភារទី១.២ រណ៌ា លម្ រណ៌ា បនាទ ប់បនស ំរណ៌ា ោយោន  

រូបភារទី១.៣ តួនាទីននការរចនាស្កាហវកិ 
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ដដ មនភារខាល ងំនិងអចទទួ បានការទទួ សាា  ់ ផដ ់សារទំនាក់ទំនងលៅ នកដនទបានោ៉ា ង
ចារ់ និងមនឥទធិរ ល ីការយ ់លឃញី និងអកបបកិរោិរបរ់ នកលស្បីស្បារ់។ 

 វធីិ្មួ្យដដ ការរចនាស្កាហវកិមនឥទធិរ 
ល ីអកបបកិរោិរបរ់ នកលស្បីស្បារ់ គឺតាម្រយៈការ
លស្បីស្បារ់ធាត៊ុដដ លមី្ លឃញី ដូចជារណ៌ា   កសរ 
និងរូបភារ។ ការរិកាបានបរហ ញថ្នរណ៌ា មួ្យ
ចំនួនអចរលំ ចអរម្មណ៍ និងអកបបកិរោិជាក់
ោក់ចំល ះ នកលស្បីស្បារ់ លហយីការវាយ កសរអច
មនឥទធិរ ល ីរលបៀបដដ រ័ត៌ាមនស្តូវបានដឹង និង
ចងចា។ំ ជាឧទាហរណ៍ រ៊ុម្ព កសរ serif ជាលរឿយៗស្តូវបានផារភាា ប់ជាមួ្យនឹងស្បនរណី និងភារល្ីត
ឆ្យ ខ្ណៈលរ ដដ រ៊ុម្ព កសរ sans-serif ស្តូវបានលគលមី្ លឃញីថ្នជាទស្ម្ង់រម័្យទំលនីប និងមន
ការលស្បីស្បារ់តិចតួច។ កតាត ទាងំលនះអចជះឥទធិរ ដ ់រលបៀបដដ  នកលស្បីស្បារ់យ ់លឃញី ំរីម៉ា ក
យលីហា និង តេន័យរបរ់វា។  

 វធីិ្មួ្យលទៀតដដ ការរចនាស្កាហវកិប៉ាះ  ់ដ ់ឥរោិបថ្ នកលស្បីស្បារ់ គឺតាម្រយៈរម្តេ
ភាររបរ់វាកន៊ុងការស្បាស្រ័យទាក់ទងរ័ត៌ាមនរម៊ុស្គសាម ញតាម្រយៈការរចនារូបភារ។ ឧទាហរណ៍ 
Infographics និងការលមី្ លឃញីទិននន័យអចជួយបំដបករ័ត៌ាមនរម៊ុស្គសាម ញលៅជាទស្ម្ង់ដដ រយ
ស្រួ យ ់ និងទាក់ទាញការចូ រមួ្របរ់ នកលស្បីស្បារ់។ ចំណ៊ុ ចទាងំលនះអចជួយកសាងទំន៊ុកចិតត 
និងភារលជឿជាក់ជាមួ្យ នកលស្បីស្បារ់ និងល ីកទឹកចិតតរួកលគឱ្យលធ្វីរកម្មភារលផសងៗផងដដរ។ 

១.៤. ការពិចារណាអ្ំពីស្រកមេលីធមក៌ៃងុការរននាស្រកាហវកិ 

  ស្កម្រី ធ្ម្៌ា គឺជាការរិចារណាដ៏
រំខាន់មួ្យលៅកន៊ុងការរចនាស្កាហវកិ ជារិលររ
លៅលរ ដដ និោយ ំរីការតំណាងឱ្យរ័ត៌ាមន
បានស្តឹម្ស្តូវ និងលជៀរវាងនូវគំរូដដ បងកលស្ោះ
ថ្នន ក់។  នករចនាស្កាហវកិមនទំនួ ខ្៊ុរស្តូវកន៊ុង
ការធានាថ្ន ការរររបរ់រួកលគមនភារលសាម ះ
ស្តង់ ស្តឹម្ស្តូវ និងមិ្នមនធាត៊ុបំភាន់ ឬលបាកបលញ្ឆ តណាមួ្យល យី។ វាតស្មូ្វឱ្យមនការលបតជ្ាចិតត
ចំល ះភារលសាម ះស្តង់ រ៊ុចរតិភារ  និងតមល ភារកន៊ុងស្គប់ទិដាភារននដំលណីរការរចនា។  

 ការរិចារណាដផនករី ធ្ម្៌ាដ៏រំខាន់មួ្យកន៊ុងការរចនាស្កាហវកិ គឺជាការទទួ ខ្៊ុរស្តូវកន៊ុងការ
តំណាងឱ្យរ័ត៌ាមនោ៉ា ងស្តឹម្ស្តូវ។ វាមនន័យថ្នការធានា ការទាម្ទារ ឬលរចកតីដថ្លងការណ៍ណាមួ្យ
ដដ បានលធ្វីល ងីលៅកន៊ុងការផាយ ណិជាកម្ម ឬរមា រៈទីផារគឺជាការរិត និងោសំ្ទលដ្ឋយភរត៊ុតាង។
ជាឧទាហរណ៍ ស្កុម្ហ ៊ុនមិ្នគួរលស្បីរេិតិបំភាន់លដីម្បផីសរវផាយផ ិតផ  ឬលរវាកម្មរបរ់រួកលគ ឬលធ្វី

រូបភារទី១.៤ រ៊ុម្ព កសរ serif និង រ៊ុម្ព កសរ sans-serif 

រូបភារទី១.៥ ស្កម្រី ធ្ម្៌ាកន៊ុងការរចនាស្កាហវកិ 
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ការទាម្ទារមិ្នរិត ំរី តេស្បលោជន៍របរ់វា។  នករចនាស្កាហវកិស្តូវដតយកចិតតទ៊ុកដ្ឋក់កន៊ុងការ
តំណាងឱ្យរ័ត៌ាមនោ៉ា ងស្តឹម្ស្តូវលៅកន៊ុងធាត៊ុដដ លមី្ លឃញីទាងំ រ់ ដូចជាស្កាហវ គំនូរតាង និង
រូបភារ លហយីលជៀរវាងការបងខូចស្ទង់ស្ទាយ ឬបរហ ញទិននន័យខ្៊ុរ។  

 ការរិចារណាល ីស្កម្រី ធ្ម្៌ាដ៏រំខាន់មួ្យលទៀតលៅកន៊ុងការរចនាស្កាហវកិ គឺតស្មូ្វការលដីម្បី
លជៀរវាងនូវគំរូដដ បងកលស្ោះថ្នន ក់។ លនះមនន័យថ្ន លជៀរវាងលស្បីស្បារ់រូបភារណាដដ នាឱំ្យមន
ការយ ់លឃញី វជិាមន ឬបងកលស្ោះថ្នន ក់ លដ្ឋយដផអកល ីជាតិសារន៍ លភទ សារនា ឬ កខណៈលផសង              
លទៀត។  នករចនាស្កាហវកិគួរដតខិ្តខំ្បលងកីតការរចនាដដ រមួ្បញ្ចូ   និងលោររភារជាប៊ុគា  និងរហ
គម្ន៍ទាងំ រ់ លហយីលជៀរវាងការរស្ងឹងអកបបកិរោិ វជិាមន ឬ ំល ៀង។ 

១.៣. កមមវិធីថ្កេស្រមលួររូភាព GIMP 

GIMP គឺជាកម្មវធីិ្រស្មប់បលងកីត និងដករស្មួ្ រូបភារស្គប់ស្បលភទ។ GIMP គឺជា កសរកាត់
រស្មប់កម្មវធីិ្ GNU Image Manipulation។ GIMP មនរម្តេភារជាលស្ចីន ដដ វាអចលស្បីជាកម្ម
វធីិ្គូររូបភារធ្ម្មតា កម្មវធីិ្ជំនាញដករស្មួ្ គ៊ុណភាររូបភារ ឧបករណ៍លដីម្បបីលងកីតរិ បៈឌី្ជីថ្  
ស្បរ័នធដំលណីរការបណត៊ុ ំ តាម្ ៊ុីនធឺ្ណិត  នកបលងកីតរូបភាររស្មប់ផ ិតកម្មធំ្ៗ កម្មវធីិ្បំដបលង
ស្ទង់ស្ទាយរូបភារជាលដីម្។ ចំណ៊ុ ចខាល ងំមួ្យរបរ់ GIMP គឺភារអចរកបានលដ្ឋយឥតគិតនថ្លរីស្បភរ
ជាលស្ចីនរស្មប់ស្បរ័នធស្បតិបតតិការលផសងៗ។ ការដចកចាយ GNU / Linux ភាគលស្ចីន រមួ្បញ្ចូ   GIMP
ជាកម្មវធីិ្រតង់ដ្ឋរ។ GIMP ក៏មនរស្មប់ស្បរ័នធស្បតិបតតិការលផសងលទៀតដូចជា Microsoft Windows ឬ 
macOS របរ់ Apple (Darwin) ផងដដរ។ GIMP គឺជាកម្មវធីិ្ឥតគិតនថ្ល ដដ ស្គបដណត ប់លដ្ឋយអជ្ា
ប័ណណសាធារណៈទូលៅកំដណ 3។ GPL  ផត ់ឱ្យ នកលស្បីស្បារ់នូវលររភីារកន៊ុងការចូ លស្បី និងផ្លល រ់បតូរ
កូដលដីម្ដដ បលងកីតកម្មវធីិ្ក៊ុំរយូទ័រ។ កំដណដំបូងនន GIMP  
ស្តូវបានបលងកីតល ងីលដ្ឋយ Peter Mattis និង Spencer 
Kimball។ កន៊ុងរយៈលរ ជាលស្ចីនឆ្ន មំ្កលនះ ម្ន៊ុរសជាលស្ចីន
លទៀតបានចូ រមួ្ចំដណកលដ្ឋយការជួយកន៊ុងការ ភិវឌ្ឍន៍ ការ
លធ្វីលតរត ការផត ់ការោសំ្ទ ការបកដស្ប និងការររលររ        
ឯកសារ។ ការលចញផាយ GIMP បចច៊ុបបននកំរ៊ុងស្តូវបាន
លរៀបចំល ងីលដ្ឋយ Mitch Natterer និង Jehan Pagès និង
រមជិកលផសងលទៀតនន GIMP -Team ។ 

១.៣.១ លកេណៈពិសេេ និងេមតថភាព 

ខាងលស្កាម្គឺជាទិដាភាររលងខបនន កខណៈរិលររ និងរម្តេភារមួ្យចំនួនដដ  GIMP ផត ់
ជូន នក រស្មប់ការដករស្មួ្ រូបភារ៖ 

រូបភារទី ១.៦ រូបតំណាងរបរ់កម្មវធីិ្ GIMP 
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• ឈ៊ុតលរញល ញននឧបករណ៍គូររមួ្មនជក់(brush) លមម នដ(pencil) ជក់ខ្យ ់(airbrush) 
ចម្លង(clone) ជាលដីម្។ 

• គំរូ sub-pixel រស្មប់ឧបករណ៍ថ្នន ោំប(Busket Fill)ទាងំ រ់រស្មប់ការលស្បីស្បារ់រណ៌ា
និងការរចនាដដ មនគ៊ុណភារខ្ពរ់។ 

• ការោសំ្ទ Alpha channel  លរញល ញរស្មប់លធ្វីការជាមួ្យស្រទាប់ដដ ោម ននផទខាង
លស្កាយ(transperency)។ 

• ការោសំ្ទការលស្បីស្បារ់ស្រទាប់(layers) និងឆ្ដន  (chanel)។ 

• មូ្ ដ្ឋា នទិននន័យនីតិវធីិ្រស្មប់ការលៅ ម្៊ុខ្ររ GIMP ខាងកន៊ុង រីកម្មវធីិ្ខាងលស្ៅដូចជា 
Script-Fu។ 

• រម្តេភារង្គ្រាីបកស្មិ្តខ្ពរ់។ 

• មិ្នលធ្វីវញិ (undo)/លធ្វីវញិ (redo) លស្ចីនដង។ 

• ឧបករណ៍បំដ ង រមួ្មន បងវិ  មស្តដ្ឋា ន កាត់ និងស្ត ប់។ 

• ោសំ្ទស្ទង់ស្ទាយឯកសារជាលស្ចីន រមួ្មន JPEG, PNG, GIF, PSD, DDS, XPM, TIFF, TGA, 
MPEG, PS, PDF, PCX, BMP និងលផសងៗលទៀត។ 

• ឧបករណ៍លស្ជីរលររី រមួ្មន ចត៊ុលកាណដកង រងរងស្កលរី លររ ី ស្ររិចស្ររិ  និងកនង្គ្នត
ឆ្ល តនវ។ 

• កម្មវធីិ្ជំនួយដដ  ន៊ុញ្ញ តឱ្យមនភាររយស្រួ កន៊ុងការបដនេម្ទស្ម្ង់ឯកសារថ្មី និងតស្ម្ង
ដបបដផនថ្មី។ 

១.៣.២. ែំសណើ រការ GIMP 

ជាធ្ម្មតា នកអចលបីកកម្មវធីិ្ GIMP លដ្ឋយច៊ុចល ីរូបតំណាងមួ្យ ឬលដ្ឋយការវាយបញ្ចូ   
gimp លៅល ីបនាទ ត់ កយបញ្ា ។ ស្បរិនលបី នកបានដំល ងីកំដណ GIMP លស្ចីន  នកស្បដហ ជាស្តូវ
វាយ gimp-2.10 លដីម្បទីទួ បានកំដណថ្មីបំផ៊ុត។   នកក៏អចលបីកកម្មវធីិ្ GIMP ជាមួ្យនឹង file រូប
ភាររចួជាលស្រច លដ្ឋយវាយបញ្ចូ  លឈាម ះ file រូបភារណាម្យយលៅល ីបនាទ ត់ កយបញ្ា បនាទ ប់រី
លឈាម ះកម្មវធីិ្ GIMP។   ន៊ុវតដដូលចនះ GIMP នឹងលបីក file ទាងំលនាះលដ្ឋយរវ័យស្បវតតិបនាទ ប់រីវាចាប់      
លផតីម្។ វាក៏អចលធ្វីលៅបានផងដដរលដីម្បលីបីក file រីកន៊ុង GIMP លៅលរ ដដ វាកំរ៊ុងដំលណីរការ។ ស្បរ័នធ
ស្បតិបតតិការភាគលស្ចីនោសំ្ទការភាា ប់ file ដដ ភាា ប់ថ្នន ក់ (level) ននឯកសារ (ដូចដដ បានកំណត់
លដ្ឋយដផនកបដនេម្លឈាម ះ file របរ់រួកលគ ដូចជា .jpg) ជាមួ្យនឹងកម្មវធីិ្ដដ ស្តូវោន  (ដូចជាGIMP)។ 
លៅលរ ដដ  file រូបភារស្តូវបាន " ភាា ប់ " ស្តឹម្ស្តូវលៅនឹង GIMP  នកអចច៊ុចរីរដងល ីរូបភារលដីម្បី
លបីកវាលៅកន៊ុង GIMP ។ 



8 

១.៣.៣. សវទិកាថ្ែលសគាា ល ់

GIMP គឺជាកម្មវធីិ្ដករស្មួ្ រូបភារ ដដ ោសំ្ទោ៉ា ងទូ ំទូោយបំផ៊ុតដដ មនររវនថ្ាលនះ។
លវទិកាដដ  GIMP ស្តូវបានលគដឹងថ្នដំលណីរការរមួ្មន GNU /Linux , Apple macOS , Microsoft 
Windows, OpenBSD, NetBSD, FreeBSD, Solaris, SunOS, AIX, HP-UX, Tru64 , digital 
UNIX, OSF/1, IRIX , OS/2 និង BeOS ជាលដីម្។ GIMP ស្តូវបានដំល ងីោ៉ា ងរយស្រួ លៅកាន់
ស្បរ័នធស្បតិបតតិការលផសងលទៀត លដ្ឋយសារដតមនកូដលដីម្របរ់វា។  

១.៣.៤. គំនិតាមូលដ្ឋា ន 

ដផនកលនះផត ់នូវការដណនាខំ្លីៗ ំរីលោ គំនិត និងវាកយរ័រទជាមូ្ ដ្ឋា នដដ លស្បីកន៊ុងកម្ម
វធីិ្ GIMP ។  

ក. ររូភាព (Images) 

រូបភារ គឺជាធាត៊ុមូ្ ដ្ឋា នដដ លស្បីលដ្ឋយ GIMP ។ និោយលដ្ឋយស្បលោ  " របូភារ " ស្តូវ
ោន លៅនឹង file ដតមួ្យ ដូចជាឯកសារ TIFF ឬ JPEG ។  នកក៏អចគិតថ្នរូបភារមួ្យដដ ស្តូវោន នឹង
បងអួចបរហ ញដតមួ្យ (លទាះបីជាការរិតវាអចលៅរចួដដ មនបងអួចលស្ចីនដដ បរហ ញរូបភារដូចោន )។ 
វាមិ្នអចឱ្យមនបងអួចដតមួ្យបរហ ញរូបភារលស្ចីនជាងមួ្យលនាះលទ ឬរស្មប់រូបភារដដ ោម នបងអួច
បរហ ញវា។ រូបភារ GIMP អចជាលរឿងដ៏រម៊ុគសាម ញមួ្យ។ ជំនួរឱ្យការគិតថ្នវាជាស្កដ្ឋរមួ្យរនលឹក
ដដ មនរូបភារលៅល ីលនាះ ចូរគិតថ្នវាដូចជារនលឹកដដ លគលៅថ្ន ស្រទាប់ (layers)។ បដនេម្រី
ល ីជង់ននស្រទាប់ រូបភារ GIMP អចមនរបាងំលស្ជីរលររី រំណ៊ុំ ននបណាត ញ និងរំណ៊ុំ ផលូវ។ តាម្
រិត GIMP ផត ់នូវយនតការរស្មប់ភាា ប់បំដណកននទិននន័យដដ លៅថ្ន " parasites" លៅនឹងរូបភារ
មួ្យ។ លៅកន៊ុង GIMP វាអចមនរូបភារជាលស្ចីនលបីកកន៊ុងលរ ដតមួ្យ។ លទាះបីជារូបភារធំ្អចលស្បី ងា
ចងចាលំស្ចីនលម្ហាា នបក៏លដ្ឋយ ដត GIMP លស្បីស្បរ័នធស្គប់ស្គង ងាចងចាដំដ មនមូ្ ដ្ឋា នល ីស្កឡាដ៏
ទំលនីបដដ  ន៊ុញ្ញ តឱ្យ GIMP ស្គប់ស្គងរូបភារធំ្បានោ៉ា ងស្ររ់សាអ ត។ លទាះោ៉ា ងណាក៏លដ្ឋយមន
ដដនកំណត់ លហយីការមន ងាចងចាដំដ មនរម្តេភារខ្ពរ់អចបលងកីនដំលណីរការស្បរ័នធ។ 

ខ. ស្រេទារ់ (Layers) 

ស្បរិនលបីរូបភារសាម្ញ្ញអចលស្បៀបលធ្ៀបលៅនឹងរនលឹកស្កដ្ឋរដតមួ្យ លនាះរូបភារដដ មន
ស្រទាប់ស្តូវបានស្បដូចលៅនឹងរនលឹកស្កដ្ឋរថ្នល ដដ ដ្ឋក់ជង់មួ្យលៅរីល ីមួ្យលទៀត។  នកអចគូរលៅ
ល ីស្កដ្ឋរនីមួ្យៗ ប៉ា៊ុដនតលៅដតលឃញីខ្លឹម្សារននរនលឹកលផសងលទៀតតាម្រយៈនផទថ្នល  (transperancy)។ 
 នកក៏អចផ្លល រ់ទីរនលឹកមួ្យទាក់ទងនឹងរនលឹកលផសងលទៀតបានដដរ។  នកលស្បីស្បារ់ GIMP ទំលនីបដតង
លធ្វីការររជាមួ្យរូបភារដដ មនស្រទាប់ជាលស្ចីន លទាះបីជាមនស្រទាប់រហូតដ ់រប់រិបក៏លដ្ឋយ។ 
ស្រទាបមិ់្នចាបំាច់មនភារស្រអបល់ទ លហយីវាមិ្នចាបំាច់ស្គបដណដ ប់ស្គប់ទំហនំនរូបភារល យី ដូលចនះ
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លរ  នកលមី្ ការបរហ ញរបរ់រូបភារ  នកអចលឃញីរូបភារលៅល ីស្រទាប់លផសងៗ មិ្នស្តឹម្ដត
ស្រទាបខ់ាងល ីលនាះលទ ( នកអចនឹងលឃញីធាត៊ុននស្រទាប់ជាលស្ចីន)។ 

គ. គុណភាពរង្ហា ញ (Resolution) 

រូបភារឌី្ជីថ្ មនស្កឡាចស្តងាននភីកដរ កាលរ ៉ា។ រូបភារនីមួ្យៗមនទំហវំារ់ដវងជារីរ      
វមិស្ត ដូចជា ទទឹង 900 ភីកដរ  និងកម្ពរ ់600 ភីកដរ ។ ប៉ា៊ុដនតភីកដរ មិ្នមនទំហកំំណត់កន៊ុង
 ំហជាក់ដរតងលទ។ លដីម្បលីរៀបចំរូបភាររស្មប់ការលបាះរ៊ុម្ព លយងីលស្បីតនម្លដដ លៅថ្នគ៊ុណភារ
បរហ ញ (Resolution) ដដ កំណត់ជារមមស្តរវាងទំហរំូបភារជាភីកដរ  និងទំហរំូបវនតរបរ់វា 
(ជាធ្ម្មតាគិតជា ៊ុីនឈ៍ ) លៅលរ វាស្តូវបានលបាះរ៊ុម្ពល ីស្កដ្ឋរ។ ស្ទង់ស្ទាយ file ភាគលស្ចីន (ប៉ា៊ុដនត
មិ្នដម្នទាងំ រ់លទ) អចរកាទ៊ុកតនម្លលនះ ដដ ស្តូវបានបរហ ញជា ppi-pixels កន៊ុងមួ្យ ៊ុីនឈ៍ ។ លៅ
លរ លបាះរ៊ុម្ពរូបភារ គ៊ុណភារបរហ ញកំណត់ទំហដំដ រូបភារនឹងមនលៅល ីស្កដ្ឋរ លហយីជា ទធ
ផ គឺ ទំហរំូបវនតននភីកដរ ។ រូបភារ 900x600 ភីកដរ ដូចោន អចស្តូវបានលបាះរ៊ុម្ពជាកាត 3x2" 
តូចមួ្យ ដដ មនភីកដរ គួរឱ្យកត់រមា  ់ ឬជាផ្លទ ងំរូបភារធំ្ដដ មនភីកដរ ធំ្។ 

ឃ. ឆាថ្នល (Channels) 

ឆ្ដន  គឺជាធាត៊ុផសដំតមួ្យននរណ៌ា របរ់ភីកដរ ។ រស្មប់ភីកដរ រណ៌ា លៅកន៊ុង GIMP 
រមរធាត៊ុទាងំលនះជាធ្ម្មតាមនរណ៌ា ស្កហម្ នបតង លខ្ៀវ និងជួនកា មនភារថ្នល  (Alpha)។ 
រស្មប់រូបភារដដ កំណត់ខាន តស្បលផះ រួកវាមនរណ៌ា ស្បលផះ និងអ ់ហាវ  លហយីរស្មប់រូបភារមន
រណ៌ា ដដ លធ្វី ិបិស្កម្ (index) រួកវាស្តូវបានដ្ឋក់ ិបិស្កម្ និងអ ់ហាវ ។ លៅលរ ដដ រូបភារស្តូវ
បានបរហ ញ លនាះ GIMP ដ្ឋក់រមរធាត៊ុទាងំលនះរមួ្ោន លដីម្បបីលងកីតជារណ៌ា ភីកដរ រស្មប់ល ស្កង់ 
ម៉ា រ៊ុីនលបាះរ៊ុម្ព ឬឧបករណ៍បលញ្ចញលផសងលទៀត។ ឧបករណ៍លបាះរ៊ុម្ាមួ្យចំនួនអចលស្បីបណាត ញលផសង
ោន រីស្កហម្ នបតង និងលខ្ៀវ។ ស្បរិនលបីរួកលគលធ្វីដូលចនះ ឆ្ដន របរ់ GIMP ស្តូវបានបំដបលងលៅជាឆ្
ដន ដដ រម្រម្យរស្មប់ឧបករណ៍ លៅលរ រូបភារស្តូវបានបរហ ញ។ ឆ្ដន អចមនស្បលោជន៍
លៅលរ  នកកំរ៊ុងលធ្វីការល ីរូបភារ ដដ ស្តូវការការដកតស្មូ្វរណ៌ា ជាក់ោក់មួ្យ។ ឧទាហរណ៍ 
ស្បរិនលបី នកចង់ ៊ុប “ ដភនកស្កហម្ ” លចញរីរូបថ្ត  នកអចលធ្វីការលៅល ីឆ្ដន ស្កហម្។  នកអច
លមី្ ឆ្ដន ជារបាងំម្៊ុខ្ដដ  ន៊ុញ្ញ ត ឬដ្ឋក់កស្មិ្ត ទធផ ននរណ៌ា ដដ ឆ្ដន បានតំណាង។ 
លដ្ឋយលស្បីតស្ម្ងល ីរ័ត៌ាមនឆ្ដន   នកអចបលងកីតដបបដផនចស្មុ្ះ និងស្សា ៗជាលស្ចីនល ីរូបភារ។
ឧទាហរណ៍សាម្ញ្ញននការលស្បីតស្ម្ងលៅល ីឆ្ដន រណ៌ា គឺ តស្ម្ង Channel Mixer ។ 

ង. ការសស្ររើេសរ ើេ (Selections) 

ជាញឹកញាប់លៅលរ ដករស្មួ្ ដស្បរូបភារ  នកស្ោន់ដតចង់ឱ្យដផនកមួ្យននរូបភារស្តូវបាន
កំណត់ដបបដផន។ យនតការ " ការលស្ជីរលររី " លធ្វីឱ្យវាអចលធ្វីលៅបាន។ រូបភារនីមួ្យៗមនជលស្មី្រ
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ផ្លទ  ់ខ្លួនរបរ់វា ដដ ជាធ្ម្មតា នកលឃញីជាបនាទ ត់ដ្ឋច់ៗ ដដ ផ្លល រ់ទីលដ្ឋយបំដបកដផនកដដ បាន
លស្ជីរលររីលចញរីដផនកដដ មិ្នបានលស្ជីរលររី (ដដ លគលៅថ្ន " marching ants" )។ តាម្រិត
លនះគឺជាការយ ់ស្ច បំនតិច៖ ការលស្ជីរលររីលៅកន៊ុង GIMP ស្តូវបានចាត់ថ្នន ក់ មិ្នដម្នទាងំ រ់ ឬោម ន
 វីលទ លហយីរិតជាការលស្ជីរលររីស្តូវបានតំណាងលដ្ឋយឆ្ដន រណ៌ា ស្បលផះលរញ កខណៈ។ បនាទ ត់  
ដ្ឋច់ៗ ដដ  នកលឃញីជាធ្ម្មតា គឺស្ោន់ដតជាបនាទ ត់វណា វងកលៅកស្មិ្តដដ បានលស្ជីរលររី 50%។ 
លទាះបីជាោ៉ា ងណាក៏លដ្ឋយ  នកអចស្រនម្លមី្ ឆ្ដន ដដ បានលស្ជីរលររីលៅកន៊ុងរ័ត៌ាមន ម្អិតដ៏ 
 សាច រយរបរ់វាលដ្ឋយការបិទ ឬលបីក ប ូត៊ុង QuickMask ។ 

រមរធាត៊ុដ៏ធំ្មួ្យននការលរៀនរីរលបៀបលស្បី GIMP ស្បកបលដ្ឋយស្បរិទធភារគឺការទទួ បាន
រិ បៈននការលស្ជីរលររីដ៏ អ ការលស្ជីរលររីដដ ផទ៊ុកនូវ វីដដ  នកស្តូវការរិតស្បាកដ និងោម នការ
លស្ជីរលររី។ លដ្ឋយសារដតការស្គប់ស្គងការលស្ជីរលររីមនសារៈរំខាន់ជាចម្បង GIMP ផត ់នូវ
ឧបករណ៍ជាលស្ចីនរស្មប់លធ្វីវា៖ ការចាត់ថ្នន ក់ននឧបករណ៍លស្ជីរលររី ម្៊ុឺន៊ុយននស្បតិបតតិការលស្ជីរលររី 
និងរម្តេភារកន៊ុងការបតូរលៅជាទស្ម្ង់របាងំរហ័រ (QuickMask) ដដ  នកអចចាត់ទ៊ុកឆ្ដន លស្ជីរ
លររី លទាះបីជាវាជាឆ្ដន រណ៌ា ក៏លដ្ឋយក៏ "painting the selection" ។ 

ន. ថ្លងសធវើ (Undoing) 

លរ  នកលធ្វីខ្៊ុរ  នកអច ៊ុបវាវញិបាន។ លរទីរដត វីៗស្គប់ោ៉ា ងដដ  នកអចលធ្វីបានចំល ះរូប
ភារគឺមិ្នអច ៊ុបលចា បានលទ។ ជាការរិត  នកអចមិ្នលធ្វីល ងីវញិនូវចំនួនដ៏លស្ចីនននលរឿងថ្មីៗបំផ៊ុត
ដដ  នកបានលធ្វី ស្បរិនលបី នករលស្ម្ចចិតតថ្នរួកលគស្តូវបាន ន៊ុវតដខ្៊ុរ។ GIMP លធ្វីឱ្យវាអចលធ្វីលៅ
បានលដ្ឋយរកាស្បវតតិននរកម្មភាររបរ់ នក។ ស្បវតតិសាង្គ្រតលនះលស្បីស្បារ់ការចងចា ំ ដូលចនះការមិ្នអច
លធ្វីវញិបានគឺមិ្នមនកំណត់លទ។ រកម្មភារខ្លះលស្បី ងាចងចាមិំ្នលធ្វីវញិតិចតួចណារ់ ដូលចនះ នកអច
លធ្វីវាបានរប់រិបដង ម្៊ុនលរ ដដ រកម្មភារដំបូងបំផ៊ុតស្តូវបាន ៊ុបលចញរីស្បវតតិលនះ។ ស្បលភទ
រកម្មភារលផសងលទៀតទាម្ទារបរមិណដ៏ធំ្ននការមិ្នលធ្វីការចងចា។ំ  នកអចកំណត់រចនារម្ព័នធ
បរមិណនន ងាចងចា ំGIMP  ន៊ុញ្ញ តឱ្យមិ្នលធ្វីវញិនូវស្បវតតិននរូបភារនីមួ្យៗ ប៉ា៊ុដនតកន៊ុងសាេ នភារណា
មួ្យ  នកគួរដតអចមិ្នលធ្វីវញិោ៉ា ងលហាចណារ់ 2-3 រកម្មភារថ្មីៗបំផ៊ុតរបរ់ នក។  

ឆ. កមមវិធីរំនួយ (Plug-ins) 

ស្បដហ ជាលរឿងជាលស្ចីនដដ  នកលធ្វីចំល ះរូបភារកន៊ុង GIMP  ស្តូវបានលធ្វីលដ្ឋយកម្មវធីិ្  GIMP 
ខ្លួនឯង។ លទាះជាោ៉ា ងណាក៏លដ្ឋយ GIMP ក៏លស្បីស្បារ់ោ៉ា ងទូ ំទូោយនូវ “ កម្មវធីិ្ជំនួយ ” ដដ ជា
កម្មវធីិ្ខាងលស្ៅដដ មន នតរកម្មោ៉ា ងជិតរនិទធជាមួ្យ GIMP លហយីមនរម្តេភារលរៀបចំរូបភារ និង 
វតេ៊ុ GIMP លផសងលទៀត តាម្រលបៀបរម៊ុស្គសាម ញ។ កម្មវធីិ្ជំនួយរំខាន់ៗជាលស្ចីនស្តូវបានរមួ្បញ្ចូ  ជាមួ្យ
GIMP ប៉ា៊ុដនតមនកម្មវធីិ្ជំនួយជាលស្ចីនដដ អចលស្បីបានលដ្ឋយម្លធ្ាបាយលផសងលទៀត។ ជាការរិតការ
ររលររកម្មវធីិ្ជំនួយ (និងង្គ្រាីប) គឺជាម្លធ្ាបាយរយស្រួ បំផ៊ុតរស្មប់ នកដដ មិ្នលៅកន៊ុងស្កុម្

https://docs.gimp.org/2.10/en/gimp-image-window-quick-mask-button.html
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 ភិវឌ្ឍន៍ GIMP លដីម្បបីដនេម្រម្តេភារថ្មីលៅ GIMP ។  កយបញ្ា ទាងំ រ់កន៊ុងម្៊ុឺន៊ុយ “Filters” និង
 កយបញ្ា ជាលស្ចីនកន៊ុងម្៊ុឺន៊ុយលផសងលទៀតគឺស្តូវបាន ន៊ុវតតជាកម្មវធីិ្ជំនួយ។ 

រ. ស្គេារី (Scripts) 

បដនេម្រីល ីកម្មវធីិ្ជំនួយដដ ជាកម្មវធីិ្ដដ ររលររជាភាសា C GIMP ក៏អចលស្បីស្បារ់ង្គ្រាីប
ផងដដរ។ ចំនួនង្គ្រាីបដដ មនស្សាប់លស្ចីនបំផ៊ុតស្តូវបានររលររជាភាសាមួ្យលៅថ្ន Script-Fu ដដ 
មន កខណៈដបលករី GIMP (រស្មប់ នកដដ យកចិតតទ៊ុកដ្ឋក់ វាគឺជាស្ោម្ភាសាននភាសា Lisp ដដ 
លៅថ្ន Scheme)។ វាក៏អចររលររ ង្គ្រាីប GIMP លៅកន៊ុង PYTHON ឬ PERL ផងដដរ។ ភាសាទាងំ
លនះមនភារបត់ដបន និងមនឥទធិរ ជាង Script-Fu ។ គ៊ុណវបិតតិរបរ់រួកលគគឺថ្នរួកលគរឹងដផអកល ី
កម្មវធីិ្ដដ មិ្នភាា ប់ម្កជាមួ្យ GIMP លដ្ឋយរវ័យស្បវតតិ ដូលចនះរួកលគមិ្នស្តូវបានធានាថ្ននឹងដំលណីរ
ការបានស្តឹម្ស្តូវលៅកន៊ុងរ ់ ការដំល ងី GIMP លនាះលទ។ 
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េណួំររលំកឹសមសរៀន 

1- លតីលោ ការណ៍រំខាន់ៗននការរចនារូបភារមន វីខ្លះ លហយីលតីរួកវាចូ រមួ្ចំដណកកន៊ុង
ការបលងកីតការរចនាស្បកបលដ្ឋយភារទាក់ទាញ និងមនស្បរិទធភារលដ្ឋយរលបៀបណា? 

2- ចូររិភាកា ំរីតួនាទីននស្ទឹរដីរណ៌ា កន៊ុងការរចនាស្កាហវកិ និងរលបៀបដដ ការយ ់ដឹងរីភារ
ច៊ុះរស្មុ្ងោន ននរណ៌ា  និងកស្មិ្តរណ៌ា អចបលងកីនឥទធិរ ដដ លមី្ លឃញីននការរចនា? 

3- លតីការលស្បីស្បារ់រូបភារ និងធាត៊ុដដ លមី្ លឃញី ដូចជារូបភារ និងរូបថ្ត រមួ្ចំដណកដ ់
ការនិទានលរឿង និងការទំនាក់ទំនងននការរចនាស្កាហវកិោ៉ា ងដូចលម្តច? 

4- លតីការរិចារណាស្បកបលដ្ឋយស្កម្រី ធ្ម្៌ា វីខ្លះ ដដ  នករចនាស្កាហវកិគួរចងចាលំៅលរ 
បលងកីតខ្លឹម្សារដដ លមី្ លឃញី ដូចជាការធានាភារស្តឹម្ស្តូវ លជៀរវាងការតំណាងឱ្យការ
យ ់ស្ច  ំនិងការលោររនូវអរម្មណ៍ននវបបធ្ម្៌ា? 

5- លតី កខណៈរិលររ និងរម្តេភាររំខាន់ៗរបរ់ GIMP (GNU Image Manipulation 
Program) មន វីខ្លះ លហយីលតីវាលស្បៀបលធ្ៀបលៅនឹងកម្មវធីិ្ដករូបភារដ៏លរញនិយម្លផសង
លទៀតទាក់ទងនឹងម្៊ុខ្ររ និង ទធភារលស្បីស្បារ់ោ៉ា ងដូចលម្តច? 

6- លតី វីជាលោ គំនិត និងលោ ការណ៍ជាមូ្ ដ្ឋា នដដ មនមូ្ ដ្ឋា នល ី GIMP (GNU 
Image Manipulation Program) លហយីលតីរួកលគចូ រមួ្ចំដណកកន៊ុងការយ ់ដឹង និង
ស្បរិទធភារកន៊ុងការលស្បីស្បារ់កម្មវធីិ្រស្មប់ដករស្មួ្  និងលរៀបចំរូបភារលដ្ឋយរលបៀបណា? 

7- ចូរលស្បៀបលធ្ៀប GIMP ជាមួ្យកម្មវធីិ្ដករស្មួ្ រូបភារដដ ស្តូវទិញកម្មរិទធិបញ្ញ ទាក់ទង
នឹងម្៊ុខ្ររ និងភាររយស្រួ ? 

8- លតីការរចនាស្កាហវកិរមួ្ចំដណកចំល ះរមា រៈ ប់រសំ្បកបលដ្ឋយស្បរិទធភារ ដូចជាលរៀវលៅ
រិកា បទបរហ ញ និងរ័ត៌ាមនស្កាហវកិ តាម្រយៈការបលងកីនភារចារ់ោរ់ដដ លមី្ 
លឃញី ការលរៀបចំ និងការចូ រមួ្រស្មប់រិរសោ៉ា ងដូចលម្តច? 

9- ចូររិភាកា ំរី តេស្បលោជន៍ននការលស្បីស្បារ់ GIMP កន៊ុងបរោិការ ប់រ ំ ជារិលររ
ទាក់ទងនឹងការល ីកកម្ពរ់ កខរកម្មឌី្ជីថ្  ការផត ់បទរិលសាធ្ន៍ជាក់ដរតងជាមួ្យកម្មវធីិ្
ដករូបភារ និងផត ់ជូនរិរសនូវជលស្មី្រជលស្មី្រកម្មវធីិ្ ណិជាកម្មដដ មនតនម្លនថ្ល? 

10- ចូរដណនាធំ្នធាន ឬឯកសារលោងបដនេម្រស្មប់រិរស លដីម្បបីលងកីនចំលណះដឹង និងជំនាញ
របរ់រួកលគកន៊ុងការលស្បីស្បារ់ GIMP និងការបលងកីតរូបភារឌី្ជីថ្ ? 

 
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សមសរៀនទី២៖ ការែសំ ើង នងិការកណំត់ GIMP សស្រកាយសពលែំស ើង 

២.១. ការែំស ើងកមមវិធី GIMP 

 លដីម្បដំីល ងី GIMP  នកអច ន៊ុវតតតាម្ជំហានទូលៅទាងំលនះ៖ 

1. ចូ លៅកាន់លគហទំរ័រ GIMP លៅ https://www.gimp.org/downloads/  
2. លស្ជីរលររីកំដណ GIMP ដដ ស្តូវោន
ជាមួ្យស្បរ័នធស្បតិបតតិការរបរ់ នក 
(Windows, macOS និង Linux) 

3. ច៊ុចល ីតំណទាញយកលដីម្បទីាញ
យក file ដំល ងី 

4. លៅលរ ការទាញយកបានបញ្ច ប់ 
រូម្ដំលណីរការ file ដំល ងី។ 

5.  ន៊ុវតតតាម្ការដណនាលំៅល ីល ស្កង់ 
លដីម្បបីញ្ច ប់ដំលណីរការដំល ងី។ 

 ខាងលស្កាម្លនះ គឺជាការដណនា ំម្អិត
បដនេម្លទៀតរស្មប់ការដំល ងី GIMP លៅល ីស្បរ័នធស្បតិបតតិការនីមួ្យៗ៖ 

ក. Windows 

1. ចូ លៅកាន់លគហទំរ័រ GIMP  https://www.gimp.org/downloads/ លៅកន៊ុងកម្មវធីិ្រ៊ុករ
កតាម្ ៊ុីនធឺ្ណិត។  នកអចលស្បីកម្មវធីិ្រ៊ុករ
កតាម្ ៊ុីនធឺ្ណិតណាមួ្យ លៅល ីក៊ុំរយូទ័រ 
Windows របរ់ នក។ 

2. ច៊ុចល ីប ូត៊ុង Download GIMP [version 

number] directly វាជាប ូត៊ុងរណ៌ា ទឹក
ស្កូចលៅខាងលស្កាម្បឋម្កថ្ន "GIMP for 
Windows" ដដ ច៊ុចវាលដីម្បទីាញយកឯក
សារដំល ងី GIMP ។ 

រូបភារទី១.៧ លគហទំរ័រលដីម្បទីាញយកកម្មវធីិ្ GIMP 

រូបភារទី១.៨ ទាញយកកម្មវធីិ្ GIMP រស្មប ់Windows 
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3. លបីកឯកសារដំល ងី GIMP លដ្ឋយច៊ុចរីរដងល ី
ឯកសារដំល ងី GIMP រីកន៊ុងកម្មវធីិ្រ៊ុករកតាម្ ៊ុីន
ធឺ្ណិតរបរ់ នក ឬកន៊ុងថ្តឯកសារទាញយករបរ់
 នក។ វាជាឯកសារដដ លៅថ្ន "gimp-[ល ខ្
កំដណ]-setup.exe"។ 

 

4. រូម្ច៊ុច  Yes  លៅលរ ស្តូវបានរួរ។ ស្តង់ចំណ៊ុ ច
លនះស្តូវបានទាម្ទារ លដីម្បដំីល ងីកម្មវធីិ្ថ្មី លដ្ឋយ
បរហ ញថ្ន នក ន៊ុញ្ញ តឱ្យកម្មវធីិ្ដំល ងី GIMP 
ដដ លធ្វីឱ្យមនការផ្លល រ់បតូរ ស្បរ័នធ Windows  
របរ់ នក។ 

5. រូម្លស្ជីរលររីភាសាដដ  នកចង់បាន លហយីច៊ុច
 Ok ។ លស្បីម្៊ុឺន៊ុយទមល ក់ច៊ុះលដីម្បលីស្ជីរលររីភាសា
ណាមួ្យដដ  នកចង់លស្បី លហយីបនាទ ប់ម្កច៊ុច
Ok  លៅខាងលស្កាម្ននផ្លទ ងំល ចល ងី។ 

 

6. ច៊ុច  Install ដដ  ន៊ុវតតការដំល ងីរតង់ដ្ឋរនន GIMP ជាមួ្យនឹងរមរធាត៊ុទាងំ         
 រ់។ ម្៉ាាងលទៀត  នកអចលស្បីជំហានខាងលស្កាម្លដីម្បលីធ្វីការដំល ងីផ្លទ  ់ខ្លួន៖ 
• ច៊ុច Customize លៅស្ជុងខាងលស្កាម្ល វ្ង 
• អនអជ្ាប័ណណ GNU លហយីច៊ុច Next 
• លដ្ឋះធី្ករមរធាត៊ុណាមួ្យដដ  នកមិ្ន
ចង់ដំល ងី លហយីច៊ុច Next 

• ច៊ុចស្ប ប់ធី្ក ស្បរិនលបី នកចង់បលងកីតផលូវកាត់
លៅល ីក៊ុំរយូទ័ររបរ់ នក លហយីច៊ុច Next 

• ច៊ុច Install លដីម្បបីញ្ច ប់ការដំល ងីផ្លទ  ់ខ្លួន
របរ់ នក។ 
 

រូបភារទី១.៩ Fileដំល ងីកម្មវធីិ្ដដ បានទាញ
យក 

រូបភារទី១.១០ ច៊ុច Yes លដីម្បដំីល ងី GIMP 

រូបភារទី១.១១ ច៊ុចលដីម្បលីស្ជីរលររីភាសា 

រូបភារទី១.១២ ច៊ុច Install លដីម្បដំីល ងី GIMP 
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7. ការចាប់លផតីម្លស្បីស្បារ់ GIMP ។ GIMP មនរូបតំណាងដដ ស្រលដៀងនឹងរតវដ ក្ ដដ 
មនជក់ោបកន៊ុងមត់របរ់វា។ ច៊ុចរូបតំណាង GIMP លៅល ី Desktop ឬ Windows 
Start menu លដីម្បលីបីក GIMP។  

ខ. macOS 

1. ចូ លៅកាន់លគហទំរ័រ GIMP 
https://www.gimp.org/downloads/ លៅ
កន៊ុងកម្មវធីិ្រ៊ុករកតាម្ ៊ុីនធឺ្ណិត។  នកអច
លស្បីកម្មវធីិ្រ៊ុករកតាម្ ៊ុីនធឺ្ណិតណាមួ្យលៅ
ល ី Mac របរ់ នក។ 

 
 

2. ច៊ុច ប ូត៊ុង  Download GIMP [version 

number] directly ដដ ជាប ូត៊ុងរណ៌ា ទឹក
ស្កូចលៅខាងលស្កាម្បឋម្កថ្ន "GIMP for 
macOS" ។ ច៊ុចប ូត៊ុងលនះលដីម្បទីាញយក
ឯកសារដំល ងី GIMP ។ 

 

3. លបីកកម្មវធីិ្ដំល ងី GIMP លដ្ឋយច៊ុចរីរដង
ល ីឯកសារដំល ងី GIMP រីកន៊ុងកម្មវធីិ្រ៊ុករក
តាម្ ៊ុីនធឺ្ណិតរបរ់ នក ឬកន៊ុងថ្តឯកសារ
ទាញយករបរ់ នក។ វាជាឯកសារដដ មន
លឈាម ះថ្ន "gimp-[ល ខ្កំដណ]-
x86_64.dmg ។" 

 

 

រូបភារទី ១.១៣ តំណរស្មប់ទាញយកកម្មវធីិ្ GIMP 

រូបភារទី ១.១៤ ការទាញយកកម្មវធីិ្ GIMP 

រូបភារទី ១.១៥ កម្មវធីិ្ GIMP ស្តូវបានទាញយក 

https://www.gimp.org/downloads/
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4.  ូររូបតំណាង GIMP លៅកន៊ុងថ្តកម្មវធីិ្
របរ់ នក។ ស្តង់ចំណ៊ុ ចលនះមនរូបតំណាង
មួ្យ ដដ ស្រលដៀងលៅនឹងរតវដ ក្ដដ មន
ជក់ោបកន៊ុងមត់របរ់វា។  ូររូបតំណាង 
GIMP លៅកន៊ុងថ្តកម្មវធីិ្កន៊ុងស្ប ប់ល ច     
ល ងី។ វានឹងចម្លង GIMP លៅកន៊ុងថ្តកម្មវធីិ្
របរ់ នក។ 

5. លបីក GIMP ។ លស្បី Finder លដីម្បរី៊ុករកលៅថ្ត
កម្មវធីិ្។ ច៊ុចរូបតំណាង GIMP លដីម្បលីបីក 
GIMP។  នករចួរ ់លហយី ចាប់លផតីម្លស្បី 
GIMP ។ 

• ជាដំបូងដដ  នកលបីក GIMP ដដ កម្ម
វធីិ្នឹងស្តូវលផទៀងផ្លទ ត់។ ស្បរិនលបី នក
ទទួ បានសារ ដដ និោយថ្នលនះជា
កម្មវធីិ្រី ៊ុីនធឺ្ណិត រូម្ច៊ុច Open លដីម្បលីផទៀងផ្លទ ត់ថ្ន នកចង់លបីក GIMP ។ 

6.  ន៊ុញ្ញ តឱ្យ GIMP លបីកដំលណីរការរី ៊ុីនធឺ្ណិតស្បរិនលបីចាបំាច់។ តាម្ ំនាលំដីម្ 
macOS  ន៊ុញ្ញ តឱ្យ នកលបីកកម្មវធីិ្ដដ បានទាញយករី App Store ប៉ា៊ុលណាណ ះ។ 
ស្បរិនលបី នកទទួ បានសារស្បាប់ នកថ្ន នកមិ្នអចលបីក GIMP បានលទ លស្ ះវាជាកម្ម
វធីិ្ដដ បានទាញយករី ៊ុីនធឺ្ណិត រូម្លស្បីជំហានខាងលស្កាម្លដីម្បផី្លល រ់បតូរការកំណត់
រ៊ុវតេិភាររបរ់ នក៖  

• ច៊ុចរូបតំណាង Apple លៅកន៊ុងរបារម្៊ុឺន៊ុយ
លៅស្ជុងខាងល ីល វ្ង 

• ច៊ុច System Preferences... 
• ច៊ុច រ៊ុវតេិភារ & ឯកជនភារ  
• ច៊ុចល ី ផ្លទ ងំទូលៅ  
• ច៊ុចរូបតំណាងចាក់លសាលៅខាងលស្កាម្   
ល ស្កង់ 

• បញ្ចូ   កយរមា ត់ នកលស្បីស្បារ់របរ់ នក 
• ច៊ុចល ីជលស្មី្រវទិយ៊ុលៅជាប់ "App Store និង នក ភិវឌ្ឍន៍ដដ បានកំណត់ តត
រញ្ញ ណ"។ 

រូបភារទី ១.១៦ ការ ូររូបតំណាង GIMP  

រូបភារទី ១.១៧ កម្មវធីិ្ GIMP ស្តូវបានដំល ងី 

រូបភារទី ១.១៨ ផ្លល រ់បតូរការកំណត់រ៊ុវតេិភា 

https://www.wikihow.com/Use-GIMP
https://www.wikihow.com/Use-GIMP
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គ. Chromebook និង Linux 

1. លបីកដំលណីរការ Linux (រស្មប់ដត Chromebook ប៉ា៊ុលណាណ ះ)។ Chromebooks ជំនាន់
ថ្មីបំផ៊ុតភាគលស្ចីន ន៊ុញ្ញ តឱ្យ នកលបីក Linux។ ស្តង់ចំណ៊ុ ចលនះ  ន៊ុញ្ញ តឱ្យ នកដំល ងី
កម្មវធីិ្ Linux ដូចជា GIMP ជាលដីម្។ ស្បរិនលបី នកមនម្៉ាូដដ  Chromebook ចារ់ 
 នកអច ដំល ងី Linux។ លស្បីជំហានខាងលស្កាម្លដីម្បលីបីកដំលណីរការ Linux លៅល  ី
Chromebook របរ់ នក៖  
• ច៊ុចល ី time លៅស្ជុងខាងសាត លំស្កាម្ 
• ច៊ុចល ី gear icon លដីម្បលីបីក Settings menu 
• ច៊ុច Advanced លៅដផនកខាងលស្កាម្នន 

Settings menu  
• ច៊ុច Developers  
• ច៊ុច Turn on លៅជាប់នឹង "Linux 

Development Environment" 
• ច៊ុច Next 
• បញ្ចូ   Linux username 
• លស្ជីរលររីទំហដំដ  នកចង់ដបងដចក
រស្មប់ Linux (ឬស្ោន់ដតលៅជាមួ្យ 10 GB ដដ បានដណនា)ំ 

• ច៊ុច Install 
2. រាោម្ទាញយក GIMP រី software manager app។ Linux distributions ភាគ
លស្ចីនមនកម្មវធីិ្ស្គប់ស្គងកម្មវធីិ្ដដ  ន៊ុញ្ញ តឱ្យ នករ៊ុករក ទាញយក និងដំល ងីកម្ម       
វធីិ្។ លៅល ី Ubuntu វាស្តូវបានលគលៅថ្នជា " Software Center" ។ លៅល ី Fedora 
វាស្តូវបានលគលៅថ្ន "Software" ។ ស្បរិនលបី នកមិ្នអចរកលឃញី GIMP លៅកន៊ុងកម្មវធីិ្
ស្គប់ស្គងកម្មវធីិ្  នកអចដំល ងីវាលដ្ឋយលស្បី Terminal។ លស្បីជំហានខាងលស្កាម្លដីម្បី
លមី្ ថ្នលតី នកអចទាញយកវា រីកម្មវធីិ្ស្គប់ស្គងកម្មវធីិ្ឬ ត់។  
• លបីក software manager app 
• វាយបញ្ចូ   កយ GIMP កន៊ុងរបារដរវងរក 
• ច៊ុចល ី GIMP ស្បរិនលបីវាមនលៅកន៊ុង
 ទធផ ដរវងរក 

• ច៊ុច Install។ 
3. ច៊ុច Ctrl + Alt + T   លដីម្បលីបីក Terminal   

 

រូបភារទី ១.១៩ ការលបីកដំលណីរការ Linux 

រូបភារទី ១.២០ ការទាញយក GIMP 

https://www.wikihow.com/Install-Linux-on-a-Chromebook
https://www.wikihow.com/Install-GIMP#/Image:Macterminal.png


18 

ស្បរិនលបី នកមិ្នអចទាញយក GIMP រីកម្មវធីិ្
ស្គប់ស្គងកម្មវធីិ្បានលទ  នកអចទាញយកវាលដ្ឋយ
លស្បី Terminal។ Terminal ជាធ្ម្មតាមនរូប
តំណាង ដដ ស្រលដៀងនឹងល ស្កង់លមម ដដ មន    
ទរសន៍ស្ទនិចរណ៌ា រ។  ជាធ្ម្មតា នកអចដរវងរក
វាលៅកន៊ុងម្៊ុឺន៊ុយកម្មវធីិ្របរ់ នក ឬលដ្ឋយច៊ុច "Ctrl 
+ Alt + T" លៅល ីកាត រច៊ុចរបរ់ នក។ 

4. បញ្ចូ   កយបញ្ា មួ្យ កន៊ុងចំលណាម្ កយបញ្ា ខាងលស្កាម្ លដីម្បលីធ្វីបចច៊ុបបននភារឃ្ល ងំ
កម្មវធីិ្របរ់ នក។ ម្៊ុនលរ  នកទាញយក GIMP រូម្ស្បាកដថ្នឃ្ល ងំកម្មវធីិ្របរ់ នក
ទាន់រម្័យ។  បញ្ចូ   កយបញ្ា មួ្យកន៊ុងចំលនាម្
 កយបញ្ា ខាងលស្កាម្លៅកន៊ុង Terminal លហយី
ច៊ុច Enter លដីម្បលីធ្វីបចច៊ុបបននភារឃ្ល ងំកម្មវធីិ្របរ់
 នក៖  
• Chromebook/ubuntu/Debian: sudo apt 

update 
• Fedora: sudo yum update 
• CentOS/RedHat: sudo dnf update 
• Arch: sudo pacman -Syu 

5. បញ្ចូ   កយរមា ត់របរ់ នក ស្បរិនលបីស្តវូបាន
រួរ។  នកនឹងស្តូវបានរួរឱ្យបញ្ចូ   កយរមា ត់
របរ់ នកលស្បីលៅលរ ណា ដដ  នកលធ្វីបចច៊ុបបនន
ភារឃ្ល ងំកញ្ច ប់របរ់ នក ឬដំល ងីកម្មវធីិ្ថ្មី។ 
ស្បរិនលបីស្តូវបានរួរ រូម្បញ្ចូ   កយរមា ត់
ដដ  នកលស្បីលដីម្បចូី កន៊ុងក៊ុំរយូទ័រ Linux របរ់
 នក លហយីច៊ុច Enter ។ 

6. ដំល ងី GIMP។ លៅលរ ដដ ឃ្ល ងំកម្មវធីិ្របរ់
 នកមនភារទាន់រម័្យ  នកអចលស្បីជំហានមួ្យ
កន៊ុងចំលណាម្ជំហានខាងលស្កាម្ លដីម្បទីាញយក 
និងដំល ងី GIMP រីសាេ នីយ៖  
• Chromebook/ubuntu/Debian: sudo apt 

install gimp 

រូបភារទី ១.២១ ការច៊ុចផលូវការល ីកាត រច៊ុច 

រូបភារទី ១.២២ ការវាយ កយបញ្ា  

រូបភារទី ១.២៣ ការបញ្ចូ   កយរំរត់ 

រូបភារទី ១.២៤ ការចាប់លផដីម្ដំល ងី GIMP 
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• Fedora: sudo yum install gimp 
• CentOS/RedHat: sudo dnf install gimp 
• Arch: sudo pacman -S gimp[7] 

7. បញ្ចូ   កយរមា ត់របរ់ នក ស្បរិនលបីស្តវូបាន
រួរ។ លៅលរ ស្តូវបានរួរ រូម្បញ្ចូ   កយ
រមា ត់ ដដ  នកលស្បីលដីម្បចូី លៅកាន់ក៊ុំរយូទ័រ 
Linux របរ់ នក លហយីច៊ុច Enter ។ GIMP នឹង
ចាប់លផតីម្ដំល ងីលៅល ីក៊ុំរយូទ័រ ីន៊ុចរបរ់ នក។ 
• ស្បរិនលបី នកស្តូវបានរួរថ្ន លតី នកចង់បនត 
រូម្ច៊ុច "Y" លៅល ីកាត រច៊ុចលហយីបនាទ ប់ម្ក
ច៊ុច Enter លដីម្បបីនត។ 

8. លបីក GIMP ។ GIMP មនរូបតំណាងដដ ស្រលដៀងនឹងរតវដ ក្ ដដ មនជក់ោបកន៊ុង
មត់របរ់ោត់។ ច៊ុចរូបតំណាងGIMP លៅកន៊ុងម្៊ុឺន៊ុយកម្មវធីិ្របរ់ នក លដីម្បលីបីកGIMP។ 
ជាជលស្មី្រ  នកអចវាយ "gimp" លៅកន៊ុង Terminal លហយីច៊ុច Enter លដីម្បលីបីក 
GIMP  បនាទ ប់ម្ក នកអចចាប់លផតីម្លស្បី GIMP បាន។ 

២.២. ការកំណតស់ផ្េងៗសលើកមមវិធី GIMP សស្រកាយសពលែំស ើង 

 ការកំណត់លផសងៗល ីកម្មវធីិ្ GIMP  ក់រ័នធនឹងការ
បដូរកម្មវធីិ្តាម្បំណងឱ្យរម្នឹង ំហូរការររ និងចំណូ ចិតត
របរ់ នក។ ខាងលស្កាម្លនះ គឺជាជំហានទូលៅមួ្យចំនួនដដ  នក
អច ន៊ុវតតតាម្លដីម្បកំីណត់រចនារម្ព័នធ GIMP៖ 

• បដូរចំណ៊ុ ចស្បទាក់ នកលស្បីតាម្បំណង៖ GIMP  ន៊ុញ្ញ ត
ឱ្យ នកបដូរចំណ៊ុ ចស្បទាក់ នកលស្បី តាម្បំណងលដ្ឋយការ
លរៀបចំល ងីវញិ និងបដូរទំហឧំបករណ៍ និងបនទះលផសងៗ។ 
 នកអច ូរឧបករណ៍លៅទីតាងំលផសងៗោន  ផ្លល រ់បតូរទំហបំនទះ និងោក់ ឬបរហ ញធាត៊ុលផសងៗ
លដីម្បបីលងកីតបលង់ដដ ដំលណីរការ អបំផ៊ុតរស្មប់ នក។  

• ដំល ងីផលូវកាត់កាត រច៊ុច៖ GIMP  ន៊ុញ្ញ តឱ្យ នកលរៀបចំផលូវកាត់កាត រច៊ុចរស្មប់ម្៊ុខ្ររលផសងៗ 
ដដ អចបលងកីនល បឿនការរររបរ់ នក និងលធ្វីឱ្យវាកាន់ដតរយស្រួ កន៊ុងការចូ លស្បី
ឧបករណ៍ដដ លស្បីញឹកញាប់។ លដីម្បដំីល ងីផលូវកាត់កាត រច៊ុច រូម្ចូ លៅកាន់ Edit > 

Keyboard Shortcuts លហយីលស្ជីរលររីម្៊ុខ្ររដដ  នកចង់កំណត់ផលូវកាត់ឱ្យ។ 

រូបភារទី ១.២៥ ការតស្មូ្វ កយរំរត់ 

រូបភារទី ១.២៦ កម្មវធីិ្ GIMP ស្តូវបានដំល ងី 

https://www.wikihow.com/Install-GIMP#_note-7
https://www.wikihow.com/Use-GIMP
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• ដំល ងីកម្មវធីិ្ជំនយួ និងង្គ្រាីប៖ GIMP ោសំ្ទកម្មវធីិ្ជំនួយ និងង្គ្រាីបដដ អចរស្ងីកម្៊ុខ្ររ
របរ់វា និងលធ្វីកិចចការមួ្យចំនួនលដ្ឋយរវ័យស្បវតតិ។  នកអចដំល ងីកម្មវធីិ្ជំនួយ និងង្គ្រាីប
លដ្ឋយចូ លៅកាន់ Filters > Plug-ins or Script-Fu លហយីលស្ជីរលររីជលស្មី្រលដីម្បី
ដំល ងីកម្មវធីិ្ជំនួយ ឬង្គ្រាីបថ្មី។ 

• កំណត់រចនារម្ព័នធឧបករណ៍បញ្ចូ  ៖ ស្បរិនលបី នកកំរ៊ុងលស្បីរ៊ុម្ាគំនូរ ឬឧបករណ៍បញ្ចូ  
លផសងលទៀត  នកស្បដហ ជាស្តូវកំណត់រចនារម្ព័នធវាលៅកន៊ុង GIMP លដីម្បធីានាថ្នវាដំលណីរការ
បានស្តឹម្ស្តូវ។ លដីម្បកំីណត់រចនារម្ព័នធឧបករណ៍បញ្ចូ   រូម្ចូ លៅកាន់ Edit > Input 

Devices ។ 

• បដូរជក់ និង ំនាតំាម្បំណង៖ GIMP ផត ់នូវជក់ និង ំនា ំំនាលំដីម្ជាលស្ចីនស្បលភទ ប៉ា៊ុដនត នកក៏
អចបលងកីតជក់ផ្លទ  ់ខ្លួនរបរ់ នក ឬទាញយកបដនេម្រី ៊ុីនធឺ្ណិតផងដដរ។ លដីម្បបីដូរជក់ និង
 ំនាតំាម្បំណង រូម្ចូ លៅកាន់ Edit > Preferences > Folders  លហយីលស្ជីរលររីថ្ត
ឯកសារដដ  នកចង់រកាទ៊ុកជក់ ឬ ំនាផំ្លទ  ់ខ្លួនរបរ់ នក។ 

• កំណត់រចនារម្ព័នធការស្គប់ស្គងរណ៌ា ៖ GIMP  ន៊ុញ្ញ តឱ្យ នកកំណត់រចនារម្ព័នធការកំណត់
ការស្គប់ស្គងរណ៌ា  លដីម្បធីានាថ្នរូបភាររបរ់ នកស្តូវបានបរហ ញ និងលបាះរ៊ុម្ពបានស្តឹម្ស្តូវ។ 
លដីម្បកំីណត់រចនារម្ព័នធការស្គប់ស្គងរណ៌ា  រូម្ចូ លៅកាន់ Edit > Preferences > 

Color Management ។ 

• ដំល ងីកម្មវធីិ្និរនធខាងលស្ៅ៖ GIMP  ន៊ុញ្ញ តឱ្យ នកលរៀបចំកម្មវធីិ្ដករស្មួ្ ខាងលស្ៅ ដដ 
អចមនស្បលោជន៍ស្បរិនលបី នកចង់លស្បីកម្មវធីិ្លផសងលទៀតជាមួ្យ GIMP។ ឧទាហរណ៍  នក
អចដំល ងីកម្មវធីិ្និរនធខាងលស្ៅលដីម្បលីបីកឯកសារ GIMP លៅកន៊ុង Adobe Photoshop។ 
លដីម្បដំីល ងីកម្មវធីិ្ដករស្មួ្ ខាងលស្ៅ រូម្ចូ លៅកាន់ Edit > Preferences > 

External Editors ។ 

• បដូរផលូវកាត់រស្មប់ឧបករណ៍ និងជក់តាម្បំណង៖ បដនេម្រីល ីការកំណត់ផលូវកាត់កាត រច៊ុច  នកក៏
អចបដូរផលូវកាត់តាម្បំណងរស្មប់ឧបករណ៍ និងជក់ជាក់ោក់លៅកន៊ុង GIMP ផងដដរ។ លដីម្បី
បដូរផលូវកាត់រស្មប់ឧបករណ៍ និងជក់តាម្បំណង រូម្ចូ លៅ Edit > Preferences > 

Interface។ 

• កំណត់រចនារម្ព័នធជលស្មី្រទស្ម្ង់ឯកសារ៖ GIMP  ន៊ុញ្ញ តឱ្យ នកកំណត់រចនារម្ព័នធជលស្មី្រ
លផសងៗរស្មប់ទស្ម្ង់ឯកសារលផសងៗោន  ដូចជាការបរហ ប់ JPEG និងភារថ្នល នន PNG ។ លដីម្បី
កំណត់រចនារម្ព័នធជលស្មី្រទស្ម្ង់ឯកសារ រូម្ចូ លៅកាន់ Edit > Preferences > 

Image Import & Export។ 
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• បដូរចំណូ ចិតតតាម្បំណង៖ GIMP  ន៊ុញ្ញ តឱ្យ នកបដូរចំណូ ចិតតលផសងៗតាម្បំណង ដូចជា
ទស្ម្ង់រណ៌ា  ំនាលំដីម្ ស្បវតតិមិ្នលធ្វីវញិ និងជលស្មី្រទស្ម្ង់ឯកសារ។ លដីម្បចូី លស្បីចំណូ ចិតត 
រូម្ចូ លៅកាន់ Edit > Preferences។ 

 ររ៊ុបម្ក GIMP ផត ់នូវជលស្មី្រជាលស្ចីនរស្មប់កំណត់រចនារម្ព័នធកម្មវធីិ្ឱ្យរម្នឹងតស្មូ្វ
ការ និងចំណូ ចិតតរបរ់ នក។ លដ្ឋយចំណាយលរ លដីម្បដីរវងយ ់រីជលស្មី្រ និងការកំណត់លផសងៗ 
 នកអចបលងកីត ំហូរការររតាម្តស្មូ្វការដដ មនស្បរិទធភារ និងស្បរិទធភាររស្មប់កិចចការដករូប
ភាររបរ់ នក។ 

២.៣. ភាា 

GIMP រកលឃញី និងលស្បីភាសាស្បរ័នធលដ្ឋយរវ័យស្បវតតិ។ កន៊ុងករណីដដ មិ្នទំនង ដដ ការរក
លឃញីភាសាបរជ័យ ឬស្បរិនលបី នកចង់លស្បីភាសាលផសង  នកអចផ្លល រ់បតូរភាសាដដ បានលស្បី
កន៊ុង Edit → Preferences បនាទ ប់ម្កចូ លៅកាន់ ដផនក Interface ។ ភាសា អចស្តូវបានកំណត់
លៅដផនកខាងល ី។ 

 នកក៏អចលស្បី៖ 

• ស្បរ័នធស្បតិបតដិការ ីន៊ុច៖ លៅកន៊ុងទស្ម្ង់ក៊ុងរូ  (console mode) វាយ 
LANGUAGE=en gimpឬ LANG=en gimp ជំនួរ en ជាមួ្យ fr, de, ... តាម្ភាសាដដ 
 នកចង់បាន។ នផទខាងលស្កាយ៖ ការលស្បីស្បារ់ LANGUAGE=en កំណត់ លថ្រទូលៅមួ្យ
រស្មប់កម្មវធីិ្ដដ បានស្បតិបតតិ gimp។ 

• ស្បរ័នធស្បតិបតដិការ Windows៖ Control Panel → System → Advanced → ច៊ុច
ប ូត៊ុង Environment លៅកន៊ុងតំបន់ “ System Variables ” លដ្ឋយច៊ុចប ូត៊ុង Add និង 
Enter LANG for Name and fr or de... រស្មប់តនម្ល។ ស្បយត័ន!  នកស្តូវច៊ុច OK បីដង
ជាប់ៗោន លដីម្បបីញ្ា ក់ជលស្មី្ររបរ់ នក។ ស្បរិនលបី នកផ្លល រ់បតូរភាសាញឹកញាប់  នកអច
បលងកីតឯកសារបាច់លដីម្បផី្លល រ់បតូរភាសា។ លបីក NotePad រចួវាយ កយបញ្ា ខាងលស្កាម្ 
(ឧទាហរណ៍ជាភាសាបារងំ)៖ 

set lang=fr 
 start gimp-2.10.exe 

រកាទ៊ុកឯកសារលនះជា GIMP-FR.BAT(ឬលឈាម ះលផសងលទៀត ប៉ា៊ុដនតដតងដតមន .BAT
ដផនកបដនេម្)។ បលងកីតផលូវកាត់ លហយី ូរវាលៅក៊ុំរយូទ័ររបរ់ នក។ 

 ទធភារម្យួលទៀត៖ Start → Programs → GTK Runtime Environment បនាទ ប់
ម្ក លស្ជីរលររីភាសា លហយីលស្ជីរលររីភាសាដដ  នកចង់បានកន៊ុងបញ្ា ីទមល ក់ច៊ុះ។ 
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• ស្បរ័នធស្បតិបតដិការ Apple macOS 

ចាប់លផដីម្រី System Settings រូម្ច៊ុច General លៅកន៊ុងរបារចំលហៀង។បនាទ ប់ម្កលស្ជីរ
លររី ភាសា និងតំបន់ ។ ភាសា ដដ ចង់បានគួរដតជាភាសាទីមួ្យកន៊ុងបញ្ា ី។ 

ឧទាហរណ៍ GIMP លផសងលទៀត 

លស្បី -n លដីម្បដំីលណីរការឧទាហរណ៍ជាលស្ចីននន GIMP។ ឧទាហរណ៍ លស្បី gimp-2.10 លដីម្បី
ចាប់លផតីម្ GIMP ជាភាសាស្បរ័នធ ំនាលំដីម្ និង LANGUAGE=en gimp-2.10 -n លដីម្បចីាប់លផតីម្
ឧទាហរណ៍លផសងលទៀតនន GIMP ជាភាសា ង់លគលរ។ វាមនស្បលោជន៍ណារ់រស្មប់ នកបកដស្ប។ 

២.៤.  រងអូនសម (Main Windows) 

ចំណ៊ុ ចស្បទាក់ នកលស្បី GIMP ឥ ូវលនះមនលៅកន៊ុងទស្ម្ង់ចំនួនរីរ៖ 

• ទស្ម្ង់រហ៊ុបងអួច 
• ទស្ម្ង់បងអួចដតមួ្យ 

លៅលរ  នកលបីក GIMP ជាល ីកដំបូង វាលបីកកន៊ុងទស្ម្ង់បងអួចដតមួ្យតាម្ ំនាលំដីម្។  នកអច
លបីកម្៊ុខ្រររហ៊ុបងអួចលដ្ឋយលដ្ឋះធី្ក ជលស្មី្រ Windows → Single-Window Mode លៅកន៊ុង
របារម្៊ុឺន៊ុយរូបភារ។ បនាទ ប់រីចាកលចញរី GIMP វានឹងចាប់លផតីម្លៅកន៊ុងរលបៀបដដ  នកបានលស្ជីរលររី
លៅលរ លស្កាយ។ 

ក.ទស្រមង់ពហុរងអួន 

រូបថ្តល ស្កង់ខាងលស្កាម្ បរហ ញរី
ការលរៀបចំរហ៊ុបងអួច ជាមូ្ ដ្ឋា នបំផ៊ុត
រស្មប់GIMP ដដ អចលស្បីបានោ៉ា ងមន
ស្បរិទធភារ។  នកនឹងលឃញីផ្លទ ងំរីរ ល វ្ង 
និងសាត  ំ និងបងអួចរូបភារលៅកណាត  ។ រូប
ភារទីរីរស្តូវបានបិទបាងំលដ្ឋយដផនក។  

ផ្លទ ងំខាងល វ្ងមនស្ប ប់ឧបករណ៍ 
ក៏ដូចជាជលស្មី្រឧបករណ៍ សាេ នភារ
ឧបករណ៍ ស្បវតតិមិ្នលធ្វីវញិ និងស្ប ប់រូបភាររមួ្ោន ។ ផ្លទ ងំខាងសាត មំនស្ប ប់ Brushes, Patterns, 
Fonts និង Document History ជាមួ្យោន លៅកន៊ុង Multi-tab Dock លហយី Layers, Channels and 
Paths dialogs ជាមួ្យោន លៅកន៊ុង Multi-tab dock លផសងលទៀត។ 

រូបភារទី ១.២៧ ទស្ម្ង់រហ៊ុបងអួចរបរ់ GIMP 
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1. ស្ប ប់ឧបករណ៍ចម្បង (Main Toolbox)៖ មនរំណ៊ុំ ននប ូត៊ុងរូបតំណាង ដដ លស្បីលដីម្បី
លស្ជីរលររីឧបករណ៍។ តាម្ ំនាលំដីម្ វាក៏មនរណ៌ា នផទខាងម្៊ុខ្ និងនផទខាងលស្កាយផងដដរ។ 
 នកអចបដនេម្រូបតំណាង ជក់  ំនា ំ ជស្ម  និងរូបភាររកម្ម។  នកអច
លស្បី  Edit → Preferences → Toolbox លដីម្បលីបីក ឬបិទធាត៊ុបដនេម្។ 

2. ជលស្មី្រឧបករណ៍ (Tool options)៖ ឧបករណ៍លៅខាងលស្កាម្ស្ប ប់ឧបករណ៍ចម្បងគឺជា
ស្ប ប់ជលស្មី្រឧបករណ៍ ដដ បរហ ញជលស្មី្ររស្មប់ឧបករណ៍ដដ បានលស្ជីរលររី
បចច៊ុបបនន (កន៊ុងករណីលនះ Move tool) ។ 

3. បងអួចរូបភារ (Image windows)៖ រូបភារនីមួ្យៗដដ លបីកលៅកន៊ុង GIMP ស្តូវបាន
បរហ ញលៅកន៊ុងបងអួចដ្ឋច់លដ្ឋយដ កមួ្យ។ រូបភារជាលស្ចីនអចលបីកបានកន៊ុងលរ ដតមួ្យ 
លដ្ឋយកំណត់លដ្ឋយធ្នធានស្បរ័នធប៉ា៊ុលណាណ ះ។ ម្៊ុនលរ  នកអចលធ្វី វីដដ មនស្បលោជន៍
លៅកន៊ុង GIMP  នកស្តូវលបីកបងអួចរូបភារោ៉ា ងលហាចណារ់មួ្យ។ បងអួចរូបភារមនម្៊ុឺន៊ុយ
នន កយបញ្ា រំខាន់របរ់ GIMP (ឯកសារ, ដករស្មួ្ , លស្ជីរលររី ... ) ដដ  នកក៏អច
ទទួ បានលដ្ឋយច៊ុចខាងសាត លំ ីបងអួច។ រូបភារអចធំ្ជាងបងអួចរូបភារ។ កន៊ុងករណីលនាះ 
GIMP បរហ ញរូបភារកន៊ុងកស្មិ្តបស្ងួម្បស្ងួម្ ដដ  ន៊ុញ្ញ តឱ្យលឃញីរូបភារលរញកន៊ុងបងអួច
រូបភារ។ ស្បរិនលបី នកបដងវរលៅកស្មិ្តរស្ងីក 100% របាររមូ្រនឹងបរហ ញល ងី ដដ 
 ន៊ុញ្ញ តឱ្យ នកផ្លល រ់ទីល ីរូបភារ។ 

4. The Brushes, Patterns, Fonts, Document History Dock — ចំណាថំ្នស្ប ប់លៅកន៊ុង
ឧបករណ៍គឺជាផ្លទ ងំ។ ផ្លទ ងំ Brushes លបីក៖ វាបរហ ញស្បលភទជក់ដដ លស្បីលដ្ឋយឧបករណ៍
ោប។ 

5. Layers, Channels, Paths៖ ស្ប ប់ដដ រេិតលៅខាងលស្កាម្ស្ប ប់ជក់ បរហ ញស្ប ប់ 
(ផ្លទ ងំ) រស្មប់ស្គប់ស្គងស្រទាប់ ឆ្ដន  និងផលូវ។ ផ្លទ ងំស្រទាប់ស្តូវបានលបីក៖ វាបរហ ញ
រចនារម្ព័នធស្រទាប់ននរូបភារដដ រកម្មបចច៊ុបបនន លហយី ន៊ុញ្ញ តឱ្យវាស្តូវបានលរៀបចំតាម្
វធីិ្លផសងៗោន ។ វាអចលៅរចួកន៊ុងការលធ្វីលរឿងជាមូ្ ដ្ឋា នមួ្យចំនួនលដ្ឋយមិ្នលស្បីស្ប ប់ 
Layers ប៉ា៊ុដនតរូម្បដីត  នកលស្បីស្បារ់ GIMP ដដ មនភាររម៊ុស្គសាម ញកស្មិ្តម្ធ្យម្ ក៏បាន
រកលឃញីថ្នវាមិ្នអចខ្វះបានកន៊ុងការមនស្ប ប់ Layers ស្គប់លរ លវោ។ 

ខ. ទស្រមង់រងអួនថ្តមយួ 

 នករកលឃញីធាត៊ុដូចោន  ជាមួ្យនឹងភារខ្៊ុរោន លៅកន៊ុងការស្គប់ស្គងរបរ់រួកលគ៖ 

• បនទះខាងល វ្ងនិងខាងសាត សំ្តូវបានជួរជ៊ុ  ដដ  នកមិ្នអចផ្លល រ់ទីរួកវាបានលទ។ ប៉ា៊ុដនត នក
អចបនេយ ឬបលងកីនទទឹងរបរ់វាលដ្ឋយ ូរស្ទនិចរកិំ ដដ ល ចល ងីលៅលរ ដដ ស្ទនិច
កណដ៊ុ រហួរស្រំដដនខាងសាត នំនសាល បស្រិ ខាងល វ្ង។ ស្បរិនលបី នកចង់រកាបនទះខាងល វ្ងឱ្យ
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តូចចលងអៀត រូម្លស្បីរបាររមូ្រលៅដផនកខាងលស្កាម្
ននជលស្មី្រឧបករណ៍ លដីម្បដី្ឋក់លៅទូទាងំការ
បរហ ញជលស្មី្រ។ ស្បរិនលបី នកកាត់បនេយ
ទទឹងរបរ់ multi-tab dock វាស្បដហ ជាមិ្ន
មនកដនលងស្គប់ស្ោន់រស្មប់ផ្លទ ងំទាងំ រ់លទ។ 
បនាទ ប់ម្ក កា ស្រួញល ចល ងី ដដ 
 ន៊ុញ្ញ តឱ្យ នករមូ្រតាម្ផ្លទ ងំ។ ដូចលៅកន៊ុងទស្ម្ង់រហ៊ុបងអួច  នកអចបិទបាងំបនទះទាងំលនះ
លដ្ឋយលស្បី ស្ោប់ច៊ុច Tab។ 

• បងអួចរូបភារស្គប់ស្គងចលនាល ះទាងំ រ់រវាងបនទះទាងំរីរ 

លៅលរ ដដ រូបភារជាលស្ចីនស្តូវបានលបីក របារថ្មីមួ្យនឹងល ចល ងីលៅខាងល ីបងអួច
រូបភារ លដ្ឋយមនផ្លទ ងំរស្មប់ស្គប់រូបភារ។  នកអចរ៊ុករករវាងរូបភារលដ្ឋយច៊ុចល ីផ្លទ ងំ ឬ
លដ្ឋយលស្បី Ctrl + Page Up ឬ Page Down ឬ Alt + Number ។ " ល ខ្ " គឺជាល ខ្
ផ្លទ ងំ;  នកស្តូវដតលស្បីស្ោប់ច៊ុចល ខ្ននបនាទ ត់ខាងល ីននកាត រច៊ុចរបរ់ នក មិ្នដម្នកាត រច៊ុច 
(Alt-shift ចាបំាច់រស្មប់កាត រច៊ុចជាតិមួ្យចំនួន)។ 

២.៥. រងអួនររូភាព 

ចំណ៊ុ ចស្បទាក់ នកលស្បី GIMP មនលៅកន៊ុងទស្ម្ង់រីរ៖ ទស្ម្ង់បងអួចដតមួ្យ ( ំនាលំដីម្) និង
ទស្ម្ង់រហ៊ុបងអួច ដដ  នកអចលដ្ឋះធី្កជលស្មី្រ Windows → Single-Window Mode ។ លៅ
លរ  នកចាប់លផតីម្ដំលណីរការ GIMP លដ្ឋយមិ្នចាបំាច់លបីករូបភារណាមួ្យ បងអួចរូបភារហាក់ ដូចជា
 វតតមនកន៊ុងទស្ម្ង់បងអួចដតមួ្យ ខ្ណៈលរ ដដ លៅកន៊ុងទស្ម្ង់រហ៊ុបងអួច បងអួចរូបភារមន លទាះបីជា
ោម នរូបភារលបីកក៏លដ្ឋយ។ លយងីនឹងចាប់លផតីម្ជាមួ្យនឹងការរិរណ៌ា នារលងខបននរមរភាគ ដដ 
មនវតតមនតាម្ ំនាលំដីម្ លៅកន៊ុងបងអួចរូបភារធ្ម្មតា។ រមរធាត៊ុមួ្យចំនួនអចស្តូវបានយកលចញ 
លដ្ឋយលស្បី កយបញ្ា លៅកន៊ុង ម្៊ុឺន៊ុយ View ។ 

រូបភារទី ១.២៨ កា ស្រួញបរហ ញផ្លទ ងំ 

https://docs.gimp.org/en/gimp-view-menu.html
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1. របារចំណងលជីង (Title Bar)៖ របារចំណងលជីងលៅកន៊ុងបងអួចរូបភារលដ្ឋយោម នរូបភារ
បរហ ញ "កម្មវធីិ្ស្គប់ស្គងរូបភារ GNU" ។ បងអួចរូបភារដដ មនរូបភារបរហ ញលឈាម ះរូប
ភារ និង កខណៈជាក់ោក់របរ់វា
កន៊ុងរបារចំណងលជីង លោងតាម្ការ
កំណត់ លៅកន៊ុងស្ប ប់ចំណូ ចិតត
(Preference  Dialog)។ របារ
ចំណងលជីង ស្តូវបានផត ់លដ្ឋយ
ស្បរ័នធស្បតិបតតិការ មិ្នដម្នលដ្ឋយ
GIMP លទ ដូលចនះរូបរងរបរ់វា
ទំនងជាដស្បស្បួ ជាមួ្យនឹងស្បរ័នធ
ស្បតិបតតិការ កម្មវធីិ្ស្គប់ស្គងបងអួច 
និង/ឬស្បធានបទ។ 

2. ម្៊ុឺន៊ុយរូបភារ (Image Menu)៖  លៅលស្កាម្របារចំណងលជីងមនរបារម្៊ុឺន៊ុយ (Menu  

bar)។ ម្៊ុឺន៊ុយរូបភារផត ់នូវការចូ លស្បីលរទីរដតស្គប់ស្បតិបតតិការ ដដ  នកអច ន៊ុវតតលៅ
ល ីរូបភារមួ្យ។  នកក៏អចច៊ុចកណដ៊ុ រសាដ លំ ីរូបភារ លដីម្បបីរហ ញម្៊ុឺន៊ុយរូបភារល ច
ល ងី ឬលដ្ឋយច៊ុចខាងល វ្ងល ី និមិ្តតរញ្ញ  " កា ស្រួញ (arrow-head)" តូចមួ្យ លៅ
ស្ជុងខាងល វ្ងខាងល ី លៅថ្ន Menu Button ដដ បានរិរណ៌ា នាខាងលស្កាម្។  

3. ប ូត៊ុងមឺ្ន៊ុយ (Menu Button)៖ ច៊ុចល ីប ូត៊ុងមឺ្ន៊ុយ លដីម្បបីរហ ញម្៊ុឺន៊ុយរូបភារកន៊ុងជួរឈរ
មួ្យ។ ស្បរិនលបី នកចូ ចិតតលស្បីផលូវកាត់កាត រច៊ុច រូម្លស្បី  Shift + F10 លដីម្បលីបីកម្៊ុឺន៊ុយ។ 

4. បនាទ ត់ (Ruler)៖ លៅកន៊ុងបលង់ ំនាលំដីម្ បនាទ ត់ស្តូវបានបរហ ញខាងល ី និងខាងល វ្ងននរូប
ភារ។ លស្បីបនាទ ត់លដីម្បកំីណត់កូ រលដ្ឋលនលៅកន៊ុងរូបភារ។ ឯកតា ំនាលំដីម្រស្មប់បនាទ ត់គឺ
ភីកដរ ។ លស្បីការកំណត់ដដ បានរិរណ៌ា នាខាងលស្កាម្លដីម្បលីស្បីឯកតាលស្ៅរីភីកដរ ។ 

5. QuickMask Toggle៖ ប ូត៊ុងតូចលៅស្ជុងខាងល វ្ងខាងលស្កាម្ននរូបភារបិទលបីក Quick 
Mask លបីកនិងបិទ។ លៅលរ លបីក Quick Mask ប ូត៊ុងស្តូវបានគូរបញ្ា ក់ជារណ៌ា          
ស្កហម្។  

6. កូ រលដ្ឋលនននស្ទនិច (Pointer Coordinates)៖ លៅលរ ដដ ស្ទនិច (ទរសន៍ស្ទនិច
កណដ៊ុ រ ស្បរិនលបី នកកំរ៊ុងលស្បីកណត៊ុ រ) រេិតលៅកន៊ុងស្រំដដនរូបភារ នផទចត៊ុលកាណដកងលៅ
ស្ជុងខាងល វ្ងខាងលស្កាម្ននបងអួចបរហ ញកូ រលដ្ឋលនស្ទនិចបចច៊ុបបនន។ ឯកតាគឺដូចោន នឹង
បនាទ ត់ (Ruler)ដដរ។ 

រូបភារទី ១.២៩ ចំណ៊ុ ចស្បទាក់ នកលស្បី GIMP តាម្ ំនាលំដីម្ 

https://docs.gimp.org/en/gimp-pimping.html#gimp-prefs-dialog
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7. ម្៊ុឺន៊ុយឯកតា (Units Menu)៖ លស្បីម្៊ុឺន៊ុយឯកតាលដីម្បផី្លល រ់បតូរឯកតាដដ លស្បី ruler និង
លោ បំណងលផសងលទៀតជាលស្ចីន។ ឯកតា ំនាលំដីម្គឺភីកដរ  ប៉ា៊ុដនត នកអចបតូរលៅជា       
 ៊ុីនឈ៍ រង់ទីដម្៉ាស្ត ឬ ទធភារលផសងលទៀតជាលស្ចីនលដ្ឋយលស្បីម្៊ុឺន៊ុយលនះ។  

8. ប ូត៊ុងរស្ងីក (Zoom Button)៖ មនវធីិ្ជាលស្ចីនលដីម្បរីស្ងីករូបភារចូ  ឬលចញ ប៉ា៊ុដនតប ូត៊ុង
រស្ងីកស្បដហ ជាសាម្ញ្ញបំផ៊ុត។  នកអចបញ្ចូ  កស្មិ្តរស្ងីកលដ្ឋយផ្លទ  ់លៅកន៊ុងស្ប ប់
 តេបទរស្មប់ការស្គប់ស្គងចារ់ោរ់។ 

9. តំបន់សាេ នភារ (Status Area)៖ តំបន់សាេ នភាររេិតលៅដផនកខាងលស្កាម្ននបងអួចរូបភា
រ។ តាម្ ំនាលំដីម្ តំបន់សាេ នភារបរហ ញលឈាម ះលដីម្ននឯកសារ image.xcf និងចំនួន ងា
ចងចាសំ្បរ័នធដដ លស្បីលដ្ឋយរូបភារ។ រូម្លស្បី Edit → Preferences → Image 

Windows → Title & Status លដីម្បបីដូររ័ត៌ាមនដដ បរហ ញលៅកន៊ុងតំបន់សាេ នភារតាម្
បំណង។ កន៊ុង ំ ៊ុងលរ ស្បតិបតតិការដដ លស្បីលរ លវោ តំបន់សាេ នភារបរហ ញជាប
លណាត ះអរនននូវស្បតិបតតិការដដ កំរ៊ុងដំលណីរការ និងរលបៀបបញ្ច ប់ស្បតិបតតិការ។ 

10. ប ូត៊ុងលបាះបង់ (Cancel Button)៖ កន៊ុង ំ ៊ុងលរ ស្បតិបតតិការដដ ចំណាយលរ រម៊ុគ
សាម ញ ជាធ្ម្មតាកម្មវធីិ្ជំនួយ ប ូត៊ុងលបាះបង់ (Cancel) នឹងល ចល ងីជាបលណាដ ះអរនន
លៅស្ជុងខាងសាត ខំាងលស្កាម្ននបងអួច។ លស្បីប ូត៊ុង លបាះបង់ លដីម្បបីញ្ឈប់ស្បតិបតតិការ។ 

11. ការស្គប់ស្គងការរ៊ុករក (Navigation Control)៖ ជាប ូត៊ុងរងតូចចលងអៀតលៅស្ជុងខាងសាត ំ
ខាងលស្កាម្ននការបរហ ញរូបភារ។ ច៊ុចឱ្យជាប់ (ក៊ុំដ ងប ូត៊ុងកណដ៊ុ រ) លៅល ីការស្គប់ស្គង
ការរ៊ុករក (navigation control) លដីម្បបីរហ ញការលមី្ ការរ៊ុករកជាម្៊ុន ( Navigation 

Preview)។ ការលមី្ ការរ៊ុករកជាម្៊ុន ( Navigation Preview) មនទិដាភារខាន តតូចនន
រូបភារជាមួ្យនឹងនផទដដ បានបរហ ញដដ បានគូរបញ្ា ក់។ លស្បីការលមី្ ការរ៊ុករកជាម្៊ុន
លដីម្បរីកិំ លៅដផនកលផសងោន ននរូបភារោ៉ា ងល ឿន រូម្ផ្លល រ់ទីកណដ៊ុ រខ្ណៈលរ ដដ ច៊ុច 
ប ូត៊ុង។ ជាលរឿយៗ បងអួចរ៊ុករក គឺជាម្លធ្ាបាយរយស្រួ បំផ៊ុត លដីម្បរី៊ុករកជ៊ុំវញិរូបភារធំ្
មួ្យបានោ៉ា ងល ឿន លដ្ឋយស្ោន់ដតបរហ ញដផនកតូចមួ្យប៉ា៊ុលណាណ ះ។  

12. តំបន់ស្ទនាប់ រកម្ម (Inactive Padding Area)៖ លៅលរ ដដ ទំហរំូបភារតូចជាង
ផ្លទ ងំរូបភារ នផទស្ទនាប់លនះបំដបកការបរហ ញរូបភាររកម្មលចញរីដផនកលផសងលទៀតននចំណ៊ុ ច
ស្បទាក់ នកលស្បីស្បារ់ ដូលចនះ នកអចដបងដចករវាងរួកវាបាន។  នកមិ្នអច ន៊ុវតតតស្ម្ង ឬ
ស្បតិបតតិការទូលៅលៅតំបន់ រកម្មបានលទ។ 

13. ការបរហ ញរូបភារ (Image Display)៖ ដផនករំខាន់បំផ៊ុតននបងអួចរូបភារគឺជាការរិត
ណារ់ ការបរហ ញរូបភារ ឬផ្លទ ងំស្កណាត់។ វាដំលណីរការលៅតំបន់កណាត  ននបងអួច ហ ៊ុ៊ុំ
រ័ទធលដ្ឋយបនាទ ត់ដ្ឋច់ៗរណ៌ា ល ឿង ដដ បរហ ញរីស្រំដដនរូបភារដដ ខ្៊ុរោន រីនផទខាង
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លស្កាយរណ៌ា ស្បលផះ។  នកអចផ្លល រ់បតូរកស្មិ្តរស្ងីកននការបរហ ញរូបភារតាម្វធីិ្លផសងៗោន  
រមួ្ទាងំការកំណត់ Zoom ដដ បានរិរណ៌ា នាខាងលស្កាម្។ 

14. បិទ/លបីកទំហបំងអួចរូបភារ (Image Window Resize Toggle)៖  ស្បរិនលបី នកផ្លល រ់បដូរ
ទំហបំងអួចរូបភារលដ្ឋយការច៊ុចនិងការ ូរកស្មិ្តស្រំដដន ទំហរំូបភារ និងការរស្ងីកមិ្ន
ផ្លល រ់បដូរលទ លបីមិ្នលបីក កខណៈរិលររលនះលទ។ ឧទាហរណ៍ស្បរិនលបី នកលធ្វីឱ្យបងអួចធំ្
ជាងលនះ លនាះ នកនឹងលឃញីរូបភារកាន់ដតលស្ចីន។ លទាះោ៉ា ងណាក៏លដ្ឋយ ស្បរិនលបីប ូត៊ុង
លនះស្តូវបានច៊ុច រូបភារនឹងផ្លល រ់បតូរទំហលំៅលរ ដដ បងអួចផ្លល រ់បតូរទំហ ំ ដូលចនះ (ភាគ
លស្ចីន) ដផនកដូចោន ននរូបភារស្តូវបានបរហ ញម្៊ុន និងលស្កាយបងអួចស្តូវបានបតូរទំហ។ំ 

ទំហរំូបភារ និងទំហបំងអួចរូបភារអចខ្៊ុរោន ។  នកអចលធ្វីឱ្យរូបភាររម្នឹង
បងអួច លហយីស្ចារម្កវញិលដ្ឋយលស្បីផលូវកាត់កាដ រច៊ុចរីរ៖ 

o បញ្ា  (Ctrl ) + J  ៖  កយបញ្ា លនះរកាកស្មិ្តរស្ងីក។ វារស្ម្បទំហបំងអួចលៅ
នឹងទំហរំូបភារ។  

o បញ្ា  (Ctrl ) + បដូរ (Shift) + J ៖  កយបញ្ា លនះដកដស្បកស្មិ្តរស្ងីក លដីម្បី
រស្ម្បការបរហ ញរូបភារលៅបងអួច។ 

២.៦. ការសរើកែំសណើ រការ GIMP 

២.៦.១. ការរសងកើតឯការលមី 

លដ្ឋយលស្បីស្ប ប់ "បលងកីតរូបភារថ្មី (Create a New Image)"  នកអចបលងកីតរូបភារទលទថ្មី 
និងកំណត់ កខណៈរបរ់វា។ រូបភារស្តូវបានបរហ ញលៅកន៊ុងបងអួចរូបភារថ្មី លហយី នកអចមនរូបភារ
លស្ចីនជាងមួ្យលៅល ីល ស្កង់របរ់ នកកន៊ុងលរ ដតមួ្យ។ 

ក. រសរៀរច្នការសរើក 

•  នកអចចូ លស្បី កយបញ្ា កន៊ុងម្៊ុឺន៊ុយរូបភារតាម្រយៈ៖
File → New…  

• ឬលដ្ឋយលស្បីផលូវកាត់កាត រច៊ុច Ctrl + N។ 

ខ. រសស្រមើេមូលដ្ឋា ន 

• ទំហរំូបភារ 

 នកអចកំណត់ទទឹង និង កម្ពរ់ននរូបភារថ្មី។ ឯកតា ំនាលំដីម្គឺស្តូវបានកំណត់ជា  
ភីកដរ  ប៉ា៊ុដនត នកអចលស្ជីរលររីឯកតាលផសងស្បរិនលបី នកចង់បាន លដ្ឋយលស្បីម្៊ុឺន៊ុយដដ លៅ
ជាប់ោន លនាះ។  

រូបភារទី ១.៣០ កំណត់ទំហរំូបភារ 
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• ប ូត៊ុងបញ្ឈរ/លផដក 

មនប ូត៊ុងរីរដដ បិទ/លបីករវាងរលបៀបរូបភារបញ្ឈរ និងលផដក។ 
រិនលបីទទឹង និងកម្ពរ់ដូចោន  ប ូត៊ុងទាងំលនះមិ្នស្តូវបានដំលណីរការលទ។ 
លៅខាងសាត សំ្ប ប់ ទំហរំូបភារ គ៊ុណភារបរហ ញល ស្កង់ និងទំហរំណ៌ា
ស្តូវបានបរហ ញ។ 

កន៊ុងករណី នកមិ្នចង់បញ្ចូ  តនម្លទាងំ រ់ ខាងល ីលដ្ឋយខ្លួនឯង 
 នកអចលស្ជីរលររីតនម្ល ដដ បានកំណត់ជាម្៊ុនមួ្យចំនួនរស្មប់រូបភារ
របរ់ នករីម្៊ុឺន៊ុយគំរូ ដដ តំណាងឱ្យស្បលភទរូបភារដដ មនស្បលោជន៍ជា
ទូលៅ។ គំរូទាងំលនះបានកំណត់តនម្លរស្មប់ទំហ ំគ៊ុណភារបរហ ញ និងម្តិលោប ់ ។  

២.៦.២. ការសរើកររូភាពមានស្រារ់ 

ម្លធ្ាបាយជាក់ដរតងបំផ៊ុត លដីម្បលីបីករូបភារដដ មន
ស្សាប់គឺ តាម្រយៈម្៊ុឺន៊ុយ។ លស្បី File → Open លដីម្បលីបីក
ស្ប ប់ Open Image ដដ  ន៊ុញ្ញ តឱ្យ នករ៊ុករកឯកសារ (file) 
លហយីច៊ុចល ីលឈាម ះរបរ់វា។ វធីិ្សាង្គ្រតលនះដំលណីរការបាន អ
ស្បរិនលបី នកដឹងរីលឈាម ះ និងទីតាងំននឯកសារដដ  នកចង់   
លបីក។ លទាះបីជាស្ប ប់លបីករូបភារ មនផ្លទ ងំលមី្ ជាម្៊ុនក៏
លដ្ឋយ វាមិ្នរយស្រួ លទ កន៊ុងការដរវងរករូបភារលដ្ឋយដផអកល ី
ផ្លទ ងំបរហ ញរូបភារតូចៗ។ 

មនវធីិ្លផសងលទៀតដដ  នកអច ន៊ុវតដបានលដ្ឋយការ  ូរ និងទមល ក់ឯកសារមួ្យលៅស្ប ប់
ឧបករណ៍ GIMP លដីម្បលីបីកឯកសារ។  ូររូបភារលៅកន៊ុង open GIMP image លដីម្បបីដនេម្ឯកសារ
ដដ បានទមល ក់ជាស្រទាប់ថ្មី ឬរំណ៊ុំ ននស្រទាប់លៅរូបភារដដ បានលបីករចួលហយី។ មនកម្មវធីិ្ជា
លស្ចីនោសំ្ទការ ូរ និងទមល ក់រូបភារលៅកន៊ុង GIMP។  ឧទាហរណ៍  ូររូបភាររី Firefox លហយី
ទមល ក់វាលៅស្ប ប់ឧបករណ៍របរ់ GIMP។ 

២.៦.៣. ការរកាទុកររូភាព 

លៅលរ  នកបញ្ច ប់ការលធ្វីការជាមួ្យរូបភារ  នកនឹង
រកាទ៊ុក ទធផ ។ ស្បលភទឯកសារលដីម្របរ់ GIMP XCF គឺ
រិលររ។ វាជាទស្ម្ង់ដតមួ្យគត់ដដ អចរកាទ៊ុក  វីស្គប់
ោ៉ា ង ំរីរូបភារ (ល ីកដ ងដតរ័ត៌ាមន "មិ្នលធ្វីវញិ
(undo) ")។ ស្បលភទឯកសារ XCF រ័កតិរម្ជារិលររ

រូបភារទី ១.៣១ លបីករូបភារមនស្សាប់ 

រូបភារទី ១.៣២ សាររ ឹំករស្មប់ការរកាទ៊ុក 
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រស្មប់ការរកាទ៊ុក ទធផ កស្មិ្តម្ធ្យម្ និងរស្មប់ការរកាទ៊ុករូបភារ ដដ ស្តូវលបីកល ងីវញិលៅ
លរ លស្កាយលៅកន៊ុង GIMP ។ ស្បរិនលបី នករាោម្រកាទ៊ុកជាទស្ម្ង់លផសងលស្ៅរី XCF  នកនឹងទទួ 
បានសារកំហ៊ុរម្ួយ ដូចរូបភារខាងសាដ លំនះ។  នកអចលធ្វីការរកាទ៊ុករូបភារលដ្ឋយ ន៊ុវតដដូចខាង
លស្កាម្៖ 

•  នកអចចូ លស្បី កយបញ្ា លនះលៅកន៊ុងរបារម្៊ុឺន៊ុយរូបភារតាម្រយៈ File → Save  

• ឬរីកាត រច៊ុចលដ្ឋយលស្បីផលូវកាត់  Ctrl + S   

• លស្បី Ctrl + Shift + S  លដីម្បរីកាទ៊ុករូបភារដដ បាន
លបីកលដ្ឋយលស្បីលឈាម ះលផសង។ 

ជាមួ្យនឹងកម្មវធីិ្រ៊ុករកឯកសារលនះ  នកអចដករស្មួ្ លឈាម ះ
ឯកសារលដ្ឋយផ្លទ  ់លៅកន៊ុងស្ប ប់ តេបទលឈាម ះ ( ំនាលំដីម្គឺ
 “ Untitled.xcf ”) ឬលដ្ឋយលស្ជីរលររីឯកសារកន៊ុងបញ្ា ីលឈាម ះ។ រូម្
បញ្ា ក់ម្តងលទៀតថ្ន មនដតទស្ម្ង់ XCF ប៉ា៊ុលណាណ ះដដ ស្តូវបាន          
 ន៊ុញ្ញ ត។  នកក៏ស្តូវដតកំណត់ទីតាងំរូបភាររស្មប់ការរកាទ៊ុកលៅ
កន៊ុង Save in Folder ។  នកអចបលងកីតថ្តថ្មីលបីចាបំាច់។  

លស្ជីរលររីស្បលភទឯកសារ៖ ស្បរិនលបី នករស្ងីកជលស្មី្រលនះលៅដផនកខាងលស្កាម្ននស្ប ប់  នក
អចលស្ជីរលររីទស្ម្ង់ដដ បានបរហ ប់រស្មប់ឯកសារ XCF របរ់ នក។ 

២.៦.៤. ការនាសំនញររូភាព 

 GIMP អចនាលំចញរូបភារដដ  នកបានដករស្មួ្ 
រចួរ ់កន៊ុងទស្ម្ង់លផសងៗ ដូចជា JPEG GIF HEIF/HEIC 
PNG TIFF WebP MNG … ។ លៅកន៊ុងដផនកលនះ  នកនឹងបាន
ដរវងយ ់ ំរីការនា ំលចញរូបភារជាទស្ម្ង់ JPEG។ ឯកសារ 
JPEG ជាធ្ម្មតាមនដផនកបដនេម្ .jpg, .JPG, ឬ .jpeg ។ វាជា
ទស្ម្ង់ដដ ស្តូវបានលគលស្បីោ៉ា ងទូ ំទូោយ លស្ ះខ្ណៈ
លរ ដដ កាត់បនេយការបាត់បង់គ៊ុណភាររូបភារ វាបស្ងួម្រូបភារោ៉ា ងមនស្បរិទធភារ។  ជាមួ្យោន
លនះដដរ វាមិ្នោសំ្ទរូបភារដដ មនភារថ្នល  ឬស្រទាប់លស្ចីនលទ។ 

• គ៊ុណភារ 

លៅលរ  នករកាទ៊ុកឯកសារកន៊ុងទស្ម្ង់ JPEG ស្ប ប់ស្តូវបានបរហ ញ ដដ  ន៊ុញ្ញ តឱ្យ
 នកកំណត់កស្មិ្តគ៊ុណភារដដ មនចាប់រី 0 ដ ់ 100។ តនម្លល ីររី 95 ជាទូលៅមិ្នមន
ស្បលោជន៍លទ។ គ៊ុណភារ ំនាលំដីម្នន 85 ជាធ្ម្មតាបលងកីតបាន ទធផ  អ ប៉ា៊ុដនតកន៊ុងករណីជា
លស្ចីន វាអចកំណត់គ៊ុណភារទាបជាងោ៉ា ងខាល ងំលដ្ឋយមិ្នលធ្វីឱ្យរូបភារធាល ក់ច៊ុះគួរឱ្យកត់

រូបភារទី ១.៣៣ រកាទ៊ុកជាទស្ម្ង់ XCF 

រូបភារទី ១.៣៤ ការនាលំចញរូបភារ 
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រមា  ់លនាះលទ។  នកអចសាក បងឥទធិរ ននការកំណត់គ៊ុណភារលផសងៗោន លដ្ឋយធី្ក 
បរហ ញការលមី្ ជាម្៊ុនលៅកន៊ុងបងអួចរូបភារកន៊ុងស្ប ប់ JPEG ។ 

• លស្បីការកំណត់គ៊ុណភាររីរូបភារលដីម្ 

ស្បរិនលបីការកំណត់គ៊ុណភារជាក់ោក់មួ្យ ស្តូវបានភាា ប់លៅរូបភារលៅលរ ដដ វា
ស្តូវបានផទ៊ុក លនាះជលស្មី្រលនះ ន៊ុញ្ញ តឱ្យ នកលស្បីរួកវាជំនួរឱ្យរតង់ដ្ឋរ។ ស្បរិនលបី នកបាន
លធ្វីការផ្លល រ់បតូរបនតិចបនតួចចំល ះរូបភារ លនាះការលស្បីការកំណត់គ៊ុណភារដូចោន ល ងីវញិនឹង 
ផត ់ឱ្យ នកនូវគ៊ុណភារ និងទំហឯំកសារលរទីរដតដូចោន លៅនឹងរូបភារលដីម្។ វានឹងកាត់បនេយ
ការខាតបង់ដដ បណាត  ម្ករីជំហានបរមិណ លបីលស្បៀបលធ្ៀបលៅនឹង វីដដ នឹងលកីតល ងី 
ស្បរិនលបី នកលស្បីការកំណត់គ៊ុណភារខ្៊ុរោន ។ 

ស្បរិនលបីការកំណត់គ៊ុណភារដដ រកលឃញី កន៊ុងឯកសារលដីម្មិ្នស្បលរីរជាងការ
កំណត់គ៊ុណភារ ំនាលំដីម្របរ់ នកលទ លនាះជលស្មី្រ " លស្បីការកំណត់គ៊ុណភាររីរូបភារ
លដីម្ " នឹងមន ប៉ា៊ុដនតមិ្នលបីកដំលណីរការលទ។ លនះធានាថ្ន នកដតងដតទទួ បានោ៉ា ងលហាច
ណារ់គ៊ុណភារ បបបរមដដ បានបញ្ា ក់លៅកន៊ុង ំនាលំដីម្របរ់ នក។ ស្បរិនលបី នកមិ្ន
បានលធ្វីការផ្លល រ់បតូរធំ្ដ៊ុំល ីរូបភារ លហយី នកចង់រកាទ៊ុកវាលដ្ឋយលស្បីគ៊ុណភារដូចោន លៅនឹងរូប
ភារលដីម្ លនាះ នកអចលធ្វីវាបានលដ្ឋយលបីកជលស្មី្រលនះ។ 

• បរហ ញការលមី្ ជាម្៊ុនលៅកន៊ុងបងអួចរូបភារ 

ការរិនិតយលមី្ ជលស្មី្រលនះបណាត  ឱ្យមនការផ្លល រ់បតូរគ៊ុណភារនីមួ្យៗ ស្តូវបាន
បរហ ញលៅកន៊ុងការបរហ ញរូបភារ។  

• រកាទិននន័យលម្តា 

ស្បរិនលបីរូបភារដដ  នកបានផទ៊ុកមនទិននន័យលម្តា ដូចជា Exif XMP IPTC រួកវា
ស្តូវបានរកាទ៊ុក លហយី នកអចរលស្ម្ចចិតដកន៊ុងការរកាទ៊ុករួកវាបាន ឬ ត់លៅលរ នាលំចញ
លៅ JPEG។ 

• រកាទ៊ុករូបភារតូច រកាទ៊ុកទស្ម្ង់រណ៌ា  

កម្មវធីិ្ជាលស្ចីនលស្បីរូបភារតូចតូចជារូបភារលមី្ ជាម្៊ុនតូចដដ អចលស្បីបានោ៉ា ងរហ័រ។ 

• ម្តិលោប ់ 

 នកអចដករស្មួ្ ម្តិលោប ់ដដ ភាា ប់ជាមួ្យរូបភារដដ  នកបានផទ៊ុក ឬបលងកីតថ្មីមួ្យ។ 
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• ជលស្មី្រកស្មិ្តខ្ពរ់ 

 នកក៏អចលធ្វីការកំណត់បដនេម្លៅកន៊ុងការកំណត់កស្មិ្តខ្ពរ់ រស្មប់រូបភារដដ ស្តូវ
នាលំចញ។ កន៊ុងលនាះផងដដរ  នកអចលធ្វីការកំណត់ លធ្វីឱ្យស្បលរីរ(Optimize) រលោង
(Smoothing) លស្បីការររលររកូដនរវនធ(Use arithmetic coding) លស្បីរញ្ញ រមា  ់ចាប់
លផតីម្ល ងីវញិ(Use restart markers) និង កខណៈលផសងៗលទៀតផងដដរ។  
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េណួំររលំកឹសមសរៀន 

1- លតីការដំល ងី GIMP មនភារខ្៊ុរដបលកោន ោ៉ា ងដូចលម្តចចំល ះស្បរ័នធស្បតិបតតិការលផសងៗោន  
លហយីលតីជំហាន ឬតស្មូ្វការជាក់ោក់ វីខ្លះដដ គួរស្តូវបានយកម្ករិចារណាលៅលរ ដំល ងី
កម្មវធីិ្លៅល ីស្បរ័នធស្បតិបតដិការនីមួ្យៗ? 

2- លតីបញ្ហ ស្បឈម្ដដ អចលកីតមន ឬការរិចារណា វីខ្លះដដ  នកលស្បីស្បារ់អចជួបស្បទះកន៊ុង
 ំ ៊ុងលរ ដំលណីរការដំល ងី GIMP លហយីលតីរួកលគអចកាត់បនេយ ឬលដ្ឋះស្សាយលដ្ឋយ
រលបៀបណា? 

3- ចូររនយ ់រីសារៈរំខាន់ននការលផទៀងផ្លទ ត់ភារស្តឹម្ស្តូវ និងរ៊ុចរតិភារននកញ្ច ប់ដំល ងី GIMP 
និងរិភាកា ំរីហានិភ័យ ដដ អចលកីតមនទាក់ទងនឹងការទាញយក និងដំល ងីកម្មវធីិ្រី
ស្បភរមិ្នផលូវការ ឬមិ្នគួរឱ្យទ៊ុកចិតត? 

4- លតី នកអចបលងកីនស្បរិទធភារស្បតិបតតិការ និងបដូរចំណ៊ុ ចស្បទាក់ នកលស្បីស្បារ់តាម្បំណងរបរ់ 
GIMP ឱ្យរម្នឹង ំហូរការររ និងចំណូ ចិតតរបរ់ នកលដ្ឋយរលបៀបណា?  

5- លដ្ឋយ ល្៊ុះបញ្ច ងំល ីបងអួចលម្លៅកន៊ុង GIMP ចូរវភិាគគ៊ុណរម្បតតិ និងដដនកំណត់រកាត ន៊ុរ 
ននការលស្បីស្បារ់ចំណ៊ុ ចស្បទាក់រហ៊ុបងអួចលធ្ៀបនឹងចំណ៊ុ ចស្បទាក់បងអួចដតមួ្យ? 

6- លៅលរ លបីកដំលណីរការ GIMP ជាល ីកដំបូង លតីម្៊ុខ្ររ និងឧបករណ៍រំខាន់ៗ វីខ្លះដដ  នក
នឹងដរវងយ ់ លដីម្បសីាា  ់ខ្លួន នកជាមួ្យនឹងចំណ៊ុ ចស្បទាក់ និងម្៊ុខ្រររបរ់កម្មវធីិ្? 

7- លៅលរ បលងកីតឯកសារថ្មីលៅកន៊ុង GIMP លតីកតាត  វីខ្លះដដ  នកគួររិចារណាទាក់ទងនឹងវមិស្ត 
គ៊ុណភារបរហ ញ និងរលបៀបរណ៌ា  លដីម្បធីានាបាននូវការកំណត់ដ៏ អស្បលរីររស្មប់គលស្មង
ជាក់ោក់របរ់ នក? លតីកតាត ទាងំលនះប៉ាះ  ់ដ ់ទិននផ ច៊ុងលស្កាយោ៉ា ងដូចលម្តច? 

8- លតី វីលៅជាគ៊ុណរម្បតតិ និងដដនកំណត់ននការលស្បីស្បារ់ម្៊ុខ្ររ "រកាទ៊ុក" លៅកន៊ុង GIMP លបី
លស្បៀបលធ្ៀបលៅនឹងម្៊ុខ្ររ "រកាទ៊ុកជា"?  

9- លៅលរ នាលំចញរូបភារលៅកន៊ុង GIMP លតី នកអចលស្ជីរលររីទស្ម្ង់ឯកសារ និងការកំណត់
រម្ស្របលដ្ឋយរលបៀបណា លដីម្បធីានាថ្នរូបភារដំលណីរការលៅល ីលវទិកា កម្មវធីិ្ និង
ឧបករណ៍លផសងៗ?  

 
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សមសរៀនទី ៣៖ ស្រេទារ់ (Layer) នងិច្ផ្ៃខាងសស្រកាយ (Background) 

៣.១. ការថ្ណនាអំ្ំពីស្រេទារ់ (Layer) 

  ស្រទាប់គឺជានផទដដ លគលស្បីស្បារ់រស្មប់
លធ្វីការដកដស្ប ឬរស្មប់រចនារូបភារ។ ស្រទាប់
នីមួ្យៗស្តូវបានដចកដ្ឋច់លដ្ឋយដ ករីោន  លហយីវា
អចលធ្វីការរររមួ្ោន  ជាមួ្យស្រទាប់លផសងោន កន៊ុងឯក
សារការររដតមួ្យ ឬលផសងោន ។ ស្រទាប់នីមួ្យៗអច
មនធាត៊ុលផសងៗោន ដូចជា  តេបទ ស្កាហវកិ ឬដបប
ដផន លហយីអចស្តូវបានលរៀបចំលដ្ឋយឯករជយរី
ស្រទាប់លផសងលទៀត។ ស្រទាប់ ន៊ុញ្ញ តឱ្យ នកលធ្វីការ
ផ្លល រ់បតូររូបភារលដ្ឋយមិ្នប៉ាះ  ់ដ ់រូបភារលដីម្លដ្ឋយផ្លទ  ់។ លៅលរ  នកលធ្វីការដករស្មួ្ ល ី
ស្រទាប់មួ្យ ការដករស្មួ្ ទាងំលនាះ ស្តូវបាន ន៊ុវតតដតចំល ះស្រទាប់ជាក់ោក់លនាះប៉ា៊ុលណាណ ះ លហយី
មិ្នដម្នចំល ះរូបភារខាងលស្កាម្លនាះលទ ដដ លធ្វីឱ្យវាកាន់ដតរយស្រួ  កន៊ុងការរិលសាធ្ន៍ជាមួ្យដបប
ដផនលផសងៗ និងលធ្វីការដករស្មួ្ ោ៉ា ងចារ់ោរ់លដ្ឋយមិ្នលធ្វីឱ្យខូ្ចរូបភារលដីម្។ 

 ស្រទាប់ក៏ផត ់ឱ្យ នកនូវការស្គប់ស្គងបដនេម្លទៀតល ីរមរភារននរូបភារនីមួ្យៗ។ តាម្    
រយៈការលរៀបចំរមរធាត៊ុ(object) លៅកន៊ុងស្រទាប់នីមួ្យៗ  នកអចស្គប់ស្គងរមរធាត៊ុណាមួ្យ
រស្មប់នផទខាងម្៊ុខ្ ឬរីខាងលស្កាយបនដបនាទ ប់ោន ។ វាមនស្បលោជន៍ជារិលររលៅលរ ដដ  នកកំរ៊ុង
លធ្វីការជាមួ្យធាត៊ុជាលស្ចីនលៅកន៊ុងរូបភារមួ្យ ដូចជាលៅលរ  នកកំរ៊ុងបលងកីតរូបភារផសលំដ្ឋយរូបភារ 
ឬធាត៊ុលផសងៗជាលដីម្។  

 បដនេម្រីល ីការ ន៊ុញ្ញ តឱ្យ នកលធ្វីការដករស្មួ្ ដដ មិ្នមនការបំផលិចបំផ្លល ញ និងផត ់ឱ្យ
 នកនូវការស្គប់ស្គងបដនេម្លទៀតល ីរមរភារននរូបភារ ស្រទាប់ក៏អចស្តូវបានលស្បីលដីម្បបីលងកីតដបប
ដផនរិលររលៅកន៊ុងរូបភារផងដដរ។ ជាឧទាហរណ៍  នកអចលស្បីស្រទាប់លដីម្បបីលងកីតដបបដផន
ស្រលម ធាល ក់ច៊ុះលដ្ឋយចម្លងស្រទាប់ដដ មនវតេ៊ុ ឬ តេបទ បដនេម្ភារស្  លៅស្រទាប់ដដ ស្តួតោន  
លហយីបនាទ ប់ម្កដ្ឋក់វាលៅខាងលស្កាម្បនតិច និងខាងសាត នំនស្រទាប់លដីម្។ វាបលងកីតការបំភាន់នន
ស្រលម  លដ្ឋយផត ់ឱ្យវតេ៊ុ ឬ តេបទកាន់ដតរ៊ុីជលស្ៅ និងវមិស្ត។ 

 ស្រទាប់ក៏អចស្តូវបានលស្បីលដីម្បបីលងកីតដបបដផនរបាងំដដ  នកលស្ជីរលររីបរហ ញ ឬោក់ដផនក
ននរូបភារ។ ឧទាហរណ៍  នកអចបលងកីតស្រទាប់របាងំដដ ោក់តំបន់ជាក់ោក់ននរូបភារ លដ្ឋយ
បរហ ញដតដផនកដដ  នកចង់បរហ ញប៉ា៊ុលណាណ ះ។ ស្រទាប់មនស្បលោជន៍ជារិលររលៅលរ ដដ  នកចង់
បញ្ចូ  ោន នូវរូបភារជាលស្ចីនជាមួ្យោន  ឬលៅលរ ដដ  នកចង់លស្ជីរលររីដបបដផនល ីនផទជាក់ោក់នន
រូបភារ។ 

រូបភារទី ២.១ ឧទាហរណ៍ននស្រទាប់ 
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៣.២. សធវើការាមួយស្រេទារ់ 

៣.២.១. រនៃះស្រេទារ់ GIMP 

ម្៊ុននឹងបរហ ញ នករីរលបៀបលធ្វីការជាមួ្យស្រទាប់កន៊ុង GIMP ជាដំបូង លយងីលៅលមី្ បនទះ      
ស្រទាប់។ ស្បរិនលបីវាមិ្នអចលមី្ លឃញីលទ រូម្ចូ លៅកាន់ម្៊ុឺន៊ុយលស្កាម្  Windows > 

Dockable Dialogs > Layers លដីម្បលីបីកបនទះ។ 

បនទះស្រទាប់មនបីដផនករំខាន់ៗ (ដូចបានបរហ ញកន៊ុងរូបខាងសាដ លំនះ)៖ 

1. ខាងល ី៖ លៅទីលនះ  នកនឹងលឃញីជលស្មី្របី
រស្មប់ នតរកម្មជាមួ្យ ស្រទាប់របរ់      នក 
ដូចជា ទស្ម្ង់ (Modes) ភារស្រអប ់
(Opacity) និងចាក់លសា (Locks)។ 

2. កណាត  ៖ ដផនកលនះនឹងបរហ ញស្រទាប់កន៊ុង
ឯកសាររបរ់ នក។ 

3. ខាងលស្កាម្៖ លៅស្តង់កដនលងលនះ  នកនឹងលឃញីរូបតំណាងចំនួនស្បាបីំលផសងោន  លដីម្បជួីយ នក
លធ្វីការររ និងស្គប់ស្គងស្រទាប់របរ់ នក។ 

ក. ទស្រមង់ស្រេទារ ់

លៅដផនកខាងល ី គឺជាជលស្មី្រមួ្យ 
(pull-down menu) លៅថ្ន ទស្ម្ង់ 
(Modes) ដដ ជាវធីិ្សាង្គ្រតមួ្យរស្មប់
ផ្លល រ់បតូរទស្ម្ង់ ដដ ស្រទាប់របរ់ នកមន
 នតរកម្មជាមួ្យោន លៅវញិលៅម្ក។ វាស្រលដៀង
ោន លៅនឹង Blend Modes លៅកន៊ុង 
Photoshop។ លៅលរ  នកលស្ជីរលររីរីម្៊ុឺ
ន៊ុយទមល ក់ច៊ុះ (drop-down menu) 
ស្រទាប់រកម្មនឹង "បញ្ចូ  ោន  (blend)" 
ជាមួ្យស្រទាប់ខាងលស្កាម្ លោងលៅតាម្
ទស្ម្ង់ដដ  នកបានលស្ជីរលររី។ 

 

រូបភារទី ២.២ បនទះស្រទាប់ GIMP 

រូបភារទី ២.៣ pull-down menu 
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ខ. ភាពស្រេអារ់ 

លដីម្បដីកតស្មូ្វភារថ្នល ននស្រទាប់ រូម្លស្បីស្ោប់
រកិំ ភារស្រអប់ លដីម្បបីលងកីន ឬបនេយតាម្តស្មូ្វការ។  

 

គ. ចាក់សា 

លដីម្បទីប់សាក ត់ការដកតស្មូ្វលដ្ឋយនចដនយចំល ះស្រទាប់  នកអចចាក់លសាវាបាន។ មនជលស្មី្រ
បីលៅទីលនះ៖ 

• រូបតំណាងជក់ោបរណ៌ា ៖ ការ រការដករស្មួ្ ណាមួ្យដដ ស្តូវបានលធ្វីល ងីចំល ះ   
ស្រទាប់។  

• រូបតំណាងស្រញួ៖ ររងំមតិកាននស្រទាប់មិ្នឱ្យផ្លល រ់ទី។ 
• រូបតំណាងកាត របនទះ៖ ររងំការដកតស្មូ្វចំល ះតមល ភារននស្រទាប់។ 

៣.២.២. ការសមើលស្រេទារ់ាមុន (Layer Previews) 

ស្រទាប់ថ្មីនីមួ្យៗដដ  នកបលងកីតនឹងបរហ ញការលមី្ ជាម្៊ុន (រូបភារតូច) ននមតិកាស្រទាប់
លៅកណាត  បនទះស្រទាប់។ ទំហនំនការលមី្ ស្រទាបដ់ដ បរហ ញជាម្៊ុនអចស្តូវបានដករស្មួ្ ធំ្ជាង
លនះឬតូចជាងលនះលដីម្បបំីលរញចំណូ ចិតតរបរ់ នក។  

ស្ោន់ដតលធ្វីតាម្ការដណនាទំាងំលនះ៖ 

• រ៊ុករកលៅដផនកខាងសាត ខំាងល ី ននបនទះស្រទាប់ 
លហយីច៊ុចល ីស្រួញចងអ៊ុ លៅល វ្ង (បរហ ញខាង
លស្កាម្កន៊ុងស្ប ប់ស្កហម្)។ 

• រមូ្រច៊ុះលស្កាម្លៅទំហលំមី្ ជាម្៊ុន លហយីលស្ជីរ
លររីទំហដំដ  នកលរញចិតត (រូម្លមី្ រញ្ញ
ស្រួញស្កហម្)។ 

៣.២.៣. ការស្រគរ់ស្រគងស្រេទារ់ 

 នកនឹងលឃញីជលស្មី្រខាងលស្កាម្រស្មប់ស្គប់ស្គងស្រទាប់របរ់ នកលៅកន៊ុង GIMP លៅដផនក
ខាងលស្កាម្ននបនទះស្រទាប់ដូចបានបរហ ញខាងលស្កាម្។ 

1. បលងកីតស្រទាប់ថ្មីលដ្ឋយច៊ុចល ីរូបតំណាងទីមួ្យ (1)  
2. ជលស្មី្រទីរីរស្តូវបានលស្បីរស្មប់បលងកីតស្រទាប់ជាស្កុម្ (2) 

រូបភារទី ២.៤ ការកំណតភ់ារស្រអប់ 

រូបភារទី ២.៥ ជលស្មី្រននLayer Previews 
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3. ជលស្មី្ររីរបនាទ ប់ ន៊ុញ្ញ តឱ្យ នកផ្លល រ់
បតូរ ំដ្ឋប់ជង់ននស្រទាប់មួ្យ មិ្នថ្ន
ល ងីល ី ឬច៊ុះលស្កាម្ ទីតាងំមួ្យកន៊ុង
លរ ដតមួ្យកន៊ុងមួ្យច៊ុច (3) 

4. បនាទ ប់ម្ក ជលស្មី្រលនះនឹងចម្លងស្រទាប់រកម្មរបរ់ នក (4) 
5. លបីចាបំាច់  នកអចបញ្ចូ  ស្រទាប់រកម្មជាមួ្យស្រទាប់ខាងលស្កាម្ លដ្ឋយច៊ុចល ីរូប
តំណាងលនះ (5) 

6. រូបតំណាងតល៊ុក ដដ លមី្ លៅគួរឱ្យ រ់រំលណីចស្តូវបានលស្បីរស្មប់ការបលងកីតរបាងំ
ស្រទាប់ (6)  

7. ស្បរិនលបី នកដ ងស្តូវការស្រទាប់ជាក់ោក់មួ្យ លដ្ឋយច៊ុចល ីរូបតំណាង “x” នឹង ៊ុបវា
លចា  (7) 

៣.២.៤. ការរសងកើតស្រេទារ់លមី 

ដូចដដ បានលរៀបរប់រីម្៊ុន លដីម្បបីលងកីតស្រទាប់ថ្មីស្ោន់ដតច៊ុចល ីរូបតំណាងទីមួ្យលៅដផនក
ខាងលស្កាម្ននបនទះស្រទាប់ (#1 កន៊ុងរូបភារខាងល ី)។ ម្៊ុនលរ បញ្ច ប់ការបលងកីតស្រទាប់  នកស្បដហ 
ជាចង់លធ្វីការលស្ជីរលររីនូវជលស្មី្រមួ្យចំនួនលៅកន៊ុងបងអួចស្ប ប់ “New Layer” ដដ ល ចល ងី។  

ខាងលស្កាម្លនះគឺជាជលស្មី្រ និងការរិរណ៌ា នា ំរីនីមួ្យៗ៖ 

• លឈាម ះស្រទាប់ (Layer Name)៖ វា ន៊ុញ្ញ តឱ្យ នកបដនេម្លឈាម ះរស្មប់ស្រទាប់របរ់ នក
ដដ រិរណ៌ា នា ំរីលោ បំណងរបរ់វា។ 
ជាឧទាហរណ៍ ស្បរិនលបីស្រទាប់ដដ 
មនបំណងលស្បីគឺរស្មប់ការប៉ាះល ងីវញិ 
រូម្ដ្ឋក់លឈាម ះវាថ្ន "Retouch"។ វាមន
ស្បលោជន៍កន៊ុ ងការកំណត់ តតរញ្ញ ណ
រួកវាោ៉ា ងរយស្រួ  ស្បរិនលបី នកមន
ស្រទាប់ជាលស្ចីន។  

• សាល ករណ៌ា  (Color Tag)៖ ការបដនេម្រណ៌ា ោបល ីការលមី្ ស្រទាប់របរ់ នកអចជួយ នក
លរៀបចំរួកវាតាម្ស្បលភទ។ ឧទាហរណ៍ រណ៌ា លខ្ៀវអចតំណាងឱ្យស្រទាប់ដដ បានប៉ាះល ងី
វញិ រណ៌ា នបតងអចជាដបបដផនរិលររ។ ។ 

• ទស្ម្ង់ (Mode)៖  ន៊ុញ្ញ តឱ្យ នកលស្ជីរលររីស្បលភទននរលបៀបោយដដ បាន ន៊ុវតតចំល ះ
ស្រទាប់លនះ។ 

រូបភារទី ២.៦ ជលស្មី្រលៅល ីរបារស្រទាប់ 

រូបភារទី ២.៧ ការបលងកីតស្រទាប់ថ្មី 
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• តំបន់ោយ(Blend Space)៖ ជលស្មី្រលនះ គឺជាការកំណត់កស្មិ្តខ្ពរ់។  ំនាលំដីម្គឺ អ
ឥតលខាច ះលៅកន៊ុងសាេ នភារភាគលស្ចីន។ 

• ភារស្រអប់ (Opacity)៖ កំណត់កស្មិ្តភារថ្នល ននស្រទាប់របរ់ នក។ 
• ទទឹង + កម្ពរ់ (Width + Height)៖ កំណត់វមិស្តននស្រទាប់ថ្មីស្បរិនលបី នកចង់ឱ្យវាខ្៊ុរ
រីទំហផំ្លទ ងំស្កណាត់បចច៊ុបបនន។ 

•  ៊ុហវរិត X + Y (Offset X + Y)៖  នកអចដ្ឋក់មតិការបរ់ស្រទាបឱ់្យរេិតលៅកន៊ុងទីតាងំ
ជាក់ោក់មួ្យកន៊ុងផ្លទ ងំស្កណាត់របរ់ នកលដ្ឋយដករស្មួ្ ការកំណត់ទាងំលនះ។ 

• បំលរញជាម្យួ (Fill With)៖ មនជលស្មី្រស្បារំស្មប់ការបំលរញស្រទាប់ថ្មីរបរ់ នក
ជាមួ្យនឹងរណ៌ា រងឹ ភារថ្នល  ឬ ំនាលំដីម្។ 

• ការបដូរ (Switches)៖ កំណត់ជលស្មី្រស្គប់ស្គងស្រទាប់តាម្តស្មូ្វការ។ 

ជលស្មី្រទាងំ រ់លនះ ល ីកដ ងដត Fill With និងទំហ ំ(ទទឹង/កម្ពរ់) អចផ្លល រ់បតូរបានស្គប់
លរ  លដ្ឋយច៊ុចខាងសាត លំ ី Layer លហយីលស្ជីរលររី “Edit Layer Attributes”។ 

សតើរនាៃ ត់ដ្ឋន់ៗពណ៌សលឿងាអ្វី? 

 កខណៈរិលររមួ្យលៅកន៊ុង GIMP 
គឺបនាទ ត់ដ្ឋច់រណ៌ា ល ឿងជ៊ុំវញិស្រទាប់មួ្យ។ 
បនាទ ត់រណ៌ា ល ឿងលនះស្តវូបានលគសាា  ់ថ្នជា 
"ស្រំដដនស្រទាប់ (Layer Boundary)"  
ដដ វាមិ្នដម្នទា ់ដត នកបតូរទំហសំ្រទាប់ធំ្
ជាង ឬតូចជាងផ្លទ ងំស្កណាត់លទ លទីបវាអច
ល ចល ងី។ ដូលចនះស្បរិនលបី នកចង់បិទវា 
រូម្ ូរល ងីលៅល ីម្៊ុឺន៊ុយខាងល ី លហយី
លស្ជីរ View > Show Layer Boundary លដីម្បបីរហ ញ ឬោក់វា។ 

៣.២.៥. ការសរៀរនំស្រេទារ់ររេអ់្ៃកាស្រកុម (Group layer) 

លៅលរ  នកលធ្វីការល ីរូបភារ  នកនឹងចាប់   
លផតីម្បលងកីតស្រទាប់ជាលស្ចីន លដីម្បរីលស្ម្ចបាន ទធ
ផ ច៊ុងលស្កាយដដ  នកចង់បាន។ ចំនួនស្រទាប់
កាន់ដតលស្ចីនដដ  នកបលងកីត វានឹងកាន់ដតមនភារ
វកឹវរ និង ំហូរការររកាន់ដតយតឺ។ ដំលណាះស្សាយគឺ
ស្តូវដ្ឋក់ស្បលភទស្រទាប់ស្បហាក់ស្បដហ ោន ជាស្កុម្។ 

រូបភារទី ២.៨ បនាទ ត់ដ្ឋច់ៗរណ៌ា ល ឿង 

រូបភារទី ២.៩ ស្កុម្ស្រទាប់ 
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ដំបូង លដីម្បបីលងកីតស្រទាប់ជាស្កុម្ថ្មី រូម្ច៊ុចរូបតំណាងទីរីរលៅខាងលស្កាម្ននបនទះស្រទាប់។ 
ច៊ុចលទវដងល ីលឈាម ះ “Layer Group” លហយីដ្ឋក់ចំណងលជីងតាម្លនាះ។ 

លដីម្បបីដនេម្ស្រទាប់ខាងកន៊ុងស្កុម្ ស្ោន់ដត ូរ និងទមល ក់រួកវាលៅកន៊ុងវា។ ច៊ុចល ីស្រទាប់មួ្យ 
រងកត់ប ូត៊ុងកណដ៊ុ ររបរ់ នកច៊ុះ លហយី ូរវារីល ីស្កុម្ស្រទាប់។ លៅលរ ដដ  នកលឃញីលស្ោងជ៊ុំវញិវា 
រូម្ដ ងប ូត៊ុងកណដ៊ុ ររបរ់ នកលដីម្បទីមល ក់វា លហយីស្រទាប់នឹងស្តូវបានបដនេម្លៅស្កុម្។ លធ្វីដបបបទ
លនះម្តងលទៀតរស្មប់ស្គប់ស្រទាប់ដដ  នកចង់បដនេម្លៅស្កុម្លនាះ។ 

៣.២.៦. របាងំស្រេទារ់ (Layer Masks) 

ការលស្បីស្បារ់របាងំស្រទាប់ គឺជាជំនាញរំខាន់ដដ នឹងល ីកកម្ពរ់ការដករស្មួ្ របរ់ នក។
របាងំផដ ់ឱ្យ នកនូវការស្គប់ស្គងោ៉ា ងចារ់ោរ់ ំរីកដនលង ដដ ការដករស្មួ្ ស្តូវបាន ន៊ុវតតលៅកន៊ុង
រូបភាររបរ់ នក។ ដូលចនះ រូម្ចំណាយលរ លដីម្បលីរៀនរីរលបៀបលស្បីរបាងំស្រទាប់។ 

ជាឧទាហរណ៍ ឧបមថ្ន នកមនរូបបញ្ឈរ ដដ រណ៌ា ដរបកខ្៊ុររីធ្ម្មជាតិ។ កន៊ុងករណីលនាះ 
 នកអចបនេយការតិតេិភារលដ្ឋយលស្បីឧបករណ៍ Hue/Saturation tool ដូចបរហ ញខាងលស្កាម្៖ 

លទាះោ៉ា ងណាក៏លដ្ឋយ វានឹងដកតស្មូ្វ Saturation រស្មប់រូបភារទាងំមូ្ ។ ស្បរិនលបី នក
ចង់ោបដតល ីដរបកននរូបម្ន៊ុរសរបរ់ នក (និងរក់កន៊ុងករណីលនះ)  នកនឹងស្តូវលស្បី Layer Mask។  

 ន៊ុវតតតាម្ជំហានទាងំលនះ៖  

• ដំបូង ចម្លងស្រទាប់រូបភារ លហយីដ្ឋក់
លឈាម ះថ្មី។ លដីម្បបីតូរលឈាម ះវា រូម្ច៊ុចរីរ
ដងល ីលឈាម ះដដ មនស្សាប់ លហយីវាយ
បញ្ចូ  លឈាម ះថ្មី។ 

• លធ្វីការដកតស្ម្វូ saturation លៅតាម្តស្ម្វូ
ការ លដ្ឋយលស្បីឧបករណ៍ 
Hue/Saturation tool លដ្ឋយលស្ជីរលររី Colors > Hue-Saturation។ បនាទ ប់រីលធ្វីការដក
រស្មួ្  រូម្ច៊ុចប ូត៊ុង OK ។ 

• បដនេម្របាងំស្រទាប់ម្យួ លដ្ឋយច៊ុចល ីរូបតំណាង "clown" លហយីលស្ជីរលររី “Black” 
រស្មប់រណ៌ា ។ បនាទ ប់រីច៊ុចប ូត៊ុង "Add" ការដករស្មួ្ នឹងរោយបាត់។ 

• លដីម្បជួីរជ៊ុ ដរបក រូម្ចាប់យកឧបករណ៍ Paintbrush tool របរ់ នក (B) លហយី
កំណត់រណ៌ា នផទខាងម្៊ុខ្លៅជារណ៌ា រ។ ោបល ីដរបក លហយីការដករស្មួ្ នឹងស្តូវបាន
 ន៊ុវតត។ 

រូបភារទី ២.១០ ការកំណត់របាងំស្រទាប់ 
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វាជាលរឿងរំខាន់កន៊ុងការកត់រមា  ់លៅទីលនះ 
ថ្ន វីក៏លដ្ឋយដដ បរហ ញជារណ៌ា រលៅល ីរបាងំ ជា
ដផនកននស្រទាប់លនាះនឹងអចលមី្ លឃញី ឬបរហ ញ។ 
ជាមួ្យោន លនះ  វីដដ រណ៌ា លមម លៅល ីរបាងំនឹងស្តូវ
បានោក់។  

ស្បរិនលបី នកគូរលៅភារស្រអប់ទាប (lower 
opacity) (រណ៌ា ស្បលផះ) មនន័យថ្នវានឹងបរហ ញ
ដផនកទាងំលនាះននស្រទាប់លនាះ។  

 

 

 

 

៣.២.៧. ការរងវិលស្រេទារ់សែើមបតីស្រមង់ររូភាព 

លរ ខ្លះ ការទទួ បានរូបភារលផតក (ឬបញ្ឈរ) ឱ្យស្តង់រីកាលម្រ៉ាថ្តរូបអចជាបញ្ហ ស្បឈម្
មួ្យផងដដរ។ ប៉ា៊ុដនតក៊ុំបារម្ា បញ្ហ លនះស្តូវបានដករស្មួ្ ោ៉ា ងរយស្រួ លៅកន៊ុង GIMP ។ លដីម្បលីដ្ឋះ
ស្សាយបញ្ហ លនះ  នកអចបងវិ ស្រទាប់ដូចខាងលស្កាម្៖  

1. ដំបូង ស្តូវដ្ឋក់បនាទ ត់នា ំ(guide line) តាម្ទិរលៅលផតក លដីម្បជួីយ នកលរ បងវិ ។ ច៊ុច
ល ីបនាទ ត់លៅដផនកកំរូ  លហយី ូរវាច៊ុះលស្កាម្ លដីម្បបីដនេម្ការបរហ ញកន៊ុងទិរលៅលផតក 
(បនាទ ត់ដ្ឋច់ៗរណ៌ា លខ្ៀវដដ លឃញីកន៊ុងរូបភារខាងលស្កាម្)។ 

2. ឧបករណ៍ចាប់បងវិ  (Grab the Rotate Tool) (ផលូវកាត់កាត រច៊ុច Shift + R) លហយី
ច៊ុចល ីរូបភារលដីម្បលីធ្វីឱ្យឧបករណ៍
ដំលណីរការ។ 

3. លៅកន៊ុងឧបករណ៍ជលស្មី្រ (Tool 

Options) ( Windows > 

Dockable Dialogs > Tool 

Options) លស្ជីរលររី “Crop 

to Result” លៅលស្កាម្ម្៊ុឺន៊ុយ
Clipping drop-down។ 

ចំណា៖ំ ស្តូវស្បាកដថ្ន នកកំរ៊ុងោបល ីរបាងំ មិ្នដម្នស្រទាប់លទ។ ស្រួញស្កហម្ខាងល ីបរហ ញរី
របាងំ។ កត់រមា  ់លស្ោងរណ៌ា រលៅជ៊ុំវញិវា។ ស្បរិនលបីរូបភារតូចននរូបភារស្តូវបានគូរបញ្ា ក់
ជំនួរវញិ រូម្ច៊ុចរបាងំលដីម្បឱី្យវារកម្ម លហយីគំនូររបរ់ នកនឹង ន៊ុវតតលៅទីលនាះ។ 

 

រូបភារទី ២.១១ តំបន់របាងំស្រទាប់ 

រូបភារទី ២.១២ ការបងវិ ស្រទាប់ 
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4. ដកតស្ម្វូម្៊ុំរូបភារ តាម្តស្មូ្វការ លហយីច៊ុចប ូត៊ុងបងវិ  (Rotate) លៅលរ  នករកីរយ
នឹងការដកតស្មូ្វ។ 

៣.២.៨. រសរៀរភាា រ់ស្រេទារ់កៃងុ GIMP  

ស្បដហ ជាមនលរ មួ្យដដ  នកនឹងស្តូវផ្លល រ់ទី បងវិ  ឬផ្លល រ់បតូរទំហសំ្រទាប់លស្ចីនកន៊ុង
លរ ដំណា ោន  និងលរមីោន ។ ជា ក៊ុរ  ជាមួ្យ
នឹងកំដណបចច៊ុបបននរបរ់ GIMP វាមិ្នអចលស្ជីរ
លររីស្រទាប់លស្ចីនកន៊ុងលរ ដតមួ្យបានលទ។   

លដីម្បឈីានដ ់ចំណ៊ុ ចលនះ  នកអចភាា ប់
ស្រទាបរី់រ ឬលស្ចីនបញ្ចូ  ោន  លហយីដករស្មួ្ វា
តាម្ វីដដ  នកចង់បាន ។ ជាមួ្យោន លនះដដរ លដីម្បី
រមា  ់ស្រទាបថ់្នបានភាា ប់ រូម្ច៊ុចលៅខាងល វ្ង
ននការលមី្ រូបភារតូចរបរ់ស្រទាប់ (ខាងសាដ នំន
រូបតំណាងដភនក) លដីម្បបីដនេម្តំណ (លមី្ ស្ប ប់ស្កហម្កន៊ុងរូបភារខាងល ី លដីម្បដឹីង ំរីទីតាងំ
ចារ់ោរ់)។ លធ្វីដូចលនះរស្មប់ស្រទាប់នីមួ្យៗដដ  នកចង់ឱ្យកាល យជាដផនកមួ្យននតំណភាា ប់។ 

៣.២.៩. រសរៀរតស្រមឹមស្រេទារ់កៃងុ GIMP 

អថ្៌ាកំបាងំរស្មប់ការតស្មឹ្ម្ស្រទាប់លៅកន៊ុង GIMP គឺលដីម្បលីធ្វីឱ្យស្រទាប់ដដ  នកចង់តស្មឹ្ម្
តាម្ផ្លទ ងំស្កណាត់ (canvas) លហយីមិ្នដម្នជាផ្លទ ងំស្រទាប់លនាះលទ។ លនះគឺលដ្ឋយសារដតមិ្នអច
លស្ជីរលររីស្រទាប់លស្ចីនលៅកន៊ុងកំដណ GIMP បចច៊ុបបនន។ 

ជាដំបូង ស្តូវចាប់យកឧបករណ៍តស្មឹ្ម្ លដ្ឋយច៊ុច Q ជាផលូវកាត់កាត រច៊ុច។ លដីម្បដំីលណីរការ
ស្រទាប់ដដ ស្តូវតស្មឹ្ម្ ច៊ុចល ីមតិការបរ់វាលៅខាងកន៊ុងផ្លទ ងំស្កណាត់។  នកនឹងដឹងថ្នស្រទាប់ស្តូវ
បានលធ្វីឱ្យដំលណីរការ លៅលរ  នកលឃញីកាលរ ៉ាតូចមួ្យលៅស្ជុងនីមួ្យៗននមតិការបរ់ស្រទាប់លនាះ 
(រូម្លមី្ ខាងលស្កាម្)។ 

បនាទ ប់ម្ក លៅកន៊ុងឧបករណ៍ជលស្មី្រ 
ស្តូវស្បាកដថ្ន "Relative to" ស្តូវបាន
កំណត់លៅជា "ធាត៊ុទីមួ្យ (First Item)"។ 
លៅខាងលស្កាម្ម្៊ុឺន៊ុយទមល ក់ច៊ុះលនាះ ច៊ុចល ីរូប
តំណាង លដីម្បតីស្មឹ្ម្ស្រទាប់លៅតាម្ផ្លទ ងំ   
ស្កណាត់របរ់ នក។  

រូបភារទី ២.១៣ ការភាា ប់ស្រទាប់ 

រូបភារទី ២.១៤ ការតស្មឹ្ម្ស្រទាប់ 
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លដីម្បតីស្មឹ្ម្ស្រទាប់រីរឬលស្ចីនជាមួ្យោន លៅវញិលៅម្ក  នកនឹងស្តូវដំលណីរការស្រទាប់បដនេម្
លដីម្បតីស្មឹ្ម្។ ដូចរីម្៊ុន លធ្វីឱ្យស្រទាប់មួ្យដំលណីរការលដ្ឋយលស្បីឧបករណ៍តស្មឹ្ម្។ បនាទ ប់ម្ករងកត់
ស្ោប់ច៊ុច Shift របរ់ នក លហយីច៊ុចល ីស្រទាប់បដនេម្នីមួ្យៗ។ វាមនស្បរិទធិភារកន៊ុងការលស្ជីរលររី
ស្រទាប់ជាលស្ចីន។ ឥ ូវលនះ នកអចលស្បីជលស្មី្រតស្មឹ្ម្លៅកន៊ុងឧបករណ៍ជលស្មី្រលដីម្បតីស្មឹ្ម្ស្រទាប់
របរ់ នក។ 

៣.៣. ការថ្កថ្ស្ររច្ផ្ៃខាងសស្រកាយ េ 

GIMP គឺជាកម្មវធីិ្ដករស្មួ្ រូបភារដ៏មនអន៊ុភារ ដដ ផត ់នូវវធីិ្លផសងៗជាលស្ចីនលដីម្ប ី៊ុប
នផទខាងលស្កាយននរូបភារ។ ប៉ា៊ុដនតលតីមួ្យណាស្តឹម្ស្តូវកន៊ុងការលស្បីស្បារ់ លហយីលតីរួកលគដំលណីរការោ៉ា ង
ដូចលម្តច? លៅកន៊ុងដផនកលនះ លយងីនឹងរិនិតយលមី្ ការដកដស្បចំនួនស្បាមួំ្យ លដីម្បជួីយ នកកន៊ុងការចាប់   
លផតីម្។ រួកវានឹង ន៊ុញ្ញ តឱ្យ នកថ្តរូប និងលធ្វីឱ្យនផទខាងលស្កាយមនភារថ្នល  លដីម្ប ី៊ុបនផទខាងលស្កាយ 
ដូលចនះ នកអចបញ្ចូ  វាជាមួ្យរូបភារលផសងលទៀត។  

៣.៣.១. សធវើឱ្យច្ផ្ៃខាងសស្រកាយថាែ សៅកៃងុ GIMP 

លៅលរ  នកលបីករូបភាររលៅកន៊ុង GIMP តាម្ ំនាលំដីម្វាមិ្នមនការោសំ្ទដំលណីរការលធ្វីឱ្យរូប
ភារមនភារថ្នល លនាះលទ។ ស្បរិនលបី នកចង់លធ្វីឱ្យនផទខាងលស្កាយមនភារថ្នល  មន បចិសាម្ញ្ញចំនួន
រីរលដីម្បលីធ្វីវាឱ្យលកីតល ងី។  

1. ច៊ុចកណដ៊ុ រសាដ លំ ីស្រទាប់កន៊ុង 
Layers dock លហយីលស្ជីរ
លររី Add Alpha Channel 
ឬចូ លៅកាន់ Layer > 
Transparency > Add 
Alpha Channel ។ 

2. ចម្លងស្រទាប់នផទខាងលស្កាយលដ្ឋយច៊ុច Shift + Ctrl + D លៅល ី Windows ឬ Linux 
ឬ Shift + Cmd + D លៅល ី Mac ។ ឥ ូវ ៊ុបស្រទាប់នផទខាងលស្កាយលដីម្។ 

កន៊ុងករណីណាមួ្យខាងល ីលនះ  នកអចលធ្វីការលស្ជីរ បនាទ ប់ម្កច៊ុច Delete លដីម្បលីធ្វីឱ្យនផទ
ដដ បានលស្ជីរមនភារថ្នល ។ 

៣.៣.២. ផ្លែ េរ់តូរច្ផ្ៃខាងសស្រកាយាមួយច្ផ្ៃខាងមុខ 

លៅលរ ដដ  នកមនបំណងចង់ផ្លដ ច់រវាងនផទខាងម្៊ុខ្ (Foreground) និងនផទខាងលស្កាយ 
(Background)ននរូបភាររបរ់ នក GIMP មនឧបករណ៍ជា លស្ចីន ដដ អចឱ្យ នកលស្ជីរលររី          

រូបភារទី ២.១៥ ការកំណត ់Alpha Channel 
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បាន។ វាស្តូវបានលគលៅថ្ន Foreground Select Tool លហយី នកអចលស្បីវាលដីម្ប ី៊ុបនផទខាងលស្កាយ
លៅកន៊ុង GIMP។ ជាមួ្យ Foreground Select  នក
ស្ោន់ដតរលំ ច (highlight) នផទខាងម្៊ុខ្ លហយី 
GIMP កត់រមា  ់កដនលងដដ លៅរ ់។ 

1. លបីករូបភាររបរ់ នក ច៊ុចកណដ៊ុ រសាដ លំ ី
ស្រទាប់ លហយីលស្ជីរលររី Add Alpha 
Channel ។  

2. លស្ជីរលររី Foreground Select 
Tool  រចួគូរជ៊ុំវញិរូបភារដដ ជានផទខាងម្៊ុខ្លនាះ។  នកអចគូរជាបនាទ ត់ដតមួ្យ ឬច៊ុចបដនេម្
ជាចំណ៊ុ ចបនដបនាទ ប់ដដ បានតភាា ប់ោន ។  នកមិ្នចាបំាច់ចូ ជិតលរកលទ ប៉ា៊ុដនតកាន់ដតជិត
កាន់ដត អ។ ច៊ុច Enter លៅលរ រចួរ ់។ 

3.  ឧបករណ៍ជក់ (brush tool) រស្មប់
ជំហានបនាទ ប់។ ការកំណត់ទំហជំក់រម្
រម្យរស្មប់រូបភាររបរ់ នក បនាទ ប់ម្ក
គូរល ីរូបភារ ដដ ជានផទខាងម្៊ុខ្កន៊ុង
ទស្ម្ង់ជាបនាទ ត់ដតមួ្យ។ ក៊ុំដ្ឋក់រណ៌ា វា
ឱ្យលសាះ ស្ោន់ដតលធ្វីជាបនាទ ត់ដដ កាត់
រីល ីរណ៌ា  និងទឹកថ្នន លំផសងៗរបរ់រូប
ភារទាងំ រ់។ បនាទ ប់ម្កច៊ុច Enter 
ម្តងលទៀត។ 

4. បនាទ ប់រីរីរបីវនិាទី GIMP នឹងវភិាគរូបភារ និងបលងកីតជលស្មី្រដដ មនដតនផទខាងលស្កាយ
ប៉ា៊ុលណាណ ះ។ ន តាម្តស្មូ្វការលស្ជីរលររីលដ្ឋយលស្ជីរលររី Free Select Tool ។ កំណត់ 
Mode លៅជា Add to the Current Selection ឬ Subtract from the Current Selection 
បនាទ ប់ម្កគូរជ៊ុំវញិតំបន់ដដ  នកស្តូវការបដនេម្ ឬដកលចញ។ 

5. ច៊ុច Ctrl + I ឬ Cmd + I លដីម្បបីង្គ្ញ្ច រ
ជលស្មី្រ ដូលចនះនផទខាងម្៊ុខ្ស្តូវបានលស្ជីរ
លររីឥ ូវលនះ។ ច៊ុច Delete លហយី នក
នឹង ៊ុបនផទខាងលស្កាយលចញ។ 

6. បិទភាា ប់ (Paste ) នផទខាងលស្កាយថ្មី
របរ់ នកលៅល ីស្រទាប់ថ្មី លហយីដ្ឋក់វា
លៅលស្កាម្រូបភារលដីម្របរ់ នក លដីម្បី
បញ្ច ប់ការររ។ 

រូបភារទី ២.១៦ ការលស្ជីរ Foreground 

រូបភារទី ២.១៧ ការគូរលដ្ឋយឧបករណ៍ជក់ 

រូបភារទី ២.១៨ នផទខាងលស្កាយស្តូវបាន ៊ុប 
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៣.៣.៣. ឧរករណ៍សស្រនើនសទៀតសែើមបលីរុច្ផ្ៃខាងសស្រកាយសៅកៃងុ GIMP 

GIMP មនឧបករណ៍បីលផសងលទៀតដដ  នកអចលស្បីលដីម្បលីស្ជីរលររី លហយីបនាទ ប់ម្ក ៊ុបនផទ
ខាងលស្កាយននរូបភារមួ្យ។  វីដដ  នកគួរលស្បីគឺអស្រ័យលៅល ីថ្នលតីនផទខាងម្៊ុខ្ និងនផទខាងលស្កាយ
ស្តូវបានបំដបកលចញរីោន បាន អកស្មិ្តណា ឬថ្នលតី នកកំរ៊ុងលស្បី graphics tablets មួ្យ លដ្ឋយលស្បីប ិក 
ឬកណដ៊ុ រ។ 

ក. Fuzzy Select Tool 

ឧបករណ៍លនះនឹងលស្ជីរលររីដផនកដដ បានតភាា ប់ននរូបភារដដ មនរណ៌ា ដូចោន ។ 

1. ស្ោន់ដតច៊ុចល ីនផទននរូបភារ ដដ  នកចង់
លស្ជីរលររី លហយី GIMP នឹង ន៊ុវតដការររ
បនាទ ប់ 

2. កំណត់ Threshold  លៅតនម្លខ្ពរ់លដីម្បរីមួ្
បញ្ចូ  ជួររណ៌ា ស្រលដៀងោន  ឱ្យកាន់ដតលស្ចីន
កន៊ុងការលស្ជីរលររីរបរ់ នក ឬទាបជាងលដីម្បី
ឱ្យកាន់ដតចារ់។ 

ឧបករណ៍លនះដំលណីរការបាន អ លៅលរ ដដ រូបភារមននផទជាមួ្យនឹងរណ៌ា ដ្ឋច់ៗរីោន  
លហយីវាជាជលស្មី្រ អរស្មប់រចនារូបតំណាង និងlogos ជាជាងរូបថ្ត។ 

ខ. Scissors Select Tool 

Scissors Select Tool  ន៊ុញ្ញ តឱ្យ នកលស្ជីរលររី ក់កណាត  រវ័យស្បវតតិ និងផ្លដ ច់រូបភារនផទ
ខាងម្៊ុខ្លចញ ដូលចនះ នកអច ៊ុបនផទខាងលស្កាយបាន។ 

1. បដនេម្ Alpha Channel លៅកាន់រូបភារ 
2. លស្ជីរលររីយក Scissors Select Tool
បនាទ ប់ម្ក លៅកន៊ុង Tool Options លស្ជីរ
លររីយក Interactive boundary  

3. ច៊ុចលហយីដ ងលៅល ីដគម្រូបភារនផទខាង
ម្៊ុខ្ដដ  នកចង់លស្ជីរ។ លរ លនាះវានឹង
ទមល ក់ចំណ៊ុ ចយ៊ុថ្នក ល ីរូបភារ។ 

4. ផ្លល រ់ទីទរសន៍ស្ទនិចលៅស្ជុងមខ ងននវតេ៊ុ បនាទ ប់ម្កច៊ុចឱ្យជាប់។ បនាទ ត់មួ្យនឹងបរហ ញល ងី 
ដដ ភាា ប់លៅចំណ៊ុ ចយ៊ុថ្នក រីម្៊ុន ដដ បរហ ញរីដគម្ននការលស្ជីរលររីរបរ់ នក។ ស្បរិនលបី

រូបភារទី ២.១៩ Fuzzy Select Tool 

រូបភារទី ២.២០ Scissors Select Tool 

https://www.makeuseof.com/tag/graphic-tablets-graphics-programs-break-digital-cartoon-design/
https://www.makeuseof.com/tag/graphic-tablets-graphics-programs-break-digital-cartoon-design/


44 

បនាទ ត់លនះលធ្វីតាម្ដគម្របរ់រូបភារដដ  នកកំរ៊ុងរាោម្កាត់លចញ រូម្ដ ងប ូត៊ុងកណដ៊ុ រ 
លដីម្បបីលងកីតចំណ៊ុ ចយ៊ុថ្នក ថ្មី។ 

5. ស្បរិនលបីបនាទ ត់ដ្ឋច់លចញរីដគម្ននវតេ៊ុរបរ់ នក  ូរថ្យលស្កាយ ឬចំលហៀងរហូតដ ់វា
តស្ម្ង់ជួរស្តឹម្ស្តូវ។ គមល តខ្លីរវាងចំណ៊ុ ចយ៊ុថ្នក ជាធ្ម្មតាដំលណីរការ អជាង។ 

6. ឥ ូវលនះ ន៊ុវតដបនដរហូតដ ់ នកបានលស្ជីរលររីរូបភារនផទខាងម្៊ុខ្ទាងំមូ្ ។ ច៊ុច Enter
លដីម្បបីញ្ច ប់ការលស្ជីរលររី។ 

7. ជាច៊ុងលស្កាយ ច៊ុច Ctrl + I ឬ Cmd + I លដីម្បលីស្ជីរលររីនផទខាងលស្កាយ បនាទ ប់ម្ក
ច៊ុច Delete ។ 

គ. Pen Tool 

ដូចជា Scissors Select ដដរ Pen Tool ក៏ ន៊ុញ្ញ តឱ្យ នកលធ្វីការលស្ជីរលររីលដ្ឋយគូរបនាទ ត់
រវាងចំន៊ុចយ៊ុថ្នក ជាបនតបនាទ ប់។ លទាះោ៉ា ងណាក៏លដ្ឋយ ល ីកលនះ បនាទ ត់មិ្នភាា ប់ជាមួ្យវតេ៊ុដដ  នក
កំរ៊ុងលស្ជីរលររីលទ។ 

1. បដនេម្ Alpha Channel លៅរូបភាររបរ់ នក 
2. លស្ជីរលររី Pen Tool លហយីច៊ុចល ីដគម្នន
វតេ៊ុដដ  នកចង់លស្ជីរលររី។ លនះដ្ឋក់ចំណ៊ុ ច
យ៊ុថ្នក ដំបូង។ 

3. ឥ ូវលនះផ្លល រ់ទីទរសន៍ស្ទនិចលៅស្ជុងមខ ងនន
វតេ៊ុ លហយីច៊ុចម្តងលទៀតលដីម្បទីមល ក់ចំណ៊ុ ច
យ៊ុថ្នក ថ្មី។ ច៊ុចលហយីដ ងលដីម្បតីភាា ប់លៅ
ចំណ៊ុ ចយ៊ុថ្នក ម្៊ុនជាមួ្យនឹងបនាទ ត់ស្តង់ ច៊ុចលហយី ូរលដីម្បភីាា ប់ជាមួ្យបនាទ ត់លកាង។ ទិរ
លៅដដ  នក ូរនឹងកំណត់ជលស្ៅ និងម្៊ុំននដខ្សលកាង។ 

4. លធ្វីម្តងលទៀតរហូតដ ់ នកបានលស្ជីរលររីរូបភារនផទខាងម្៊ុខ្ទាងំមូ្ ។ លៅលរ  នកបញ្ច ប់
រូម្ច៊ុច Enter ។ 

5. ច៊ុច Ctrl + I ឬ Cmd + I លដីម្បដី្ឋក់បង្គ្ញ្ច រជលស្មី្រ បនាទ ប់ម្កច៊ុច Delete លដីម្ប ី៊ុបនផទ
ខាងលស្កាយលចញ។ 

មិ្នថ្នឧបករណ៍ណាដដ  នកលស្បីលទ ជាធ្ម្មតាវារយស្រួ កន៊ុងការបលងកីតការលស្ជីរលររីរបរ់
 នកថ្នលតីមួ្យណាតូចជាងរវាងនផទខាងម្៊ុខ្ ឬនផទខាងលស្កាយ ដូលចនះ នកនឹងមិ្នរូវលធ្វីការររលស្ចីនល ីការ
លស្ជីរលររីលនះ។ 

 

រូបភារទី ២.២១ Pen Tool 
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ឃ. លរុច្ផ្ៃខាងសស្រកាយពណ៌េសៅកៃងុ GIMP 

GIMP មនឧបករណ៍ឯកលទរដដ អចឱ្យ នក ៊ុបនផទខាងលស្កាយរណ៌ា រ។ វា អជារិលររ
រស្មប់ធាត៊ុស្កាហវកិដូចជា logos និងរូបតំណាង ដដ នផទខាងលស្កាយជារណ៌ា រ។ 

1. ជាមួ្យនឹងរូបភាររបរ់ នកលបីក រូម្
ចូ លៅកាន់ Layer > Transparency 
> Add Alpha Channel  

2. លស្ជីរលររី Colors > Color to Alpha 
។ វានឹងលបីកស្ប ប់ថ្មីមួ្យ។  

3. ច៊ុច dropper icon លៅជាប់ Color
បនាទ ប់ម្កច៊ុចល ីនផទខាងលស្កាយរណ៌ា
រកន៊ុងរូបភាររបរ់ នក។ លនះនឹងលធ្វីឱ្យ
នផទរណ៌ា រលៅជាថ្នល  លហយីស្បដហ ជាស្គប់ស្ោន់លហយី។ 

4. លដីម្បដីករស្មួ្ ជលស្មី្រ រូម្លស្ជីរលររី dropper លៅជាប់នឹង Transparency 
Threshold បនាទ ប់ម្កច៊ុចល ីនផទងងឹតបំផ៊ុតនននផទខាងលស្កាយដដ  នកចង់ ៊ុបលចញ។  នក
អចលស្បីវាលដីម្បលីររីតំបន់ដដ មនស្រលម តិចៗ ដូចជាកន៊ុងរូបថ្តបញ្ឈរជាលដីម្។ 

5. លស្ជីរលររី dropper លៅជាប់នឹង Opacity Threshold  បនាទ ប់ម្កច៊ុចល ីនផទស្សា បំផ៊ុត
ននវតេ៊ុខាងម្៊ុខ្។  

6. ច៊ុច OK លដីម្បបីញ្ច ប់។ 

ង. ផ្លែ េរ់តូរពណ៌ច្ផ្ៃខាងសស្រកាយសៅកៃងុ GIMP 

លដីម្បផី្លល រ់បតូររណ៌ា នផទខាងលស្កាយលៅកន៊ុង GIMP រូម្លស្បីដំលណីរការដូចោន ដដ លយងីបាន
រនយ ់លដីម្ប ី៊ុបនផទខាងលស្កាយរណ៌ា រលចញ 
ដដ បានបរហ ញលៅកន៊ុងដផនកខាងលដីម្។ 

ឥ ូវលនះបដនេម្មួ្យជំហានលទៀត លដ្ឋយ
បលងកីតស្រទាប់ថ្មី លហយីលស្បី Bucket Fill Tool 
លដីម្បបំីលរញវាជាមួ្យនឹងរណ៌ា  ដដ  នកស្តូវ     
ការ។ លៅកន៊ុង Layers dock រូម្ ូរស្រទាបថ់្មី
រីលស្កាម្ស្រទាបល់ដីម្ លដីម្បកំីណត់វាជានផទខាង
លស្កាយ។  

 

រូបភារទី ២.២២ កំណត់រណ៌ា លៅឱ្យ Alpha Channel 

រូបភារទី ២.២៣ ផ្លល រ់បតូររណ៌ា នផទខាងលស្កាយ 
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ន. លរុច្ផ្ៃខាងសស្រកាយសៅកៃងុ GIMP សដ្ឋយសស្ររើរបាងំ 

ជាច៊ុងលស្កាយ ស្បរិនលបី នកកំរ៊ុងោយរូបភារលស្ចីនជាមួ្យោន   នកស្បដហ ជាស្តូវ ៊ុបនផទខាង
លស្កាយននស្រទាប់ខាងល ីមួ្យ លដីម្បបីរហ ញ វីដដ លៅលស្កាម្។  នកអចលធ្វីវាបានោ៉ា ងល ឿនលដ្ឋយ
លស្បី របាងំ ។ 

1. លបីករូបភារទាងំរីររបរ់ នកលៅល ី
ស្រទាប់ដ្ឋច់លដ្ឋយដ កលៅកន៊ុងឯក
សារដូចោន ។ 

2. លស្ជីរលររីស្រទាប់ខាងល  ី លហយី
ច៊ុចប ូត៊ុង Masks លៅដផនកខាង
លស្កាម្នន Layers dock។ 
ច៊ុច Add លដីម្បបីដនេម្របាងំ។  

3. លស្ជីរលររី Brush tool លហយីកំណត់រណ៌ា លៅជា លមម  ។ 

4. ឥ ូវលនះចាប់លផតីម្គូរ ល ីស្រទាប់ខាងល ី។កដនលងដដ  នកោបរណ៌ា លមម  ស្រទាប់ខាងល ី
នឹងស្តូវបាន ៊ុប លហយីស្រទាប់ខាងលស្កាម្នឹងអចលមី្ លឃញី។ 

5. ស្បរិនលបី នកមនកំហ៊ុរ រូម្បតូររណ៌ា ជក់លៅជារណ៌ា រ។ ឥ ូវោបល នីផទលមម ននរបាងំ 
លហយីវានឹងលធ្វីឱ្យស្រទាបខ់ាងល ីលមី្ លឃញីម្ដងលទៀត។ 

 

 

 

 

 

 

 

 

 

រូបភារទី ២.២៤ ការកំណត់របាងំឱ្យនផទខាងលស្កាយ 
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េណួំររលំកឹសមសរៀន 

1- លៅលរ បលងកីតស្រទាប់ថ្មីលៅកន៊ុង GIMP លតី នកអចដកតស្មូ្វភារស្រអប់របរ់ស្រទាប់លដ្ឋយ
រលបៀបណា លដីម្បសី្គប់ស្គងភារលមី្ លឃញី និងការោយបញ្ចូ  ោន ននស្រទាប់ជាមួ្យនឹង
ស្រទាប់ខាងលស្កាម្? ចូរផត ់ឧទាហរណ៍ជាក់ដរតងននការលស្បីស្បារ់ការដកតស្មូ្វភារស្រអប់ 
លដីម្បរីលស្ម្ចបាននូវស្បរិទធិភារលមី្ លឃញីដដ ចង់បាន។ 

2- លតី នកអចបលងកីនស្បរិទធភារការកំណត់ការលមី្ ជាម្៊ុន និងលស្បីបលចចកលទរដូចជាការបស្ងួម្
ស្រទាប់ ឬការរមួ្បញ្ចូ  ោន លដីម្បដីក ម្អការ ន៊ុវតតលដ្ឋយមិ្នប៉ាះ  ់ដ ់ដំលណីរការដករស្មួ្ 
លដ្ឋយរលបៀបណា? 

3- ចូររិភាកា ំរី តេស្បលោជន៍ននការលស្បីស្បារ់ការលមី្ ថ្តជាម្៊ុន រស្មប់រការចនារម្ព័នធ
ស្រទាប់ចារ់ោរ់? 

4- លតី នកអចស្គប់ស្គងភារថ្នល ននស្រទាប់ និងការោយបញ្ចូ  ោន ស្បកបលដ្ឋយស្បរិទធភារលដ្ឋយ
រលបៀបណាដដ ដកតស្មូ្វភារស្រអប់ននស្រទាប់ និងបំលរញភារស្រអប់លៅលរ បលងកីត
ស្រទាប់ថ្មីលៅកន៊ុង GIMP? 

5- លតី នកអចលស្បីរបាងំស្រទាប់លដីម្បសី្គប់ស្គងភារលមី្ លឃញី និងការោយបញ្ចូ  ោន ននតំបន់
ជាក់ោក់លៅកន៊ុងរមរភារលដ្ឋយរលបៀបណា លៅលរ បលងកីតស្រទាប់ថ្មីលៅកន៊ុង GIMP? 

6- លតី នកអចស្គប់ស្គង ំដ្ឋប់ស្រទាប់ ស្កុម្ស្រទាប់ និងការដ្ឋក់លឈាម ះឱ្យស្កុម្ស្រទាប់ លដីម្បរីកា
ឋានាន៊ុស្កម្ស្រទាប់ចារ់ោរ់ និងលរៀបចំលដ្ឋយរលបៀបណា លៅលរ លធ្វីការជាមួ្យរមរ
ភារស្រទាប់រម៊ុគសាម ញលៅកន៊ុង GIMP? 

7- ស្រនម្លមី្ ថ្ន នកស្តូវផសរំូបភារជាលស្ចីនជាមួ្យនឹងកស្មិ្តភារខ្៊ុរដបលកោន ននភារថ្នល  និងភារ
លមី្ លឃញីលៅកន៊ុង GIMP។ លតី នកអចលស្បីស្រទាប់របាងំលដីម្បផីសរំូបភារោ៉ា ងរ ូនលដ្ឋយ
រលបៀបណា លដីម្បធីានាឱ្យមនការផ្លល រ់បតូររ ូន និងការបញ្ចូ  ោន ស្តឹម្ស្តូវ? រិភាកា ំរី
ដំលណីរការការររជាក់ដរតងរស្មប់ការបលងកីត និងដកតស្មូ្វរបាងំស្រទាប់កន៊ុងបរបិទលនះ។ 

8- លតី នកអចលធ្វីឱ្យនផទខាងលស្កាយននរូបភារមនភារថ្នល លៅកន៊ុង GIMP លដ្ឋយលស្បីឧបករណ៍ 
"Fuzzy Select" លដ្ឋយរលបៀបណា? រិរណ៌ា នា ំរីដំលណីរការមួ្យជំហានម្តងមួ្យៗននការ
លស្ជីរលររីនផទខាងលស្កាយ និងយកវាលចញលដីម្បបីលងកីតភារថ្នល ។ 

 
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សមសរៀនទី ៤៖ ស្ររអ្រ់ឧរករណ៍ និងការសធវើការាមួយរក ់

៤.១. ស្ររអ្រ់ឧរករណ៍ 

ស្ប ប់ឧបករណ៍គឺជាលបះដូងរបរ់ GIMP ។ លនះគឺជាដំលណីរកម្ានតដ៏រហ័រនន វីដដ  នកនឹង
រកលឃញីលៅទីលនាះ។ 

តាម្ ំនាលំដីម្ មនដតរូបតំណាងនផទខាងម្៊ុខ្ប៉ា៊ុលណាណ ះដដ 
អចលមី្ លឃញី។  នកអចបដនេម្រូបតំណាង Brush-Pattern-
Gradient និងរូបតំណាងរូបភាររកម្ម តាម្រយៈ Edit →

Preferences → Toolbox: Tools configuration.។ 

1. រូបតំណាងឧបករណ៍ (Tool icons)៖ រូបតំណាងទាងំ
លនះគឺជាប ូត៊ុង ដដ លធ្វីឱ្យដំលណីរការឧបករណ៍រស្មប់
លោ បំណងជាលស្ចីន ដូចជា ការលស្ជីរលររីដផនកននរបូ
ភារ ការគូររូបភារ ការបំដបលងរូបភារជាលដីម្។  

2. រណ៌ា នផទខាងម្៊ុខ្/នផទខាងលស្កាយ (Foreground/Background colors)៖   Foreground 
colors មនតួនាទីរស្មប់តំណាងឱ្យរណ៌ា របរ់នផទខាងម្៊ុខ្(Foreground)។ 
Background color មនតួនាទីរស្មប់តំណាងឱ្យរណ៌ា របរ់នផទខាងលស្កាយ
(Background)។ លយងីអចលធ្វីការឆ្ល រ់ោន រលវៀង Foreground/Background colors 
លដ្ឋយច៊ុច  កសរ “x”។ វាបានផត ់ភាររយស្រួ ដ ់ នកលស្បីស្បារ់កន៊ុងការផ្លល រ់បតូររណ៌ា
របរ់ Foreground/Background បានឆ្ប់រហ័យ និងភាររយស្រួ ។ 

3. ជក់/ ំនា/ំរណ៌ា ជស្ម  (Brush/Pattern/Gradient)៖ និមិ្តតរញ្ញ លៅទីលនះបរហ ញ នករី
ការលស្ជីរលររីបចច៊ុបបននរបរ់ GIMP រស្មប់៖ ជក់ថ្នន ោំប ដដ លស្បីលដ្ឋយឧបករណ៍ទាងំ
 រ់ដដ  ន៊ុញ្ញ តឱ្យ នកគូរល ីរូបភារ (“ គំនូរ ” រមួ្មនស្បតិបតតិការដូចជាការ ៊ុប និង
សាន ម្ស្បឡាក់ជាលដីម្) រស្មប់ ំនា ំដដ ស្តូវបានលស្បីកន៊ុងការបំលរញតំបន់ដដ បានលស្ជីរ

រូបភារទី ៤.១ ស្ប ប់ឧបករណ៍ 

https://docs.gimp.org/2.10/en/gimp-pimping.html#prefs-tools-config
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លររីននរូបភារ។ រស្មប់ Gradient ដដ ចូ ម្កល ងលៅលរ ណាដដ ស្បតិបតតិការតស្មូ្វ
ឱ្យមនជួររណ៌ា ដស្បស្បួ ោ៉ា ងរ ូន។ ការច៊ុចល ីរញ្ញណាមួ្យនននិមិ្តតរញ្ញ ទាងំលនះនឹង
បរហ ញបងអួចស្ប ប់ដដ  ន៊ុញ្ញ តឱ្យ នកផ្លល រ់បតូរវា។ 

4. រូបភាររកម្ម (Active Image)៖ លៅកន៊ុង GIMP  នកអចលធ្វីការជាមួ្យរូបភារជាលស្ចីនកន៊ុង
លរ ដតមួ្យ ប៉ា៊ុដនតលៅលរ ណាមួ្យ មនដតរូបភារមួ្យប៉ា៊ុលណាណ ះគឺ " រូបភាររកម្ម " ។ លៅ
ទីលនះ នករកលឃញីរូបតំណាងតូចមួ្យននរូបភាររកម្ម។ ច៊ុចរូបតំណាងលដីម្បបីរហ ញស្ប ប់
ដដ មនបញ្ា ីរូបភារដដ លបីកបចច៊ុបបនន ច៊ុចល ីរូបភារកន៊ុងស្ប ប់លដីម្បលីធ្វីឱ្យវារកម្ម។ ជា
ធ្ម្មតា  នកច៊ុចផ្លទ ងំរូបភារកន៊ុងទស្ម្ង់រហ៊ុបងអួច ឬផ្លទ ងំរូបភារកន៊ុងរលបៀបបងអួចដតមួ្យ លដីម្បី
លធ្វីឱ្យវាជារូបភាររកម្ម។ 

៤.២.  ស្ររអ្រ់រក ់

ស្ប ប់ " Brushes " ស្តូវបានលស្បីលដីម្បលីស្ជីរលររីជក់ រស្មប់លស្បី
ជាមួ្យឧបករណ៍គូរ។ ស្ប ប់លនះ ក៏ផត ់ឱ្យ នកនូវការចូ លស្បីម្៊ុខ្ររជា
លស្ចីនរស្មប់លរៀបចំជក់ផងដដរ។  នកអចលស្ជីរលររីជក់លដ្ឋយច៊ុចល ីវា
កន៊ុងបញ្ា ី បនាទ ប់ម្កវានឹងស្តូវបានបរហ ញកន៊ុងនផទ Brush/Pattern/
Gradient ននស្ប ប់ឧបករណ៍។  ម្កឥ ូវលនះ GIMP ម្កជាមួ្យនឹងជក់
ចំនួន 56 ដដ ខ្៊ុរោន រីោន លៅវញិលៅម្ក រីលស្ ះទំហ ំរមមស្ត និងម្៊ុំ
ននជក់នីមួ្យៗអចស្តូវបានកំណត់លៅកន៊ុងស្ប ប់ជលស្មី្រឧបករណ៍។  នក
ក៏អចបលងកីតជក់ផ្លទ  ់ខ្លួនលដ្ឋយលស្បី Brush Editor ឬលដ្ឋយការរកាទ៊ុក
រូបភារកន៊ុងទស្ម្ង់ឯកសារជក់រិលររ។  

 

 

រូបភារទី ៤.២ ស្ប ប់ជក់ 
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លៅដផនកខាងលស្កាម្ននស្ប ប់  នកលឃញីស្ោប់រកិំ  និងប ូត៊ុងមួ្យចំនួន៖ 

• គមល ត (Spacing)៖ ស្ោប់រកិំ លនះ ន៊ុញ្ញ តឱ្យ នក
កំណត់ចមា យរវាងរញ្ញ ជក់ជាប់ៗោន  លៅលរ  នក
គូររញ្ញ ជក់លដ្ឋយលស្បីស្រួញកណត៊ុ រ។ គមល តគឺជាភាគ
រយននទទឹងជក់។ 

• ដករស្ម្ ួជក់ (Edit Brush)៖ វាលធ្វីឱ្យ Brush Editor ដំលណីរការ។ ការច៊ុចប ូត៊ុងនឹងលបីក
ការដករស្មួ្ រស្មប់ជក់ណាមួ្យ។ លទាះោ៉ា ងណាក៏លដ្ឋយ វាដំលណីរការដតរស្មប់ជក់បា៉ា
រ៉ា ដម្៉ាស្តប៉ា៊ុលណាណ ះ រស្មប់ស្បលភទលផសងលទៀត ការដករស្មួ្ នឹងបរហ ញ នកនូវជក់ ប៉ា៊ុដនតមិ្ន
 ន៊ុញ្ញ តឱ្យ នកលធ្វី វីជាមួ្យវាលទ។ 

• ជក់ថ្មី (New Brush)៖ វាបលងកីតជក់បា៉ា រ៉ា លម្ស្ទិចថ្មី ចាប់លផតីម្វាជាមួ្យរងមូ្ តូចមិ្នចារ់ 
លហយីលបីក Brush Editor ដូលចនះ នកអចដកដស្បវាបាន។ ជក់ថ្មីស្តូវបានរកាទ៊ុកលដ្ឋយ
រវ័យស្បវតតិលៅកន៊ុង brushes ថ្តផ្លទ  ់ខ្លួនរបរ់ នក។ 

• ចម្លងជក់ (Duplicate Brush)៖ ប ូត៊ុងលនះស្តូវបានលបីក ៊ុះស្តាដតជក់ដដ បានកំរ៊ុងលស្ជីរ
លររីជាជក់បា៉ា រ៉ា ដម្៉ាស្ត។ លបីដូលចនះ ជក់ស្តូវបានចម្លង លហយីការដករស្មួ្ ជក់ស្តូវបានលបីក 
ដូលចនះ នកអចដកដស្បចាប់ចម្លងបាន។  ទធផ ស្តូវបានរកាទ៊ុកលដ្ឋយរវ័យស្បវតតិលៅកន៊ុង
brushesថ្តផ្លទ  ់ខ្លួនរបរ់ នក។ 

•  ៊ុបជក់ (Delete Brush)៖ ជលស្មី្រលនះគឺដំលណីរការរស្មប់ដតជក់បា៉ា រ៉ា ដម្៉ាស្តប៉ា៊ុលណាណ ះ។ វា
 ៊ុបដ្ឋនទាងំ រ់ននជក់ ទាងំលចញរីស្ប ប់និងថ្តដដ ឯកសាររបរ់វាស្តូវបានរកាទ៊ុក។  

• លធ្វីឱ្យជក់ស្ររ់ (Refresh Brushes)៖ ស្បរិនលបី នកបដនេម្ជក់លៅថ្តជក់ផ្លទ  ់ខ្លួនរបរ់
 នក ឬថ្តលផសងលទៀតលៅកន៊ុងផលូវដរវងរកជក់របរ់ នក លដ្ឋយម្លធ្ាបាយមួ្យចំនួនលស្ៅរី 
Brush Editor ប ូត៊ុងលនះលធ្វីឱ្យបញ្ា ីស្តូវផទ៊ុកល ងីវញិ ដូលចនះធាត៊ុថ្មីនឹងមនលៅកន៊ុងស្ប ប់។ 

• លបីកជក់ដូចរូបភារ (Open brush as image)៖ ជលស្មី្រថ្មីលៅកន៊ុង GIMP-2.10.10  នក
អចដករស្មួ្ រូបភារលនះ ចម្លងវា និងច៊ុច Edit > Paste as > New brush។  

៤.៣. ការសធវើការាមួយរក់ (Brushes) 

ជក់ គឺជា pixmap ឬរំណ៊ុំ នន pixmaps ដដ លស្បីរស្មប់ការគូរ ។ GIMP រមួ្បញ្ចូ  
នូវ " paint tools " ចំនួន 10 ដដ មិ្នស្តឹម្ដត ន៊ុវតតស្បតិបតតិការដដ ជាធ្ម្មតា នកនឹងគិតថ្នជាការ
គូរប៉ា៊ុលណាណ ះលទ ប៉ា៊ុដនតក៏មនស្បតិបតតិការលផសងលទៀតផងដដរ ដូចជាការ ៊ុប ការចម្លង ការលធ្វីឱ្យមនសាន ម្
ស្បឡាក់ ការបំភលឺ ឬលធ្វីឱ្យងងឹតជាលដីម្។ ឧបករណ៍ោបទាងំ រ់ ល ីកដ ងដត ឧបករណ៍ទឹកថ្នន  ំ(ink 

រូបភារទី ៤.៣ កំណត់ កខណៈរបរ់ជក់ 

https://docs.gimp.org/en/gimp-brush-dialog.html#gimp-brush-editor-dialog


51 

tool) លស្បីជក់ដូចោន ។ ជក់ pixmaps តំណាងឱ្យរញ្ញ
ដដ ស្តូវបានបលងកីតល ងីលដ្ឋយ "ការប៉ាះ (touches)" ដត
មួ្យ ននជក់លៅនឹងរូបភារ។ ជក់ដដ ជាធ្ម្មតាលធ្វីល ងី 
លដ្ឋយការរកិំ ស្ទនិច ល្ងកាត់រូបភារ លដ្ឋយលស្បីប ូត៊ុង
កណដ៊ុ រដដ រងកត់ច៊ុះលស្កាម្ បលងកីតជាលរ រនីនរញ្ញ ដដ 
មនគមល តតាម្គនលង តាម្វធីិ្ដដ បានបញ្ា ក់លដ្ឋយ   
 កខណៈននឧបករណ៍ជក់ និងឧបករណ៍ថ្នន ោំបដដ 
កំរ៊ុងលស្បីស្បារ់។ 

ជក់អចស្តូវបានលស្ជីរលររីលដ្ឋយច៊ុចល ីរូបតំណាងលៅកន៊ុង ស្ប ប់ Brushes ។ ជក់បចច៊ុបបនន 
(current brush) របរ ់GIMP ស្តូវបានបរហ ញលៅកន៊ុងនផទ Brush/Pattern/Gradient ននស្ប ប់     
ឧបករណ៍។ ការច៊ុចល ីនិមិ្តតរញ្ញ ជក់ មនវធីិ្មួ្យកន៊ុងការលធ្វីឱ្យស្ប ប់ Brushes ដំលណីរការ។ 

លៅលរ  នកដំល ងី GIMP វាភាា ប់ម្កជាមួ្យជក់ជាមូ្ ដ្ឋា នមួ្យចំនួន បូករមួ្ទាងំជក់ដ៏
ចដម្លកមួ្យចំនួនដដ បលស្មី្ជាចម្បង លដីម្បផីត ់ឱ្យ នកនូវឧទាហរណ៍នន វីដដ អចលធ្វីលៅបាន 
(ឧទាហរណ៍ ជក់ "លស្ម្ចនបតង (green pepper)" លៅកន៊ុងរូបភារខាងល ី)។  នកក៏អចបលងកីតជក់ថ្មី 
ឬទាញយករី ៊ុីនធឺ្ណិត លហយីដំល ងីរួកវា ដដ  GIMP នឹងសាា  ់រួកវាដដរ។ GIMP អចលស្បីជក់ជា
លស្ចីនស្បលភទ។ លទាះោ៉ា ងណាក៏លដ្ឋយ រួកវាទាងំ រ់ស្តូវបានលស្បីតាម្រលបៀបដូចោន  លហយីរស្មប់
លោ បំណងភាគលស្ចីន  នកមិ្នចាបំាច់ស្រួយបារម្ា ំរីភារខ្៊ុរោន លៅលរ  នកគូរជាមួ្យរួកលគ។ ខាង
លស្កាម្លនះគឺជាស្បលភទជក់ដដ មន៖ 

៤.៣.១. រក់ធមមតា (Ordinary brushes) 

ជក់ភាគលស្ចីនដដ ផាត់ផាង់ជាមួ្យ GIMP រេិតលៅកន៊ុងស្បលភទជក់ធ្ម្មតាលនះ។ រួកវាស្តូវបាន
តំណាងលៅកន៊ុងស្ប ប់ Brushes លដ្ឋយ pixmaps មស្តដ្ឋា នស្បលផះ។ លៅលរ  នកគូរលដ្ឋយលស្បីរួកវា 
រណ៌ា បចច៊ុបបនននននផទខាងម្៊ុខ្ (ដូចបរហ ញកន៊ុងនផទរណ៌ា ននស្ប ប់ឧបករណ៍) ស្តូវបានជំនួរលដ្ឋយរណ៌ា
លមម  លហយី pixmap ដដ បានបរហ ញលៅកន៊ុងស្ប ប់ជក់តំណាងឱ្យរញ្ញ រមា  ់ដដ ជក់បលងកីតលៅ
ល ីរូបភារ។  

លដីម្បបីលងកីតជក់ដបបលនះ  នកស្តូវបលងកីតរូបភារតូចមួ្យកន៊ុងកស្មិ្តរណ៌ា ស្បលផះ លដ្ឋយលស្បីការ     
រស្ងីក។ រកាទ៊ុកវាជាមួ្យនឹង extension ជា .gbr ។ ច៊ុចល  ី Refresh button លៅកន៊ុងស្ប ប់ជក់ 
លដីម្បទីទួ បានវាលៅកន៊ុងការលមី្ ជាម្៊ុនលដ្ឋយមិ្នចាបំាច់ចាប់លផតីម្ GIMP ល ងីវញិ ។ 

 

 

រូបភារទី ៤.៤ ស្បលភទលផសងៗននជក់ 

https://docs.gimp.org/2.10/en/gimp-brush-dialog.html
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៤.៣.២. រក់ពណ៌ 

ជក់លៅកន៊ុងស្កុម្ស្បលភទលនះ ស្តូវបានតំណាងលដ្ឋយរូបភាររណ៌ា លៅកន៊ុងស្ប ប់ Brushes។ រួក
វាអចជារូបភារ ឬ តេបទ។ លៅលរ  នកគូរជាមួ្យជក់ទាងំលនះ រណ៌ា ស្តូវបានលស្បីដដ ស្តូវបានបរហ ញ 
លហយីរណ៌ា បចច៊ុបបនននននផទខាងម្៊ុខ្ មិ្នទាក់ទងលនាះលទ។ ជាមួ្យោន លនះដដរ ជក់ទាងំលនះដំលណីរការដូច
ោន នឹងជក់ធ្ម្មតាដដរ។ 

លដីម្បបីលងកីតជក់ដបបលនះ  នកស្តូវបលងកីតរូបភារស្បលភទ RGBA តូចមួ្យ។ ជាមួ្យោន លនះដដរ រូម្
លបីករូបភារថ្មី លហយីលស្ជីរលររី RGB រស្មប់ស្បលភទរូបភារ និង Transparent រស្មប់ស្បលភទ
នផទ។ គូររូបភាររបរ់ នក លហយីរកាទ៊ុកវាជាឯកសារ .xcf លដីម្បរីកា កខណៈរម្បតតិរបរ់វា។ បនាទ ប់
ម្ករកាទ៊ុកវាជា ទស្ម្ង់ .gbr ។ ច៊ុចល ី ប ូត៊ុង Refresh កន៊ុងស្ប ប់ជក់ លដីម្បទីទួ បានជក់របរ់ នក
លដ្ឋយមិ្នចាបំាច់ចាប់លផតីម្ GIMP ល ងីវញិ ។ 

  រ័ត៌ាមនជំនយួ 

លៅលរ  នកលធ្វកីារចម្លង ឬកាត់លៅល ីការលស្ជីរលររី (selection)ណាមួ្យ  នកនឹងលឃញី 
contenct នន clipboard (លនាះគឺជាការលស្ជីរលររី) លៅទីតាងំដំបូងកន៊ុងស្ប ប់ជក់។ លហយី នកអច
លស្បីវារស្មប់គូរ។ 

៤.៣.៣. Image hoses / Image pipes 

ជក់លៅកន៊ុងស្កុម្ស្បលភទលនះ អចបលងកីតរញ្ញ
លស្ចីនជាងមួ្យស្បលភទលៅល ីរូបភារ។ រួកវាស្តូវបាន
ចងអ៊ុ បរហ ញលដ្ឋយ ស្តីលកាណស្កហម្តូចៗលៅស្ជុង
ខាងសាត ខំាងលស្កាម្ នននិមិ្តតរញ្ញ ជក់លៅកន៊ុងស្ប ប់ 
Brushes ។ ជួនកា  រួកវាស្តូវបានលគលៅថ្ន "ជក់
មនច នា (animated brushes)" រីលស្ ះរញ្ញ
ផ្លល រ់បតូរលៅលរ  នក ូរនូវររនរជក់។ ជាលោ 
ការណ៍ image hose brushes អចមន កខណៈទំលនីប ជារិលររស្បរិនលបី នកលស្បី tablet ផ្លល រ់  
បតូររូបរងដដ ជាម្៊ុខ្រររស្មប់ pressure ឬ angle ។ ។ លហយី វីដដ ផដ ់ឱ្យជាមួ្យ GIMP គឺ
មន កខណៈសាម្ញ្ញ (ប៉ា៊ុដនតលៅដតមនស្បលោជន៍)។ 

 

 

រូបភារទី ៤.៥ Image hoses / Image pipes 
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ឧទាហរណ៍ច្នការអ្នុវតដការរសងកើត Image pipes 

ការយករំណ៊ុំ ននរូបភារ និងបលងកីត
បំរង់រូបភារ (Image pipes) លចញរីរួក
វា គឺជាការកំណត់ទូលៅមួ្យ។ ម្លធ្ាបាយ
រយស្រួ បំផ៊ុតលដីម្បលីធ្វីដូលចនះ គឺបលងកីតរូប
ភារនីមួ្យៗដ្ឋច់រីោន ជាស្រទាប់ដ្ឋច់លដ្ឋយ
ដ កលៅកន៊ុងរូបភារមួ្យ លហយីស្បរិនលបី
 នកនឹងរកាទ៊ុករូបភារមនច នា  នកក៏អចលធ្វីវាបានដដរ។ ចូរចាប់លផតីម្ជាមួ្យការបលងកីររូបភារគស្មូ្
មួ្យដដ មន 8 ស្រទាប់។ កន៊ុងករណីលនះជាមួ្យនឹងល ខ្ 1 ដ ់ 8 លៅល ីស្រទាប់នីមួ្យៗ។  

លដីម្បចីាប់លផតីម្បលងកីតបំរង់រូបភារ  នកនឹងស្តូវរកាទ៊ុកឯកសារ extension ជា “.gih”។ លដីម្បី
លស្បីជក់ភាល ម្ៗ  នកស្បដហ ជាចង់រកាទ៊ុកវាលៅកន៊ុង brushes/subdir ននថ្ត GIMP របរ់ នក 
(ស្បដហ ជា ~/.gimp-2.4)។ លដីម្បរីកាទ៊ុករូបភារ  នកនឹងស្តូវបានបរហ ញជាមួ្យស្ប ប់រកាទ៊ុក
រស្មប់ កម្មវធីិ្ជំនួយ GIH ។ (រូបភារខាងល ី) 

រស្មប់រូបភារសាម្ញ្ញដូចលនះ តនម្លដតមួ្យគត់ដដ  នកស្តូវ
ផ្លល រ់បតូរគឺ "គមល ត (Spacing)" "ចំនួនស្កឡា (Number of Cells)" 
ចំនួន "ចំណាត់ថ្នន ក់ (Ranks)" និង "ការលស្ជីរលររី (Selection)" 
រស្មប់ចំណាត់ថ្នន ក់នីមួ្យៗ។ គមល ត គឺស្បហាក់ស្បដហ នឹងជក់ធ្ម្ម
តា។ វាបរហ ញរីភាគរយននទទឹងជក់ ឬកម្ពរ់ដដ ទរសន៍ស្ទនិចផ្លល រ់ទី
រវាងរ ់លរ ដដ ទស្ម្ង់ស្តូវបានបិទភាា ប់។ 

ចំណាត់ថ្នន ក់ បរហ ញរីកស្មិ្តននការដស្បស្បួ ដដ ស្តូវលស្បីលដ្ឋយ តនម្លលស្ជីរលររី ។ រស្មប់រូប
ភារលនះ តនម្លននចំណាត់ថ្នន ក់គួរដតលរមីនឹងចំនួនរូបភារលៅកន៊ុងជក់។ លដ្ឋយសារវាអចលធ្វីលៅបានលដីម្បី
ឱ្យមនបំរង់រហ៊ុវមិស្ត វាចាបំាច់ស្តូវមនវធីិ្លដីម្បកំីណត់ ំដ្ឋប់លស្ចីនជាងមួ្យ។ 

រស្មប់ឧទាហរណ៍លនះ លយងីនឹងលស្ជីរលររីលស្ជីរលររីរីចំណាត់ថ្នន ក់លដ្ឋយលស្បីវធីិ្សាង្គ្រត 
"បដនេម្"។ លនះមនន័យថ្នរូបភារនឹងស្តូវបានលស្ជីរលររីតាម្ ំដ្ឋប់ដដ រួកលគរេិតលៅកន៊ុងស្រទាប់។ 

ជលស្មី្រលផសងលទៀតរមួ្មន: 

• Random៖ លស្ជីរលររីរូបភារតាម្ ំដ្ឋប់នចដនយ។ 
• Angular៖ លស្ជីរលររីរូបភារលដ្ឋយដផអកល ីម្៊ុំដដ ជក់កំរ៊ុងផ្លល រ់ទី។ 
• Velocity៖ លស្ជីរលររីរូបភារលដ្ឋយដផអកល ីល បឿនដដ ជក់កំរ៊ុងលធ្វីច នា។ 

រូបភារទី ៤.៦ ជលស្មី្ររស្មប់ brush pipe 

រូបភារទី ៤.៧ ការគូរលដ្ឋយជក់ 
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• Pressure៖ លស្ជីរលររីរូបភារលដ្ឋយដផអកល ីរំ ធ្របរ់ជក់ (ស្តូវការលថ្លបលតដដ រយ
នឹងរំ ធ្) 

• xtilt៖ លស្ជីរលររីរូបភារលដ្ឋយដផអកល ី xtilt (ក៏ស្តូវការលថ្លបលតផងដដរ) 
• ytilt៖ លស្ជីរលររីរូបភារលដ្ឋយដផអកល ី ytilt (ក៏ស្តូវការក៊ុំរយូទ័របនទះផងដដរ) 

បនាទ ប់រីរកាទ៊ុករូបភារ  នកអច "Refresh" បញ្ា ីជក់ លហយីបនាទ ប់ម្កលស្ជីររូបភារថ្មី។  

៤.៣.៤. Parametric brushes 

មនជក់ជាលស្ចីនដដ បលងកីតល ងីលដ្ឋយលស្បី Brush Editor 
ដដ  ន៊ុញ្ញ តឱ្យ នកបលងកីតរូបរង  ជក់ជាលស្ចីនស្បលភទ លដ្ឋយលស្បី
ចំណ៊ុ ចស្បទាក់ស្កាហវកិ ( graphical interface) សាម្ញ្ញ។  កខណៈ
រិលររដ៏ អននជក់ស្បលភទលនះ គឺថ្នរួកវា អចផ្លល រ់បតូរទំហបំាន។       
វាអចលៅរចួ លដ្ឋយលស្បី Preferences dialog លដីម្បបីលងកីតការច៊ុច
ស្ោប់ច៊ុច ឬការបងវិ កង់កណដ៊ុ រ បណាត  ឱ្យជក់បចច៊ុបបននធំ្ជាង ឬតូច
ជាង ស្បរិនលបីវាជា Parametric brushes។  

៤.៤. ការរសងកើតរក់លមី 

• វធីិ្រីរោ៉ា ងលដីម្បបីលងកីតជក់ថ្មីោ៉ា ងរយស្រួ ៖ 

1. វធីិ្សាង្គ្រត " ល ឿន "៖  នកមននផទរូបភារដដ  នកចង់បលងកីតជក់រីវា លដីម្បលីស្បីជាមួ្យ
ឧបករណ៍ដូចជា លមម នដ ជក់ខ្យ ់... លស្ជីរលររីវាលដ្ឋយលស្បីឧបករណ៍លស្ជីរលររីរងចត៊ុ
លកាណដកង (ឬរងល  ីប) បនាទ ប់ម្កលធ្វីចាប់ចម្លងននជលស្មី្រលនះលហយី នកអចលមី្ 
លឃញីភាល ម្ៗ ។ ចាប់ចម្លងលនះលៅកន៊ុងទីតាងំដំបូង
ននស្ប ប់ Brush Dialog លហយីលឈាម ះរបរ់វា
គឺ "Clipboard " ។ ជាក់ថ្មីលនះនឹងអចលស្បីស្បារ់
បានភាល ម្ៗ។ ជក់លនះគឺស្តូវបានបលងកីតជាបលណាត ះ
អរនន។ វាបាត់លៅវញិលៅលរ  នកបិទ GIMP។ 
ជាមួ្យនឹង GIMP-2.10  នកអចលធ្វីឱ្យវា ចិនង្គ្នតយ៍
លដ្ឋយច៊ុចល ី Duplicate this brush លៅដផនក
ខាងលស្កាម្ននបនទះជក់។  

 

 

រូបភារទី ៤.៨ កំណត់ Parametric brushes 

រូបភារទី ៤.៩ ការបលងកីតជក់ថ្មី 

https://docs.gimp.org/2.10/en/gimp-brush-dialog.html#gimp-brush-editor-dialog
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2. វធីិ្សាង្គ្រតទីរីរគឺ អិត អន់ជាង៖ 

• រូម្ចូ លៅកាន់ File → New ជាមួ្យ
ឧទាហរណ៍ ទទឹង និងស្បដវង 35 ភីក
ដរ  លហយីកន៊ុងជលស្មី្រកស្មិ្តខ្ពរ់ 
Color Space កន៊ុង Gray Level និង Fill 
with: white  

• រស្ងីករូបភារថ្មីលនះ លដីម្បរីស្ងីកវា 
លហយីគូរល ីវាលដ្ឋយលស្បីលមម នដរណ៌ា លមម  

• រកាទ៊ុកវាលដ្ឋយលស្បី extension ស្បលភទ.gbr លៅកន៊ុងថ្ត /home/name_of_user/.confi
g/GIMP/2.10/brushes/  

• លៅកន៊ុងបងអួចស្ប ប់ Brushes ច៊ុចល ីប ូត៊ុង Refresh brushes   
•  លហយីជក់ដ៏ សាច រយរបរ់ នកល ចល ងីលៅកណាត  ននជក់លផសងលទៀត។  នកអចលស្បីវា
បានភាល ម្ៗ លដ្ឋយមិ្នចាបំាច់ចាប់លផតីម្ GIMP ម្តងលទៀត។  

៤.៥. ការរថ្នថមរក់លមី 

លដីម្បបីដនេម្ជក់ថ្មី បនាទ ប់រីបលងកីត ឬទាញយកវា  នកស្តូវរកាទ៊ុកវាជាទស្ម្ង់ដដ  GIMP អច
លស្បីបាន។ ឯកសារជក់ (brush file) ស្តូវដ្ឋក់កន៊ុងទីតាងំដដ ជាផលូវដរវងរកជក់របរ់ GIMP ដូលចនះ 
GIMP អចលធ្វី ិបិស្កម្ (index) និងបរហ ញវាលៅកន៊ុងស្ប ប់ Brushes។  នកអចច៊ុច ប ូត៊ុង Refresh 
ដដ លធ្វី ិបិស្កម្ថ្តជក់ល ងីវញិ។ GIMP លស្បីទស្ម្ង់ឯកសារបីរស្មប់ជក់៖ 

• GBR 

ទស្ម្ង់ .gbr(" gimp brush") ស្តូវ
បានលស្បីរស្មប់ជក់ធ្ម្មតា និងរណ៌ា ។  នកអច
បំដបលងរូបភារជាលស្ចីនស្បលភទលផសងលទៀត រមួ្ទាងំ
ជក់ជាលស្ចីន ដដ លស្បីលដ្ឋយកម្មវធីិ្លផសងលទៀត 
លៅជាជក់ GIMP លដ្ឋយលបីករួកវាកន៊ុង GIMP 
លហយីរកាទ៊ុករួកវាលដ្ឋយលឈាម ះឯកសារ ដដ 
បញ្ច ប់លដ្ឋយ .gbr។ វាបរហ ញស្ប ប់មួ្យដដ 
 នកអចកំណត់គមល ត ំនាលំដីម្រស្មប់ជក់។ ការរិរណ៌ា នាលរញល ញបដនេម្លទៀតននទស្ម្ង់
ឯកសារ GBR អចស្តូវបានរកលឃញីលៅកន៊ុងឯកសារ gbr.txt លៅកន៊ុង devel-docs ថ្តននការ
ដចកចាយស្បភរ GIMP ។  

 

 

រូបភារទី ៤.១០ ជក់ថ្មីស្តូវបានបលងកីតនិងលស្បីស្បារ់ 

រូបភារទី ៤.១១ កំណត់ spacing ឱ្យជក់ 
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• GIH 
ទស្ម្ង់ .gih(" gimp i mage h ose") ស្តូវបានលស្បី

រស្មប់ជក់ដដ មនច នា។ ជក់ទាងំលនះស្តូវបានបលងកីត
ល ងីរីរូបភារដដ មនស្រទាប់លស្ចីន ដដ ស្រទាប់នីមួ្យៗ
អចមនរូបរងជក់លស្ចីន ដដ លរៀបចំជាស្កឡាចស្តងាមួ្យ។
លៅលរ  នករកាទ៊ុករូបភារជាទស្ម្ង់ .gih  ស្ប ប់នឹងលកីត
ល ងី ដដ  ន៊ុញ្ញ តឱ្យ នករណ៌ា នា ំរីទស្ម្ង់ននជក់។       
រូម្លមី្  ស្ប ប់ GIH រស្មប់រ័ត៌ាមនបដនេម្ ំរីស្ប ប់។  

ទស្ម្ង់ GIH មនភាររម៊ុគសាម ញជាងលគ ដដ ការរិរណ៌ា នាលរញល ញអចស្តូវបានរក
លឃញីលៅកន៊ុងឯកសារ gih.txt លៅកន៊ុងdevel-docsថ្តននការដចកចាយស្បភរ GIMP ។  

• VBR 
ទស្ម្ង់ .vbr ស្តូវបានលស្បីរស្មប់ parametric brushes ល  គឺជក់ដដ បានបលងកីត

លដ្ឋយលស្បី Brush Editor។ រិតជាោម នម្លធ្ាបាយដ៏មនន័យលផសងលទៀត កន៊ុងការទទួ បាន
ឯកសារកន៊ុងទស្ម្ង់លនះលទ។ 
• MYB 

ទស្ម្ង់ .myb ស្តូវបានលស្បីរស្មប់ជក់ MyPaint ។ លដីម្បលីធ្វីឱ្យជក់អចលស្បីបាន រូម្
ដ្ឋក់វាលៅកន៊ុងថ្តមួ្យកន៊ុងផលូវដរវងរកជក់របរ់ GIMP ។ តាម្ ំនាលំដីម្ ផលូវដរវងរកជក់រមួ្មន
ថ្តរីរ ថ្តស្បរ័នធ brushes (system brushes folder) ដដ  នកមិ្នគួរលស្បី ឬផ្លល រ់បតូរដ្ឋច់
ខាត និង brushesថ្ត (brushes folder) លៅកន៊ុងថ្ត GIMP ផ្លទ  ់ខ្លួនរបរ់ នក។  នកអច
បដនេម្ថ្តថ្មីលៅផលូវដរវងរកជក់លដ្ឋយលស្បីទំរ័រ Brush Folders ននស្ប ប់ចំណូ ចិតត។ ឯកសារ 
GBR, GIH, ឬ VBR ណាមួ្យដដ បានរមួ្បញ្ចូ  លៅ
កន៊ុងថ្តលៅកន៊ុងផលូវដរវងរកជក់នឹងបរហ ញលៅកន៊ុងស្ប ប់ 
Brushes លៅលរ ដដ  នកចាប់លផតីម្ GIMP ឬលៅ
លរ ដដ  នកច៊ុចប ូត៊ុងលធ្វី Refresh លៅកន៊ុងស្ប ប់ 
Brushes។ 

៤.៦.ការផ្លែ េរ់តូរទំហរំក់ 

 នកអចផ្លល រ់បតូរទំហជំក់តាម្វធីិ្ជាលស្ចីន៖ 

1. លដ្ឋយលស្បី ស្ោប់រកិំ ទំហ ំ(Size slide) លៅកន៊ុងជលស្មី្រឧបករណ៍។  

2. លដ្ឋយលស្បីស្ោប់ច៊ុចផលូវកាត់ ំនាលំដីម្រស្មប់ការផ្លល រ់បតូរទំហឧំបករណ៍៖ 

• បនេយទំហ ំម្ដង 1កស្មិ្ត: [  

រូបភារទី ៤.១២ ការកំណត់ កខណៈ 

រូបភារទី ៤.១៣ ការផ្លល រ់បតូរទំហជំក់ 

https://docs.gimp.org/2.10/en/gimp-using-animated-brushes.html
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• បលងកីនទំហ ំម្ដង 1កស្មិ្ត: ]  
• បនេយទំហ ំម្ដ ង 1០កស្មិ្ត: {  
• បលងកីនទំហ ំម្ដង 10កស្មិ្ត: }  

3. លដ្ឋយលស្បីរកម្មភាររមូ្រកណដ៊ុ រ ំនាលំដីម្រស្មប់ការផ្លល រ់បតូរទំហឧំបករណ៍៖ 

• បនេយទំហ ំម្ដង 1កស្មិ្ត៖ Ctrl + Alt + Scrollwheel Down  
• បលងកីនទំហ ំម្ដង 1កស្មិ្ត៖ Ctrl + Alt + Scrollwheel Up  

៤.៧. ការសស្ររើស្របាេឧ់រករណ៍រក់សផ្េងៗ 

៤.៧.១. រក់ថាៃ លំារ (paintbrush) 

ឧបករណ៍ Paintbrush ស្តូវបានលស្បីស្បារ់រស្មប់ការគូរលដ្ឋយលស្បីជក់។ វាផត ់នូវដគម្ទន់
ជាងលបីលស្បៀបលធ្ៀបលៅនឹងឧបករណ៍ Pencil លហយីរ័កតិរម្រស្មប់ការបលងកីតបនាទ ត់រលោង និងដ្ឋក់
ស្រលម ។ 

ក. ែំសណើ រការរក់ថាៃ លំារ 

•  នកអចលៅឧបករណ៍ Paintbrush តាម្ ំដ្ឋប ់ំលដ្ឋយរីម្៊ុឺន៊ុយរូបភារ៖ 

 Tools → Paint Tools → Paintbrush 

• ឧបករណ៍ក៏អចលៅបានលដ្ឋយច៊ុចល ីរូបតំណាងឧបករណ៍ កន៊ុងស្ប ប់ឧបករណ៍ 

• ឬលដ្ឋយលស្បី ផលូវកាត់កាត រច៊ុច  P   ។ 

ខ. ស្រោរ់នុន (លនំាសំែើម) 

• បញ្ា (Ctrl)៖ ស្ោប់ច៊ុចលនះ ផ្លល រ់បតូរជក់ោបរណ៌ា លៅជា ឧបករណ៍លស្ជីរលររីរណ៌ា
(Color Picker)។ 

• បដូរ (Shift)៖ ស្ោប់ច៊ុចលនះលធ្វីឱ្យ Paintbrush លៅជាទស្ម្ង់បនាទ ត់ស្តង់។ ការច៊ុច Shift 
ឱ្យជាប់ ខ្ណៈលរ ច៊ុច Button 1 នឹងបលងកីតបនាទ ត់ស្តង់។ ការច៊ុចជាប់ោន នឹងបនតគូរបនាទ ត់
ស្តង់ដដ មនស្បភរលចញរីច៊ុងបនាទ ត់ច៊ុងលស្កាយ។ 

 

 

 

https://docs.gimp.org/2.10/en/gimp-tool-color-picker.html
https://docs.gimp.org/2.10/en/gimp-tool-color-picker.html
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គ.  រសស្រមើេឧរករណ៍ (Tool Options) 

ជាធ្ម្មតា ជលស្មី្រឧបករណ៍នឹងស្តូវបានបរហ ញកន៊ុងបងអួចដដ ភាា ប់លៅ
លស្កាម្ស្ប ប់ឧបករណ៍ភាល ម្ៗតាម្ដដ  នកលបីកឧបករណ៍។ ស្បរិនលបីជលស្មី្រ
ឧបករណ៍មិ្នបរហ ញលទ  នកអចចូ លស្បីរួកវារីរបារម្៊ុឺន៊ុយរូបភារតាម្រយៈ 
Windows → Dockable Windows → Tool Options ដដ លបីកបងអួច
ជលស្មី្រននឧបករណ៍ដដ បានលស្ជីរលររី។ តាម្រយៈ ស្ប ប់ជលស្មី្រឧបករណ៍
របរ់ជក់ោបថ្នន  ំ  នកអចលធ្វីការកំណត់ កខណៈលផសងកន៊ុងការលស្បីស្បារ់ជក់
ស្បលភទលនះ ដដ កន៊ុងលនាះមនជលស្មី្រលផសងៗដូចជា Mode, Opacity, Brush, 
Size, Aspect Ratio, Angle, Spacing, Hardness, Dynamics, Dynamics 
Options, Force, Apply Jitter, Smooth Stroke, Lock brush size to view   
និង Incremental ជាលដីម្។ 

៤.៧.២. រក់ MyPaint 

MyPaint គឺជាកម្មវធីិ្គំនូរឥតគិតនថ្លដដ ភាា ប់ម្កជាមួ្យជក់ជាលស្ចីន។ Libmypaint ស្តូវបាន
ដកដស្បកន៊ុងឆ្ន  ំ 2016 កន៊ុងទស្ម្ង់មួ្យដដ អចស្តូវបានលស្បីលដ្ឋយកម្មវធីិ្លផសងលទៀត។ GIMP 2.10 អច
លស្បីជក់ទាងំលនះបាន។  នកអចដរវងរកបណត៊ុ ំ ជាលស្ចីនននជក់ MyPaint លៅល ី ៊ុីនធឺ្ណិតកន៊ុងទស្ម្ង់
ដដ បានបរហ ប់ដដ ភាគលស្ចីនលៅកន៊ុងស្បលភទ .zip។  នកអចរនាល ឯកសារដដ  នកទទួ បាន លៅកន៊ុង
ថ្តឯកសារ។ 

ក. ការែំស ើងរក់ MyPaint 

ដំបូងចូ លៅ Preferences → Folders → MyPaint Brushes។ លៅទីលនាះ  នកនឹង
លឃញីផលូវលៅកាន់ថ្ត Mypaint ផ្លទ  ់ខ្លួនរបរ់ នក។ 

• រស្មប់ Linux៖ /home/YourUserName/.mypaint/brushes (ចំណា៖ំ វាជាថ្ត
ដដ ោក់) 

▪ លបីកកម្មវធីិ្រ៊ុករកឯកសាររបរ់ នក។ រិនិតយជលស្មី្រ "Show hidden files" ។ 
ចូ លៅកាន់ថ្ត MyPaint ផ្លទ  ់ខ្លួនរបរ់ នក។ ស្បរិនលបីវាមិ្នទាន់មនលៅ
ល យី  នកស្តូវដតបលងកីតវា លដ្ឋយមនថ្តជក់លៅខាងកន៊ុង។ 

▪ ចម្លង-បិទភាា ប់ឯកសារដដ រនាល ទាងំ រ់រីថ្តឯកសាររបរ់ នកលៅ៖ 
home/YourUserName/.mypaint/brushes 

រូបភារទី ៤.១៤ Tool Options 
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• រស្មប់ Windows 10៖ C:\Users\your-user-name\.mypaint\brushes។ ច៊ុចល ី
ធាត៊ុដដ បានទទួ លដីម្បលីស្ជីរលររីវា លហយីច៊ុចល ីរូបតំណាងដដ លបីកកម្មវធីិ្រ៊ុករក
ឯកសារ។ លៅកន៊ុង root ននថ្ត home របរ់ នក បលងកីត folder ថ្មី "mypaint"។ MyPaint 
path កន៊ុង Preferences កាល យជាC:\Users\your-user-name\mypaint។ 
ចម្លង-បិទភាា ប់ឯកសារដដ រនាល ទាងំ រ់រីថ្តឯកសាររបរ់ នកលៅ៖  
C:\Users\your-user-name\mypaint 

ខ.ែំសណើ រការរក់ MyPaint 

មន ទធភារលផសងៗោន កន៊ុងការលធ្វីឱ្យឧបករណ៍ដំលណីរការលដ្ឋយ៖ 

• តាម្រយៈម្៊ុឺន៊ុយរូបភារ៖ Tools → Paint Tools → MyPaint Brush 

• ឧបករណ៍ក៏អចលៅបានលដ្ឋយច៊ុចល ីរូបតំណាងឧបករណ៍៖  

• ឬលដ្ឋយច៊ុចល ី ផលូវកាត់កាត រច៊ុច  Y   

គ. រសស្រមើេឧរករណ៍ (Tool Options) 

ជលស្មី្រឧបករណ៍ ដដ មនអចស្តូវបានចូ លស្បីលដ្ឋយច៊ុចរីរ
ដងល ីរូបតំណាងឧបករណ៍ជក់ Mypaint  ។ ជលស្មី្រអចនឹងមន
រកម្មភារខ្៊ុរោន លដ្ឋយលោងលៅតាម្ជក់ MyPaint ដដ  នកលស្បី។ 

• ភារស្រអប់៖ លដីម្បកំីណត់ភារស្រអប់ននជក់ (0.0 - 
100.0) ។  

• ដខ្សរ ូន៖ ស្បរិនលបីជលស្មី្រលនះស្តូវបានធី្ក លនាះដខ្ស
ដដ គូរលដ្ឋយឧបករណ៍លនះនឹងកាន់ដតរ ូន។ មន
ជលស្មី្ររីរគឺ៖ 

o គ៊ុណភារ ៖ ជលស្ៅននការរលោង 

o ទំងន់៖ ទំនាញរបរ់ប ិក 

• ជក់៖ រូបតំណាងរបរ់ជក់ដដ កំរ៊ុងលស្បីស្បារ់ស្តូវបានបរហ ញ។ ស្បរិនលបី នកច៊ុចល ីវា 
បញ្ា ីជក់ MyPaint ស្តូវបានបរហ ញ លហយី នកអចលស្ជីរលររីជក់លផសងលទៀត។ លៅកន៊ុង 
របារខាងលស្កាម្ននស្ប ប់  នកមនប ូត៊ុងរស្មប់រូបតំណាងតូច ឬធំ្ លហយីលមី្ ជាបញ្ា ី ឬ
ជាស្កឡាចស្តងា។ ប ូត៊ុងខាងសាត បំំផ៊ុតគឺលដីម្បលីបីកស្ប ប់ MyPaint Brushes។  

រូបភារទី ៤.១៥ Tool Options 

https://docs.gimp.org/2.10/en/gimp-mypaint-brush-dialog.html
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•  ៊ុបលដ្ឋយលស្បីជក់៖ ស្បរិនលបីជលស្មី្រលនះស្តូវបានធី្ក ជក់នឹងលដីរតួជាជ័រ ៊ុប។ រស្មប់
ឧបករណ៍ Eraser តំបន់ដដ បាន ៊ុបមនភារថ្នល  ស្បរិនលបីមនស្រទាប់អ ់ហាវ  មន
រណ៌ា នផទខាងលស្កាយ ស្បរិនលបីមិ្នមនស្រទាប់អ ់ហាវ ។ 

• កា៖ំ លដីម្បកំីណត់កានំនជក់។ 
• ភារស្រអប់មូ្ ដ្ឋា ន៖ តនម្លទាងំលនះ (0.00 - 

2.00) គឺជាកតាត គ៊ុណ។ ឧទាហរណ៍ ស្បរិនលបី
 នកកំណត់ជលស្មី្រលនះលៅ 0.50 ភារស្រអប់
 តិបរមនឹងកាល យលៅជា 100 X 0.50 = 50 
លទាះបីជាវាលៅដតជា 100.0 លៅកន៊ុងជលស្មី្រភារស្រអប់ក៏លដ្ឋយ។ 

• ភារដឹត៖ ជក់កាន់ដតដឹត នាឱំ្យជក់លនាះកាន់ដតចារ់។ លៅលរ  នកកាត់បនេយភារ     
ដឹតជក់ Mypaint ស្បដហ ជាមិ្នដំលណីរការលទ ស្បរិន លបីទំហជំក់តូចលរក។ 

៤.៧.៣. រក់ថ្ររថ្ផ្នពិសេេ (Special effects brush) 

ជក់ទាងំលនះស្តូវបានបលងកីតល ងី លដីម្បោីបលៅ
តាម្លោ បំណងរបរ់ នក។ រួកលគនឹងបលងកីតដបបដផន
រិលររលផសងៗលៅលរ  នកគូរ ឬគូរបនាទ ត់ជាមួ្យរួកលគ។ 
បនាទ ត់ដដ  នកលឃញីកន៊ុងរូបភារលមី្ ជាម្៊ុន គឺជា វីដដ 
ជក់លមី្ លៅដូចដដ  នកគូរលដ្ឋយលស្បីស្បារ់ជក់លនាះ ដដ 
រមួ្បញ្ចូ  ទាងំដបបដផនស្បលភទ grungy, overlapping 
circles, various glowing dots, splotches, glitters និង
ស្បលភទលផសងៗលទៀត។  

ឧបករណ៍ដករូបភារដ៏មនអន៊ុភាររបរ់ GIMP រឹងដផអកោ៉ា ងខាល ងំល ីជក់រស្មប់ភារបត់
ដបន និងរយស្រួ បដូរតាម្បំណង។ ខ្ណៈលរ ដដ  នកអច បលងកីតជក់ផ្លទ  ់ខ្លួនរបរ់ នក លហត៊ុ វី
បានជាចំណាយលរ បលងកីតជក់ដដ បានបលងកីតល ងីវញិ? ស្បលភទជក់ដបបដផនរិលររទាងំ រ់លនះ 
លយងីអចទាញយករី ៊ុីនធឺ្ណិត លដីម្បដំីល ងីលស្បីស្បារ់ជាមួ្យ GIMP ដដ ស្កុម្ជក់ទាងំលនាះរេិតកន៊ុង
ទស្ម្ង់ ABR។  

ក. ស្ររសេទរក់ថ្ររថ្ផ្នពិសេេខែះៗ 

• Effect Brushes 

ស្បរិនលបី នកជា នកថ្តរូបបញ្ឈរ  នកស្បដហ ជាដឹងោ៉ា ងចារ់ ំរីរលបៀបដដ  ំរូ 
លភលីងអចជះឥទធិរ  ល ីការបរហ ញរបរ់ នក ំរីរូបភារលោ លៅរបរ់ នក។ ដកវដភនកជាបងអួច

រូបភារទី ៤.១៦ ការកំណត់ទំហរំបរ់ជក់ 

រូបភារទី ៤.១៧ ឧទាហរណ៍ននជក់ដបបដផនរិលររ 

https://thegimptutorials.com/how-to-make-brushes/
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រស្មប់បរហ ញអរម្មណ៍ ឬក៏ វីដដ លគចង់និោយ។ ជក់រិលររ
ទាងំលនះ ន៊ុញ្ញ តឱ្យ នកបលងកីតដបបដផនចាប់រនលឺលផសងៗ បានោ៉ា ង
រយស្រួ  លដ្ឋយមិ្នស្តូវការឧបករណ៍បំភលឺ   លផសងៗោន ដ៏ធំ្ និង
មនតនម្លនថ្លលទ។  

 នកអចទាញយកកញ្ច ប់ជក់ដបបដផនរិលររ លដ្ឋយមិ្ន
គិតនថ្ល រស្មប់ការលស្បីស្បារ់ផ្លទ  ់ខ្លួន ឬចំណាយស្បាក់តិចតួច
រស្មប់អជ្ាប័ណណឥតគិតនថ្ល។កន៊ុងលនាះផងដដរ ObsidianDawn ក៏មនបណត៊ុ ំ ដ៏ធំ្ននជក់ GIMP 
លផសងលទៀតដដ រិតជាមនតនម្លកន៊ុងការលមី្ ។  

• Flourishes 

Redheadstock មនធាត៊ុមួ្យចំនួនលៅកន៊ុងបញ្ា ីននជក់ 
GIMP លនះលហយីជាមួ្យនឹងលហត៊ុផ ដ៏ អ។ បណាណ  ័យដ៏ធំ្នន
ជក់មិ្នលរញល ញលទ លបីោម នការរកីដ៊ុះដ្ឋ និងគំនិតនចនស្បឌិ្ត
កន៊ុងការបលងកីតជក់ដបបដផនរិលររជាលស្ចីនទស្ម្ង់ លហយីវតេ៊ុទាងំ
លនះអចស្តូវបានផសតំាម្វធីិ្លផសងៗ លដីម្បបីលងកីតការរចនាដបលកៗ
ទាងំស្រុង។  នកក៏អចទាញយកកញ្ច ប់លរញល ញននជក់ដបប
ដផនរិលររ លៅល ី DeviantArt ឬ ទិញអជ្ាប័ណណរស្មប់ការ
លស្បីស្បារ់ដដ មិ្នគួរឱ្យទ៊ុកចិតត។  

• Gradient Shapes 

Gradient Shapes គឺជា កខណៈរិលររមួ្យននការ
រចនាទាងំឡាយ ដដ ហាក់ដូចជាមិ្នបាត់លៅវញិ ប៉ា៊ុដនតការោសំ្ទ 
gradient ដដ ភាា ប់ម្កជាមួ្យរបរ់ GIMP គឺមន កខណៈជា
មូ្ ដ្ឋា នបនតិច។ រស្ងីករម្តេភាររបរ់ នកជាមួ្យនឹងកញ្ច ប់នន
ជក់រណ៌ា  Gradient ចំនួន 13 រី Fresh eMedia លដ្ឋយឥតគិត
នថ្លរស្មប់ការលស្បីស្បារ់ផ្លទ  ់ខ្លួន និង ណិជាកម្ម។  

• Unstable Brushes 

ខ្្៊ុ ំមិ្នស្បាកដថ្នខ្្៊ុំស្ោន់ដតស្រោញ់លឈាម ះ ឬរណ៌ា  
និងវាយនភារដដ បានលស្បីកន៊ុងរូបភារតូច ដដ ទាក់ទាញខ្្៊ុំ
ល ីកញ្ច ប់លនះលទ ប៉ា៊ុដនតវាអចបលងកីតរូបរង រូបីដ៏ស្ររស់ាអ ត
មួ្យចំនួន។  នកអចរកបានលដ្ឋយឥតគិតនថ្លលៅល ី 
DeviantArt  នកបលងកីតជក់ Axelraider70 ក៏មនកញ្ច ប់ជក់
ដដ រយស្រួ លស្បី GIMP លផសងលទៀតដដ មនផងដដរ។  

រូបភារទី ៤.១៩ Flourishes brush 

រូបភារទី ៤.២០ Gradient Shapes 

រូបភារទី ៤.២១ Unstable Brushes 

រូបភារទី៤.១៨ Effect Brushes 

https://www.deviantart.com/redheadstock/art/Flourishes-Photoshop-and-GIMP-Brushes-536911509
https://www.obsidiandawn.com/flourishes-photoshop-gimp-brushes
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ខ. ការែំស ើងរក់ថ្ររថ្ផ្នពិសេេ 

ការដំល ងីជក់ថ្មីរបរ់ នកលៅកន៊ុង GIMP 
គឺរយស្រួ ដូចការទាញយករួកវាដដរ។  នក
អចរនាល  (extract) រួកវាលៅកន៊ុងថ្តផ្លទ  ់ខ្លួន
លៅល ីក៊ុំរយូទ័ររបរ់ នក លដីម្បរីយស្រួ ចូ 
លស្បី លហយីស្បាប់ GIMP កដនលងដដ ស្តូវរករួក
វា ឬ នកអចដ្ឋក់ឯកសារជក់ លៅកន៊ុងថ្តជក់នន
ការដំល ងី GIMP របរ់ នកជាស្បាជំំហាន។  

1. លស្ជីរលររីកញ្ច ប់ជក់រីបញ្ា ីខាងល ី លហយីទាញយកវារីលគហទំរ័ររបរ់វចិិស្តករ។ កញ្ច ប់
ជក់ភាគលស្ចីនអចរកបានជាឯកសារ ដដ បានបរហ ប់ ដូលចនះលបីកវាលៅកន៊ុងកម្មវធីិ្ដដ  នក
លស្ជីរលររី។ ទ៊ុកបងអួចលនះឱ្យលបីករស្មប់លរ លនះ លហយីលយងីនឹងស្ត ប់ម្កវញិលៅលរ 
លស្កាយ។  

 

2. លបីក GIMP លហយីលបីក Preferences window រី 
Edit menu (ដរវងរកវាលៅកន៊ុងម្៊ុឺន៊ុយកម្មវធីិ្ GIMP 
លៅល ី macOS)។  

 

 

3. លៅកន៊ុងសាល បស្រិ ខាងល វ្ងនន Preferences 

window រូម្រមូ្រលដីម្បដីរវងរកថ្ត លហយីច៊ុច
រូបតំណាង + លដីម្បរីស្ងីកវា។ លស្ជីរលររី 
Brushes រីបញ្ា ី Folders ដដ បានរស្ងីក 
លហយី GIMP នឹងបរហ ញទីតាងំទាងំ រ់ដដ 
វារិនិតយ Brush កំ ៊ុងលរ ចាប់លផតីម្។  

4. លស្ជីរលររីថ្តឯកសារ ដដ បានរមា  ់ថ្នអចររលររបាន ដដ គួរដតជាថ្ត GIMP 
ផ្លទ  ់ខ្លួនរបរ់ នកលស្បីរស្មប់ដំល ងីជក់ GIMP ថ្មីណាមួ្យ លហយីច៊ុចប ូត៊ុង Show file 

location in the file manager លៅខាងសាត ខំាងល ី។ 

រូបភារទី ៤.២២ File របរ់ជក់ដបបដផនរិលររ 

រូបភារទី ៤.២៣ Preferences window 

រូបភារទី ៤.២៤ លស្ជីរលររីជក់រីបញ្ា ី folders 
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5. បងអួចថ្មីលបីកបរហ ញថ្តBrushes ដដ បានលស្ជីរលររី។ ស្ត ប់
លៅបងអួចដដ មនឯកសារបរហ ប់របរ់ នក លហយី ូរនិង
ទមល ក់ឯកសារជក់រីបងអួចលនាះលៅកន៊ុងបងអួច Brushes ដដ  នក
លទីបដតលបីក។  

តាម្រយៈការ ន៊ុវតដទាងំលនះ លយងីនឹងរនាល រួកវាលចញរីឯកសារ
ដដ បានបរហ ប់លៅកន៊ុងថ្ត Brushes រចួរ ់រស្មប់លស្បីស្បារ់។ 

គ. តំណភាា រ់មួយនំនួនសែើមបទីាញយករក់ថ្ររថ្ផ្នពិសេេ 

ខាងលស្កាម្លនះ ជាតំណភាា ប់មួ្យចំនួនដដ  នកអចដរវងរក burhes ឥតគិតនថ្លរបរ់ នក
រស្មប់ការទាញយក។  នកស្តូវរមូ្រច៊ុះលស្កាម្ទំរ័រលដីម្បដីរវងរកតំណទាញយក។ ជក់ភាគលស្ចីនស្តូវបាន
ខ្ចប់ជាឈ៊ុត។  នកអចអន ំរីជក់ និង វីដដ រួកលគលធ្វីលៅល ីទំរ័រទាញយក។ 

o http://hawksmont.deviantart.com/art/GIMP-Floral-I-56478361 

o http://hawksmont.com/blog/gimp-brushes-floral-part-2/ 

o http://hawksmont.com/blog/gimp-brushes-pine-mega-pack/ 

o http://project-gimpbc.deviantart.com/art/GIMP-Vector-Foliage-Plants-
69681357 

o http://hawksmont.com/blog/gimp-brushes-moon/ 

o http://hawksmont.com/blog/gimp-brushes-snowflakes/ 

o http://project-gimpbc.deviantart.com/art/GIMP-Water-Brushes-62663732 

o http://hawksmont.com/blog/gimp-brushes-butterflie 
http://shiranui.deviantart.com/art/Autumn-Glory-100431092 s-part-i/ 

o http://shiranui.deviantart.com/art/Autumn-Glory-100431092 

o http://browse.deviantart.com/resources/applications/gimpbrushes/?alltime=y
es&order=9 

o http://browse.deviantart.com/resources/applications/gimpbrushes/?alltime=y
es&order=9#/art/Night-2-GIMP-BRUSHES-fullview-
121867399?_sid=145749c0 

o http://www.smashingapps.com/2012/01/05/60-high-quality-free-gimp-brush-
packs.html 

រូបភារទី ៤.២៥ ជក់លផសងៗ 

http://hawksmont.deviantart.com/art/GIMP-Floral-I-56478361
http://hawksmont.com/blog/gimp-brushes-floral-part-2/
http://hawksmont.com/blog/gimp-brushes-pine-mega-pack/
http://project-gimpbc.deviantart.com/art/GIMP-Vector-Foliage-Plants-69681357
http://project-gimpbc.deviantart.com/art/GIMP-Vector-Foliage-Plants-69681357
http://hawksmont.com/blog/gimp-brushes-moon/
http://hawksmont.com/blog/gimp-brushes-snowflakes/
http://project-gimpbc.deviantart.com/art/GIMP-Water-Brushes-62663732
http://hawksmont.com/blog/gimp-brushes-butterflie%20http:/shiranui.deviantart.com/art/Autumn-Glory-100431092%20s-part-i/
http://hawksmont.com/blog/gimp-brushes-butterflie%20http:/shiranui.deviantart.com/art/Autumn-Glory-100431092%20s-part-i/
http://shiranui.deviantart.com/art/Autumn-Glory-100431092
http://browse.deviantart.com/resources/applications/gimpbrushes/?alltime=yes&order=9
http://browse.deviantart.com/resources/applications/gimpbrushes/?alltime=yes&order=9
http://browse.deviantart.com/resources/applications/gimpbrushes/?alltime=yes&order=9#/art/Night-2-GIMP-BRUSHES-fullview-121867399?_sid=145749c0
http://browse.deviantart.com/resources/applications/gimpbrushes/?alltime=yes&order=9#/art/Night-2-GIMP-BRUSHES-fullview-121867399?_sid=145749c0
http://browse.deviantart.com/resources/applications/gimpbrushes/?alltime=yes&order=9#/art/Night-2-GIMP-BRUSHES-fullview-121867399?_sid=145749c0
http://www.smashingapps.com/2012/01/05/60-high-quality-free-gimp-brush-packs.html
http://www.smashingapps.com/2012/01/05/60-high-quality-free-gimp-brush-packs.html
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o http://www.1stwebdesigner.com/freebies/40-free-gimp-brushes/ 

o http://www.gimp.org/tutorials/Custom_Brushes/ 

 ជក់មនរូបរង និងទំហលំផសងៗ ដដ ភាគលស្ចីនអចស្តូវ
បានដកតស្មូ្វរស្មប់ទំហជំក់ រណ៌ា  និងភារស្រអប់។  នកអច
បដនេម្ររក ស្រះអទិតយ និងភរនានាលៅកន៊ុងរូបថ្តរបរ់ នក ឬ
បលងកីតរូបភារដ៏ សាច រយរស្មប់ការរបាយផ្លទ  ់ខ្លួនរបរ់ នក។ 

 

 

 
  

រូបភារទី ៤.២៦ រូបរងននជក់លផសងៗ 

http://www.1stwebdesigner.com/freebies/40-free-gimp-brushes/
http://www.gimp.org/tutorials/Custom_Brushes/
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េណួំររលំកឹសមសរៀន 

1- លតី នកអចដកតស្មូ្វទំហ ំ (size) និងភាររងឹ (hardness) របរ់ជក់លដ្ឋយរលបៀបណា 
លដីម្បរីលស្ម្ចបាននូវកស្មិ្តននភារជាក់ោក់ខ្៊ុរៗោន ? រិរណ៌ា នា ំរីជំហានជាក់ដរតង 
លដីម្បដីកដស្បទំហជំក់ និងការកំណត់ភាររងឹ លដីម្បបំីលរញតស្មូ្វការជាក់ោក់របរ់ នក។ 

2- លៅលរ លធ្វីការជាមួ្យគំនូរឌី្ជីថ្  ឬការដករូបថ្តលៅកន៊ុង GIMP លតី នកអចនាចូំ  និង
ដំល ងីការកំណត់ជាម្៊ុនរបរ់ជក់ថ្មីលៅកន៊ុង Brush Box លដ្ឋយរលបៀបណា?  

3- លតី នកអចបលងកីតជក់ផ្លទ  ់ខ្លួនដដ ជាការបលងកីតជក់ថ្មីរបរ់ នកលដ្ឋយរលបៀបណា? រនយ ់
រីជំហានជាក់ដរតង លដីម្បបីលងកីតជក់ថ្មីមួ្យលៅកន៊ុងស្ប ប់ជក់។ 

4- លតី នកអចលស្បីការកំណត់ភារស្រអប់របរ់ជក់លៅកន៊ុង GIMP លដីម្បបីលងកីតការផ្លល រ់បតូរ
រណ៌ា លដ្ឋយរ ូនលដ្ឋយរលបៀបណា? 

5- លតីលៅកន៊ុង GIMP មនជក់ប៉ា៊ុនាម នស្បលភទ? ចូរលរៀបរប់លឈាម ះនិង កខណៈរិលរររបរ់
ស្បលភទជក់នីមួ្យៗ។ 

6- លតី នកអចលស្បីផលូវកាត់កាត រច៊ុចលដីម្បបិីទលបីករវាងឧបករណ៍ជក់លផសងោន លៅកន៊ុង GIMP ដូច
ជា Paintbrush ោ៉ា ងដូចលម្តច? រិរណ៌ា នា ំរីបនសគំនលឹះជាក់ដរតង ឬផលូវកាត់លដីម្បបីតូររវាង
ឧបករណ៍ជក់ោ៉ា ងរហ័រ ខ្ណៈលរ ដដ កំរ៊ុងលធ្វីការល ីទិដាភារលផសងៗននសាន នដ
រិ បៈឌី្ជីថ្  ឬការដករស្មួ្ រូបថ្តរបរ់ នក។ 

7- លតី នកអចលស្បីស្បារ់ជលស្មី្រឧបករណ៍ជក់ (tool options) លៅកន៊ុង GIMP លដីម្បដីក
រស្មួ្ ភារស្រអប់ននជក់របរ់ នកលដ្ឋយរលបៀបណា? រិភាកា ំរីជំហានជាក់ដរតង 
លដីម្បដីកតស្មូ្វភារស្រអប់ននស្រទាប់កន៊ុងសាន នដរិ បៈរបរ់ នក។ 

8- លតី នកអចដរវងរកជក់ដបបដផនរិលររ ដដ ស្តូវបានរចនាល ងីស្សាប់ោ៉ា ងរិលររ
រស្មប់លស្បីកន៊ុង GIMP ោ៉ា ងដូចលម្តច?  

9- លតីជំហាន វីខ្លះលដីម្បទីាញយក និងដំល ងីជក់ដបបដផនរិលររដដ ទទួ បានរី ៊ុីនធឺ្  
ណិតលៅកន៊ុង GIMP? 

 
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សមសរៀនទី ៥៖ ការសធវើការាមយួឧរករណ៍សស្ររើេសរ ើេ 

៥.១. លកេណៈទូសៅ 

ឧបករណ៍លស្ជីរលររីស្តូវបានរចនាល ងី លដីម្បលីស្ជីរលររីតំបន់រីស្រទាប់រកម្ម (active layer) 
ដូលចនះ នកអចលធ្វីការល ីរួកវា លដ្ឋយមិ្នប៉ាះ  ់ដ ់តំបន់ដដ មិ្នបានលស្ជីរលររី។ ឧបករណ៍
នីមួ្យៗមន កខណៈរម្បតតិផ្លទ  ់ខ្លួនរបរ់វា ប៉ា៊ុដនតឧបករណ៍លស្ជីរលររីក៏មនជលស្មី្រ និងម្៊ុខ្ររមួ្យ
ចំនួនដូចោន ដដរ។  កខណៈទូលៅទាងំលនះស្តូវបានរិរណ៌ា នាលៅទីលនះ លហយីបំដរបំរ ួស្តូវបានរនយ ់
លៅកន៊ុងដផនកខាងលស្កាម្រស្មប់ឧបករណ៍នីមួ្យៗជារិលររ។  

មនឧបករណ៍លស្ជីរលររីចំនួនស្បារីំរ៖ 

• Rectangle Select 

• Ellipse Select 

• Free Select (the Lasso) 

• Select Contiguous Regions 

(the Magic Wand)  

• Select by Color 

• Select Shapes from Image (Intelligent Scissors)  

• Foreground Select 

៥.២. ស្រោរ់នុន (លនំាសំែើម) 

ជលស្មី្រម្៊ុខ្រររបរ់ឧបករណ៍លស្ជីរលររីស្តូវបានផ្លល រប់តូរ ស្បរិនលបី នករងកត់ឱ្យជាប់នូវស្ោប់
ច៊ុច Ctrl, Shift , និង/ឬ Alt ខ្ណៈលរ ដដ  នកលស្បីរួកវា។ 

• បញ្ា (Ctrl)៖ លៅលរ កំរ៊ុងលធ្វីការលស្ជីរលររី ការច៊ុចស្ោប់ច៊ុចបញ្ា  (Ctrl )ឱ្យជាប់ អច
មនរកម្មភាររីរលផសងោន លោងលៅតាម្វធីិ្ដដ  នកលស្បីវា៖ 
o ការច៊ុចឱ្យជាប់នូវស្ោប់ច៊ុច ខ្ណៈលរ ដដ គូរ ការជលស្មី្របិទលបីកការលស្ជីរលររី 

" រស្ងីករីកណាត   " ។ 
o ស្បរិនលបី នកច៊ុចឱ្យជាប់នូវ ស្ោប់ច៊ុចបញ្ា  (Ctrl) ម្៊ុនលរ គូរជលស្មី្រ ជលស្មី្រថ្មីលនះ
បតូរលៅជា Subtract mode។ ដូលចនះ ជលស្មី្រថ្មីលនះនឹងស្តូវបានដកលចញរីជលស្មី្រ
ដដ មនស្សាប់ភាល ម្ៗលៅលរ ដដ  នកបញ្ច ប់បលញ្ចញការច៊ុច។ 

• ជំនរួ (Alt )៖ ការច៊ុច Alt ឱ្យជាប់ នឹង ន៊ុញ្ញ តឱ្យមនច នារស្មប់ វីដដ  នកកំរ៊ុង
លស្ជីរលររី (មនដតរ ៊ុម្របរ់វា មិ្នដម្នមតិការបរ់វាលទ)។ ស្បរិនលបីរូបភារទាងំមូ្ 
ស្តូវបានផ្លល រ់ទីជំនួរឱ្យការលស្ជីរលររី រូម្សាក បង Shift + Alt ។ រូម្ចំណាថំ្ន លរ 
ខ្លះស្ោប់ច៊ុចជំនួរ (Alt ) ស្តូវបានសាទ ក់ចាប់លដ្ឋយស្បរ័នធ Windows (មនន័យថ្ន GIMP

រូបភារទី ៥.១ ស្បលភទលផសងៗននឧបករណ៍លស្ជីរលររី 

https://docs.gimp.org/en/gimp-tool-ellipse-select.html
https://docs.gimp.org/en/gimp-tool-free-select.html
https://docs.gimp.org/en/gimp-tool-fuzzy-select.html
https://docs.gimp.org/en/gimp-tool-fuzzy-select.html
https://docs.gimp.org/en/gimp-tool-by-color-select.html
https://docs.gimp.org/en/gimp-tool-iscissors.html
https://docs.gimp.org/en/gimp-tool-foreground-select.html


67 

មិ្នដដ ដឹងថ្នវាស្តូវបានច៊ុចលទ) ដូលចនះវាអចនឹងមិ្នដំលណីរការរស្មប់ម្ន៊ុរសស្គប់ោន
លទ។ 

• បដូរ(Shift)៖ លៅលរ បលងកីតការលស្ជីរលររី ការច៊ុចស្ោប់ច៊ុច បតូរ (Shift) ឱ្យជាប់ អចមន
រកម្មភាររីរលផសងោន លោងលៅតាម្វធីិ្ដដ  នកលស្បីវា៖ 

o ស្បរិនលបី នកច៊ុចស្ោប់ច៊ុចបតូរ (Shift) ឱ្យជាប់ ម្៊ុនលរ ច៊ុច (click) លដីម្បចីាប់លផតីម្កា
រលស្ជីរលររី ការលស្ជីរលររីលនះនឹងរេិតលៅកន៊ុង  Addition mode រហូតដ ់រល  នក
ច៊ុចស្ោប់ច៊ុច។ 

o ស្បរិនលបី នកច៊ុចស្ោប់ច៊ុចបតូរ (Shift) ឱ្យជាប់  បនាទ ប់រីច៊ុច លដីម្បចីាប់លផតីម្ការលស្ជីរ
លររី ឥទធិរ នឹងអស្រ័យល ីឧបករណ៍ដដ  នកកំរ៊ុងលស្បី៖ ឧទាហរណ៍ ការលស្ជីរលររី
នឹងជាកាលរ ៉ាដដ មនឧបករណ៍លស្ជីរលររីចត៊ុលកាណ។ 

• បញ្ា  (Ctrl) + បដូរ (Shift)៖ ការលស្បី Ctrl + Shift រមួ្ោន អចលធ្វីកិចចការលផសងៗបាន 
អស្រ័យល ីឧបករណ៍ណាដដ ស្តូវលស្បី។ ជាទូលៅចំល ះឧបករណ៍លស្ជីរលររីទាងំ រ់គឺថ្ន 
រលបៀបលស្ជីរលររីនឹងស្តូវបានបតូរលៅជាចំន៊ុចស្បររវ ដូលចនះបនាទ ប់រីស្បតិបតតិការស្តូវបាន
បញ្ច ប់ ការលស្ជីរលររីនឹងមនចំន៊ុចស្បររវននតំបន់ដដ បានតាម្ដ្ឋនជាមួ្យនឹងជលស្មី្រ
ដដ មនស្សាប់។ វាគឺជា ំហាត់រស្មប់ នកអនលដីម្បលី ងជាមួ្យបនសលំផសងៗដដ មន
លៅលរ លធ្វីការលស្ជីរលររី ខ្ណៈលរ រងកត់ Ctrl + Shift លហយីដ ងទាងំរីរ ឬម្៊ុននឹង
បលញ្ចញ Mouse Left Button។ 

• បញ្ា  (Ctrl )+ ជំនរួ ( Alt ) + ច៊ុចកណដ៊ុ រល វ្ង និង ូរ លហយីនិង បដូរ ( Shift )+ ជំនរួ 
( Alt ) + ច៊ុចកណដ៊ុ រល វ្ង និង ូរ ស្តូវបានលស្បីលដីម្បផី្លល រ់ទីជលស្មី្រ។  

• Space bar៖ ការច៊ុច Space bar ខ្ណៈលរ កំរ៊ុងលស្បីឧបករណ៍លស្ជីរលររី បំដបលង
ឧបករណ៍លនះលៅជា Navigation  ដដ  ន៊ុញ្ញ តឱ្យ នករ៊ុញជ៊ុំវញិរូបភារជំនួរឱ្យការលស្បី
របាររមូ្រ លៅលរ ដដ របូភាររបរ់ នកធំ្ជាងផ្លទ ងំស្កណាត់។ លនះគឺជាជលស្មី្រ ំនាលំដីម្ 
លៅកន៊ុង Preferences/Image Windows  នកអចបិទលបីក Space bar លៅ Move tool។ 

៥.៣. ស្ររសេទសផ្េងៗច្នឧរករណ៍សស្ររើេសរ ើេ 

៥.៣.១.ការសស្ររើេសរ ើេាទស្រមង់នតុសកាណ (Rectangle Selection) 

ឧបករណ៍លស្ជីរលររីទស្ម្ង់ចត៊ុលកាណស្តូវបានរចនាល ងី លដីម្បលីស្ជីរលររីតំបន់ចត៊ុលកាណនន  
ស្រទាប់រកម្ម វាជាឧបករណ៍លស្ជីរលររីសាម្ញ្ញបំផ៊ុត ប៉ា៊ុដនតស្តូវបានលស្បីស្បារ់ជាទូលៅបំផ៊ុត។ 



68 

ឧបករណ៍លនះ ក៏ស្តូវបានលស្បីស្បារ់រស្មប់បរហ ញរងចត៊ុលកាណ
ដកងលៅល ីរូបភារផងដដរ។ លដីម្បបីរហ ញរងចត៊ុលកាណដដ 
បំលរញលដ្ឋយរណ៌ា  រូម្លធ្វីការលស្ជីរលររីជារងចត៊ុលកាណមួ្យ 
លហយីបនាទ ប់ម្កបំលរញរណ៌ា វាលដ្ឋយលស្បី  Bucket Fill Tool
។ លដីម្បបីលងកីតលស្ោងរងចត៊ុលកាណ វធីិ្សាង្គ្រតសាម្ញ្ញបំផ៊ុត និង
អចបត់ដបនបានបំផ៊ុត គឺបលងកីតលស្ជីរលររីជារងចត៊ុលកាណ លហយី
បនាទ ប់ម្កកំណត់រ ូម្ឱ្យវា។ 

ក. រសរៀរសស្ររើស្របាេឧ់រករណ៍សស្ររើេសរ ើេ 

 នកអចចូ លស្បីឧបករណ៍លស្ជីរលររីតាម្វធីិ្លផសងៗោន ៖ 

• បារម្៊ុឺន៊ុយរូបភារ (image menu bar) Tools → Selection Tools → Rectangle 

Select 
• លដ្ឋយច៊ុចល ីរូបតំណាងឧបករណ៍  លៅកន៊ុងស្ប ប់ឧបករណ៍ 
• លដ្ឋយលស្បីផលូវកាត់កាត រច៊ុច  R  

ខ. រសស្រមើេឧរករណ៍ (Tool Options) 

ជាធ្ម្មតា ជលស្មី្រម្៊ុខ្ររបដនេម្ននឧបករណ៍នឹងស្តូវបានបរហ ញកន៊ុងផ្លទ ងំដដ ភាា ប់លៅលស្កាម្
ស្ប ប់ឧបករណ៍  ភាល ម្ៗលរ  នកលបីកឧបករណ៍។ ស្បរិនលបីរួកវាមិ្នមនលទ  នកអចចូ លបីកបរហ ញ
រួកវារីរបារម្៊ុឺន៊ុយរូបភារតាម្រយៈ Windows → Dockable Windows → Tool Options ដដ លបីក
ផ្លទ ងំជលស្មី្រននឧបករណ៍ដដ បានលស្ជីរលររី។ 

• Mode, Antialiasing, Feather edges៖ ជលស្មី្រលស្ជីរលររីទូ
លៅ។ 

• Rounded corners៖ ស្បរិនលបី នកលបីកជលស្មី្រលនះ ស្ោប់រកិំ 
ល ចល ងី។  នកអចលស្បីវាលដីម្បដីកតស្មូ្វកាដំដ លស្បីលដីម្បបីងាត់
ស្ជុងននជលស្មី្រ។ 

• Expand from center៖ ស្បរិនលបី នកលបីកជលស្មី្រលនះ ចំណ៊ុ ច 
ដដ ការលស្ជីរលររីស្តូវបានចាប់លផតីម្លដ្ឋយច៊ុចប ូត៊ុងកណដ៊ុ រ ស្តូវ
បានលស្បីជាកណាត  នននផទដដ បានលស្ជីរលររី។ 

• Fixed៖ ម្៊ុឺន៊ុយលនះ ន៊ុញ្ញ តឱ្យ នកមនជលស្មី្រននការដ្ឋក់កស្មិ្តរងចត៊ុលកាណតាម្វធីិ្
លផសងោន ។ 

រូបភារទី ៥.២ Rectangle Selection 

រូបភារទី ៥.៣ ជលស្មី្រឧបករណ៍ 

https://docs.gimp.org/en/gimp-tool-bucket-fill.html
https://docs.gimp.org/en/gimp-selection-stroke.html
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• Position៖ នផទ តេបទទាងំរីរលនះមនកូ រលដ្ឋលនលផដក និងបញ្ឈរននទីតាងំជាក់ោក់ននស្ជុង
ខាងល វ្ងខាងល ីននជលស្មី្រ។  នកអចលស្បីនផទទាងំលនះលដីម្បដីករស្មួ្ ទីតាងំលស្ជីរលររី
ោ៉ា ងជាក់ោក់។ 

• Size៖ នផទ តេបទទាងំរីរលនះមនទទឹង និងកម្ពរ់បចច៊ុបបននននការលស្ជីរលររី។  នកអចលស្បី
នផទទាងំលនះលដីម្បដីករស្មួ្ ទំហកំារលស្ជីរលររីោ៉ា ងជាក់ោក់។ 

• Highlight៖ ស្បរិនលបី នកលបីកជលស្មី្រលនះ តំបន់ដដ បានលស្ជីរលររីស្តូវបានរងកត់ធ្ាន់
លដ្ឋយរបាងំជ៊ុំវញិលដីម្បលីធ្វីឱ្យជលស្មី្រដដ លមី្ លឃញីកាន់ដតរយស្រួ ។ 

• Guides៖ ជាមួ្យនឹងម្៊ុឺន៊ុយលនះ  នកអចលស្ជីរលររីស្បលភទននការចងអ៊ុរបរហ ញដដ ស្តូវបាន
បរហ ញកន៊ុងជលស្មី្រ លដីម្បលីធ្វីឱ្យការបលងកីតជលស្មី្រកាន់ដតរយស្រួ  លដ្ឋយលោររចាប់
នន រមរភាររូបថ្ត ។ 

មនជលស្មី្រស្បាមួំ្យ៖ 
o No Guides 
o Center lines 
o Rule of thirds 
o Rule of fifths 
o Golden sections 
o Diagonal lines 

• ការលស្ជីរលររីបស្ងួម្លដ្ឋយរវ័យស្បវតតិ (Auto Shrink Selection)៖ ជលស្មី្រលនះគឺដំលណីរ
ការលៅលរ ដដ ការលស្ជីរលររីចត៊ុលកាណស្តូវបានគូរ។ ការច៊ុចល ី ប ូត៊ុង Auto Shrink 
Selection នឹងលធ្វីឱ្យការលស្ជីរលររីបស្ងួម្ លដ្ឋយរវ័យស្បវតតិលៅជារងចត៊ុលកាណដកងដដ 
លៅជិតបំផ៊ុត រមួ្ទាងំធាត៊ុលៅកន៊ុងជលស្មី្រផងដដរ។ កបួនលដ្ឋះស្សាយរស្មប់ការដរវងរកចត៊ុ
លកាណដកងដដ  អបំផ៊ុតលដីម្បបីស្ងួម្គឺ " ឆ្ល តនវ (intelligent)" ដដ កន៊ុងករណីលនះមន
ន័យថ្នលរ ខ្លះវាលធ្វីលរឿងដ៏គួរឱ្យភ្ាក់លផអី  លហយីជួនកា លធ្វីលរឿងចដម្លកគួរឱ្យភ្ាក់លផអី ។ 
កន៊ុងករណីណាក៏លដ្ឋយ ស្បរិនលបីតំបន់ដដ  នកចង់លស្ជីរលររីមនរណ៌ា រ័ទធជ៊ុំវញិ ការ
បស្ងួម្លដ្ឋយរវ័យស្បវតតិនឹងដតងដតលស្ជីរលររីវាបានស្តឹម្ស្តូវ។ ចំណាថំ្នការលស្ជីរលររី ទធ
ផ  មិ្នចាបំាច់មនរូបរងដូចោន លៅនឹងជលស្មី្រដដ  នក ូរលចញលនាះលទ។ 

ឧទាហរណ៍ននការបស្ងមួ្លដ្ឋយរវ័យស្បវតតិ៖ 
 
 
 
 
 រូបភារទី ៥.៤ ការបស្ងួម្លដ្ឋយរវ័យស្បវតតិ 
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           រូបភារដដ មនធាត៊ុលផសងោន រីរស្តូវបានលស្ជីរលររី     បាន ន៊ុវតតការបស្ងួម្លដ្ឋយរវ័យស្បវតតិ 

• Shrink merged៖ ស្បរិនលបីលស្ជីរលនះស្តូវបានលបីកផងដដរលនាះ Auto Shrink នឹងលស្បី
រ័ត៌ាមនភីកដរ រីការបរហ ញរូបភារដដ លមី្ លឃញី ជាជាងស្ោន់ដតរីស្រទាប់រកម្ម។ 

៥.៣.២. ការសស្ររើេសរ ើេពងស្រកសពើ (Ellipse Selection) 

ឧបករណ៍ Ellipse Selection ស្តូវបានរចនាល ងីលដីម្បី
លស្ជីរលររីតំបន់រងជារងវង់ និងរងរងស្កលរីរីរូបភារ។ 
ឧបករណ៍លនះក៏ស្តូវបានលស្បីរស្មប់លបាះរ៊ុម្ាជារងរងវង់ ឬរង
រងស្កលរីលៅល ីរូបភារផងដដរ។ លដីម្បលីបាះរ៊ុម្ាការដ្ឋក់រណ៌ា រង
រងស្កលរី ការ ន៊ុវតដដូចោន លៅនឹងលបាះរ៊ុម្ារងចត៊ុលកាណដកង
ខាងល ីផងដដរ។  

ក. រសរៀរសស្ររើស្របាេឧ់រករណ៍សស្ររើេសរ ើេ 

 នកអចចូ លស្បីឧបករណ៍លស្ជីរលររីតាម្វធីិ្លផសងៗោន ៖ 

• បារម្៊ុឺន៊ុយរូបភារ (image menu bar) Tools → Selection Tools → Ellipese Select 

• លដ្ឋយច៊ុចល ីរូបតំណាងឧបករណ៍   លៅកន៊ុងស្ប ប់ឧបករណ៍ 

• លដ្ឋយលស្បីផលូវកាត់កាត រច៊ុច  E  

ខ. ការស្រគរ់ស្រគងឧរករណ៍ 

លៅលរ ដដ ឧបករណ៍លនះ ស្តូវបានលស្ជីរលររី 
ស្រួញកណដ៊ុ រភាា ប់ម្កជាមួ្យរូបតំណាងរងវង់  ភាល ម្ៗលៅ
លរ ដដ វារេិតលៅរីល ីរបូភារ។ ការ ូរនិងទមល ក់
 ន៊ុញ្ញ តឱ្យ នកទទួ បានរងរងស្កលរី (ឬរងវង់) លៅកន៊ុង
ស្ប ប់ចត៊ុលកាណ។ លៅលរ ដដ ប ូត៊ុងកណដ៊ុ រស្តូវបាន
ស្រដ ង បនាទ ត់ដ្ឋច់ៗ “ marching ants” គូរបញ្ា ក់ការ
លស្ជីរលររីរងរងស្កលរី។ វាមិ្នចាបំាច់កន៊ុងការដកតស្មូ្វការ
លស្ជីរលររីលដ្ឋយស្បុងស្បយត័នលទ។  នកអចផ្លល រ់បតូរទំហវំា
ោ៉ា ងរយស្រួ លៅលរ លស្កាយ។ 

លៅលរ ដដ ស្ទនិចកំរ៊ុងផ្លល រ់ទីល ីផ្លទ ងំស្កណាត់ ស្ទនិច និងទិដាភារលស្ជីរលររីផ្លល រ់បតូរ។
 នកអចផ្លល រ់បតូរទំហនំនការលស្ជីរលររីលដ្ឋយលស្បីចំណ៊ុ ចទាញ។ 

រូបភារទី ៥.៥ Ellipse Selection 

រូបភារទី ៥.៦ ការស្គប់ស្គងឧបករណ៍ 
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៥.៣.៣. ការសស្ររើេសរ ើេសដ្ឋយសេរ ី(Free Selection) (Lasso) 

ឧបករណ៍លស្ជីរលររីលររ ី ឬ Lasso  ន៊ុញ្ញ តឱ្យ នកបលងកីតការលស្ជីរលររីលដ្ឋយគូរវាលដ្ឋយលស្បី
ស្ទនិច។  នកអចលស្បីឧបករណ៍លនះតាម្រីរវធីិ្។ ដំបូងបលងកីត ចំណ៊ុ ចចាប់លផតីម្ លដ្ឋយច៊ុចល ីរូបភារ
របរ់ នក។ បនាទ ប់ម្ក រូម្ ន៊ុវតដដូចខាងលស្កាម្៖ 

• ច៊ុចប ូត៊ុងកណដ៊ុ រឱ្យជាប់ (ឧ. ច៊ុចលហយី ូរ) រចួ ូរលដីម្បី
គូរលៅតាម្លោ លៅដដ  នកចង់បាន។ លៅលរ ដដ ចំ
ន៊ុចបញ្ច ប់រេិតលៅដផនកខាងល ីននចំណ៊ុ ចចាប់លផតីម្ រូម្
ដ ងប ូត៊ុងកណដ៊ុ រ លដីម្បបិីទការលស្ជីរលររី។ ស្បរិនលបី នក
ច៊ុចល ីចំណ៊ុ ចបញ្ច ប់ លនាះវាដស្បជាផ្លល រ់ទីកាត់។ បនាទ ប់
ម្ក  នកអចការ ូររស្ងីករូបរងលនាះ។ 

• ឬដ ងប ូត៊ុងកណដ៊ុ រ លហយី ូរលដីម្បគូីរជលស្មី្ររហ៊ុ     
លកាណ។ លៅលរ ចំន៊ុចបញ្ច ប់រេិតលៅដផនកខាងល ីនន
ចំណ៊ុ ចចាប់លផតីម្ ច៊ុចលដីម្បបិីទជលស្មី្រ។ 

ច៊ុចស្ោប់ច៊ុចបញ្ា  (Ctrl) លហយីច៊ុចល ីចំណ៊ុ ច
បញ្ច ប់៖ ផ្លល រ់ទីស្រួញកណដ៊ុ រលដ្ឋយផ្លល រ់ទីម្៊ុំលៅ 15° លនាះ
 នកអចគូរបនាទ ត់លផដក ឬបញ្ឈរបានោ៉ា ងរយស្រួ ។ 
កន៊ុងករណីទាងំរីរ ការច៊ុចរីរដងល ីចំណ៊ុ ចបញ្ច ប់ វានឹង
បិទការលស្ជីរលររីលដ្ឋយបនាទ ត់ស្តង់។  នកលស្បីដដ មន
បទរិលសាធ្រកលឃញីថ្ន វាជាញឹកញាបរ់យស្រួ កន៊ុង
ការចាប់លផតីម្ជាមួ្យនឹងឧបករណ៍ lasso ប៉ា៊ុដនតបនាទ ប់ម្ក
បតូរលៅទស្ម្ង់QuickMask រស្មប់ការររ ម្អិត។ 

ក. រសរៀរសស្ររើស្របាេឧ់រករណ៍សស្ររើេសរ ើេ 

 នកអចចូ លស្បីឧបករណ៍ Lasso Tool តាម្វធីិ្លផសងៗោន ៖ 

• បារម្៊ុឺន៊ុយរូបភារ (image menu bar) Tools → Selection Tools → Free Select 

• លដ្ឋយច៊ុចល ីរូបតំណាងឧបករណ៍   លៅកន៊ុងស្ប ប់ឧបករណ៍ 

• លដ្ឋយលស្បីផលូវកាត់កាត រច៊ុច  E  

 

 

រូបភារទី ៥.៧ Free Selection 

រូបភារទី ៥.៨ លស្បី free selection tool លដ្ឋយច៊ុច Ctrl 

https://docs.gimp.org/en/gimp-channel-dialog.html#gimp-quick-mask
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ខ. រសស្រមើេឧរករណ៍ (Options) 

ជលស្មី្រននឧបករណ៍នឹងស្តូវបានបរហ ញកន៊ុងបងអួច ដដ ភាា ប់
លៅលស្កាម្ស្ប ប់ឧបករណ៍ភាល ម្ៗលរ  នកលបីកឧបករណ៍។   ស្បរិនលបី
ជលស្មី្រននឧបករណ៍មិ្នបានបរហ ញលទ  នកអចចូ លស្បីរួកវារីរបារម្៊ុឺ
ន៊ុយរូបភារតាម្រយៈ Windows → Dockable  Windows   
→ Tool Options ដដ លបីកផ្លទ ងំជលស្មី្រននឧបករណ៍ដដ បានលស្ជីរ
លររី។ ឧបករណ៍លស្ជីរលររីលដ្ឋយលររមិី្នមនជលស្មី្រឧបករណ៍
រិលររលទ មនដតឧបករណ៍ដដ ប៉ាះ  ់ដ ់ឧបករណ៍លស្ជីរលររី
ទាងំ រ់តាម្រលបៀបដូចោន ។  

ចាប់តាងំរីជំនាន់ GIMP-2.10.12 ម្ក ទស្ម្ង់លស្ជីរលររីដំលណីរការខ្៊ុរោន ។ Marching ants

ម្កជាមួ្យបនាទ ត់បនត មនន័យថ្នការលស្ជីរលររីមិ្នទាន់មនរ៊ុរ ភារលៅល យីលទ លហយី នកលៅដត
អចផ្លល រ់បតូររូបរងការលស្ជីរលររី (ស្រួញកណដ៊ុ រភាា ប់ម្កជាមួ្យរូបតំណាងផ្លល រ់ទី)។ ប៉ា៊ុដនត នកមិ្នអច
លស្បី ឬច៊ុចវាឱ្យជាប់ (Shift , Ctrl ...) លៅល យីលទ។  នកស្តូវច៊ុច ស្ោប់ច៊ុច Enter។ បនាទ ប់ម្ក នកអច
លស្បី (ច៊ុចវាឱ្យជាប់) Shift លដីម្បបីដនេម្ការលស្ជីរលររី លហយី Ctrl លដីម្បដីកជលស្មី្រមួ្យ រឯី Shift  + 
Ctrl លដីម្បផី្លដ ច់ជលស្មី្ររីរ។ លៅលរ  នកលរញចិតតនឹងការផ្លល រ់បតូររបរ់ នក រូម្ច៊ុច Enter លដីម្បី
បញ្ា ក់ការលស្ជីរលររី។ 

៥.៣.៤. Fuzzy selection (Magic wand) 

Fuzzy Select (Magic Wand) Tool ស្តូវបានរចនា
ល ងីលដីម្បលីស្ជីរលររីតំបន់នន  current layer ឬរូបភារលដ្ឋយ
ដផអកល ីភារស្រលដៀងោន ននរណ៌ា ។ លៅលរ លស្បីឧបករណ៍លនះ 
វាមនសារៈរំខាន់ខាល ងំណារ់ កន៊ុងការលស្ជីរលររីចំណ៊ុ ចចាប់
លផតីម្ស្តឹម្ស្តូវ។ស្បរិនលបី នកលស្ជីរលររីកដនលងខ្៊ុរ  នកអច
ទទួ បាន វីដដ ខ្៊ុរដបលករី វីដដ  នកចង់បាន។  

ក. រសរៀរសស្ររើស្របាេឧ់រករណ៍សស្ររើេសរ ើេ 

 នកអចចូ លស្បីឧបករណ៍ Magic wand តាម្វធីិ្លផសងៗោន ៖ 

• បារម្៊ុឺន៊ុយរូបភារ (image menu bar) Tools → Selection Tools → Fuzzy Select 
• លដ្ឋយច៊ុចល ីរូបតំណាងឧបករណ៍   លៅកន៊ុងស្ប ប់ឧបករណ៍ 
• លដ្ឋយលស្បីផលូវកាត់កាត រច៊ុច  U  

រូបភារទី ៥.៩ tool options 

រូបភារទី ៥.១០ Fuzzy selection 
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ខ. ការស្រគរ់ស្រគងឧរករណ៍ 

ការលស្បីស្បារ់ Magic Wand Tool គឺលដីម្បលីស្ជីរលររី ភីកដរ ជាប់ៗោន ។ វាចាប់លផតីម្លស្ជីរ
លររីលៅលរ  នកច៊ុចលៅកដនលងណាមួ្យកន៊ុងរូបភារ លហយីរស្ងីកលៅខាងលស្ៅដូចជាទឹកជន់ ិចតំបន់
ទំនាប (រកីរ ដ្ឋ ) លដ្ឋយលស្ជីរលររីភីកដរ ជាប់ោន ដដ 
រណ៌ា របរ់វាស្រលដៀងនឹងភីកដរ ចាប់លផតីម្។  នកអចស្គប់ស្គង
កស្មិ្តននភារស្រលដៀងោន លដ្ឋយ ូរកណដ៊ុ រច៊ុះលស្កាម្ ឬលៅខាងសាត ។ំ 
កា ណា នក ូរវាកាន់ដតឆ្ា យ  នកនឹងទទួ បានតំបន់ដដ បាន
លស្ជីរលររីកាន់ដតធំ្។ លហយី នកអចកាត់បនេយការលស្ជីរលររី
លដ្ឋយ ូរល ងីល ី ឬលៅខាងល វ្ង។  នកអចផ្លល រ់ទីលស្ោងលស្ជីរ
លររីលដ្ឋយលស្បី ស្ោប់ច៊ុចជំនរួ(Alt) + ស្រញួ។ 

៥.៣.៥. សស្ររើេសរ ើេតាមពណ៌ (Select By Color) 

ឧបករណ៍លស្ជីរលររីតាម្រណ៌ា ស្តូវបានរចនាល ងី លដីម្បី
លស្ជីរលររីរណ៌ា ជាក់ោក់មួ្យ ននរូបភារស្តង់ចំណ៊ុ ចណាមួ្យ 
លហយីវានឹងលស្ជីរលររីរណ៌ា ដដ ស្រលដៀងោន  ដដ មនលៅល ី
រូបភារលនាះ។ វាដំលណីរការស្បហាក់ស្បដហ នឹងឧបករណ៍ 
Fuzzy Select “Magic Wand” ដដរ។ ភារខ្៊ុរោន ចំបងរវាង
រួកវាគឺថ្ន Magic Wand លស្ជីរលររីតំបន់ជាប់ៗោន  លដ្ឋយដផនក
ទាងំ រ់ស្តូវបានតភាា ប់លៅចំណ៊ុ ចចាប់លផតីម្ លដ្ឋយមិ្នមន
ចលនាល ះ ខ្ណៈដដ ឧបករណ៍លស្ជីរលររីតាម្រណ៌ា លស្ជីរលររីភីក
ដរ ទាងំ រ់ ដដ មនរណ៌ា ស្បហាក់ស្បដហ នឹងភីកដរ 
ដដ  នកច៊ុចល ី លដ្ឋយមិ្នគិតរីកដនលងដដ រួកវារេិតលៅ។ 

ក. រសរៀរសស្ររើស្របាេឧ់រករណ៍សស្ររើេសរ ើេ 

 នកអចចូ លស្បីឧបករណ៍ Select By Color តាម្វធីិ្លផសងៗោន ៖ 

• បារម្៊ុឺន៊ុយរូបភារ (image menu bar) Tools → Selection Tools → By Color Select 
• លដ្ឋយច៊ុចល ីរូបតំណាងឧបករណ៍   លៅកន៊ុងស្ប ប់ឧបករណ៍ 
• លដ្ឋយលស្បីផលូវកាត់កាត រច៊ុច   Shift + O  

 

រូបភារទី ៥.១១ ការលស្បី Magic Wand  

រូបភារទី ៥.១២ Select By Color 
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ខ. ការស្រគរ់ស្រគងឧរករណ៍ 

ដូចោន លៅនឹងឧបករណ៍ fuzzy ដដរ ការលស្ជីរលររីចាប់លផតីម្
ភាល ម្ៗលៅលរ  នកច៊ុច លហយីអស្រ័យលៅតាម្ភីកដរ ដដ បាន
ច៊ុចដំបូង។ ស្បរិនលបី នកច៊ុចលហយី ូរ  នកអចផ្លល រ់បតូរកស្មិ្តចាប់
លផដីម្លដ្ឋយវធីិ្ដូចោន នឹងឧបករណ៍ fuzzy ដដរ។  នកអចផ្លល រ់ទី
លស្ោងលស្ជីរលររីលដ្ឋយលស្បីស្ោប់ច៊ុចស្រួញ មិ្នដម្នលដ្ឋយលស្បីកណដ៊ុ រ
លទ។ 

ការលស្បីស្បារ់ឧបករណ៍លស្ជីរលររីតាម្រណ៌ា គឺ ភីកដរ 
ដដ បានលស្ជីរលររីមិ្នមន កខណៈជាប់ោន លនាះលទ។ 

៥.៣.៦. កច្ស្គនតឆាែ តច្វ (Intelligent Scissors) 

ឧបករណ៍កនង្គ្នតឆ្ល តនវ គឺជាឧបករណ៍ដ៏គួរឱ្យចាប់អរម្មណ៍ 
មួ្យ។ វាមន កខណៈរិលររមួ្យចំនួនដូចលៅនឹង Lasso លហយី
 កខណៈរិលររមួ្យចំនួន ដដ មន កខណៈដូចោន ជាមួ្យ
ឧបករណ៍ Path និង កខណៈរិលររមួ្យចំនួនរបរ់វាផ្លទ  ់។         
វាមនស្បលោជន៍ លៅលរ  នកកំរ៊ុងរាោម្លស្ជីរលររីដផនកដគម្នន
រូបភារ ដដ មនរណ៌ា លស្ចីនលៅដផនកខាងលស្កាយ។ លដីម្បលីស្បីកនង្គ្នត 
 នកច៊ុចលដីម្បបីលងកីតរំណ៊ុំ  "control nodes" ដដ លគលៅថ្នយ៊ុថ្នក  ឬចំណ៊ុ ចបញ្ា  លៅដគម្ននតំបន់
ដដ  នកកំរ៊ុងរាោម្លស្ជីរលររី។ ឧបករណ៍លនះបលងកីតដខ្សលកាងបនត ល្ងកាត់ថ្នន ងំស្គប់ស្គងទាងំលនះ 
លដ្ឋយលធ្វីតាម្ដគម្កស្មិ្តរណ៌ា ខ្ពរ់ដដ វាអចរកបាន។ ម្លធ្ាបាយដ៏ អកន៊ុងការរមអ តរួកវា គឺស្តូវបតូរ
លៅជាទស្ម្ង់ QuickMask លហយីលស្បីឧបករណ៍ោបលដីម្បគូីរដផនកដដ មនបញ្ហ ។  

ក. រសរៀរសស្ររើស្របាេឧ់រករណ៍សស្ររើេសរ ើេ 

 នកអចចូ លស្បី Intelligent Scissors Tool តាម្វធីិ្លផសងៗោន ៖ 

• បារម្៊ុឺន៊ុយរូបភារ (image menu bar) Tools → Selection Tools → Intelligent 
Scissors 

• លដ្ឋយច៊ុចល ីរូបតំណាងឧបករណ៍   លៅកន៊ុងស្ប ប់ឧបករណ៍ 
• លដ្ឋយលស្បីផលូវកាត់កាត រច៊ុច I  

 

 

រូបភារទី ៥.១៣ ការស្គប់ស្គងឧបករណ៍ 

រូបភារទី ៥.១៤ Intelligent Scissors 

https://docs.gimp.org/en/gimp-channel-dialog.html#gimp-quick-mask


75 

ខ. ការស្រគរ់ស្រគងឧរករណ៍ 

រ ់លរ ដដ  នកច៊ុចកណដ៊ុ រល វ្ងលដ្ឋយលស្បីកណដ៊ុ រ  នកបលងកីត
ចំណ៊ុ ចបញ្ា ថ្មី ដដ ស្តូវបានភាា ប់លៅចំណ៊ុ ចបញ្ា ច៊ុងលស្កាយលដ្ឋយ
ដខ្សលកាងដដ រាោម្រត់តាម្ដគម្កន៊ុងរូបភារ។ លដីម្បបីញ្ច ប់រូម្
ច៊ុចល ីចំណ៊ុ ចទីមួ្យ (ទរសន៍ស្ទនិចផ្លល រ់បតូរលដីម្បចីងអ៊ុ បរហ ញលៅ
លរ ដដ  នករេិតលៅកដនលងស្តឹម្ស្តូវ)។  នកអចដកតស្មូ្វដខ្សលកាង
លដ្ឋយ ូរថ្នន ងំវតេ៊ុបញ្ា  ឬលដ្ឋយច៊ុចលដីម្បបីលងកីតថ្នន ងំវតេ៊ុបញ្ា ថ្មី។  
លៅលរ  នកលរញចិតត រូម្ច៊ុចកដនលងណាមួ្យលៅខាងកន៊ុងដខ្សលកាង 
លដីម្បបំីដបលងវាលៅជាការលស្ជីរលររីមួ្យ។  

ដូចដដ បានល ីកល ងីខាងល ី លៅលរ  នកច៊ុចលដ្ឋយលស្បីឧបករណ៍លនះ នកទមល ក់នូវ           
ចំណ៊ុ ចៗ។ ស្រំដដនលស្ជីរលររីស្តូវបានដឹកនាលំដ្ឋយចំណ៊ុ ចស្តួតរិនិតយទាងំលនះ។ កន៊ុង ំ ៊ុងលរ បលងកីត 
 នកអចផ្លល រ់ទីចំណ៊ុ ចស្តួតរិនិតយនីមួ្យៗលដ្ឋយច៊ុច និង ូរ ល ីកដ ងដតចំណ៊ុ ចស្តួតរិនិតយទីមួ្យ 
និងច៊ុងលស្កាយ។ ការលស្ជីរលររីស្តូវបានបិទ លៅលរ  នកច៊ុចចំណ៊ុ ចច៊ុងលស្កាយល ីចំណ៊ុ ចទីមួ្យ។ លៅ

លរ ដដ ការលស្ជីរលររីស្តូវបានបិទ រូបរងស្ទនិចផ្លល រ់បតូរលៅតាម្ទីតាងំរបរ់វា ខាងកន៊ុង   ល ីស្រំ

ដដន   និងខាងលស្ៅ  ។  នកអចដករស្មួ្ ការលស្ជីរលររីលដ្ឋយបលងកីតចំណ៊ុ ចថ្មី លដ្ឋយច៊ុចល ី
ស្រំដដន ឬលដ្ឋយផ្លល រ់ទីចំណ៊ុ ចបញ្ា នីមួ្យៗ (លធ្វីការបញ្ចូ  ោន រវាងចំណ៊ុ ចទីមួ្យនិងច៊ុងលស្កាយ)។ 
ការលស្ជីរលររីមនរ៊ុរ ភារលៅលរ  នកច៊ុចខាងកន៊ុង។    

 នកស្តូវដតកត់រមា  ់ថ្ន នកអចទទួ បានការលស្ជីរលររីដតមួ្យគត់ ស្បរិនលបី នកបលងកីតការ
លស្ជីរលររីទីរីរ លនាះការលស្ជីរលររីទីមួ្យនឹងស្តូវ ៊ុបលចញ លៅលរ  នកលធ្វីឱ្យលស្ជីរលររីទីរីរមន      
រ៊ុរ ភារ។ 

៥.៣.៧. សស្ររើេសរ ើេច្ផ្ៃខាងមុខ (Foreground Select) 

ឧបករណ៍លនះ  ន៊ុញ្ញ តឱ្យ នកទាញយកនផទខាងម្៊ុខ្
លចញរីស្រទាប់រកម្ម ឬរីជលស្មី្រមួ្យ។ ជាមួ្យនឹង GIMP -
2.10 ឬជំនាន់លស្កាយ ការដក ម្អការលស្ជីរលររីស្តូវបានលធ្វីឱ្យ
ស្បលរីរល ងី។ បនាទ ប់ រីការលស្ជីរលររីស្តូវបានបលងកីតល ងី 
លដ្ឋយមន marching ants  នកអចចម្លង-បិទភាា ប់ ឬច៊ុច
លហយី ូរវាលៅកាន់រូបភារលផសងលទៀត ដដ លស្បីជានផទខាង
លស្កាយ លហយីការដ្ឋក់បង្គ្ញ្ច រការលស្ជីរលររី  នកអចលធ្វីការ
ផ្លល រ់បតូរលៅនផទខាងលស្កាយ។ 

 

រូបភារទី ៥.១៥ ការស្គប់ស្គងឧបករណ៍ 

រូបភារទី ៥.១៦ Foreground Select 
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ក. រសរៀរសស្ររើស្របាេឧ់រករណ៍សស្ររើេសរ ើេ 

 នកអចចូ លស្បី Foreground Select Tool តាម្វធីិ្
លផសងៗោន ៖ 

• លដ្ឋយច៊ុចល ីរូបតំណាងឧបករណ៍ លៅកន៊ុងស្ប ប់
ឧបករណ៍  

• តាម្រយៈ Tools → Selection Tools → 
Foreground Select កន៊ុងមឺ្ន៊ុយរូបភារ។ 

• ឧបករណ៍លនះមិ្នមនផលូវកាត់លទ ប៉ា៊ុដនត នកអចកំណត់បាន លដ្ឋយលស្បី Edit → Keyboard 
Shortcuts បនាទ ប់ម្កលបីក Tools group លៅខាងល វ្ង រចួលស្ជីរលររី Foreground 
Select លហយីបនាទ ប់ម្កច៊ុចស្ោប់ច៊ុចដដ  នកចង់លស្បីជាផលូវកាត់។ 

ខ. ការថ្ណនាេំស្រមារ់ការសស្ររើស្របាេ ់

ចូរ នកចាប់លផតីម្ជាមួ្យវតេ៊ុ ដដ រយស្រួ កន៊ុងការដបងដចករីនផទខាងលស្កាយ លហយីមិ្នចាបំាច់
ស្តូវដក ម្អ។ 

1. រលបៀបដដ វាដំលណីរការ គឺស្រលដៀងនឹងឧបករណ៍
លស្ជីរលររីលររផីងដដរ។ លស្ជីរលររីវតេ៊ុដដ  នកចង់
ស្រង់លចញនូវនផទខាងលស្កាយខ្លះលៅជ៊ុំវញិវា។ លដីម្បី
ទទួ បានលស្ោងដដ ស្តឹម្ស្តូវ រូម្ច៊ុចប ូត៊ុងកណដ៊ុ រ   
ខ្ណៈលរ កំរ៊ុងផ្លល រ់ទី។ លដីម្បលីស្បីបនាទ ត់ស្តង់
រស្មប់ដផនកននការលស្ជីរលររីរបរ់ នក រូម្ច៊ុច និង
ដ ងប ូត៊ុងរវាងចំណ៊ុ ចចាប់លផតីម្ និងច៊ុងបញ្ច ប់ននដផនក
ស្តង់។ លៅលរ ដដ  នកច៊ុចលដីម្បចីាប់លផតីម្គូរការលស្ជីរលររី លនាះបងអួចតូចមួ្យនឹងល ច
ល ងីដូចខាងលស្កាម្។ 

ម្៊ុនលរ ការលស្ជីរលររីស្តូវបានបញ្ច ប់ មនដតប ូត៊ុងបិទ x ប៉ា៊ុលណាណ ះ ដដ ដំលណីរ
ការ ដដ  ន៊ុញ្ញ តឱ្យ នកលបាះបង់ និងស្ត ប់លៅរូបភារលដីម្វញិ (វាក៏អចស្តូវបានលធ្វី
លដ្ឋយច៊ុច ស្ោប់ច៊ុច Esc)។ 

លដីម្បបីញ្ច ប់ការលស្ជីរលររីដំបូង វាចាបំាច់ស្តូវដតបិទ។ លៅលរ ទរសន៍ស្ទនិច
កណដ៊ុ រដ្ឋក់រីល ីចំណ៊ុ ច ដដ  នកចាប់លផតីម្ការលស្ជីរលររី វាដស្បជារណ៌ា ល ឿង។ ច៊ុចវាលដីម្បី
បិទការលស្ជីរលររី។ ជំនួរឱ្យការលធ្វីដូលចនះ  នកក៏អចច៊ុចរីរដងលដីម្បបិីទការលស្ជីរលររីផង
ដដរ។  

រូបភារទី ៥.១៧ Foreground select option 

រូបភារទី ៥.១៨ រូបភារស្តូវបានលស្ជីរលររី 

https://docs.gimp.org/en/gimp-tool-free-select.html
https://docs.gimp.org/en/gimp-tool-free-select.html
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2. លដីម្បបីលងកីតរបាងំរីការលស្ជីរលររីរបរ់ នក ច៊ុច Enter ឬច៊ុចរីរដងលៅខាងកន៊ុងជលស្មី្រ៖ 
ឥ ូវលនះ ស្រួញកណដ៊ុ របានផ្លល រ់បតូរលៅជារូបតំណាង Paintbrush ដដ មនរងវង់មួ្

យ។ នផទរណ៌ា លខ្ៀវងងឹត (រណ៌ា លនះអចផ្លល រ់បតូរបាន)បរហ ញនផទខាងលស្កាយ។ តំបន់
ស្សា ជាងលនះស្គបដណត ប់បរលិវណដដ  នកបានលស្ជីរលររីជានផទខាងម្៊ុខ្ និងដផនកតូច
មួ្យនននផទខាងលស្កាយ។ លៅខាងលស្ៅតំបន់ដដ បានលស្ជីរលររី តំបន់រណ៌ា លខ្ៀវងងឹតស្តូវ
បានលគលៅថ្ន " តំបន់មិ្នសាា  ់ភីកដរ  (Unknown pixels area) " ។ 

ជលស្មី្រលៅកន៊ុងផ្លទ ងំតូចលៅដផនកខាងល ីននរូបភារកាល យជារកម្ម៖ 

• ស្ប ប់ធី្ក រស្មប់លមី្ របាងំ (Preview mask) ដដ បិទលបីកបរហ ញការលមី្ ជា
ម្៊ុនននសាេ នភារកាត់លចញនននផទខាងម្៊ុខ្។ ដូចោន លនះដដរ  នកក៏អច ន៊ុវតដលធ្វីលដ្ឋយ
ច៊ុច ស្ោប់ច៊ុច Enter ផងដដរ ។ 

• ប ូត៊ុង Select ដដ នឹងស្តូវបានលស្បី លដីម្បបីលងកីតការកាត់លចញបនាទ ប់រីរមា  ់នផទខាង
ម្៊ុខ្។ 

3. ឥ ូវលនះ នកអចចាប់លផតីម្ដំលណីរការទាញយកនផទ
ខាងម្៊ុខ្រិតស្បាកដ លដ្ឋយគូរបនាទ ត់កាត់នផទខាង     
ម្៊ុខ្។ ទំហនំនជក់អចស្តូវបានផ្លល រ់បតូរលៅកន៊ុងតំបន់
ជលស្មី្រឧបករណ៍។ គូរបនាទ ត់បនតល ីនផទខាងម្៊ុខ្ដដ 
បានលស្ជីរលររី លដ្ឋយផ្លល រ់ទីល ីរណ៌ា ដដ នឹងស្តូវ
បានរកាទ៊ុករស្មប់ការកាត់លចញ។ រណ៌ា ដដ លស្បីរស្មប់គូរបនាទ ត់មិ្នរំខានល់ទ ប៉ា៊ុដនត
ការមិ្នលស្បីរណ៌ា ដូចនផទខាងម្៊ុខ្លធ្វីឱ្យរយលមី្ លឃញី។ ស្បយត័នក៊ុំោបភីកដរ នផទខាង
លស្កាយ។ 

ជាមួ្យនឹងវតេ៊ុមនរណ៌ា ដតមួ្យលនះ គឺវារយ
ស្រួ កន៊ុងការដបងដចករីនផទខាងលស្កាយ លដ្ឋយលស្បីដត
រមឹ្មួ្យចំនួនគឺស្គប់ស្ោន់លហយី។ 

4. បិទលបីកប ូត៊ុងលមី្ ជាម្៊ុន ឬច៊ុច Enter លដីម្បលីផទៀង
ផ្លទ ត់ ទធផ ។ 
 

5. លៅលរ  នកលរញចិតតនឹង ទធផ រូម្ច៊ុច Select 

button ឬច៊ុច Enter លដីម្បបីញ្ច ប់ការលស្ជីរលររី និង
បញ្ច ប់ស្បតិបតតិការលស្ជីរលររីដផនកខាងម្៊ុខ្។  នកអច
លបាះបង់ស្បតិបតតិការលដ្ឋយច៊ុច Esc ។ 

  រូបភារទី ៥.១៩ លធ្វីការជាមួ្យឧបករណ៍ 

រូបភារទី ៥.២០ ការគូរកាត់នផទខាងម្៊ុខ្ 

រូបភារទី ៥.២១ រូបភារស្តូវបានលមី្ ជាម្៊ុន 
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េណួំររលំកឹសមសរៀន 

1- លតីបញ្ហ ស្បឈម្ ឬឧបរគាទូលៅ វីខ្លះដដ ប៊ុគា  ឬស្កុម្ជួបស្បទះលៅលរ លធ្វីការជាមួ្យ
ឧបករណ៍ដដ បានលស្ជីរលររី? លហយីលតីបញ្ហ ស្បឈម្ទាងំលនះអចយកឈនះបានលដ្ឋយ
រលបៀបណា លដីម្បបីលងកីនស្បរិទធភារស្បតិបតតិការ និងរលស្ម្ចបាន ទធផ ដដ ចង់បាន? 

2- លតីឧបករណ៍លស្ជីរលររីស្បលភទលផសងោន  វីខ្លះដដ មនលៅកន៊ុង GIMP (GNU Image 
Manipulation Program)? ចូរលរៀបរប់ ំរីម្៊ុខ្ររ និងករណីននការលស្បីស្បារ់ជាក់ោក់របរ់
ស្បលភទឧបករណ៍លស្ជីរលររីទាងំលនាះ? 

3- លតី "Rectangle Select Tool" លៅកន៊ុង GIMP ខ្៊ុររី "Ellipse Select Tool" កន៊ុង កខខ្ណា នន
ជលស្មី្រននរូបរងោ៉ា ងដូចលម្តច? លតីឧបករណ៍ទាងំលនះអចស្តូវបានលស្បីោ៉ា ងមនស្បរិទធភារ
រស្មប់កិចចការដករស្មួ្ រូបភារលផសងៗលដ្ឋយរលបៀបណា? 

4- លតី វីលៅជា កខណៈនិងរម្តេភាររិលររនន "Free Select Tool" លៅកន៊ុង GIMP លហយីលតីវា
 ន៊ុញ្ញ តឱ្យមនការលស្ជីរលររីបានចារ់ោរ់ និងអចបត់ដបនបានលដ្ឋយរលបៀបណាលបី
លស្បៀបលធ្ៀបលៅនឹងឧបករណ៍លផសងលទៀត? ចូរ នកផត ់ឧទាហរណ៍ននការលស្បីស្បារ់ដដ  Free 
Select Tool មនស្បលោជន៍ជារិលររ? 

5- លតី "Fuzzy Select Tool" (ដដ លគសាា  ់ថ្នជា Magic Wand Tool) លៅកន៊ុង GIMP ដំលណីរ
ការោ៉ា ងដូចលម្តច លហយីលតី កខណៈរិលររ និងការកំណត់រំខាន់ៗរបរ់វារស្មប់លស្ជីរលររី
តំបន់ជាប់ោន ននរណ៌ា មន វីខ្លះ? លតីឧបករណ៍លនះអចស្តូវបានលស្បីោ៉ា ងមនស្បរិទធភារ
រស្មប់កិចចការដូចជាការ ៊ុបនផទខាងលស្កាយ ឬការដករណ៌ា លដ្ឋយរលបៀបណា? 

6- លតី "Foreground Select Tool" លៅកន៊ុង GIMP អចស្តូវបានលស្បីលដីម្បទីាញយកវតេ៊ុរម៊ុស្គសាម ញ
រីនផទខាងលស្កាយរបរ់រួកលគលដ្ឋយរលបៀបណា លហយីលតីបលចចកលទរ ឬគនលឹះ វីខ្លះរស្មប់ការ
រលស្ម្ចបានការលស្ជីរលររីស្តឹម្ស្តូវលដ្ឋយលស្បីឧបករណ៍លនះ? 

7- លតី "Scissors Select Tool" លៅកន៊ុង GIMP ដំលណីរការោ៉ា ងដូចលម្តច លហយី វីដដ ជា        
 កខណៈរិលរររបរ់វារស្មប់លធ្វីការលស្ជីរលររីលដ្ឋយដផអកល ីរណ៌ា  និងកស្មិ្តរណ៌ា ? លតី
 នកអចផត ់ការយ ់ដឹងឱ្យកាន់ដតរ៊ុីជលស្ៅ ំរីការលស្បីស្បារ់របរ់វារស្មប់កិចចការដូចជាការ
ទាញយកវតេ៊ុ ឬការដញកធាត៊ុរូបភារជាក់ោក់ដ្ឋច់លដ្ឋយដ កបានលទ? 

 
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សមសរៀនទី ៦៖ ការសធវើការាមយួរបាងំស្រេទារ់ (Layer Masks) 

៦.១. លកេណៈទូសៅ 

របាងំស្រទាប់ គឺជាឧបករណ៍មូ្ ដ្ឋា ន កន៊ុងកាត់តររូប
ភារលដ្ឋយមិ្នចាបំាច់ ៊ុបលចា ដផនក ដដ មិ្នចង់រីរូបភារ 
វាស្ោន់ដតបិទបាងំនផទមួ្យចំនួនននស្រទាប់ ឬបិទបាងំនផទ
ទាងំមូ្ ននស្រទាប់ដដ មិ្នចង់លឃញី លដ្ឋយជំនួរការ
បរហ ញរីស្រទាប់ខាងលស្កាម្វញិ។ រួកលគ ន៊ុញ្ញ តឱ្យ នកដក
ដស្បភារថ្នល  (transparency) ននស្រទាប់ដដ រួកលគចង់    
បាន។ ទាងំលនះ វាខ្៊ុររីការលស្បីស្បារ់ស្រទាប់ Opacity 
slider លដ្ឋយសាររបាងំមនរម្តេភារកន៊ុងការលស្ជីរលររីដក
ដស្បភារស្រអប់ននតំបន់លផសងៗោន ល្ងកាត់ស្រទាប់ដតមួ្យ។ ការដកដស្បភារថ្នល របរ់ស្រទាប់តាម្រយៈ
របាងំលនះ គឺមិ្នមនការបំផលិចបំផ្លល ញដ ់ស្រទាប់ខ្លួនឯងលនាះលទ។ ភារបត់ដបនលនះលដីម្បកំីណត់ភារ
ស្រអប់នននផទលផសងៗននស្រទាប់ គឺជាមូ្ ដ្ឋា នរស្មប់បលចចកលទរននការលរៀបចំរូបភារ ដដ គួរឱ្យចាប់
អរម្មណ៍បដនេម្លទៀត ដូចជាការលស្ជីរលររីរណ៌ា  និងការបិទបាងំរនលឺជាលដីម្។ 

របាងំថ្នល អចស្តូវបានបដនេម្លៅស្រទាប់នីមួ្យៗ វាស្តូវបានលគលៅថ្នរបាងំស្រទាប់។ របាងំ
ស្រទាប់មនទំហដូំចោន  និងចំនួនភីកដរ ដូចោន លៅនឹងស្រទាប់ដដ វាស្តូវបានភាា ប់។ រ ់ភីកដរ 
ននរបាងំម្៊ុខ្អចស្តូវបានភាា ប់ ជាមួ្យភីកដរ លៅទីតាងំដូចោន លៅកន៊ុងស្រទាប់។ របាងំគឺជារំណ៊ុំ នន   
ភីកដរ លៅកន៊ុងទឹកថ្នន រំណ៌ា ស្បលផះលៅល ីមស្តដ្ឋា នតនម្លរី 0 ដ ់ 255 ។ ភីកដរ ដដ មនតនម្ល 0 
មនរណ៌ា លមម  លហយីផត ់ភារថ្នល លរញល ញដ ់ភីកដរ  ដដ ផសលំៅកន៊ុងស្រទាប់។ ភីកដរ ដដ 
មនតនម្ល 255 មនរណ៌ា រ និងផត ់ភារស្រអបល់រញល ញលៅនឹងភីកដរ គូកន៊ុងស្រទាប់។  

៦.២. ការង្ហរនំបាន់មួយនំនួនាមួយរបាស្រេទារ់ 

លដីម្បបីលងកីតរបាងំស្រទាប់ ចាប់លផតីម្លដ្ឋយច៊ុចខាងសាត លំ ី
ស្រទាប ់ លដីម្បលីៅ context menuលហយីលស្ជីរលររី Add layer 

mask កន៊ុងម្៊ុឺន៊ុយ។ ស្ប ប់មួ្យល ចល ងី ដដ  នកអចចាប់លផតីម្
មតិកាននរបាងំ៖ 

• White (full opacity)៖ ម៉ា រមនរណ៌ា រលៅកន៊ុង
ស្ប ប់ស្រទាប់។ ដូលចនះ ភីកដរ ទាងំ រ់ននស្រទាប់រកម្ម
ដដ បានបដនេម្ Mask គឺអចលមី្ លឃញីដដដ កន៊ុងបងអួច
រូបភារ លដ្ឋយសារការោបម៉ា រលដ្ឋយរណ៌ា រ លធ្វីឱ្យភីក

រូបភារទី៦.១ រូបភារកំណត់លដ្ឋយ layer masks 

រូបភារទី ៦.២ របារស្រទាប់ 
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ដរ ស្រទាបអ់ចលមី្ លឃញីោ៉ា ងលរញល ញ។  នកនឹងោបរណ៌ា លមម លដីម្បលីធ្វីឱ្យស្រទាប់
ភីកដរ ថ្នល លដីម្បបីរហ ញស្រទាប់ខាងលស្កាម្។ 

• Black (full transparency)៖ របាងំគឺរណ៌ា លមម លៅកន៊ុងស្ប ប់ស្រទាប់។ ដូលចនះ ស្រទាប់
មនភារថ្នល លរញល ញ ចាប់តាងំរីការោបរបាងំជាមួ្យរណ៌ា លមម លធ្វីឱ្យភីកដរ ស្រទាប់
ថ្នល ។ ការោបរណ៌ា រនឹង ៊ុបរបាងំ និងលធ្វីឱ្យលមី្ លឃញីស្រទាបភី់កដរ ។ 

• Layer's alpha channel៖ របាងំស្តូវបានចាប់លផតីម្លដ្ឋយលោងលៅតាម្ខ្លឹម្សារនន      
ឆ្ដន អ ់ហាវ របរ់ស្រទាប់។ ស្បរិនលបីស្រទាប់លៅដតមនភារថ្នល  វាស្តូវបានចម្លងលៅ
កន៊ុងរបាងំ។ 

• Transfer layer's alpha channel៖ លធ្វីដូចោន នឹងជលស្មី្រម្៊ុន ល ីកដ ងដតវាកំណត់
ល ងីវញិនូវឆ្ដន អ ់ហាវ របរ់ស្រទាប់លៅជាភារស្រអប់លរញល ញ។ 

• Selection៖ របាងំស្តូវបានបលងកីតមន២រណ៌ា  គឺ រ និងលមម  បនាទ ប់រី នកលស្បីឧបករណ៍
លស្ជីរលររី លដីម្បលីស្ជីរលររីនផទស្រទាប់  តាម្តនម្លភីកដរ ដដ រកលឃញីកន៊ុងរូបភារ។ របាងំ 
រណ៌ា រនឹងស្គបដណត ប់ល ីនផទ ដដ បានលស្ជីរលររី លហយីរណ៌ា លមម  (ថ្នល ) នឹងស្គបដណត ប់
ល ីនផទ ដដ មិ្នបានលស្ជីរលររី។  

• Grayscale copy of layer៖ របាងំស្តូវបានចាប់លផតីម្លដ្ឋយលោងលៅតាម្តនម្លភីកដរ 
ននស្រទាប់។ 

• Channel៖ របាងំស្រទាប់ស្តូវបានចាប់លផតីម្ជាមួ្យរបាងំលស្ជីរលររីដដ  នកបានបលងកីតរី
ម្៊ុន រកាទ៊ុកកន៊ុងស្ប ប់ឆ្ដន ។ 

• Invert mask៖ ស្ប ប់ធី្កលនះ ន៊ុញ្ញ តឱ្យ នកដ្ឋក់បង្គ្ញ្ច ររបាងំ (លមម លៅរ លហយី រ
លៅលមម ) ឬបង្គ្ញ្ច ររបាងំរវាងដផនក រ និងលមម  ដដ បានលធ្វីការលស្ជីរលររី (Selection)។  

លៅលរ ដដ របាងំស្តូវបានបលងកីត វាបរហ ញជារូបភារតូចខាងសាត លំៅរូបភារតូចៗនន            
ស្រទាប់។ លដ្ឋយច៊ុចជាជលស្មី្រល ីស្រទាប់ និងរូបភារតូចរបាងំ  នកអចលបីកមួ្យ ឬលផសងលទៀត។ ធាត៊ុ
រកម្មមនរ ៊ុម្រណ៌ា រ     (ដដ លមី្ មិ្នលឃញីចារ់ជ៊ុំវញិរបាងំរណ៌ា រ)   ដដ ទាងំលនាះជាចំណ៊ុ ច    
រំខាន់។ រូម្រកាស្ប ប់ Layers Dialog ឱ្យមនភារល ចលធាល លៅលរ លធ្វីការជាមួ្យរបាងំ រីលស្ ះ
 នកមិ្នអចលមី្ បានលទ រម្លឹងលមី្ ផ្លទ ងំស្កណាត់ លតីស្រទាប់មួ្យណា ឬរបាងំកំរ៊ុងលបីក។ 

ការច៊ុច Alt   (ឬ Ctrl + Alt លហយីច៊ុចល ីរូបភារតូចៗននរបាងំស្រទាប់) គឺលរមីនឹង កយ
បញ្ា  Show Layer Mask ដដ រ ៊ុម្ស្រទាប់របាងំដស្បលៅជារណ៌ា នបតង។ ស្បរិនលបី នក
ច៊ុច Ctrl  រ ៊ុម្មនរណ៌ា ស្កហម្ លហយី ទធផ គឺលរមីនឹង កយបញ្ា   Disable Layer។ លដីម្បសី្ត ប់
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លៅទិដាភារធ្ម្មតាវញិ លធ្វីស្បតិបតតិការច៊ុងលស្កាយ។ ជលស្មី្រទាងំលនះគឺរស្មប់ភាររយស្រួ កាន់ដត
លស្ចីនកន៊ុងការរររបរ់ នក។ 

ឧទាហរណ៍ច្នរបាងំស្រេទារ់ 

រូបភារខាងលស្កាម្លនះ មនស្រទាប់នផទ
ខាងលស្កាយជាមួ្យផ្លក  និងរណ៌ា លខ្ៀវមួ្យលទៀត 
ស្រអប់ទាងំស្រុង។ របាងំស្រទាប់រណ៌ា រស្តូវ
បានបដនេម្លៅស្រទាប់រណ៌ា លខ្ៀវ។ លៅកន៊ុងបងអួច
រូបភារ ស្រទាប់រណ៌ា លខ្ៀវលៅដតអចលមី្ លឃញី 
រីលស្ ះ របាងំរណ៌ា រលធ្វីឱ្យស្រទាប់ភីកដរ 
លមី្ លឃញី។ 

របាងំស្រទាប់ស្តូវបានកំណត់ឱ្យ
ដំលណីរការ។  នកោបរណ៌ា លមម  ដដ លធ្វី
ឱ្យស្រទាប់ថ្នល   លហយីស្រទាប់ខាងលស្កាម្
អចលមី្ លឃញីដូចរូបខាងលស្កាម្។ 

 

៦.២.១. ការរថ្នថមស្រេទារ់របាងំសៅឱ្យស្រេទារ់ 

Add Layer Mask គឺជាដំលណីរការបដនេម្របាងំស្រទាប់មួ្យលៅស្រទាប់ដដ កំរ៊ុងលបីក។ វា
បរហ ញស្ប ប់ដដ  នកអចកំណត់ កខណៈដំបូងននរបាងំលនាះ។ ស្បរិនលបីស្រទាប់មនរបាងំស្រទាប់
រចួលហយីលនាះ ម្៊ុឺន៊ុយដដ ស្តូវបដនេម្នឹងស្តូវបិទ និងមនរណ៌ា ស្បលផះ។ របាងំស្រទាប់ ន៊ុញ្ញ តឱ្យ នក
កំណត់ថ្ន លតីដផនកណាមួ្យននស្រទាប់មនភារស្រអប់ ក់           
កណាត  ថ្នល  ឬថ្នល ។ របាងំស្រទាប់ចាបំាច់ស្តូវបដនេម្លៅស្រទាប់មួ្យ 
ម្៊ុនលរ រួកវាអចលស្បីបាន។ ដំលណីរការននការបដនេម្រួកវាគឺមន
 កខណៈសាម្ញ្ញ។ 

រស្មប់ឧទាហរណ៍លនះ  នកនឹង ន៊ុវតដលដ្ឋយលស្បីរូបភារ
សាម្ញ្ញដដ មនដតរីរស្រទាប់ដូចបរហ ញខាងសាដ លំនះ។ មនរូប
ភារមូ្ ដ្ឋា នលៅខាងលស្កាម្ លហយីស្រទាប់ដតមួ្យននរណ៌ា ទឹកប ិក
រីល ីវា។ ស្រទាប់រណ៌ា ទឹកប ិកគឺជាស្រទាប់រកម្ម (រកលមី្ រ ៊ុម្
រណ៌ា រ) និងក៏ជាស្រទាប់ដដ លយងីនឹងបដនេម្របាងំស្រទាប់លៅឱ្យ
ផងដដរ។ 

រូបភារទី ៦.៣ ការបដនេម្របាងំស្រទាប់ 

រូបភារទី ៦.៤ របាងំស្រទាប់ 

រូបភារទី ៦.៥ ការបដនេម្ស្រទាប់របាងំ 
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ច៊ុចកណដ៊ុ រសាដ  ំ ល ីស្រទាប់ដដ  នកចង់បដនេម្របាងំលៅឱ្យ (ស្រទាប់ "រណ៌ា ទឹកប ិក" កន៊ុង
ឧទាហរណ៍របរ់ខ្្៊ុ ំ) លហយីម្៊ុឺន៊ុយបរបិទនឹងបរហ ញជលស្មី្រមួ្យលដីម្ប ីបដនេម្របាងំស្រទាប់ (Add 
Layer Mask)  

 នកក៏អចបដនេម្ស្រទាប់របាងំតាម្រយៈម្៊ុឺន៊ុយ៖  

Layer → Mask → Add Layer Mask… 

បនាទ ប់ម្កវានឹងបរហ ញស្ប ប់ " Add a Mask to the Layer" 
ជាមួ្យនឹងជលស្មី្រមួ្យចំនួន៖ 

មនជលស្មី្រជាលស្ចីនរស្មប់ការចាប់លផតីម្ស្រទាប់របាងំ ( តេន័យននជលស្មី្រនីមួ្យៗបានបក
ស្សាយលៅកន៊ុង កខណៈទូលៅខាងល ី)។ រូម្កត់រមា  ់ថ្នជលស្មី្រដំបូងគឺកំណត់របាងំទាងំមូ្ លៅ
ជារណ៌ា រ ដដ នឹងលធ្វីឱ្យមនភារស្រអប់លរញស្រទាប់ (មិ្នមនភារថ្នល រីរបាងំ)។ ជលស្មី្រលដីម្បី
ចាប់លផតីម្លៅជារណ៌ា លមម បរហ ញថ្ន របាងំនឹងលធ្វីឱ្យស្រទាប់ទាងំមូ្ មនភារថ្នល លរញល ញ។ 

រស្មប់លោ បំណងននការ ន៊ុវតដលនះ លយងីនឹង ន៊ុញ្ញ តឱ្យ
របាងំចាប់លផតីម្លៅជារណ៌ា រ (ភារស្រអប់លរញល ញ)។  នកគួរដតកត់
រមា  ់ការផ្លល រ់បតូរលៅកន៊ុងស្ប ប់ Layers របរ់ នកឥ ូវលនះ ដដ 
បរហ ញរូបភារតូចៗននរបាងំស្រទាប់លៅខាងសាត នំនស្រទាប់ ដដ វា ន៊ុវតត 
(កន៊ុងករណីលនះស្រទាប់ "រណ៌ា ទឹកប ិក")៖ 

ឥ ូវលនះរបាងំស្រទាប់ស្តូវបានបដនេម្លៅស្រទាប់ "រណ៌ា ទឹកប ិក"។ ស្រទាប់លនះក៏ដំលណីរការ
ផងដដរ (មនរ ៊ុម្រណ៌ា រលៅជ៊ុំវញិរូបភារតូចលៅកន៊ុងស្ប ប់ ប៉ា៊ុដនតលមី្ មិ្នលឃញីលទ លដ្ឋយសារដត
របាងំមនរណ៌ា រផងដដរ) និងរចួរ ់រស្មប់ការដកដស្ប។ 

៦.២.២. ការលរុស្រេទារ់របាងំ 

Delete Layer Mask លស្បីលដីម្ប ី៊ុបរបាងំស្រទាប់ដដ កំរ៊ុងដំលណីរការរបរ់ស្រទាប់ លដ្ឋយ
មិ្នចាបំាច់ដកដស្បស្រទាប់ដដ កំរ៊ុងដំលណីរការលដ្ឋយខ្លួនឯង ស្បរិនលបីស្រទាប់លនាះមិ្នមនរបាងំ
ស្រទាប់លទ ធាត៊ុម្៊ុឺន៊ុយនឹងបិទ និងមនរណ៌ា ស្បលផះ។ លដីម្ប ី៊ុបស្រទាប់របាងំ  នកអច ន៊ុវតដដូចខាង
លស្កាម្៖ 

•  នកអចចូ លស្បី កយបញ្ា  ៊ុបស្រទាប់របាងំរីរបារម្៊ុឺន៊ុយរូបភារតាម្រយៈ  

Layer →Mask → Delete Layer Mask 

• ឬរីម្៊ុឺន៊ុយល ចល ងីដដ  នកទទួ បានលដ្ឋយច៊ុចខាងសាត លំ ីស្រទាប់រកម្មលៅកន៊ុងស្ប ប់
ស្រទាប់។ 

រូបភារទី ៦.៦ មនជលស្មី្រលស្ចីន 

រូបភារទី ៦.៧ ស្រទាប់បានបលងកីត 
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៦.២.៣. ការរង្ហា ញស្រេទារ់របាងំ 

Show Layer Mask  ន៊ុញ្ញ តឱ្យ នកលមី្ លឃញីរបាងំស្រទាប់បានស្បលរីរជាងម្៊ុនលដ្ឋយបដងវរ
រូបភារលមី្ មិ្នលឃញី។ លៅលរ  នកច៊ុចល ីធាត៊ុម្៊ុឺន៊ុយ ជលស្មី្រធី្កមួ្យស្តូវបានបរហ ញលៅជាប់វា 
លហយីរូបភារតូចរបរ់របាងំស្រទាប់លៅកន៊ុងស្ប ប់ស្រទាប់ ស្តូវបានបរហ ញលដ្ឋយរ ៊ុម្រណ៌ា នបតង។ លបី
ស្រទាបល់នាះមិ្នស្តូវបានដកដស្ប  នកអចលបីកវាឱ្យលមី្ លឃញីម្តងលទៀតលៅលរ លស្កាយ។  នកអច
បរហ ញស្រទាប់របាងំ លដ្ឋយ ន៊ុវតដតាម្វធីិ្ដូចខាងលស្កាម្៖ 

•  នកអចចូ បរហ ញស្រទាប់របាងំរីរបារម្៊ុឺន៊ុយរូបភារតាម្រយៈ  

Layer → Mask → Show Layer Mask  

• ឬលដ្ឋយច៊ុច ស្ោប់ច៊ុច Alt  ឱ្យជាប់ ( Ctrl + Alt   លៅល ីស្បរ័នធមួ្យចំនួន) លហយីច៊ុចដត
ម្តងគត់ល ីរូបភារតូចរបរ់របាងំស្រទាប់កន៊ុងស្ប ប់ស្រទាប់។ 

•  នកអចមិ្នលធ្វីរកម្មភារលនះវញិលដ្ឋយលដ្ឋះធី្កធាត៊ុម្៊ុឺន៊ុយកន៊ុង Layer → Mask នន       
ម្៊ុីន៊ុយរង ឬលដ្ឋយ Alt -clicking (ឬ Ctrl + Alt -clicking) ម្ដងលទៀតលៅល រីូបភារតូច
របរ់ Layer Mask។ 

៦.២.៤. ការថ្កេស្រមលួស្រេទារ់របាងំ 

លៅលរ  នកច៊ុចល ី Edit Layer Mask លៅល ីម្៊ុឺន៊ុយរង Layer Mask រញ្ញ ធី្កមួ្យស្តូវបាន
បរហ ញលៅជាប់វា របាងំស្រទាប់កាល យជាធាត៊ុផសរំកម្មននស្រទាប់បចច៊ុបបនន លហយីរបាងំស្រទាប់ស្តូវបាន
បរហ ញលៅកន៊ុងស្ប ប់ Layers Dialog ជាមួ្យនឹងរ ៊ុម្រណ៌ា រ។ លៅលរ  នកលដ្ឋះធី្កវា ស្រទាប់ខ្លួនវា
កាល យជារមរធាត៊ុរកម្ម លហយីវាស្តូវបានបរហ ញលដ្ឋយរ ៊ុម្រណ៌ា រ។  នកក៏អចលធ្វីរកម្មភារ
រមរភាគដដ  នកចង់បានបដនេម្លទៀតលដ្ឋយស្ោន់ដតច៊ុចល ីវាលៅកន៊ុងស្ប ប់ស្រទាប់។ កន៊ុងការដក
រស្មួ្ ស្រទាប់របាងំ  នកអច ន៊ុវតដតាម្វធីិ្ដូចខាងលស្កាម្៖ 

•  នកអចចូ លស្បី កយបញ្ា លនះរីរបារម្៊ុឺន៊ុយរូបភារតាម្រយៈ  
Layer → Mask → Edit Layer Mask 

•  នកអចមិ្នលធ្វីរកម្មភារលនះវញិលដ្ឋយមិ្នធី្កធាត៊ុម្៊ុឺន៊ុយកន៊ុងម្៊ុឺន៊ុយ Layer → Mask ឬ
លដ្ឋយច៊ុចល ីរមរភាគស្រទាបក់ន៊ុងស្ប ប់ស្រទាប់។ 

៦.២.៥. ការរិទស្រេទារ់របាងំ 

ដរបណា នកបលងកីតស្រទាប់របាងំម្៊ុខ្ វាដំលណីរការល ីរូបភារ។  កយបញ្ា  Disable Layer 
Mask  ន៊ុញ្ញ តឱ្យ នកផ្លអ ករកម្មភារលនះ។ លៅលរ  នកច៊ុចល ីធាត៊ុម្៊ុឺន៊ុយ ជលស្មី្រធី្កមួ្យស្តូវបាន
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បរហ ញលៅជាប់វា លហយីរ ៊ុម្ននរូបភារតូចរបរ់របាងំស្រទាប់លៅកន៊ុងស្ប ប់ស្រទាប់ដស្បជារណ៌ា           
ស្កហម្។ កន៊ុងការបិទស្រទាប់របាងំ  នកអច ន៊ុវតដតាម្វធីិ្ដូចខាងលស្កាម្៖ 

•  នកអចចូ លស្បី កយបញ្ា លនះរីរបារម្៊ុឺន៊ុយរូបភារតាម្រយៈ  

Layer → Mask → Disable Layer Mask 

• ឬលដ្ឋយច៊ុច ស្ោប់ច៊ុច  Ctrl  ឱ្យជាប់ ( Ctrl + Alt លៅល ីស្បរ័នធមួ្យចំនួន) លហយីច៊ុចដត
ម្តងល ីរូបភារតូចរបរ់របាងំស្រទាប់កន៊ុងស្ប ប់ស្រទាប់។ 

•  នកអចមិ្នលធ្វីរកម្មភារលនះវញិលដ្ឋយលដ្ឋះធី្កធាត៊ុម្៊ុឺន៊ុយកន៊ុង  Layer → Mask ឬ
លដ្ឋយ Ctrl -clicking (ឬ Ctrl + Alt -clicking) ម្តងលទៀតលៅល ីរូបភារតូចរបរ់
ស្រទាបរ់បាងំ។ 

៦.២.៦. របាងំេស្រមារក់ារសស្ររើេសរ ើេ 

 កយបញ្ា  Mask to Selection បំដបលងរបាងំស្រទាប់ននស្រទាប់រកម្មលៅជាការលស្ជីរលររី 
ដដ ជំនួរការលស្ជីរលររីដដ រកម្មកន៊ុងរូបភាររចួលហយី។ តំបន់រណ៌ា រននរបាងំស្រទាប់ស្តូវបាន
លស្ជីរលររី តំបន់លមម មិ្នស្តូវបានលស្ជីរលររីលទ លហយីតំបន់រណ៌ា ស្បលផះស្តូវបានបំដបលងលៅជាការលស្ជីរ
លររីដដ មន កខណៈលផសងលទៀត។  

រូបភារខាងសាដ  ំ បរហ ញ ំរីការកំណត់
ស្រទាប់របាងំលៅជាការលស្ជីរលររី លដ្ឋយលៅ
ខាងល វ្ង ជារូបភារលដីម្ជាមួ្យនឹងការលស្ជីរ  
លររី។ លៅកណាត  ជាស្ប ប់ Layers Dialog 
ជាមួ្យស្រទាប់របាងំ ដដ បានបលងកីតជាមួ្យ
Layer's alpha channel option។ លៅខាងសាត  ំ ជា ទធផ បនាទ ប់រី ន៊ុវតត " Mask to 

Selection"  ដដ ការលស្ជីរលររីភីកដរ មិ្នថ្នល ននស្រទាប់រកម្មជំនួរការលស្ជីរលររីដំបូង។ 

កន៊ុង ន៊ុវតដរបាងំរស្មប់ការលស្ជីរលររី  នកអច ន៊ុវតដតាម្វធីិ្ដូចខាងលស្កាម្៖ 

•  នកអចចូ លស្បី កយបញ្ា លនះរីរបារម្៊ុឺន៊ុយរូបភារតាម្រយៈ  
Layer → Mask → Mask to Selection  

• ឬរីម្៊ុឺន៊ុយល ចល ងីដដ  នកទទួ បានលដ្ឋយច៊ុចខាងសាត លំ ីស្រទាប់រកម្មលៅកន៊ុងស្ប ប់
ស្រទាប់។ 

 

រូបភារទី ៦.៨ ការកំណត់ស្រទាប់របាងំ 
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៦.២.៧. ការរថ្នថមស្រេទារ់របាងំសៅនឹងការសស្ររើេសរ ើេ 

 កយបញ្ា  Add to Selection បំដបលងរបាងំស្រទាប់ននស្រទាប់រកម្មលៅជាការលស្ជីរលររី ដដ 
ស្តូវបានបដនេម្លៅការលស្ជីរលររីដដ កំរ៊ុងដំលណីរការកន៊ុងរូបភាររចួលហយី។ តំបន់រណ៌ា រននរបាងំ
ស្រទាប់ស្តូវបានលស្ជីរលររី តំបន់លមម មិ្នស្តូវបានលស្ជីរលររីលទ លហយីតំបន់រណ៌ា ស្បលផះស្តូវបានបំដបលង
លៅជាជលស្មី្រលផសងលទៀត។ របាងំស្រទាប់ខ្លួនឯងមិ្នស្តូវបានដកដស្បលដ្ឋយ កយបញ្ា លនះលទ (Add to 
Selection)។ 

រូបភារខាងសាដ  ំបរហ ញ ំរីការកំណត់
ការបដនេម្ស្រទាបរ់បាងំ លៅនឹងការលស្ជីរលររី 
លដ្ឋយលៅខាងល វ្ង ជារូបភារលដីម្ជាមួ្យនឹង
ការលស្ជីរលររី។ លៅកណាត  ជាស្ប ប់ 
Layers Dialog ជាមួ្យស្រទាប់របាងំ ដដ 
បានបលងកីតជាមួ្យ Layer's alpha channel 

option។ លៅខាងសាត  ំ ជា ទធផ បនាទ ប់រី ន៊ុវតត " Add Layer Mask to Selection"  ដដ ការ
លស្ជីរលររីភីកដរ មិ្នថ្នល ននស្រទាប់រកម្មជំនួរការលស្ជីរលររីដំបូង។ 

កន៊ុង ន៊ុវតដការបដនេម្ស្រទាប់របាងំលៅនឹងការលស្ជីរលររី  នកអច ន៊ុវតដតាម្វធីិ្ដូចខាងលស្កាម្៖ 

•  នកអចចូ លស្បី កយបញ្ា លនះរីរបារម្៊ុឺន៊ុយរូបភារតាម្រយៈ  
Layer → Mask → Add to Selection 

៦.២.៨. ការែកស្រេទារ់របាងំសនញពីការសស្ររើេសរ ើេ 

 កយបញ្ា  Subtract from Selection បំដ ងរបាងំស្រទាប់ននស្រទាប់រកម្មលៅជាការ
លស្ជីរលររី ដដ ស្តូវបានដកលចញរីការលស្ជីរលររីដដ ដំលណីរការកន៊ុងរូបភាររចួលហយី។ តំបន់រណ៌ា រ
ននរបាងំស្រទាប់ស្តូវបានលស្ជីរលររី តំបន់លមម មិ្នស្តូវបានលស្ជីរលររីលទ លហយីតំបន់រណ៌ា ស្បលផះស្តូវ
បានបំដបលងលៅជាជលស្មី្រលផសងលទៀត។ របាងំស្រទាប់ខ្លួនឯងមិ្នស្តូវបានដកដស្បលដ្ឋយ កយបញ្ា លនះលទ 
(Subtract from Selection)។ 

រូបភារខាងសាដ  ំ បរហ ញ ំរីការកំណត់
ការដកស្រទាបរ់បាងំ លចញរីការលស្ជីរលររី 
លដ្ឋយលៅខាងល វ្ង ជារូបភារលដីម្ជាមួ្យនឹង
ការលស្ជីរលររី។ លៅកណាត  ជាស្ប ប់ Layers 
Dialog ជាមួ្យស្រទាប់របាងំដដ បានបលងកីត

រូបភារទី ៦.៩ ការបដនេម្ស្រទាប់របាងំ 

រូបភារទី ៦.១០ ការដកស្រទាប់របាងំ 
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ជាមួ្យ Layer's alpha channel option។ លៅខាងសាត  ំ ជា ទធផ បនាទ ប់រី ន៊ុវតត " Subtract 
from Selection"  ដដ ការលស្ជីរលររីភីកដរ មិ្នថ្នល ននស្រទាប់រកម្មជំនួរការលស្ជីរលររីដំបូង។ 

កន៊ុង ន៊ុវតដការដកស្រទាប់របាងំលចញរីការលស្ជីរលររី  នកអច ន៊ុវតដតាម្វធីិ្ដូចខាងលស្កាម្៖ 

•  នកអចចូ លស្បី កយបញ្ា លនះរីរបារម្៊ុឺន៊ុយរូបភារតាម្រយៈ  
Layer → Mask → Subtract from Selection 

៦.២.៩. ការរថ្នថមឆាថ្នលអាលហ់្វវ (Alpha Channel) 

ឆ្ដន អ ់ហាវ ស្តូវបានបដនេម្លដ្ឋយរវ័យស្បវតតិលៅកន៊ុងស្ប ប់ស្ប ប់ភាល ម្ៗ លៅលរ  នក
បដនេម្ស្រទាប់ទីរីរលៅរូបភាររបរ់ នក។ វាតំណាងឱ្យភារនថ្លននរូបភារ។ ស្បរិនលបីរូបភាររបរ់ នក
មនស្រទាប់ដតមួ្យ ស្រទាប់នផទខាងលស្កាយលនះមិ្នមនឆ្ដន អ ់ហាវ លទ។ កន៊ុងករណីលនះ  នកអច
បដនេម្ឆ្ដន អ ់ហាវ លដ្ឋយលស្បី កយបញ្ា លនះ (Add Alpha Channe)។ 

កន៊ុង ន៊ុវតដការបដនេម្ឆ្ដន អ ់ហាវ   នកអច ន៊ុវតដតាម្វធីិ្ដូចខាងលស្កាម្៖ 

•  នកអចចូ លស្បី កយបញ្ា លនះរីរបារម្៊ុឺន៊ុយរូបភារតាម្រយៈ  
Layer → Transparency → Add Alpha Channel 

• ល ីររីលនះលទៀត លៅស្ប ប់ស្រទាប់  នកអចចូ លស្បីវាតាម្រយៈ Add Alpha Channel នន
ម្៊ុឺន៊ុយល ចល ងីបរបិទរបរ់វា។ 

៦.២.១០. លរុឆាថ្នលអាលហ់្វវ  

 កយបញ្ា លនះ គឺដកឆ្ដន អ ់ហាវ ននស្រទាប់រកម្មលដ្ឋយរកាឆ្ដន អ ់ហាវ ននស្រទាប់
លផសងលទៀត។ ស្បរិនលបីស្រទាប់រកម្មគឺជាស្រទាប់នផទខាងលស្កាយ លហយីស្បរិនលបី នកមិ្នបានបដនេម្
ឆ្ដន អ ់ហាវ រីម្៊ុនលទ (បនាទ ប់ម្កលឈាម ះស្រទាប់គឺលៅកន៊ុង កសរដិតលៅកន៊ុងស្ប ប់ស្រទាប់)  កយ
បញ្ា ស្តូវបានបិទ។ ស្បរិនលបីស្រទាប់រកម្មមិ្នដម្នជាស្រទាប់នផទខាងលស្កាយលទ ភារនថ្លស្តូវបាន
ជំនួរលដ្ឋយរណ៌ា នផទខាងលស្កាយននស្ប ប់ឧបករណ៍។ 

កន៊ុង ន៊ុវតដការ ៊ុបឆ្ដន អ ់ហាវ   នកអច ន៊ុវតដតាម្វធីិ្ដូចខាងលស្កាម្៖ 

•  នកអចចូ លស្បី កយបញ្ា លនះរីរបារម្៊ុឺន៊ុយរូបភារតាម្រយៈ  
Layer → Transparency → Remove Alpha Channel 

• ល ីររីលនះលទៀត លៅស្ប ប់ស្រទាប់  នកអចចូ លស្បីវាតាម្រយៈ Remove Alpha 
Channel ននម្៊ុឺន៊ុយល ចល ងីបរបិទរបរ់វា។ 
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៦.៣. ការថ្កថ្ស្ររភាពថាែ ច្នស្រេទារ់ាមួយនឹងរបាងំ 

លៅចំណ៊ុ ចលនះ រ ់ស្បតិបតតិការដដ បាន ន៊ុវតតលៅល ី
ផ្លទ ងំស្កណាត់ (cavas) នឹង ន៊ុវតតចំល ះរបាងំ និងមិ្នអច ន៊ុ
វតដលៅល ីស្រទាប់ណាមួ្យលដ្ឋយខ្លួនឯងបានល យី។ លដីម្បី
បរហ ញរីរលបៀប ដដ របាងំអចលធ្វីឱ្យមនភារថ្នល ននស្រទាប់
របរ់វា  នកស្តូវ ន៊ុវតដដូចខាងលស្កាម្៖ 

ជាជំហានដំបូងនឹងលស្បី Rectangle Select tool លដីម្បី
លស្ជីរលររីដផនកខាងល ីមួ្យភាគបីននរូបភារ លហយី នកស្តូវ
កំណត់ជលស្មី្រលនះលដ្ឋយរណ៌ា លមម ។ 

Tools → Selection Tools → Rectangle Select 

លដ្ឋយលស្បី Rectangle Select tool ស្តូវលស្ជីរលររីដផនកខាងល ីមួ្យភាគបីននរូបភារ ៖   

 

 

 

 នកស្តូវបំលរញលស្ជីរលររី (selection) លនះលដ្ឋយរណ៌ា លមម  ប៉ា៊ុដនតម្៊ុននឹងលធ្វី  នកស្តូវស្បាកដថ្ន
រណ៌ា នផទខាងម្៊ុខ្ (foreground color) របរ់ នកគឺរណ៌ា លមម ។ ច៊ុចល រីណ៌ា នផទខាងម្៊ុខ្កន៊ុង នផទរណ៌ា  
(Color area) លដីម្បបីរហ ញស្ប ប់ "ផ្លល រ់បដូររណ៌ា នផទខាងម្៊ុខ្ (Change Foreground Color)"៖ 

 

 

កន៊ុងស្ប ប់ "ផ្លល រ់បតូររណ៌ា នផទខាងម្៊ុខ្"  ន៊ុញ្ញ តឱ្យ នកកំណត់រណ៌ា នផទខាងម្៊ុខ្។  រស្មប់
ឧទាហរណ៍លនះកំណត់រណ៌ា លៅជាលមម  RGB (0, 0, 0)៖ 

 

 

 

រូបភារទី ៦.១១ លស្ជីរលររីរងចត៊ុលកាណដកង 
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ជាមួ្យនឹងរំណ៊ុំ រណ៌ា នផទខាងម្៊ុខ្ ឥ ូវលនះ នកអចលស្បី Bucket 
Fill Tool លដីម្បបំីលរញការលស្ជីរលររី។ 

T ools → P aint Tools → B ucket Fill  

 

 

ឥ ូវលនះ  នកអចច៊ុចកន៊ុងជលស្មី្រលដីម្បបំីលរញវា
លដ្ឋយរណ៌ា នផទខាងម្៊ុខ្ (លមម )។ លៅលរ ដដ  នកលធ្វីភាល ម្ 
 នកនឹងស្តូវបានបរហ ញជាមួ្យនឹងទិដាភារថ្មីននរូបភាររបរ់
 នកលៅល ីផ្លទ ងំស្កណាត់។ 

 

ដូចដដ  នកអចលឃញី ការបំលរញដផនកដដ បាន
លស្ជីរលររីននរបាងំស្រទាប់ជាមួ្យនឹងរណ៌ា លមម  បណាត  
ឱ្យនផទលនាះមនភារតនម្ល 100% ដដ អចបរហ ញស្រទាប់
ខាងលស្កាម្វាបានចារ់។ 

ស្បរិនលបី នកលធ្វីការ ន៊ុវតដ ការលស្ជីរលររីរងជា
ចត៊ុលកាណល នីផទលផសងននរបាងំ  នកអចបំលរញវាលដ្ឋយ
ស្រលម លផសងោន ននរណ៌ា ស្បលផះ លដីម្បបីលងកីតភារស្រអប់
 លថ្រ។ ជាឧទាហរណ៍ ខ្្៊ុ ំនឹងលស្ជីរលររីតំបន់លផសងោន មួ្យចំនួនននរបាងំម្៊ុខ្ លហយីបំលរញវាលដ្ឋយ
កស្មិ្តរណ៌ា ស្បលផះលផសងៗោន ។ 

ស្បរិនលបី នករិនិតយលមី្ របាងំស្រទាប់  នកនឹងលឃញីថ្នមនកស្មិ្តរណ៌ា ស្បលផះខ្៊ុរៗោន  (រី
លមម លៅរ រីកំរូ លៅបាត) លហយីតនម្លរបរ់វាគឺជា វីដដ កំណត់ភារស្រអប់ននស្រទាប់។ 

ឧទាហរណ៍ច្នការសស្ររើេសរ ើេពណ៌ 

ឧទាហរណ៍ដ៏ អននការ ន៊ុវតតស្រទាប់របាងំ គឺការលធ្វីការលស្ជីរលររីរណ៌ា ននរូបភារ (លស្ជីរលររី
លដ្ឋយ ន៊ុញ្ញ តឱ្យរណ៌ា បរហ ញតាម្រយៈរូបភារភាគលស្ចីនជារ និងលមម )។ ខ្្៊ុ ំនឹង ន៊ុវតដរីរលបៀបលធ្វី
ោ៉ា ងរយស្រួ ជាម្ួយរូបភារដូចខាងលស្កាម្៖ 

ចាប់លផតីម្ដំលណីរការលដ្ឋយចម្លងរូបភារលដីម្ (Shift+Ctrl+D, ឬ Right-Click Layer→ 
Duplicate Layer)។ តាម្រយៈម្៊ុឺន៊ុយ៖ 

រូបភារទី ៦.១២ Bucket Fill Tool 

រូបភារទី ៦.១៣ ច៊ុចកន៊ុងជលស្មី្រ 

រូបភារទី ៦.១៤ ការកំណត់កស្មិ្តស្រអប់ 



89 

Layer → Duplicate Layer 

បនាទ ប់ម្កលធ្វីឱ្យស្រទាប់ខាងល ី desaturate លដ្ឋយលស្បី៖ 

Colors → Desaturate 

 ន៊ុវតតតាម្ជំហានខាងល ី បដនេម្ស្រទាប់របាងំមួ្យលៅ
ស្រទាប់ដដ  ន៊ុវតដខាងល ី លហយីចាប់លផតីម្វាលៅជា រ (ភារ
ស្រអប់លរញ)។ លៅចំណ៊ុ ចលនះ ស្ប ប់ស្រទាប់គួរដតលមី្ លៅដូច
រូបខាងសាដ ។ំ  

ដូចរីម្៊ុនផងដដរ  នកស្តូវកំណត់រណ៌ា នផទខាងម្៊ុខ្របរ់ នកលៅជា
លមម ។ ល ីកលនះ ជាជាងការបំលរញការលស្ជីរលររី លយងីនឹងលស្បី ឧបករណ៍ 
Paintbrush លដីម្បគូីរតំបន់ននរូបភារដដ លយងីចង់ឱ្យរណ៌ា បរហ ញតាម្ 
រយៈស្រទាប់ខាងលស្កាម្។ 

 

 

ខ្្៊ុ ំបានរលស្ម្ចចិតតគូរលកមងស្បុរលៅល ីរបង។ លដ្ឋយលស្បី 
ឧបករណ៍ Paintbrush ខ្្៊ុ ំបានោបល ីអវ និងកា របរ់ោត់។ 
វា ន៊ុញ្ញ តឱ្យរណ៌ា ទាងំលនាះបរហ ញតាម្រយៈស្រទាប់ខាងលស្កាម្។
ខាងសាដ លំនះជា ទធផ បនាទ ប់រីការោបរណ៌ា ។ 

 

 

លដីម្បបីរហ ញរី វីដដ ស្តូវបានលធ្វី ខាងល វ្ងលនះគឺជា Layer 
Mask ដដ ខ្្៊ុំបានោបលដីម្បទីទួ បាន ទធផ ខាងល ី។ 

 

ជាការរិតណារ់ ខ្្៊ុ ំអចលស្ជីរលររីរណ៌ា លផសងរីរណ៌ា លមម  
លដីម្បបីលងកីតរបាងំបាន។ ស្បរិនលបីខ្្៊ុ ំចង់បានរណ៌ា ដដ ងងឹតជាង
លនះបនតិច ខ្្៊ុអំចោបរណ៌ា ស្បលផះស្តង់ដផនកកណាត  លធ្ៀបនឹងលមម
បាន ដូចបរហ ញកន៊ុងរូបខាងលស្កាម្ ដដ លធ្វីការជាមួ្យរណ៌ា          
ស្បលផះ។  

 

រូបភារទី ៦.១៥ រូបភារកន៊ុងសាេ នភារលដីម្ 

រូបភារទី ៦.១៦ ស្រទាប់ថ្មីបានបលងកីត 

រូបភារទី ៦.១៧  ទធផ ននការោបរណ៌ា  

រូបភារទី ៦.១៨ ស្រទាប់របាងំ 

រូបភារទី ៦.១៩  ទធផ ននការកំណត់ 
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េណួំររលំកឹសមសរៀន 

1- លតី វីជាលោ បំណងននការលស្បីស្បារ់ Layer Masks លៅកន៊ុង GIMP លហយីលតីរួកវា ន៊ុញ្ញ តឱ្យ
មនការដករស្មួ្ ដដ មិ្នមនការប៉ាះ  ់ និងការោយបញ្ចូ  ោន ននស្រទាប់ជាលស្ចីនលៅ
កន៊ុងរូបភារលដ្ឋយរលបៀបណា? 

2- លតី នកអចរនយ ់រីដំលណីរការននការបលងកីត Layer Mask លៅកន៊ុង GIMP និងរលបៀបដដ វា
អចស្តូវបានលស្បីលដីម្បលីស្ជីរលររីបរហ ញ ឬោក់ដផនកខ្លះននស្រទាប់មួ្យ? 

3- លតី វីលៅជា តេស្បលោជន៍ននការលស្បីស្បារ់រូបភាររណ៌ា ស្បលផះជាស្រទាប់របាងំលៅកន៊ុង GIMP 
លហយីលតីរួកវាអចលស្បីលដីម្បសី្គប់ស្គងភារស្រអប់ ឬភារនថ្លនននផទជាក់ោក់លៅកន៊ុងស្រទាប់
មួ្យោ៉ា ងដូចលម្តច? 

4- លតីមនស្ោប់ច៊ុចផលូវកាត់ណាមួ្យដដ មនលៅកន៊ុង GIMP ដដ លបីកការដកតស្មូ្វភារស្រអប់ 
ឬស្រទាប់របាងំ ដដ  ន៊ុញ្ញ តឱ្យលធ្វីការដកតស្មូ្វការោយបញ្ចូ  ោន  និងភារនថ្លននដផនកជាក់
ោក់លៅកន៊ុងស្រទាប់លទ?  លបីដូលចនះ លតីស្ោប់ច៊ុចផលូវកាត់ទាងំលនាះមន វីខ្លះ? 

5- លតី នកអចផត ់ការលរៀបរប់ ំរីស្ោប់ច៊ុចផលូវកាត់រំខាន់ៗលៅកន៊ុង GIMP ដដ ផដ ់ ទធភារលធ្វី
ការជាមួ្យស្រទាប់របាងំ លដ្ឋយរនយ ់រលងខប ំរីម្៊ុខ្រររបរ់រួកលគបានលទ?  

6- លតីស្រទាប់របាងំអចស្តូវបានបដនេម្លៅស្រទាប់ដដ មនស្សាប់លៅកន៊ុង GIMP ោ៉ា ងដូចលម្តច 
លហយីលតីមនជំហាន វីខ្លះដដ  ក់រ័នធនឹងការបលងកីត និង ន៊ុវតតរបាងំ? លតី នកអចផត ់ការ
រនយ ់ ម្អិត ំរីដំលណីរការបានលទ? 

7- លតីមនវធីិ្លផសងោន  វីខ្លះលៅកន៊ុង GIMP លដីម្បបីលងកីតស្រទាប់របាងំរស្មប់ស្រទាប់ជាក់ោក់
មួ្យ? លតី នកអចរនយ ់រីភារខ្៊ុរោន រវាងការលស្បីរូបភារមស្តដ្ឋា នស្បលផះជារបាងំ និងការ
លស្បីជលស្មី្រជារបាងំម្៊ុខ្បានលទ? 

8- លតីឧបករណ៍ជក់លៅកន៊ុង GIMP អចស្តូវបានលស្បីលដីម្បគូីរល ីស្រទាប់របាងំលដ្ឋយរលបៀបណា 
លហយីលស្ជីរលររីបរហ ញ ឬោក់ដផនកខ្លះននស្រទាប់ខាងលស្កាម្? លតីមនបលចចកលទរ ឬការ
កំណត់ជាក់ោក់ណាមួ្យដដ  នកគួរចងចាលំរ លស្បីឧបករណ៍ជក់រស្មប់បិទបាងំ? 

9- លតីរបាងំអចស្តូវបានដកលចញរីការលស្ជីរលររីលៅកន៊ុង GIMP ោ៉ា ងដូចលម្តច លហយីលតីមន
ជំហាន វីខ្លះដដ  ក់រ័នធកន៊ុងដំលណីរការលនះ? លតី នកអចផត ់ការរនយ ់ ម្អិត ំរីរកម្មភារ
ចាបំាច់លដីម្បយីករបាងំលចញបានលទ? 

  
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សមសរៀនទី ៧៖ ការស្រនឹរ នងិរតូរទហំរំរូភាព 

៧.១. លកេណៈទូសៅ 

ឧបករណ៍ស្ចឹបស្តូវបានលស្បីលដីម្បសី្ចឹប ឬ កាត់រូបភារ ឬ    
ស្រទាប់។ ឧបករណ៍លនះស្តូវបានលស្បីជាញឹកញាប់ លដីម្ប ី៊ុប
បំបាត់តំបន់ដដ មិ្នចង់បាន លដីម្បផីត ់ឱ្យ នកនូវតំបន់លធ្វីការ
ដដ លផ្លត តអរម្មណ៍ជាងម្៊ុន។ វាក៏មនស្បលោជន៍ផងដដរ ស្បរិន
លបី នកស្តូវការទំហរំូបភារជាក់ោក់ ដដ មិ្នស្តូវោន នឹងទំហលំដីម្
ននរូបភាររបរ់ នក។  

លដីម្បលីស្បីឧបករណ៍លនះ រូម្ច៊ុចដផនកខាងកន៊ុងននរូបភារ លហយី ូរលចញនូវតំបន់ចត៊ុលកាណ 
ម្៊ុនលរ ដ ងប ូត៊ុងកណដ៊ុ រ។ លៅលរ  នកច៊ុច ស្ប ប់មួ្យនឹងបរហ ញ នករីវមិស្តននតំបន់ស្ចឹប លហយី
 ន៊ុញ្ញ តឱ្យ នក ន៊ុវតតរកម្មភារលផសងៗ។ ស្បរិនលបី នកចង់ដកដស្បតំបន់ស្ចឹប  នកអចលធ្វីដូលចនះបាន
លដ្ឋយច៊ុច និង ូរល ីស្ជុង ឬលដ្ឋយការផ្លល រ់បតូរតនម្លកន៊ុងស្ប ប់។ លៅលរ  នករចួរ ់  នកអចបញ្ច ប់
ស្បតិបតតិការលដ្ឋយច៊ុចលៅខាងកន៊ុងតំបន់ស្ចឹប ឬលដ្ឋយច៊ុចប ូត៊ុងស្ចឹប ឬបតូរទំហលំៅល ីស្ប ប់។ 

 ៧.២. រសរៀរសស្ររើស្របាេឧ់រករណ៍ស្រនឹរ 

 នកអចចូ លស្បីឧបករណ៍ Crop Tool តាម្វធីិ្លផសងៗោន ៖ 

• រីម្៊ុឺន៊ុយរូបភារ៖ Tools → Transform Tools → Crop and Resize 
• លដ្ឋយច៊ុចល ីរូបតំណាងឧបករណ៍   លៅកន៊ុងស្ប ប់ឧបករណ៍ 
• លដ្ឋយលស្បីផលូវកាត់កាត រច៊ុច    Shift+C  

៧.៣. ស្រោរ់នុន (លនំាសំែើម) 

• បញ្ា (Ctrl)៖ ការច៊ុច Ctrl ឱ្យជាប់ នឹងបតូររលបៀបឧបករណ៍ស្ចឹបរវាងស្ចឹប និងបតូរទំហ។ំ 

• បដូរ (Shift)៖ ការច៊ុច Shift ឱ្យជាប់នឹងបិទ/លបីកននរមមស្ត Fixed Aspect ។ 

• ជំនរួ (Alt)៖ ការច៊ុច Alt ឱ្យជាប់នឹងបិទ/លបីកការលស្បីស្បារ់ Allow Enlarging ។ 

 

រូបភារទី ៧.១ ឧបករណ៍ស្ចឹប 
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៧.៤. រសស្រមើេឧរករណ៍ 

លដីម្បលីបីកផ្លទ ងំជលស្មី្រឧបករណ៍រស្មប់ស្ចឹបអចចូ លស្បីបានលដ្ឋយច៊ុចរីរដងល ីរូបតំណាង
ឧបករណ៍ស្ចឹប កន៊ុងស្ប ប់ឧបករណ៍។ 

Tool Toggle៖  រស្មប់ផ្លដ រ់បដូរម្៊ុខ្ររននឧបករណ៍ស្ចឹប 
ដដ ផ្លដ រ់បដូររវាងម្៊ុខ្ររស្ចឹប និង ម្៊ុខ្ររបដូរទំហ ំ។  

Crop Mode គឺជាទស្ម្ង់រតង់ដ្ឋរននស្បតិបតតិការរស្មប់ 
Crop Tool។ ការស្ចឹបរូបភារ ឬស្រទាប់នឹងផ្លល រ់បតូរស្រទាប់មួ្យ 
លដ្ឋយ ៊ុប វីៗទាងំ រ់លៅខាងលស្ៅតំបន់ស្ចឹប។ តំបន់ស្ចឹបអច
ស្តូវបានកំណត់លដ្ឋយ ូរឧបករណ៍ លដីម្បបីលងកីតជានផទចត៊ុលកាណ
ដកង ឬកំណត់ស្បភរលដីម្ ទទឹង និងកម្ពរ់លដ្ឋយ នកលស្បីស្បារ។់ តំបន់ស្ចឹបក៏អចស្តូវបានកំណត់
លដ្ឋយដផអកល ីជលស្មី្រដដ មនស្សាប់ ឬលដ្ឋយលស្បីប ូត៊ុងបស្ងួម្លដ្ឋយរវ័យស្បវតតិផងដដរ។ ជលស្មី្រទាងំ
លនះមនលៅកន៊ុងស្ប ប់រ័ត៌ាមនស្ចឹប និងផ្លល រ់បតូរទំហ ំ ដដ ស្តូវបានបរហ ញលៅលរ ឧបករណ៍ស្ចឹបស្តូវ
បានច៊ុចល ីរូបភារ ឬស្រទាប់។ 

ស្បរិនលបី នកកំរ៊ុងស្ចឹបរូបភារ (រមួ្ទាងំស្រទាប់) លនាះ Resize Mode ផ្លល រ់បតូររូបរងរបរ់រូប
ភារលដ្ឋយមិ្នផ្លល រ់បតូរទំហ ំឬរូបរងរបរ់ស្រទាប់លនាះលទ។ វាអចនឹងទ៊ុកដផនកខ្លះននស្រទាបដ់ដ ោត
រនធឹងហួររីដគម្ននរូបភារ ដដ  នកមិ្នអចលមី្ លឃញីរួកវា ប៉ា៊ុដនតស្បរិនលបី នកផ្លល រ់ទីស្រទាបល់នាះ 
 នកនឹងលឃញីថ្នដផនកលផសងលទៀតលៅដតមន។ ស្បរិនលបី នកកំរ៊ុងស្ចឹបស្រទាប់ លនាះម្៊ុខ្ររបដូរទំហលំធ្វី
ដូចោន នឹងរលបៀបស្ចឹបដដរ។ 

• Current Layer Only៖ ជលស្មី្រលនះនឹងលធ្វីឱ្យការស្ចឹប ឬផ្លល រ់បតូរទំហដំដ  ន៊ុវតដដតចំល ះ
ស្រទាប់រកម្មប៉ា៊ុលណាណ ះ។ 

• Allow Enlarging៖ ជលស្មី្រលនះ ន៊ុញ្ញ តឱ្យស្ចឹប ឬបដូរទំហដំដ លធ្វីល ងីលៅលស្ៅស្រំដដនរូប
ភារ ឬស្រទាប់។ 

• Fixed Aspect Ratio៖ ជាមួ្យនឹងជលស្មី្រលនះ ការស្ចឹបនឹងលោរររមមស្តលថ្ររវាងទទឹង 
និងកម្ពរ់។ 

រូបភារទី ៧.២ ជលស្មី្រឧបករណ៍ 
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៧.៥. ឧទាហរណ៍ច្នការស្រនឹរ និងរតូរទំហរំរូភាព 

៧.៥.១. ការផ្លែ េរ់តូរទំហចំ្នររូភាព 

វាជាបញ្ហ ទូលៅដដ  នកស្បដហ ជាមនរូបភារ ដដ មនទំហធំំ្លរករស្មប់លោ បំណង
ជាក់ោក់មួ្យ (បលរហ ះកន៊ុងលគហទំរ័រ បលរហ ះលៅកដនលងណាមួ្យតាម្ ៊ុីនធឺ្ណិត ឬភាា ប់កន៊ុង ៊ុីដម្ ជា
លដីម្)។ កន៊ុងករណីលនះ  នកនឹងចង់លធ្វី មស្តដ្ឋា ន (scale) រូបភារឱ្យតូចជាងដដ រ័កតិរម្រស្មប់
ការលស្បីស្បារ់របរ់ នក។ 

លៅលរ  នកលបីករូបភាររបរ់ នកជាល ីកដំបូងលៅកន៊ុង GIMP ឱ្ការដដ រូបភារនឹងស្តូវបាន
រស្ងីកលដីម្បឱី្យរូបភារទាងំមូ្ រម្នឹងផ្លទ ងំស្កណាត់របរ់ នក។ លរឿងដដ ស្តូវកត់រមា  ់រស្មប់
ឧទាហរណ៍លនះគឺថ្នតាម្ ំនាលំដីម្ ការត៊ុបដតងផ្លទ ងំបងអួចលៅដផនកខាងល ីនន GIMP នឹងបរហ ញ នកនូវ
រ័ត៌ាមនមួ្យចំនួន ំរីរូបភារ។ 

រូម្កត់រមា  ់ថ្នរ័ត៌ាមនលៅដផនកខាងល ីននបងអួច បរហ ញ
ទំហភីំកដរ បចច៊ុបបននននរូបភារ (កន៊ុងករណីលនះទំហភីំកដរ គឺ 
1225 × 1280) ។ 

លដីម្បបីតូរទំហរំូបភារលៅជាវមិស្តថ្មី លយងីស្តូវការដតស្ប ប់ 
Scale Image ប៉ា៊ុលណាណ ះ ៖ 

Image → Scale Image… 

បនាទ ប់ម្កវានឹងលបីក ស្ប ប់ Scale Image ដូចខាងសាដ ំ
លនះ។លៅកន៊ុងស្ប ប់ Scale Image  នកនឹងរកលឃញី កដនលងមួ្យ
លដីម្បបីញ្ចូ  តនម្លថ្មីរស្មប់ ទទឹង (Width) និងកម្ពរ់ (Height)។
ស្បរិនលបី នកដឹងរីវមិស្តថ្មីណាមួ្យ ដដ  នកចង់បានរស្មប់រូប
ភារ រូម្បំលរញវាលៅទីលនះ។ 

 នកក៏នឹងរមា  ់លឃញីដខ្សររវ ក់តូចមួ្យ លៅខាងសាដ នំន
ស្ប ប់បញ្ចូ   ទទឹង និងកម្ពរ់។ រូបតំណាងលនះបរហ ញថ្នតនម្ល
ទទឹង និងកម្ពរ់ស្តូវបានចាក់លសា លដីម្បភីាា ប់ជលស្មី្រទាងំរីរលនះ
ជាមួ្យោន  ដដ មនន័យថ្ន ការផ្លល រ់បតូរតនម្លមួ្យនឹងលធ្វីឱ្យតនម្លមួ្យ
លទៀតផ្លល រ់បតូរ លដីម្បរីការមមស្តដូចោន ។ 

រូបភារទី ៧.៣ រូបភារកន៊ុងសាេ នភារលដីម្ 

រូបភារទី ៧.៤ ស្ប ប់ Scale Image 

រូបភារទី ៧.៥ ការដកដស្បវមិស្តននរូបភារ 
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ឧទាហរណ៍ ស្បរិនលបី នកដឹងថ្ន នកចង់ឱ្យរូបភាររបរ់ នកមនទទឹងថ្មី 600px  នកអច
បញ្ចូ  តនម្លលនាះកន៊ុង Width input លហយី Height នឹងផ្លល រ់បតូរលដ្ឋយរវ័យស្បវតតិ លដីម្បរីការមមស្ត
ននរូបភារ។  

ដូចដដ  នកអចលឃញីការបញ្ចូ   600px រស្មប់
ទទឹងនឹងផ្លល រ់បតូរកម្ពរ់លដ្ឋយរវ័យស្បវតតិលៅ 627px ។ រូម្
កត់រមា  ់ផងដដរ ខ្្៊ុ ំបានបរហ ញរីជលស្មី្រលផសងលៅលស្កាម្ 
Quality → Interpolation។ តនម្ល ំនាលំដីម្រស្មប់លនះ
គឺ Cubic ប៉ា៊ុដនតលដីម្បរីកាគ៊ុណភារ អបំផ៊ុត វាជាការស្បលរីរកន៊ុង
ការលស្បី Sinc (Lanczos3)។ 

ស្បរិនលបី នកចង់កំណត់ទំហថំ្មី លដ្ឋយលស្បីស្បលភទតនម្ល
លផសងោន  (លស្ៅរីទំហ ំPixel)  នកអចបតូរស្បលភទលដ្ឋយច៊ុចល  ី
" px " spinner។ ការលស្បីស្បារ់ទូលៅរស្មប់ការផ្លល រ់បដូរលនះ
អចលៅរចួ ស្បរិនលបី នកចង់បញ្ា ក់ទំហថំ្មីជាភាគរយននទំហចំារ់។ កន៊ុងករណីលនះ  នកអចបតូរលៅជា 
"ភាគរយ" លហយីបនាទ ប់ម្កបញ្ចូ   50 លៅកន៊ុងនផទណាមួ្យលដីម្បលីធ្វីមស្តដ្ឋា នរូបភារជា ក់កណាត  ។ 

៧.៥.២. ការផ្លែ េរ់តូរទំហរំរូភាពស្ររសេទ JPEG 

ការដកដស្បទំហឯំកសារននរូបភារលៅលរ នាលំចញវាលៅ
ជាទស្ម្ង់ដូចជា JPEG ។ JPEG គឺជាស្បលភទ lossy 
compression algorithm  ដដ មនន័យថ្នលៅលរ រកាទ៊ុក
រូបភារលៅជាទស្ម្ង់ JPEG  នកនឹង ះបង់គ៊ុណភាររូបភារ
មួ្យចំនួន លដីម្បទីទួ បានទំហឯំកសារតូចជាងម្៊ុន។ លស្បីរូប
ភារ Horsehead Nebula ដូចោន រីខាងល ី បតូរទំហវំាលៅជា
ទទឹង 200px (រូម្លមី្ ខាងល ី) លហយីនាលំចញវាលដ្ឋយលស្បី
កស្មិ្តលផសងៗោន ននរូបភារស្បលភទ JPEG។  

ដូចដដ  នកអចលឃញីលហយីថ្ន រូម្បដីតការកំណត់គ៊ុណភារ 80 រូបភារគឺតូចជាងម្៊ុនោ៉ា ង
ខាល ងំរស្មប់ទំហឯំកសារ (ការកាត់បនេយទំហ ំ 77%) ខ្ណៈលរ ដដ គ៊ុណភាររូបភារលៅដតរម្
លហត៊ុផ ។ 

 
 

រូបភារទី ៧.៦ ការផ្លល រ់បដូរខាន តននរូបភារ 

រូបភារទី ៧.៧ កស្មិ្តគ៊ុណភារននរូបភារ 
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លៅលរ ដដ  នកបានបញ្ច ប់ការដកដស្បរូប
ភារណាមួ្យដដ  នកកំរ៊ុងលធ្វី លហយីរចួរ ់កន៊ុងការ
នាលំចញ លនាះស្ោន់ដតលៅស្ប ប់នាលំចញជាមួ្យ៖ 

File → Export… 

វានឹងលៅស្ប ប់ នាលំចញរូបភារ ដូចខាង
ល វ្ងលនះ។  

 

ឥ ូវលនះ  នកអចបញ្ចូ   លឈាម ះថ្មីរស្មប់ឯកសាររបរ់
 នកលៅទីលនះ។ ស្បរិនលបី នករមួ្បញ្ចូ  ដផនកបដនេម្ស្បលភទឯកសារ 
(កន៊ុងករណីលនះ.jpg) GIMP នឹងរាោម្នាលំចញលដ្ឋយរវ័យស្បវតតិ
កន៊ុងទស្ម្ង់ឯកសារលនាះរស្មប់ នក។ លៅទីលនះខ្្៊ុ ំកំរ៊ុងនាលំចញរូប
ភារជាស្បលភទJPEG។  នកក៏អចរ៊ុក រកលៅកាន់ទីតាងំថ្មីលៅល ីក៊ុំ
រយូទ័ររបរ់ នកតាម្រយៈ ផ្លទ ងំ Places ស្បរិនលបី នកស្តូវការនាលំចញ
ឯកសារលៅទីតាងំលផសង។ លៅលរ  នកបានកំណត់រចួរ ់លដីម្បនីាលំចញរូបភារលនាះ ស្ោន់ដតច៊ុចប ូ
ត៊ុង Export។ បនាទ ប់ម្កវានឹងបរហ ញ ស្ប ប់ នាលំចញរូបភារជា JPEG ដដ  នកអចផ្លល រ់បតូរគ៊ុណ
ភារននការនាលំចញ។  

រស្មប់ស្ប ប់លនះ  នកអចផ្លល រ់បតូរគ៊ុណភារនន
ការនាលំចញ ។ ស្បរិនលបី នកបានធី្កជលស្មី្រ "Show 
preview in image window" លនាះរូបភារលៅល ីផ្លទ ងំស្ក
ណាត់នឹងអប់លដតលដីម្បី្ ល៊ុះបញ្ច ងំរីតនម្លគ៊ុណភារដដ 
 នកបញ្ចូ  ។ វានឹងលបីកដំលណីរការរ័ត៌ាមន "File size:" 
លដីម្បសី្បាប់ នក ំរីទំហឯំកសារ     លៅលរ  នកលរញចិតដ
នឹង ទធផ លនះលហយី រូម្ច៊ុច ប ូត៊ុង  Export លដីម្បនីាលំចញ។ 

៧.៥.៣. ការស្រនឹរររូភាព 

មនលហត៊ុផ ជាលស្ចីន ដដ  នកស្បដហ ជាចង់
ស្ចឹបរូបភារ។  នកស្បដហ ជាចង់ ៊ុបស្រំដដន ឬរ័ត៌ាមន
ដដ ោម នស្បលោជន៍លចញ រស្មប់លហត៊ុផ លសាភ័ណ
ភារ ឬ នកស្បដហ ជាចង់ឱ្យការលផ្លត តអរម្មណ៍ននរូបភារ

រូបភារទី ៧.៨ ស្ប ប់នាលំចញរូបភារ 

រូបភារទី ៧.៩ កំណត់គ៊ុណភាររូបភារ 

រូបភារទី ៧.១០ រូបភារម្៊ុននឹងលស្កាយស្ចឹប 

រូបភារទី  ៧.១១ Crop tool 
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ច៊ុងលស្កាយ មនរ័ត៌ាមន ម្អិតជាក់ោក់។ ររ៊ុបម្កការស្ចឹបគឺស្ោន់ដតជាស្បតិបតតិការមួ្យ លដីម្បកីាត់
បនេយរូបភារឱ្យតូចជាងស្ទង់ស្ទាយលដីម្។ 

ដំលណីរការកាត់រូបភារ លដ្ឋយោម នភាររម៊ុកសាម ញលនាះលទ។  នកអចចូ លៅ Crop Tool តាម្ 
រយៈស្ប ប់ឧបករណ៍។ ឬ នកអចចូ លស្បីឧបករណ៍ស្ចឹបតាម្រយៈម្៊ុឺន៊ុយ៖ 

Tools → Transform Tools → Crop 

 លៅលរ ដដ ឧបករណ៍លនះស្តូវបានលធ្វីឱ្យដំលណីរការ  នកនឹងរមា  ់លឃញីថ្នទរសន៍
ស្ទនិចកណដ៊ុ ររបរ់ នកលៅល ីផ្លទ ងំស្កណាត់នឹងផ្លល រ់បតូរលដីម្បបីរហ ញថ្ន ឧបករណ៍ស្ចឹបកំរ៊ុងស្តូវបានលស្បី
ស្បារ់។ 

ឥ ូវលនះ  នកអចច៊ុចកណដ៊ុ រខាងល វ្ងកដនលង
ណាមួ្យល ីផ្លទ ងំស្កណាត់រូបភាររបរ់ នក លហយី ូរ
កណដ៊ុ រលៅទីតាងំថ្មីលដីម្បរីលំ ចជលស្មី្រដំបូងលដីម្បសី្ចឹប។ 
 នកមិ្នចាបំាច់ស្រួយបារម្ា  ំរីភារជាក់ោក់លៅចំណ៊ុ ច
លនះលទ លស្ ះ នកនឹងអចដកដស្បការលស្ជីរលររីច៊ុង
លស្កាយ ម្៊ុនលរ ស្ចឹបរិតស្បាកដ។ 

បនាទ ប់រីលធ្វីការលស្ជីរលររីដំបូងល ីតំបន់លដីម្បសី្ចឹប  នកនឹងលឃញីការលស្ជីរលររីលនាះលៅដត
ដំលណីរការ។ លៅចំណ៊ុ ចលនះការដ្ឋក់ទរសន៍ស្ទនិចកណដ៊ុ ររបរ់ នកល ីស្ជុងណាមួ្យននស្ជុងទាងំបួននន
ការលស្ជីរលររីនឹងផ្លល រ់បតូរទរសន៍ស្ទនិចកណដ៊ុ រលហយីបនលិចតំបន់លនាះ។ ទាងំលនះ ន៊ុញ្ញ តឱ្យ នកដក
រស្មួ្ ជលស្មី្ររស្មប់ការស្ចឹប។  នកអចច៊ុច និង ូរដផនកណាមួ្យ ឬស្ជុងណាមួ្យលដីម្បផី្លល រ់ទីការ
លស្ជីរលររីដផនកលនាះ។ 

លៅលរ ដដ  នកលរញចិតតនឹងតំបន់ដដ ស្តូវស្ចឹប  នកស្ោន់ដតច៊ុច ស្ោប់ច៊ុច "Enter" លៅល ី
កាត រច៊ុចរបរ់ នកលដីម្បលីធ្វីការស្ចឹប។ ស្បរិនលបី នកចង់ចាប់លផតីម្ល ងីវញិ ឬរលស្ម្ចចិតតមិ្នស្ចឹបទា ់ដត
លសាះ  នកអចច៊ុចស្ោប់ច៊ុច "Esc" លៅល ីកាត រច៊ុចរបរ ់នកលដីម្បសី្ត ប់លចញរីស្បតិបតតិការ។ 

វិធីាស្គេតសផ្េងសទៀតច្នការស្រនឹរ 

វធីិ្មួ្យលទៀតលដីម្បសី្ចឹបរូបភារគឺស្តូវលធ្វីការលស្ជីរលររី
ជាម្៊ុនរិន លដ្ឋយលស្បី Rectangle Select Tool។ 

ឬតាម្រយៈម្៊ុឺន៊ុយ៖ 

រូបភារទី ៧.១២ ទីតាងំននការលស្ជីរលររីលដីម្បសី្ចឹប 

រូបភារទី ៧.១៣ Rectangle Select Tool 
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Tools → Selection Tools → Rectangle Select 

បនាទ ប់ម្ក  នកអចរលំ ចការលស្ជីរលររីតាម្វធីិ្ដូចោន លៅនឹងឧបករណ៍ស្ចឹប លហយីដកតស្មូ្វការ
លស្ជីរលររីផងដដរ។ លរ ដដ  នកមនការលស្ជីរលររីមួ្យដដ  នកលរញចិតតលហយី  នកអចស្ចឹបរូប
ភារឱ្យរម្នឹងជលស្មី្រលនាះតាម្រយៈ៖ 

Image → Crop to Selection 

៧.៥.៤. រងវិល និង/ឬស្រត រ់ររូភាព 

ស្បដហ ជាមនលរ ម្ួយ ដដ  នកនឹងស្តូវបងវិ រូបភារ។ ជាឧទាហរណ៍  នកស្បដហ ជាបាន
ថ្តរូបភារជាមួ្យកាលម្រ៉ា របរ់ នកកន៊ុងទិរបញ្ឈរ លហយីរស្មប់លហត៊ុផ មួ្យចំនួនវាមិ្នស្តូវបានរក
លឃញីលដ្ឋយ GIMP ថ្នចាបំាច់ស្តូវបងវិ ។ 

វាក៏អចមនលរ មួ្យដដ  នកចង់ស្ត ប់រូបភារផងដដរ។  កយបញ្ា ទាងំលនះស្តូវបានដ្ឋក់
ជាស្កុម្ជាមួ្យោន លៅលស្កាម្ធាត៊ុម្៊ុឺន៊ុយដូចោន ៖ 

Image → Transform 

ក. ការស្រត រ់ររូភាព 

ស្បរិនលបី នកចង់ស្ត ប់រូបភាររបរ់ នក ម្៊ុឺន៊ុយ Transform 
ផត ់នូវជលស្មី្ររីរគឺ Flip Horizontally ឬ Flip Vertically។ ស្បតិបតតិ
ការលនះនឹង ល្៊ុះរូបភាររបរ់ នកតាម្ ័កសដដ បានបញ្ា ក់។ឧទាហរណ៍ 
ខាងលស្កាម្លនះជាស្បតិបតតិការស្ត ប់ទាងំ រ់ ដដ បរហ ញកន៊ុងរូបភារ
ដតមួ្យ។ 

ខ. ការរងវិលររូភាព 

ការបងវិ រូបភាររី ម្៊ុឺន៊ុយ Transform  ស្តូវបានកំណត់លៅ 90° តាម្ស្ទនិចនា កិា/
ស្ចារស្ទនិចនា កិា ឬ 180°។ 

រូម្ក៊ុំយ ់ស្ច សំ្តង់ថ្ន GIMP មិ្នអចលធ្វីការបងវិ តាម្ ំលរី
ចិតត (ម្៊ុំណាមួ្យ)។ ការបងវិ លដ្ឋយបំ នស្តូវបានស្គប់ស្គងល ីមូ្ 
ដ្ឋា នកន៊ុងមួ្យស្រទាប់ ខ្ណៈលរ ដដ ការបងវិ រូបភារដដ បាន
រិរណ៌ា នាលៅទីលនះគឺ អច ន៊ុវតតបានចំល ះរូបភារទាងំមូ្ កន៊ុងលរ 
ដតមួ្យ។   

រូបភារទី ៧.១៤ ការស្ត ប់រូបភារ 

រូបភារទី ១០.១៥ ការបងវិ រូបភារ 
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េណួំររលំកឹសមសរៀន 

1- លតីឧបករណ៍ស្ចឹបលៅកន៊ុង GIMP អចលស្បីស្បារ់ោ៉ា ងមនស្បរិទធភារលដីម្ប ី៊ុបតំបន់ដដ មិ្ន
ចង់បាន ឬដកតស្មូ្វរមរភាររូបភារលដ្ឋយរលបៀបណា? លតី នកអចផដ ់ការដណនាជំា          
ជំហានៗ ំរីរលបៀបកាត់រូបភារលៅទំហជំាក់ោក់ ឬរមមស្តទិដាភារបានលទ? 

2- លតីជលស្មី្រលផសងោន  វីខ្លះដដ មនលៅកន៊ុង GIMP រស្មប់ផ្លល រ់បតូរទំហរំូបភារ លហយីលតីរួកវា
អចលស្បីស្បារ់បានលដ្ឋយរលបៀបណា លដីម្បផី្លល រ់បតូរទំហ ំ ឬមស្តដ្ឋា នននរូបភារ ខ្ណៈលរ 
ដដ រកាបាននូវគ៊ុណភាររបរ់វា?  

3- លតី នកអចរនយ ់រីភារខ្៊ុរោន រវាងការបតូរទំហលំដ្ឋយដផអកល ីភីកដរ  ភាគរយ ឬវមិស្តជាក់
ោក់បានលទ? 

4- លតី នកអចរនយ ់រីរលបៀបដដ ម្៊ុខ្ររ "Crop to Selection" លៅកន៊ុង GIMP អចស្តូវបានលស្បី
លដីម្បសី្ចឹបរូបភារលដ្ឋយដផអកល ីតំបន់លស្ជីរលររីជាក់ោក់មួ្យបានលទ  លតី វីលៅជាគ៊ុណ
រម្បតតិ និងកស្មិ្តននការលស្បីវធីិ្លនះលបីលធ្ៀបនឹងឧបករណ៍ស្ចឹបធ្ម្មតា? 

5- លតីរមមស្តននរូបភារអចរកាបានលដ្ឋយរលបៀបណាលរ បដូរទំហកំន៊ុង GIMP? លតីមន
ឧបករណ៍ ឬបលចចកលទរណាខ្លះដដ អចធានាបានថ្នរមមស្តននរូបភារលដីម្ស្តូវបានរកា
ទ៊ុកលៅលរ ដកតស្មូ្វទំហរំបរ់វា? 

 
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សមសរៀនទី ៨៖ មុខង្ហរលាយរញ្ចូលោៃ  (Blending Modes) 

៨.១. លកេណៈទូសៅ 

ជាធ្ម្មតាស្រទាប់មនភារស្រអប់ ដដ មនន័យថ្នស្រទាប់ខាងល ីស្គបដណត ប់ និងររងំ
ស្រទាប់ខាងលស្កាម្លដ្ឋយលមី្ លឃញី។ ម្៊ុខ្ររោយបញ្ចូ  ោន ផ្លល រ់បតូរឥរោិបថ្លនះ និង ន៊ុញ្ញ តឱ្យ
 កខណៈរណ៌ា មួ្យចំនួនននស្រទាប់មួ្យស្តូវបានផសជំាមួ្យនឹងរណ៌ា ននស្រទាប់ខាងលស្កាម្វា។ ម្៊ុខ្ររ
ោយបញ្ចូ  ោន ក៏អចស្តូវបានលស្បីលដីម្បលីធ្វីឱ្យរណ៌ា ដដ ទទួ បានរីឧបករណ៍គូរ (painting tool) 
ោយបញ្ចូ  ោន ជាមួ្យស្រទាប់ដដ ស្តូវបានោបរណ៌ា ផងដដរ។ 

ការបរហ ញម្៊ុឺន៊ុយ blending mode រស្មប់
ស្រទាប់ ដដ លៅកន៊ុង Layers dialog។ រូបភារ (b) 
បរហ ញម្៊ុឺន៊ុយ blending mode រស្មប់ឧបករណ៍
គូរ  ដដ ស្តូវបានរកលឃញីលៅកន៊ុង Brush Selection 
dialog។ ម្៊ុឺន៊ុយកន៊ុង Brush Selection dialog  ន៊ុវតត
ម្៊ុខ្ររោយបញ្ចូ  ោន  ដដ បានលស្ជីរលររីចំល ះ
ឧបករណ៍ោបរណ៌ា ទាងំ រ់ មនដូចជា លមម នដ ជក់
ោបថ្នន  ំ ជក់ ប ិកទឹកថ្នន  ំ និងឧបករណ៍ជក់ខ្យ ់  Xinput។ ល ីររីលនះលទៀត ម្៊ុឺន៊ុយលនះស្គប់ស្គងវធីិ្
ដដ  ឧបករណ៍ Bucket Fill , Gradient និង Clone  ន៊ុវតតថ្នន ោំបរបរ់រួកលគផងដដរ។    

ម្៊ុខ្ររោយបញ្ចូ  ោន លផសងៗោន ស្តូវបានរិរណ៌ា នាលៅកន៊ុងដផនកលនះ លហយីការលស្បីស្បារ់ និង
កម្មវធីិ្ជាក់ដរតងរបរ់រួកលគស្តូវបានរិរណ៌ា នាបនដបនាទ ប់។ GIMP មន 16 រលបៀបននការោយបញ្ចូ  
ោន ។ រួកវាស្តូវបានរយកន៊ុងស្កុម្ទាងំស្បាខំាងលស្កាម្៖ 

• ធ្ម្មតា(Normal) រោំយ(Dissolve) និង លៅខាងលស្កាយ(Behind) (មនលៅកន៊ុងរលបៀប
ោបដតប៉ា៊ុលណាណ ះ) 

• ភារខ្៊ុរោន  ការបដនេម្ និង ការដកលចញ 
• ការគ៊ុណល ងី (Burn) ការដចក (Dodge) ល ស្កង់ និង ការស្តួតល ីោន   
• ងងឹត និង ស្សា  
• រណ៌ា ស្  ៗ ជលស្ម្ៀប តនម្ល និង រណ៌ា  

លៅកន៊ុងការរិរណ៌ា នាខាងលស្កាម្ននម្៊ុខ្ររោយបញ្ចូ  ោន  ភីកដរ ននស្រទាប់ខាងល ី (ឬថ្នន ំ
ោបដដ បាន ន៊ុវតត) ស្តូវបានលគរំលៅថ្នជាភីកដរ នផទខាងម្៊ុខ្ និងស្រទាប់ខាងលស្កាម្ ឬស្រទាប់
ខាងលស្កាម្ជាភីកដរ នផទខាងលស្កាយ។ រញ្ញ ណ F និង B ស្តូវបានលស្បីលដីម្បតំីណាងឱ្យតនម្លលរៀងៗ   

រូបភារទី ៨.១ ម្៊ុឺន៊ុយ blending mode 
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ខ្លួន។ ការោយតនម្លភីកដរ នផទខាងម្៊ុខ្ F ជាមួ្យតនម្លនផទខាងលស្កាយ B លនាះនឹងផត ់ ទធផ តនម្ល
ភីកដរ  R។ 

៨.២. មុខង្ហរលាយរញ្ចូលោៃ ធមមតា រលំាយ និង សៅខាងសស្រកាយ 

ធ្ម្មតា(Normal) រោំយ(Dissolve) និង លៅខាងលស្កាយ(Behind) គឺជាទស្ម្ង់ pseudo-
blending modes លស្ ះវារិតជាមិ្នរមួ្បញ្ចូ  ោន នូវតនម្លភីកដរ នផទខាងម្៊ុខ្ និងនផទខាងលស្កាយននរូប
ភារលនាះលទ។ 

ម្៊ុខ្ររធ្ម្មតា (Normal mode) គឺជាទស្ម្ង់ ំនាលំដីម្នន GIMP ដដ ភីកដរ ខាងម្៊ុខ្អច
លមី្ លឃញី លហយីភីកដរ នផទខាងលស្កាយមិ្នលឃញីលទ។ ជាការរិតណារ់ លនះអចស្តូវបានផ្លល រ់បតូរ
លដ្ឋយការដករស្មួ្ ស្ោប់រកិំ ភារស្រអប ់ (opacity slider) លៅកន៊ុងស្ប ប់ស្រទាប់ (Layers 
dialog)។ 

ម្៊ុខ្រររោំយ (Dissolve)  ដំលណីរការលដ្ឋយ ន៊ុញ្ញ តឱ្យភាគរយននភីកដរ នផទខាងលស្កាយ
អចលមី្ លឃញីតាម្រយៈនផទខាងម្៊ុខ្។ វាអចលកីតល ងីដូចលនះ លដ្ឋយលធ្វីឱ្យដផនកខ្លះនននផទខាងម្៊ុខ្មន
ភារថ្នល មួ្យដផនក លហយីដផនកខ្លះលទៀតមនភារថ្នល លរញល ញ។ ទស្ម្ង់ទាងំរីរលនះស្តូវបានោយបញ្ចូ  
ោន តាម្រលបៀបនចដនយ។ លដីម្បឱី្យម្៊ុខ្រររោំយមនដបបដផន (effect) ស្រទាប់ខាងម្៊ុខ្ស្តូវដតមន    
ឆ្ដន អ ់ហាវ  (alpha channel) ដដ មនតនម្លតិចជាង 255។ ឆ្ដន អ ់ហាវ រស្មប់
ស្រទាប់អចស្តូវបានដកដស្បលដ្ឋយលស្បីរបាងំស្រទាប់។ 

កន៊ុងរូបភារទី ៨.២ បរហ ញរីការលស្បីស្បារ ់
Dissolve លដ្ឋយរូបភារ (a) បរហ ញស្ប ប់ 
Layers ដដ បរហ ញរីរលបៀបដដ គំរូលនះស្តូវបាន
សាងរង់។ រូបភារមនរីរស្រទាប់គឺ នផទខាង
លស្កាយរណ៌ា ស្កហម្ និងនផទខាងម្៊ុខ្រណ៌ា រ។ នផទ
ខាងម្៊ុខ្មនឆ្ដន អ ់ហាវ កំណត់តនម្ល 191 
(ស្រអប់ស្បដហ  75%)។       Mode menu 
កន៊ុងរូបភារ  (a) បរហ ញថ្ន រលបៀបរោំយបញ្ចូ  ោន
ស្តូវបានលស្ជីរលររីរស្មប់នផទខាងម្៊ុខ្។ 

រូបភារ (b) បរហ ញ ទធផ ននម្៊ុខ្ររោយបញ្ចូ  ោន ។ លដ្ឋយសារដតតនម្លននឆ្ដន អ ់
ហាវ ខាងម្៊ុខ្គឺ 75% ននភីកដរ រណ៌ា រដដ ស្រអប ់75% និង 25% មនភារស្រអប់ទាងំស្រុង។ 
រ័ត៌ាមន ម្អិតននដបបដផនអចស្តូវបានលគលមី្ លឃញីកាន់ដតចារ់លៅកន៊ុងតំបន់តូច ដដ រ៊ុរ័ំទធលដ្ឋយ

រូបភារទី ៨.២ ម្៊ុខ្រររោំយ (Dissolve) 
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ស្ប ប់លមម ដដ បរហ ញកន៊ុងរូបភារ(b)។ តំបន់លនះស្តូវបានរស្ងីក 900% និងបរហ ញល ងីវញិកន៊ុងរូប
ភារ(c)ដដ លធ្វីឱ្យទំនាក់ទំនងននភីកដរ ស្កហម្ និងរកាន់ដតចារ់។ 

ម្៊ុខ្ររលៅខាងលស្កាយ (Behind) ខ្៊ុររីម្៊ុខ្ររោយបញ្ចូ  ោន លផសងលទៀតទាងំ រ់លៅកន៊ុង 
GIMP  លដ្ឋយវាដំលណីរការដតជាមួ្យឧបករណ៍គំនូរប៉ា៊ុលណាណ ះ។ វាមិ្នមនម្៊ុខ្ររោយបញ្ចូ  ោន
រស្មប់ស្រទាប់លទ។ លដីម្បយី ់រីរលបៀបដដ វាដំលណីរការ រូម្ស្រនម្លមី្ ផ្លទ ងំកញ្ច ក់ដដ ោបល ី
នផទខាងម្៊ុខ្ ប៉ា៊ុដនតមនដផនកខ្លះននផ្លទ ងំស្កដ្ឋរទលទ ឬមនដតថ្នន ោំបថ្នល មួ្យដផនកលៅល ីវា។ ការោប
រណ៌ា ល ីនផទខាងលស្កាយននបនទះ ន៊ុញ្ញ តឱ្យរណ៌ា រីថ្នន ោំបថ្មីលនះបរហ ញលៅដផនកខាងម្៊ុខ្ ស្គប់ទីកដនលង
ដដ ដផនកខាងម្៊ុខ្មិ្នមនភារស្រអប់លរញល ញ។ 

កន៊ុងរូបភារទី ៨.៣ លៅកន៊ុងរូបភារ
(a) រូបភារស្រទាប់ដតមួ្យ ដដ មនរងវង់
ស្កហម្កណាត  ស្តូវបានបរហ ញ។ ស្រទាប់
ដដ លៅរ ់មនភារថ្នល ។ ស្ប ប់លស្ជីរ
លររីជក់ ដដ បរហ ញកន៊ុងរូបភារ(b) ស្តូវ
បានលស្បីលដីម្បលីស្ជីរលររីជក់ធំ្ រងឹ និងលដីម្បី
កំណត់ម្៊ុខ្ររោយលៅខាងលស្កាយ។ រូប
ភារក៏បានបរហ ញរី ទធផ ននការគូរ ន្ូតរណ៌ា នបតងភលឺ លដ្ឋយលស្បីឧបករណ៍ Paintbrush លដ្ឋយកាត់
រងវង់រណ៌ា ស្កហម្។ លទាះោ៉ា ងណាក៏លដ្ឋយ លៅកន៊ុងទស្ម្ង់លៅខាងលស្កាយ រណ៌ា នបតងស្តូវបានលគលមី្ 
លឃញីដតតាម្រយៈដផនកថ្នល ននស្រទាប់ប៉ា៊ុលណាណ ះ។ វាដំលណីរការរស្មប់ដតស្រទាប់ដដ មនឆ្ដន អ ់
ហាវ ប៉ា៊ុលណាណ ះ។ 

៨.៣. មុខង្ហរការលាយរញ្ចូលោៃ រថ្នថម ការែកសនញ និង ភាពខុេោៃ  

ការបដនេម្(addition) ការដកលចញ(subtract) និង ភារខ្៊ុរោន (difference) គឺជារលបៀប
ោយបញ្ចូ  ោន ដដ បដនេម្ និងដកតនម្លភីកដរ នផទ
ខាងម្៊ុខ្ និងនផទខាងលស្កាយកន៊ុងចលនាល ះរណ៌ា  RGB។ 

ម្៊ុខ្ររោយបដនេម្ ដំលណីរការដូចខាង   
លស្កាម្។ លដ្ឋយផដ ់ភីកដរ នផទខាងម្៊ុខ្ និងនផទខាង
លស្កាយ តំណាងលដ្ឋយវ៊ុចិទ័រ RGB F =[r 1 , g 1 , b 1] 
និង B =[ r 2 , g 2 , b 2 ] ភីកដរ ដដ ទទួ បាន
រីម្៊ុខ្ររោយបញ្ចូ  បដនេម្គឺ R = F + B = [ r 1 + 

រូបភារទី ៨.៣ ម្៊ុខ្ររលៅខាងលស្កាយ 

រូបភារទី ៨.៤ ការបដនេម្និងដកភីកដរ លៅកន៊ុងគូប RGB 
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r 2 , g 1 + g 2 , b 1 + b 2 ]។ ដូលចនះកន៊ុងរូបភារ(a)ស្រួញរណ៌ា លខ្ៀវទាងំរីរ តំណាងឱ្យភីកដរ នផទខាង
ម្៊ុខ្ និងនផទខាងលស្កាយ លហយីស្រួញស្កហម្គឺជាផ បូកននវ៊ុចិទ័រទាងំរីរ។ ការបដនេម្ដតងដតបលងកីតជា
រណ៌ា  ទធផ ដដ ស្សា  ឬស្សា ជាងរណ៌ា នផទខាងម្៊ុខ្ ឬនផទខាងលស្កាយ។ លនះលដ្ឋយសារដតផ បូក
វ៊ុចិទ័រស្តូវដតមនការរាករណ៍ល ី ័កស រាស្កឹត ដដ លៅជិតរណ៌ា រជាងការរាករណ៍រស្មប់រណ៌ា
នផទខាងលស្កាយ ឬនផទខាងម្៊ុខ្។ 

កន៊ុងករណីដដ ផ បូកវ៊ុចិទ័របលងកីត ទធផ លៅខាងលស្ៅគូបរណ៌ា  លនាះគឺលដ្ឋយការផ ិត
រមរធាត៊ុ RGB ណាមួ្យធំ្ជាង 255) តនម្លរបរ់វាស្តូវបានខាទ រ់លៅល ីនផទគូប។ រមី្ការដដ 
រណ៌ា នា ំរីម្៊ុខ្ររោយបញ្ចូ  បដនេម្ គឺ៖ 

 
ដដ  W ជាវ៊ុចិទ័រ [255,255,255] លហយី   ន៊ុវគម្ន៍ ន៊ុវតតការបស្ងួម្ បបបរមតាម្

ដផនកននវ៊ុចិទ័រទាងំរីរ។ 

រណ៌ា  cyan, magenta និង yellow គឺជាផ បូកននរណ៌ា គូរលផសងៗោន  លដ្ឋយនបតងនិង
លខ្ៀវ ស្កហម្និងលខ្ៀវ និង ស្កហម្និងនបតង។ ដូលចនះ រណ៌ា ទាងំបីមន cyan, magenta និង yellow 
លមី្ លៅស្សា ជាងស្កហម្ នបតង ឬលខ្ៀវ លស្ ះវាបញ្ច ងំខ្ពរ់ជាងល ី ័កស រាស្កឹត។ ល ីររីលនះ 
រណ៌ា បនាទ ប់បនសណំាមួ្យ (cyan, magenta, yellow) បូករមួ្ជាមួ្យនឹងរណ៌ា ចម្បងដដ បំលរញ
បដនេម្ (ស្កហម្ នបតង លខ្ៀវ) បលងកីតបានជារណ៌ា រ ដដ ជារណ៌ា ស្សា បំផ៊ុតកន៊ុងចំលណាម្រណ៌ា ទាងំ
 រ់។ 

កន៊ុងរូបភារទី ៨.៥ ការបរហ ញការ ន៊ុវតដម្៊ុខ្
ររោយបញ្ចូ  ោន បដនេម្ កន៊ុងរូបភារ(a) បរហ ញរូប
ភារននផ្លក  លហយីរូបភារ(b)បរហ ញស្ប ប់ Layers 
ដដ  ក់រ័នធ បរហ ញថ្នរូបភារលនះមនស្រទាប់រីរ។ 
ស្រទាប់ខាងល ីគឺជារូបភារផ្លក  លហយីស្រទាប់ខាង
លស្កាម្ស្តូវបានបំលរញលដ្ឋយរណ៌ា ស្បលផះកស្មិ្តម្ធ្យម្ 
ដដ តនម្លភីកដរ គឺលរមីោន  127 R 127 G 127 B ។  

លៅកន៊ុងរូបភារទី ៨.៥ ដដ រូបភារ(a) បរហ ញរូបភារផ្លក រស្មប់ម្៊ុខ្ររោយបញ្ចូ  ោន ធ្ម្ម
តា។ រូបភារ(c)បរហ ញរូបភារដូចោន លៅលរ  ដដ ម្៊ុខ្ររោយបញ្ចូ  ោន  (blending mode) 
ននស្រទាប់ខាងល ីស្តូវបានបតូរលៅជាAddition។ ទាងំលនះមនឥទធិរ ននការបដនេម្127 R 127G 127 B  
លៅស្គប់ភីកដរ កន៊ុងស្រទាប់ផ្លក  ដដ បំភលឺរូបភារទាងំមូ្ គួរឱ្យកត់រមា  ់។ តាម្រិតដផនកខ្លះននរូប
ភារស្តូវបានផា៊ុ ំលៅជារណ៌ា រទាងំស្រុង។ 

រូបភារទី ៨.៥ ម្៊ុខ្ររោយបញ្ចូ  ោន បដនេម្ 
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ឥទធិរ ននម្៊ុខ្ររោយដកលចញ ស្តូវបានបរហ ញកន៊ុងរូបភារ(b)។ ម្៊ុខ្ររោយលនះដំលណីរ
ការលដ្ឋយការផដ ់ភីកដរ នផទខាងម្៊ុខ្ និងនផទខាងលស្កាយ ដដ វាតំណាងនផទនីមួ្យៗលដ្ឋយវ៊ុចិទ័រ RGB 
F =[ r 1 , g 1 , b 1 ] និង B = [ r 2 , g 2 , b 2 ]។ ភីកដរ ដដ ទទួ បានរីម្៊ុខ្ររោយដកលចញ 
គឺ R = B - F =[ r 2 - r 1 , g 2 - g 1 , b 2 - b 1 ]។ ដូលចនះរស្មប់ស្រួញរណ៌ា លខ្ៀវរីរដដ មនសាល ក F
និងB កន៊ុងរូបភារ(b)  ទធផ ននការដកនផទខាងម្៊ុខ្លចញរីនផទខាងលស្កាយស្តូវបានផត ់ឱ្យលដ្ឋយរញ្ញ
ស្រួញស្កហម្ដដ មនសាល កR ។ 

ម្៊ុខ្ររោយដកលចញខ្៊ុរោន រីរលបៀបោយបញ្ចូ  ោន បដនេម្ លដ្ឋយម្៊ុខ្ររោយដកលចញមិ្ន
រ៊ុីលម្ស្ទីលទ(ការដក F រី B មិ្នដូចការដក B រី F លទ)។  ទធផ ននការដកនផទខាងម្៊ុខ្លចញរីនផទខាង
លស្កាយអចបលងកីតតនម្ល វជិាមន។ ស្បរិនលបីរមរធាត៊ុននវ៊ុចិទ័រ RGB  ទធផ គឺតិចជាងរូនយ វាស្តូវ
បានខាទ រ់លៅល ីនផទននគូប។ ដូលចនះរមី្ការដដ តំណាងឱ្យ ម្៊ុខ្ររោយដកលចញ គឺ៖ 

                                
ដដ  0 តំណាងឱ្យរណ៌ា  0R 0G 0B និង  ជា ន៊ុគម្ន៍ដដ  ន៊ុវតតការរស្ងីក តិបរម 

តាម្ដផនកននវ៊ុចិទ័រទាងំរីរ។ លដ្ឋយសាររណ៌ា នផទខាងម្៊ុខ្ដតងដតជាល ខ្វជិាមន  ទធផ គឺដតងដតងងឹត
ជាងនផទខាងលស្កាយ (លបីរិនជានផទខាងម្៊ុខ្ ឬនផទខាងលស្កាយរណ៌ា លមម  លនាះមិ្នមនការផ្លល រ់បតូរលទ)។ 

ម្៊ុខ្ររោយបញ្ចូ  ោន  គឺដូចជាដកលចញ ប៉ា៊ុដនត ទធផ គឺរ៊ុីលម្ស្ទីរវាងនផទខាងម្៊ុខ្ និងនផទខាង
លស្កាយ។ ភារខ្៊ុរោន  គឺរ៊ុីលម្ស្ទី លស្ ះវា ន៊ុវតតតនម្លដ្ឋច់ខាតចំល ះភារខ្៊ុរោន ននតនម្លនផទខាងម្៊ុខ្ និង
នផទខាងលស្កាយ។ ដូលចនះស្បរិនលបីរមរធាត៊ុ RGB មួ្យ គឺ វជិាមនបនាទ ប់រីការដក រញ្ញ របរ់វាស្តូវ
បានបង្គ្ញ្ច រ់លដីម្បលីធ្វីឱ្យវាវជិាមន។ កលនាម្គណិតវទិា ទធផ រស្មប់ ម្៊ុខ្ររោយបញ្ចូ  ោន
(របារបញ្ឈរកន៊ុងរមី្ការតំណាងឱ្យម្៊ុខ្ររតនម្លដ្ឋច់ខាត) គឺ៖ 

R =| F - B | 

តាម្រយៈការបរហ ញរីការ ន៊ុវតតម្៊ុខ្ររោយ
ដកលចញ និង ភារខ្៊ុរោន  គឺថ្នម្៊ុខ្ររទាងំលនះស្តូវ
បាន ន៊ុវតតចំល ះរូបភារ លដ្ឋយបរហ ញកន៊ុងរូបភារ
(a)ដដ មនផ្លក លៅកន៊ុងស្រទាប់ខាងល ី និងរណ៌ា
ស្បលផះម្ធ្យម្លៅស្រទាប់ខាងលស្កាម្។  នកអចលមី្ 
លឃញីថ្ន  ទធផ ននការលស្បីស្បារ់ម្៊ុខ្ររោយដក
លចញ ដដ បរហ ញកន៊ុងរូបភារ(a) មនតំបន់ដដ 
មនរណ៌ា លមម ទាងំស្រុង។ លនះជាភារខ្៊ុរោន រវាងនផទខាងម្៊ុខ្ និងនផទខាងលស្កាយ ដដ បលងកីតតនម្ល
 វជិាមនស្តូវបានកាត់លៅជារូនយ។ ភារខ្៊ុរោន  បរហ ញកន៊ុងរូបភារ(b)លទាះោ៉ា ងណាក៏លដ្ឋយ មិ្ន

រូបភារទី ៨.៦ ម្៊ុខ្ររោយដកលចញនិងរោយលផសងោន  
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មនតនម្លស្ចឹបលទ លស្ ះវាលស្បីតនម្លដ្ឋច់ខាតននភារខ្៊ុរោន ។ ចំណាថំ្នរស្មប់ទាងំទស្ម្ង់ដកលចញ
និង ភារខ្៊ុរោន  ទធផ គឺងងឹតជាងរូបភារលដីម្។ 

៨.៤.  មុខង្ហរគុណស ើង (Burn) ថ្រងថ្នក (Dodge) សអ្ស្រកង់ និង ការស្រតួតោៃ   

គ៊ុណល ងី  ដបងដចក  ល ស្កង់ និងការស្តួត
ោន  គឺជាម្៊ុខ្ររោយបញ្ចូ  ោន លស្ចីន។  ទធផ នន
តនម្លភីកដរ  គឺជាផ ិតផ  ឬម្៊ុខ្ររមួ្យនន
ផ ិតផ របរ់ភីកដរ ខាងម្៊ុខ្ និងនផទខាង  
លស្កាយ។ ដំលណីរការននម្៊ុខ្ររគ៊ុណល ងី និងល 
ស្កង់លៅល ីភីកដរ  ដដ តំណាងលៅកន៊ុងគូប 
RGB ស្តូវបានបរហ ញកន៊ុងរូបភារខាងសាដ លំនះ។ 

រស្មប់ភីកដរ ខាងម្៊ុខ្ដដ មនទីតាងំលៅកន៊ុងគូប RGB គឺ [ r 1 , g 1 , b 1 ] និងភីកដរ 
នផទខាងលស្កាយដដ មនទីតាងំគឺ [ r 2 , g 2 , b 2 ] ភីកដរ  ទធផ រស្មប់ម្៊ុខ្ររោយបញ្ចូ  ោន
គ៊ុណល ងី គឺជាផ ិតផ លដ្ឋយរមរភាគនននផទទាងំរីរឬ [r 1 r 2/255, g 1 g 2/255,b 1 b 2/255] 
ដដ ដចកជាមួ្យ 255 គឺចាបំាច់លដីម្បលីធ្វីឱ្យ ទធផ ធ្ម្មតាស្ត ប់លៅកន៊ុងគូប RGB ។ លនះអចស្តូវបាន

បរហ ញោ៉ា ងខ្លីលដ្ឋយរមី្ការ (និមិ្តតរញ្ញ  X មនន័យថ្ន គ៊ុណននរមរភាគ)៖ 

 
លដ្ឋយសារកតាត មស្តដ្ឋា ននន 255 តនម្លរមរធាត៊ុ

ននវ៊ុចិទ័រ RGB មួ្យស្តូវបានលធ្វីឱ្យមន កខណៈធ្ម្មតាលៅជួរ 
[0,1]។ ដូលចនះ R គឺតូចជាង F ឬ B ។ បនដរីការរិភាការីម្៊ុន 
 នកដឹងថ្នតូចជាងមនន័យថ្នងងឹតជាង លដ្ឋយសារការ
រាករល ី ័កស រាស្កឹតគឺខិ្តលៅជិតស្បភរលដីម្។ រូម្លមី្ 
រូបដដ បានបរហ ញកន៊ុងរូបភារខាងសាដ  ំ (a) រញ្ញ ស្រួញ
រណ៌ា លខ្ៀវរីរតំណាងឱ្យទីតាងំភីកដរ នផទខាងម្៊ុខ្ និងនផទ
ខាងលស្កាយ និងរញ្ញ ស្រួញរណ៌ា ស្កហម្តំណាងឱ្យផ ិត 
ផ ដដ មនធាត៊ុផស។ំ 

   

 

រូបភារទី ៨.៧ ម្៊ុខ្ររោយបញ្ចូ  ោន លស្ចីន និងម្៊ុខ្ររល ស្កង់ 

រូបភារទី ៨.៨ កំណត់ម្៊ុខ្ររោយបញ្ចូ  ោន លស្ចីន 
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ការបរហ ញឧទាហរណ៍ននការ ន៊ុវតតម្៊ុខ្ររោយបញ្ចូ  គ៊ុណល ងី លៅនឹងរូបភារផ្លក រីរូបភារ
ខាងល (ីa)។ ជាមួ្យនឹងការកំណត់លនះ ស្រទាប់ខាងលស្កាម្ននរូបភារលនះគឺជារណ៌ា ស្បលផះមនភីក
ដរ លរមីនឹង127 R 127 G 127 B ។  ទធផ ដដ បរហ ញកន៊ុងរូបភារ(a) គឺរូបភារស្តូវបានលធ្វីឱ្យងងឹត
លរមីភារោន ។ ជាក់ដរដងលដ្ឋយសារស្រទាប់ខាងលស្កាម្មនរណ៌ា ស្បលផះម្ធ្យម្ ដូលចនះតនម្លភីកដរ លៅ
កន៊ុងស្រទាប់ផ្លក ស្តូវបានលធ្វីមស្តដ្ឋា នលដ្ឋយ ស្គប់ទីកដនលង។  

 
រស្មប់ភីកដរ ខាងម្៊ុខ្ដដ មនទីតាងំលៅកន៊ុងគូប RGB គឺ [ r 1 , g 1 , b 1 ] និងភីកដរ 

នផទខាងលស្កាយដដ មនទីតាងំគឺ [ r 2 , g 2 , b 2 ] ដដ  នកស្បដហ ជាស្រនម្ថ្នភីកដរ ដដ ជា
 ទធផ រស្មប់ម្៊ុខ្ររោយបញ្ចូ  ោន  នឹងមន កខណៈស្រលដៀងោន លៅនឹងម្៊ុខ្ររគ៊ុណល ងី។ 
ដូលចនះរស្មប់ការដណនានឹំងបរហ ញ វីមួ្យដូចជា [255 r 2 / r 1 ,255 g 2 / g 1 ,255 b 2 / b 1 ]។ លទាះ
ោ៉ា ងណាក៏លដ្ឋយ កលនាម្លនះបរហ ញរីបញ្ហ ចំនួនរីរ។ បញ្ហ ទីមួ្យលៅលរ ដដ ភីកដរ ខាងម្៊ុខ្
មនរមរធាត៊ុរូនយ  ទធផ មិ្នស្តូវបានកំណត់លទ។ វាស្តូវបានលដ្ឋះស្សាយ លដ្ឋយបដនេម្តនម្លមួ្យ
លៅរមរធាត៊ុនីមួ្យៗននភីកដរ ខាងម្៊ុខ្។ ម្លធ្ាបាយលនះររងំការដបងដចកលដ្ឋយរូនយ។ បញ្ហ
ទីរីរ លៅលរ ដដ តនម្លភីកដរ ខាងម្៊ុខ្តូច  ទធផ អចមនទំហធំំ្ដដ វាដ ងលៅខាងកន៊ុងគូប 
RGB លទៀតលហយី។  វាស្តូវបានលដ្ឋះស្សាយលដ្ឋយការកាត់តនម្លដដ ធំ្លរកលៅល ីនផទគូប។ 

កលនាម្រលងខបរស្មប់ម្៊ុខ្ររដបងដចក គឺ៖ 

 
ដដ  W គឺ 255 R 255 G 255 B  រញ្ញ   ÷តំណាងឱ្យការដបងដចកតាម្ដផនកននវ៊ុចិទ័ររីរ លហយី 
តំណាងឱ្យការបស្ងួម្ បបបរមតាម្ដផនក។ រូបភារ(b)បរហ ញរីការ ន៊ុវតតននការដបងដចកលៅរូបភារផ្លក
រីរូបភារ(a)។ ដផនកខ្លះននរូបភារ ទធផ ស្តូវបានផល៊ុ ំលៅជារណ៌ា រ វាលកីតល ងីលៅកន៊ុងតំបន់ដដ រូប
ភារផ្លក លដីម្មនតនម្លភីកដរ តូច(ដដ ងងឹត)។ រូម្ចំណាថំ្ន Divide ដតងដតបំភលឺរូបភារមួ្យ លស្ ះ
វាដបងដចករមរធាត៊ុភីកដរ នីមួ្យៗលដ្ឋយចំនួនតិចជាង 1។ 

ម្៊ុខ្ររោយល ស្កង់ មនឥទធិរ រនលឺដដ ស្រលដៀងោន នឹងឥទធិរ ភារងងឹត ដដ បលងកីត
លដ្ឋយ Multiply ផងដដរ។ គំនិតលនះស្តូវបានបរហ ញលៅកន៊ុងរូបភារ(b)។ ដូចដដ បានបរហ ញកន៊ុងរូប
ភារ ម្៊ុខ្ររោយល ស្កង់ កំណត់ស្បភរលដីម្លៅជា 255 R 255 G 255 B ដដ ជាចំណ៊ុ ចរណ៌ា រលៅ
កន៊ុងគូប។ ដូលចនះ វ៊ុចិទ័រលៅភីកដរ នផទខាងម្៊ុខ្ និងនផទខាងលស្កាយ ដូចបរហ ញលដ្ឋយរញ្ញ ស្រួញរណ៌ា
លខ្ៀវរីរកន៊ុងរូបភារ(b)។ បនាទ ប់ម្កល ស្កង់នឹងគ៊ុណនឹងវ៊ុចិទ័រទាងំរីរបលងកីត ទធផ ដដ បរហ ញជា
រញ្ញ ស្រួញស្កហម្កន៊ុងរូបភារ(b)។ ដូចលៅនឹងម្៊ុខ្ររគ៊ុណល ងីដដរ វ៊ុចិទ័រ ទធផ ននម្៊ុខ្ររល 
ស្កង់ គឺខ្លីជាងវ៊ុចិទ័រខាងម្៊ុខ្ ឬនផទខាងលស្កាយ ប៉ា៊ុដនតទាក់ទងនឹងចំណ៊ុ ចរណ៌ា រលៅកន៊ុងគូប។ ដូលចនះ          
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វ៊ុចិទ័រ ទធផ គឺលៅជិតចំណ៊ុ ចរណ៌ា រ លហយីជា ទធផ ស្សា ជាងរណ៌ា នផទខាងម្៊ុខ្ ឬនផទខាង      
លស្កាយ។ កលនាម្គណិតវទិារស្មប់ម្៊ុខ្ររល ស្កង់គឺ៖ 

 
ជាថ្មីម្តងលទៀតកតាត នន 255 ស្តូវបានដណនាលំដីម្បរីកាតនម្លភីកដរ  ទធផ លៅខាងកន៊ុងគូប 

RGB ។ 

រូបភារ(c)បរហ ញរីឧទាហរណ៍ននការ ន៊ុវតតម្៊ុខ្ររល ស្កង់ លៅរូបភារផ្លក តាម្រយៈរូបភារ 
(a)។ ដូចដដ បានទាយ ទធផ គឺលៅស្គប់ទីកដនលងភលឺជាងលៅកន៊ុងរូបភារលដីម្ននផ្លក ។ រូម្កត់
រមា  ់ផងដដរថ្នមិ្នដូច Divide លទ ម្៊ុខ្ររល ស្កង់មិ្នផល៊ុ ំលៅជារណ៌ា រលទ។ ដូលចនះ ថ្វីតបតិដត Divide
និង Screen មន កខណៈរនលឺស្រលដៀងោន  ប៉ា៊ុដនតរួកលគមនប៊ុគា ិក កខណៈខ្៊ុរោន ខាល ងំ។ 

ជាច៊ុងលស្កាយ ម្៊ុខ្ររ Overlay គឺជាការរមួ្បញ្ចូ  ោន រវាង Multiply និង Screen ។ រមី្ការ
រស្មប់ម្៊ុខ្ររ Overlayគឺ៖ 

 
ដដ  R s តំណាងឱ្យតនម្លភីកដរ  ទធផ រស្មប់ម្៊ុខ្ររល ស្កង់ លហយី R m តំណាងឱ្យម្៊ុខ្ររ     
គ៊ុណ។ រមី្ការលនះនិោយថ្នតនម្លភីកដរ  ទធផ រស្មប់ម្៊ុខ្ររស្តួតោន   គឺជាការរមួ្បញ្ចូ  ោន នន
ម្៊ុខ្ររល ស្កង់ និង គ៊ុណល ងី។ ការោយបញ្ចូ  ោន ននរលបៀបទាងំរីរគឺរមមស្តលៅនឹងតនម្លភីកដរ
 នផទខាងលស្កាយ។ 

ដូលចនះ ស្បរិនលបីនផទខាងលស្កាយងងឹត (លនាះគឺមនតនម្ល RGB ជិតរូនយកន៊ុងរមរធាត៊ុទាងំបី) 
លនាះ ទធផ ននម្៊ុខ្ររ Multiply នឹងស្គបដណដ ប់ លហយី ទធផ ននម្៊ុខ្ររល ស្កង់នឹងស្តូវបិទ។ ផទ៊ុយ
លៅវញិស្បរិនលបីភីកដរ នផទខាងលស្កាយមនរនលឺ (លនាះគឺមនតនម្ល RGB ជិតរកន៊ុងរមរភាគទាងំ
បី)។ ររ៊ុបម្ក ម្៊ុខ្ររ Overlay មនទំលនារលធ្វីឱ្យរូបភារងងឹតជាងលៅកដនលងដដ វាងងឹត លហយី
ស្សា ជាងលៅកដនលងដដ មនរនលឺរចួលហយី។ រូបភារ(d) បរហ ញរីឧទាហរណ៍ននការ ន៊ុវតតម្៊ុខ្ររ
Overlay លៅរូបភារផ្លក តាម្រយៈរូបភារ(a)។   

៨.៥. មុខង្ហរលាយរញ្ចូលោៃ ភាពងងឹត និងភាពស្រាល 

ភារងងឹត (darken) គឺបលងកីតដតភីកដរ ដដ ជា ទធផ  ដដ រកានូវរមរធាត៊ុតូច
បំផ៊ុតននភីកដរ នផទខាងម្៊ុខ្ និងនផទខាងលស្កាយ។ ដូលចនះ ស្បរិនលបីភីកដរ ខាងម្៊ុខ្មនរមរ
ធាត៊ុ [ r 1 , g 1 , b 1 ] លហយីនផទខាងលស្កាយមន [ r 2 , g 2 , b 2 ] លនាះភីកដរ  ទធផ គឺ៖  
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លហយីទស្ម្ង់ខាងល លីនះ ស្តូវបានបញ្ា ក់លដ្ឋយបស្ងួម្លៅជាទស្ម្ង់ដូចខាងលស្កាម្៖ 

 
ដដ   មនន័យថ្នការបស្ងួម្ បបបរមតាម្រមរភាគ។ មិ្នគួរឱ្យភ្ាក់លផអី លទ ដដ រលបៀប 
Darken Only លធ្វីឱ្យរូបភារងងឹត។ 

តាម្រយៈការបរហ ញរីការលស្បីស្បារ់ម្៊ុខ្ររ 
Darken Only លៅល ីរបូភារផ្លក តាម្រយៈរូបភារ
(a) លដ្ឋយសារដតស្រទាប់ស្បលផះខាងលស្កាម្ផ្លក គឺ
លរម ី127R 127G 127B  ដដ  វីស្គប់ោ៉ា ងលៅកន៊ុងផ្លក
ដដ មនរមរធាត៊ុ RGB ងងឹតជាង 127 រកាតួ
 កសររបរ់វាលៅកន៊ុងរូបភារ។ ដផនកននរូបភារផ្លក ដដ 
ស្សា ជាងម្៊ុនស្តូវបានជំនួរលដ្ឋយរណ៌ា ស្បលផះ។ 

ម្៊ុខ្ររ Lighten Only មនរកម្មភារផទ៊ុយរី Darken Only ។ វាលស្ជីរលររីកស្មិ្ត តិបរមនន
រមរធាត៊ុនីមួ្យៗរីភីកដរ នផទខាងម្៊ុខ្ និងនផទខាងលស្កាយ។កលនាម្គណិតវទិារស្មប់ Lighten 
Only គឺ៖ 

 
ដដ   មនន័យថ្នការរស្ងីក តិបរមតាម្ដផនក។ ម្៊ុខ្ររ Lighten Only លធ្វីឱ្យរូបភារស្សា 
ជាងម្៊ុន។ រូបភារ(b)បរហ ញ ំរីការលស្បីស្បារ់ម្៊ុខ្ររ Lighten Only លៅល ីរូបភារផ្លក តាម្រយៈរូប
ភារ(a)។ ឥ ូវលនះ វីស្គប់ោ៉ា ងលៅកន៊ុងផ្លក ដដ មនរមរធាត៊ុ RGB ស្សា ជាង 127 រកាតួ កសរ
របរ់វាលៅកន៊ុងរូបភារ។ ដផនកននរូបភារផ្លក ដដ ងងឹតស្តូវបានជំនួរលដ្ឋយរណ៌ា ស្បលផះ។ 

៨.៦. មុខង្ហរលាយរញ្ចូលោៃ ពណ៌ស្រាលៗ រសស្រមៀរ តច្មែ និង ពណ៌ 

ម្៊ុខ្ររោយរណ៌ា ស្  ៗ(hue) ជលស្ម្ៀប(saturation) តនម្ល(value) និង រណ៌ា (color) 
រ៊ុទធដតជាដំលណីរការស្រលដៀងោន ។ រស្មប់រលបៀបនីមួ្យៗ រមរធាត៊ុ HSV មួ្យស្តូវបានយកលចញរី
ភីកដរ នផទខាងម្៊ុខ្ និងរមរភាគរីរលផសងលទៀតរីភីកដរ នផទខាងលស្កាយ។ ឧទាហរណ៍ ស្បរិនលបី
ម្៊ុខ្ររោយរណ៌ា ស្  ៗ ស្តូវបានលស្ជីរលររី  ទធផ គឺរណ៌ា ស្  ៗននភីកដរ នផទខាងម្៊ុខ្ រមួ្ផសំ
ជាមួ្យនឹងរណ៌ា ស្  ៗ និងតនម្លននភីកដរ នផទខាងលស្កាយ។ ដំលណីរការដូចោន លនះស្តូវបានលស្បី
រស្មប់ម្៊ុខ្ររោយបញ្ចូ  ោន  ជលស្ម្ៀប និង តនម្ល។  លទាះជាោ៉ា ងណាក៏លដ្ឋយ ម្៊ុខ្ររោយរណ៌ា គឺ

រូបភារទី ៨.៩ Darken only និង Lighten only 
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ខ្៊ុរោន បនតិចបនតួច។ រស្មប់ម្៊ុខ្រររណ៌ា ស្  ៗ និងជលស្ម្ៀបននភីកដរ នផទខាងម្៊ុខ្ស្តូវបានលស្បី
លដ្ឋយភាា ប់ជាមួ្យនឹងរនលឺននភីកដរ នផទខាងលស្កាយ។ ដូលចនះ រកម្មភារននរលបៀបោយរណ៌ា  Hue
អចស្តូវបានបរហ ញជា៖ 

R = [ h ( F ), s ( B ), v ( B )] 

ដដ  h ( F ) មនន័យថ្នរណ៌ា នផទខាងម្៊ុខ្ s ( B ) តំណាងឱ្យភារតិតេិភារនននផទខាងលស្កាយ 
លហយី v ( B ) គឺជាតនម្លនននផទខាងលស្កាយ។ ឧទាហរណ៍ននការ ន៊ុវតត រលបៀបោយរណ៌ា  Hue ស្តូវ
បានបរហ ញកន៊ុងរូបភារខាងលស្កាម្លនះ។ 

កន៊ុងរូបភារទី ៨.១០ រូបភារផ្លក រីរូបភារខាងលដីម្
បងអរ់(a) ស្តូវបានបរហ ញកន៊ុងរូបភារខាងល ីលនះ(a)។ រូប
ភារលនះគឺជានផទខាងម្៊ុខ្ននម្៊ុខ្រររណ៌ា ស្  ៗ លហយីនផទ
ខាងលស្កាយគឺជាស្រទាប់រណ៌ា លខ្ៀវ ដដ បរហ ញកន៊ុងរូបភារ
(b)ខាងល ីលនះ។ ស្រទាប់រណ៌ា លខ្ៀវលនះដស្បស្បួ លដ្ឋយ
លផដកកន៊ុងទស្ម្ង់តនម្ល និងបញ្ឈរលៅកន៊ុងទស្ម្ង់ជលស្ម្ៀប។  ទធ
ផ ននការ ន៊ុវតតម្៊ុខ្រររណ៌ា ស្  ៗ ស្តូវបានបរហ ញកន៊ុង
រូបភារ(c)។ លៅទីលនះ វាអចស្តូវបានលគលមី្ លឃញីោ៉ា ង
ចារ់ថ្ន ការដស្បស្បួ ជលស្ម្ៀប និងតនម្លននស្រទាប់រណ៌ា លខ្ៀវ
ស្តូវបានផសជំាមួ្យនឹងរណ៌ា ស្  ៗននស្រទាប់ផ្លក ។ 

ស្រលដៀងលៅនឹងរណ៌ា ស្  ៗ ម្៊ុខ្ររោយជលស្ម្ៀប បលងកីតផ ភីកដរ ដដ ជាការបញ្ចូ  
ោន ននភារជលស្ម្ៀបនននផទខាងម្៊ុខ្ និងរណ៌ា ស្  ៗ និងតនម្លនននផទខាងលស្កាយ។ កលនាម្រស្មប់ម្៊ុខ្ររ
ោយបញ្ចូ  ោន លនះគឺ៖ 

R = [ h ( B ), s ( F ), v ( B )] 

ដដ  s ( F ) គឺជាតិតេិភារនននផទខាងម្៊ុខ្ h ( B ) គឺជា
រណ៌ា ស្  ៗនននផទខាងលស្កាយ លហយីv ( B ) តំណាងឱ្យ
តនម្លនននផទខាងលស្កាយ។ ឧទាហរណ៍ននការ ន៊ុវតត រលបៀប
ោយ តិតេិភារ ស្តូវបានបរហ ញកន៊ុងរូបភារខាងលស្កាម្លនះ។ 

លៅកន៊ុងរូបភារទី ៨.១២ លយងីលឃញីម្តងលទៀតនូវរូប
ភារផ្លក របរ់លយងីកន៊ុងរូបភារ(a ខាងល លីដីរតួនាទីរស្មប់
ស្រទាបខ់ាងម្៊ុខ្។ លទាះោ៉ា ងណាក៏លដ្ឋយ ឥ ូវលនះ
ស្រទាប់នផទខាងលស្កាយដដ បរហ ញកន៊ុងរូបភារ(b) ខាងល ី

រូបភារទី ៨.១០ ការោយរណ៌ា  Hue 

រូបភារទី ៨.១១ ការ ន៊ុវតតម្៊ុខ្ររជលស្ម្ៀប 
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លនះ ស្តូវបានសាងរង់លដីម្បដីស្បស្បួ ដតលៅកន៊ុងរណ៌ា ស្  ៗ និងតនម្លប៉ា៊ុលណាណ ះ។ លៅកន៊ុងស្រទាប់លនះ 
រណ៌ា ស្  ៗផ្លល រ់បតូរតាម្ទិរលផដក និងតនម្លលៅតាម្បលណាត យបញ្ឈរ។  ទធផ ននការ ន៊ុវតតម្៊ុខ្ររ 
ជលស្ម្ៀបស្តូវបានបរហ ញកន៊ុងរូបភារ(c)។  

រលបៀបោយ តនម្ល បលងកីត ទធផ ភីកដរ  ដដ ជាការរមួ្បញ្ចូ  ោន ននតនម្លនផទខាងម្៊ុខ្ និង
រណ៌ា ស្  ៗ និងការតិតេិភារនននផទខាងលស្កាយ។ កលនាម្រស្មប់លនះគឺ 

R = [ h ( B ), s ( B ), v ( F )] 

លៅទីលនះ v ( F ) តំណាងឱ្យតនម្លនផទខាងម្៊ុខ្ h ( B ) រណ៌ា នផទខាងលស្កាយ និង s ( B )        
ជលស្ម្ៀបនផទខាងលស្កាយ។ ឧទាហរណ៍ននម្៊ុខ្ររោយលនះស្តូវបានបរហ ញកន៊ុងរូបភារខាងលស្កាម្។ 

 

កន៊ុងរូបភារទី ៨.១៣ ស្រទាប់នផទខាងលស្កាយ 
បរហ ញកន៊ុងរូបភារ(b) ដស្បស្បួ រណ៌ា ស្  ៗកន៊ុងទិរ
លផដក និងជលស្ម្ៀបកន៊ុងទិរបញ្ឈរ។  ទធផ ននម្៊ុខ្ររលនះ
ស្តូវបានបរហ ញកន៊ុងរូបភារ (c)។ 

 

ឧទាហរណ៍ច៊ុងលស្កាយលៅកន៊ុងដផនកលនះ បរហ ញរី
ម្៊ុខ្ររោយរណ៌ា ។ ម្៊ុខ្ររលនះរមួ្បញ្ចូ  ោន នូវរណ៌ា
ស្  ៗ និងរណ៌ា នផទខាងម្៊ុខ្ជាមួ្យនឹងរនលឺនផទខាង    
លស្កាយ។  កលនាម្រស្មប់ម្៊ុខាររោយលនះគឺ៖ 

R = [ h ( F ), s ( F ), l ( B )] 

ដដ  h ( F )និង s ( F ) គឺជារណ៌ា ស្  ៗ 
និងជលស្ម្ៀបនននផទខាងម្៊ុខ្ លហយី l ( B ) គឺជារនលឺនននផទ
ខាងលស្កាយ។ ឧទាហរណ៍ននរលបៀបោយលនះស្តូវបាន
បរហ ញកន៊ុងរូបភារខាងសាដ លំនះ (រូបភារទី ៨.១៤)។  

 

 

  

រូបភារទី ៨.១២ ម្៊ុខ្ររោយបញ្ចូ  ោន  

រូបភារទី ៨.១៣ ម្៊ុខ្ររោយបញ្ចូ  ោន  
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េណួំររលំកឹសមសរៀន 

1- លតី នកអចរនយ ់រីលោ បំណង និងម្៊ុខ្ររននទស្ម្ង់ោយបញ្ចូ  ោន  "Multiply" លៅកន៊ុង 
GIMP និងរលបៀបដដ វាអចស្តូវបានលស្បីលដីម្បរីលស្ម្ចបាននូវដបបដផនននការោយបញ្ចូ  ោន
លផសងៗ ដូចជាលធ្វីឱ្យរូបភារងងឹត ឬបលងកីតរូបភារចស្មុ្ះ? 

2- លតីម្៊ុខ្ររោយបញ្ចូ  ោន  "Screen" លៅកន៊ុង GIMP ខ្៊ុររីរលបៀបោយបញ្ចូ  ោន  " Multiply" 
ោ៉ា ងដូចលម្ដច លហយីលតីមនករណីលស្បីស្បារ់ វីខ្លះ ដដ ម្៊ុខ្ររោយល ស្កង់មនស្បលោជន៍ជា
រិលររ? 

3- លតី នកអចផត ់នូវឧទាហរណ៍ននម្៊ុខ្ររោយបញ្ចូ  ោន  "Overlay" លៅកន៊ុង GIMP លដីម្បី
បលងកីនកស្មិ្តរណ៌ា  បដនេម្ជលស្ៅ ឬ ន៊ុវតតដបបដផនរិលររលៅល រីូបភារបានលទ? 

4- លតី វីលៅជាការ ន៊ុវតតជាក់ដរតងមួ្យចំនួនននម្៊ុខ្ររោយបញ្ចូ  ោន  "Difference" លៅកន៊ុង 
GIMP លហយីលតីវាអចស្តូវបានលស្បីលដីម្បបីលងកីតដបបដផនដដ គួរឱ្យចាប់អរម្មណ៍ ឬកំណត់ភារ
ខ្៊ុរោន រវាងស្រទាប់ទាងំរីរលដ្ឋយរលបៀបណា? 

5- លតី នកអចរនយ ់រីរលបៀបដដ ម្៊ុខ្ររោយបញ្ចូ  ោន  "Hard Light" លៅកន៊ុង GIMP អចស្តូវ
បានលស្បីស្បារ់លដីម្បរីស្ងឹងរណ៌ា  បលងកីនកស្មិ្តរណ៌ា  ឬបដនេម្រូបរងដដ មនផ ប៉ាះ  ់ខ្ពរ់
ដ ់រូបភារបានលទ? 

6- ម្៊ុខ្ររោយបញ្ចូ  ោន  "Dodge" និង "Burn" លៅកន៊ុង GIMP ស្តូវបានលស្បីលដីម្បលីស្ជីរលររីរនល ឺ
ឬលធ្វីឱ្យងងឹតននរូបភារ លហយីលតីគនលឹះ វីខ្លះលដីម្បរីលស្ម្ចបាន ទធផ ជាក់ដរតង និងជាក់ដរតង? 

7- លតី វីជាឧទាហរណ៍ជាក់ដរតងមួ្យចំនួនននរលបៀបដដ ម្៊ុខ្ររោយបញ្ចូ  ោន  "Value" លៅកន៊ុង 
GIMP អចស្តូវបានលស្បីលដីម្បសី្គប់ស្គងរនលឺ ឬតនម្លរំលនៀងននស្រទាប់ខាងលស្កាម្ លហយីលតីគនលឹះ
 វីខ្លះរស្មប់រលស្ម្ចបាន ទធផ ដដ ចង់បាន? 

8- លតីការកំណត់ភារស្រអប់ ឬការបំលរញអចស្តូវបានដកតស្មូ្វលដ្ឋយភាា ប់ជាមួ្យនឹងម្៊ុខ្ររ
ោយបញ្ចូ  ោន លៅកន៊ុង GIMP ោ៉ា ងដូចលម្តច លដីម្បដីករស្មួ្ ស្បរិទធភារននការោយបញ្ចូ  
ោន រវាងស្រទាប់? លតីការរិចារណា វីខ្លះរស្មប់ការរលស្ម្ចបាននូវត៊ុ យភារដដ ចង់បានរវាង
 នកទាងំរីរ? 

 
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